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Preface

Thank you for considering and/or adopting our text Simply Visual Basic .NET. If you have not read the preface to
Simply Visual Basic .NET, we strongly encourage you to do so. The preface contains a careful walkthrough of
book’s key features. We have worked hard to produce a textbook and ancillaries that we hope you and your stu-
dents will find valuable.

The following ancillary resources are available:

• Simply Visual Basic .NET’s program examples are included on a CD-ROM in the back of the book. The
examples help instructors prepare lectures faster and aid students in their study of the Visual Basic .NET.
The examples are also available for download at www.deitel.com. When extracting the source code
from the ZIP file, you must use a ZIP-file reader such as WinZip (www.winzip.com) or PKZIP
(www.pkware.com) that understands directories. The file should be extracted into a separate directory
such as simplyvb1_solutions.

• This Simply Visual Basic .NET Instructor’s Manual contains answers to the exercises in Simply Visual Basic
.NET. The Instructor’s Manual CD also contains programming exercise solutions. The programs are separat-
ed into directories by tutorial and by project name. 

• Companion Web site at www.prenhall.com/deitel.

• Powerpoint Slide Show which contains the source code for each program and key discussion points for the
examples. Instructors can edit these slides for their own use in classroom discussions.

• Test Item File which contains hundreds of multiple-choice questions. Instructors can use these questions to
create exams.

We would sincerely appreciate your comments, criticisms and corrections. Please send them to: 

deitel@deitel.com

We will respond immediately. Please watch our Deitel & Associates, Inc. Web site and our Prentice Hall Web site
for book and product updates:

www.deitel.com
www.prenhall.com/deitel

We would like to thank the extraordinary team of publishing professionals at Prentice Hall who made Simply
Visual Basic .NET and its ancillaries possible. Our Computer Science editor, Petra Recter, worked closely with us
to ensure the timely availability and professional quality of these ancillaries. 

Harvey M. Deitel
Paul J. Deitel
Cheryl Yaeger
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Instructor’s Manual
Exercise Solutions

Tutorial 1

MULTIPLE-CHOICE
QUESTIONS

1.1 The World Wide Web was developed .

1.2 Microsoft’s  initiative integrates the Internet and the Web into software
development. 

1.3 TextBoxes, Buttons and RadioButtons are examples of . 

1.4  is an example of primary memory.

1.5 Visual Basic .NET is an example of a(n)  language, in which single program
statements accomplish more substantial tasks.

1.6 Which protocol is primarily intended to create a “network of networks?”

1.7 A major benefit of  programming is that it produces software that is more
understandable and better organized than software produced with previously used
techniques.

1.8 .NET’s collection of prepackaged classes and methods is called the .

1.9 The information-carrying capacity of communications lines is called .

1.10 Which of these programming languages was specifically created for .NET?

Answers: 1.1) b.  1.2) a.  1.3) d.  1.4) b.  1.5) c.  1.6) b.  1.7) a.  1.8) c.  1.9) d.  1.10) a.

EXERCISES 1.11 Categorize each of the following items as either hardware or software:

a) by ARPA b) at CERN by Tim Berners-Lee
c) before the Internet d) as a replacement for the Internet

a) .NET b) BASIC
c) Windows d) W3C

a) platforms b) high-level languages
c) IDEs d) controls

a) TCP b) RAM
c) ALU d) CD-ROM

a) machine b) intermediate-level
c) high-level d) assembly

a) TCP b) IP
c) OOP d) FCL

a) object-oriented b) centralized
c) procedural d) HTML

a) NCL b) WCL
c) FCL d) PPCM

a) networking b) secondary storage
c) traffic d) bandwidth

a) C# b) C++
c) BASIC d) Visual Basic

a) CPU b) Compiler
c) Input unit d) A word-processor program
e) A Visual Basic .NET program
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Answers: a) hardware.  b) software.  c) hardware.  d) software.  e) software.

1.12 Translator programs, such as assemblers and compilers, convert programs from one lan-
guage (referred to as the source language) to another language (referred to as the target lan-
guage). Determine which of the following statements are true and which are false:

a) A compiler translates high-level-language programs into target-language programs.

b) An assembler translates source-language programs into machine-language programs.

c) A compiler translates source-language programs into target-language programs.

d) High-level languages are generally machine dependent.

e) A machine-language program requires translation before it can be run on a
computer.

Answers: a) True.  b) True.  c) True.  d) False. High-level languages are generally machine 
independent.  e) False. A machine language program is native to that specific machine and 
can be run without translation.

1.13 Computers can be thought of as being divided into six units.

a) Which unit can be thought of as “the boss” of the other units?

b) Which unit is the high-capacity “warehouse” and retains information even when the
computer is powered off?

c) Which unit might determine whether two items stored in memory are identical?

d) Which unit obtains information from devices like the keyboard and mouse?

Answers: a) CPU.  b) Secondary storage unit.  c) ALU.  d) Input unit.

1.14 Expand each of the following acronyms:

Answers: a) World Wide Web Consortium.  b) Transmission Control Protocol/Internet Pro-
tocol.  c) Object-oriented programming.  d) Framework Class Library.  e) HyperText Markup 
Language.

1.15 What are the advantages to using object-oriented programming techniques?

Answer: Programs that use object-oriented programming techniques are easier to under-
stand, correct and modify. The key advantage with using object-oriented programming is that 
it tends to produce software that is more understandable because it is better organized and 
has fewer maintenance requirements than software produced with earlier methodologies. 
OOP helps the programmer build applications faster by reusing existing software compo-
nents. OOP also helps programmers create new software components that can be reused on 
future software-development projects.

a) W3C b) TCP/IP
c) OOP d) FCL
e) HTML
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 Introducing the Visual Studio® .NET IDE
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Instructor’s Manual
Exercise Solutions

Tutorial 2

MULTIPLE-CHOICE
QUESTIONS

2.1 The  integrated development environment is used for creating applications
written in .NET programming languages such as Visual Basic.NET.

2.2 The.vb filename extension indicates a .

2.3 The pictures on toolbar Buttons are called .

2.4 The  allows programmers to modify controls visually, without writing code.

2.5 The  hides the Toolbox when the mouse pointer is moved outside the Tool-
Box’s area.

2.6 A  appears when the mouse pointer is positioned over an IDE toolbar icon
for a few seconds.

2.7 The Visual Studio .NET IDE provides .

2.8 The  contains a list of helpful links, such as Get Started and Online Commu-
nity.

2.9 The Properties window contains .

2.10 A  can be enhanced by adding reusable components such as Buttons.

2.11 For Web browsing, Visual Studio .NET includes .

2.12 An application’s GUI can include .

a) Solution Explorer b) Gates
c) Visual Studio .NET d) Microsoft

a) Visual Basic file b) dynamic help file
c) help file d) very big file

a) prototypes b) icons
c) tool tips d) tabs

a) Properties window b) Solution Explorer 
c) menu bar d) Toolbox 

a) component-selection feature b) Auto Hide feature
c) pinned command d) minimize command

a) drop-down list b) menu
c) tool tip d) down arrow

a) help documentation b) a toolbar
c) windows for accessing project files d) All of the above.

a) Solution Explorer window b) Properties window
c) Start Page d) Toolbox link

a) the component object box b) a Solution Explorer 
c) menus d) a menu bar

a) control b) Form 
c) tab d) property

a) Web View b) Excel
c) a Web tab d) Internet Explorer

a) toolbars b) icons
c) menus d) All of the above.
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2.13 The  does not contain a pin icon.

2.14 When clicked,  in the Solution Explorer window will expand nodes and
 will collapse nodes.

2.15 Form  specify attributes such as size and position.

Answers:  2.1) c.  2.2) a.  2.3) b.  2.4) a.  2.5) b.  2.6) c.  2.7) d.  2.8) c.  2.9) a.  2.10) b.  2.11) d.  
2.12) d.  2.13) d.  2.14) b.  2.15) c.

EXERCISES 2.16 (Closing and Opening the Start Page) In this exercise, you will learn how to close and
reopen the Start Page. To accomplish this task, perform the following steps:

a) Close Visual Studio .NET if it is open by selecting File > Exit or by clicking its close
box.

b) Start Visual Studio .NET.

c) Close the Start Page by clicking its close box (Fig. 2.30).

Figure 2.30 Closing the Start Page.

d) Select Help > Show Start Page to display the Start Page.

2.17 (Enabling Auto Hide for the Solution Explorer Window) In this exercise, you will
learn how to use the Solution Explorer window’s Auto Hide feature by performing the fol-
lowing steps:

a) Open the Start Page.

b) In the Get Started page (displayed by default), click the Open Project Button to dis-
play the Open Project dialog. You can skip to step e) if the Welcome application is
already open.

c) In the Open Project dialog, navigate to C:\SimplyVB\Welcome and click Open.

d) In the Open Project dialog, select Welcome.sln and click Open.

e) Position the mouse pointer on the vertical pin icon in the Solution Explorer window’s
title bar. After a few seconds, a tool tip appears displaying the words Auto Hide
(Fig. 2.31).

a) Dynamic Help window b) Solution Explorer window
c) Toolbox window d) active tab

a) minus boxes; plus boxes b) plus boxes; minus boxes
c) up arrows; down arrows d) left arrows; right arrows

a) nodes b) inputs
c) properties d) title bars
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Figure 2.31 Enabling Auto Hide.

f) Click the vertical pin icon. This action causes a Solution Explorer tab to appear on
the right side of the IDE. The vertical pin icon changes to a horizontal pin icon
(Fig. 2.32). Auto Hide has now been enabled for the Solution Explorer window.

Figure 2.32 Solution Explorer window with Auto Hide enabled.

g) Position the mouse pointer outside the Solution Explorer window to hide the win-
dow.

h) Position the mouse pointer on the Solution Explorer tab to view the Solution
Explorer window.

2.18 (Sorting Properties Alphabetically in the Properties Window) In this exercise, you
will learn how to sort the Properties window’s properties alphabetically by performing the
following steps:

a) Open the Welcome application by performing steps a) through d) of Exercise 2.17. If
the Welcome application is already open, you can skip this step.

b) Locate the Properties window. If it is not visible, select View > Properties Window
to display the Properties window.

c) To sort properties alphabetically, click the Properties window’s alphabetic icon
(Fig. 2.33). The properties now display in alphabetic order.

Figure 2.33 Sorting properties alphabetically.
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Instructor’s Manual
Exercise Solutions

Tutorial 3

MULTIPLE-CHOICE
QUESTIONS

3.1 Property  determines the Form’s background color. 

3.2 To save all the solution’s files, select .

3.3 When the ellipsis Button to the right of the Font property value is clicked, the
 is displayed.

3.4 PictureBox property  contains a preview of the image displayed in the
PictureBox.

3.5 The  tab allows you to create your own color.

3.6 The PictureBox class has namespace .

3.7 A Label control displays the text specified by property . 

3.8 In  mode, the application is executing.

3.9 The  command prevents programmers from accidentally altering the size and
location of the Form’s controls.

3.10 Pixels are .

Answers: 3.1) a.  3.2) c.  3.3) d.  3.4) c.  3.5) a.  3.6) a.  3.7) c.  3.8) b.  3.9) a.  3.10) a.

EXERCISES For Exercises 3.11–3.16, you are asked to create the GUI shown in each exercise. You
will use the visual programming techniques presented in this tutorial to create a vari-
ety of GUIs. Because you are creating only GUIs, your applications will not be fully
operational. For example, the Calculator GUI in Exercise 3.11 will not behave like a
calculator when its Buttons are clicked. You will learn how to make your applica-
tions fully operational in later tutorials. Create each application as a separate project. 

a) BackColor b) BackgroundColor 
c) RGB d) Color 

a) Save > Solution > Save Files b) File > Save 
c) File > Save All d) File > Save As… 

a) Font Property dialog b) New Font dialog
c) Font Settings dialog d) Font dialog

a) Picture b) ImageName 
c) Image d) PictureName 

a) Custom b) Web 
c) System d) User 

a) System.Windows.Forms b) System.Form.Form 
c) System.Form.Font d) System.Form.Control 

a) Caption b) Data 
c) Text d) Name 

a) start b) run
c) break d) design

a) Lock Controls b) Anchor Controls 
c) Lock d) Bind Controls 

a) picture elements b) controls in the Toolbox
c) a set of fonts d) a set of colors on the Web tab
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3.11 (Calculator GUI) Create the GUI for the calculator shown in Fig. 3.33. 

Figure 3.33  Calculator GUI.

a) Creating a new project. Create a new Windows Application named Calculator.

b) Renaming the Form file. Name the Form file Calculator.vb.

c) Manipulating the Form’s properties. Change the Size property of the Form to 272,
192. Change the Text property of the Form to Calculator. Change the Font prop-
erty to Tahoma.

d) Adding a TextBox to the Form. Add a TextBox control by double clicking it in the
Toolbox. A TextBox control is used to enter input into applications. Set the Text-
Box’s Text property in the Properties window to 0. Change the Size property to
240, 21. Set the TextAlign property to Right; this right aligns text displayed in the
TextBox. Finally, set the TextBox’s Location property to 8, 16.

e) Adding the first Panel to the Form. Panel controls are used to group other controls.
Double click the Panel icon ( ) in the Toolbox to add a Panel to the
Form. Change the Panel’s BorderStyle property to Fixed3D to make the inside of
the Panel appear recessed. Change the Size property to 88, 112. Finally, set the
Location property to 8, 48. This Panel contains the calculator’s numeric keys.

Button

Panel
(contains 6 Buttons)

Panel
(contains 2 Buttons)

Decimal point Button

 Subtraction ButtonTextBox

Panel (contains 11 Buttons
for the numeric keys)
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f) Adding the second Panel to the Form. Click the Form. Double click the Panel icon in
the Toolbox to add another Panel to the Form. Change the Panel’s BorderStyle
property to Fixed3D. Change the Size property to 72, 112. Finally, set the Location
property to 112, 48. This Panel contains the calculator’s operator keys.

g) Adding the third (and last) Panel to the Form. Click the Form. Double click the
Panel icon in the Toolbox to add another Panel to the Form. Change the Panel’s
BorderStyle property to Fixed3D. Change the Size property to 48, 72. Finally, set
the Location property to 200, 48. This Panel contains the calculator’s C (clear) and
C/A (clear all) keys.

h) Adding Buttons to the Form. There are 20 Buttons on the calculator. To add a But-
ton to a Panel, double click the Button control ( ) in the Toolbox.
Then add the Button to the Panel by dragging and dropping it on the Panel. Change
the Text property of each Button to the calculator key it represents. The value you
enter in the Text property will appear on the face of the Button. Finally, resize the
Buttons, using their Size properties. Each Button labelled 0–9, x, /, -, = and .
should have a size of 24, 24. The 00 and OFF Buttons have size 48, 24. The + Button
is sized 24, 64. The C (clear) and C/A (clear all) Buttons are sized 32, 24.

i) Saving the project. Select File > Save All to save your changes.

3.12 (Alarm Clock GUI) Create the GUI for the alarm clock in Fig. 3.34.

Figure 3.34 Alarm Clock GUI.

a) Creating a new project. Create a new Windows Application named AlarmClock.

b) Renaming the Form file. Name the Form file AlarmClock.vb.

Buttons

Label

RadioButton

GroupBox
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c) Manipulating the Form’s properties. Change the Size property of the Form to 256,
176. Change the Text property of the Form to Alarm Clock. Change the Font prop-
erty to Tahoma.

d) Adding Buttons to the Form. Add six Buttons to the Form. Change the Text prop-
erty of each Button to the appropriate text. Change the Size properties of the Hour,
Minute and Second Buttons to 56, 23. The ON and OFF Buttons get size 40, 23. The
Timer Button gets size 48, 32. Align the Buttons as shown in Fig. 3.34.

e) Adding a Label to the Form. Add a Label to the Form. Change the Text property to
Snooze. Set its Size to 248, 23. Set the Label’s TextAlign property to Middle-
Center. Finally, to draw a border around the edge of the Snooze Label, change the
BorderStyle property of the Snooze Label to FixedSingle.

f) Adding a GroupBox to the Form. GroupBoxes are like Panels, except that GroupBoxes
can display a title. To add a GroupBox to the Form, double click the GroupBox control
( ) in the Toolbox. Change the Text property to AM/PM, and set the
Size property to 72, 72. To place the GroupBox in the correct location on the Form,
set the Location property to 104, 38.

g) Adding AM/PM RadioButtons to the GroupBox. Add two RadioButtons to the Form
by dragging the RadioButton control ( ) in the Toolbox and dropping it
onto the GroupBox twice. Change the Text property of one RadioButton to AM and
the other to PM. Then place the RadioButtons as shown in Fig. 3.34 by setting the
Location of the AM RadioButton to 16, 16 and that of the PM RadioButton to 16,
40. Set their Size properties to 48, 24.
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h) Adding the time Label to the Form. Add a Label to the Form and change its Text
property to 00:00:00. Change the BorderStyle property to Fixed3D and the Back-
Color to Black. Set the Size property to 64, 23. Use the Font property to make the
time bold. Change the ForeColor to Silver (located in the Web tab) to make the
time stand out against the black background. Set TextAlign to MiddleCenter to
center the text in the Label. Position the Label as shown in Fig. 3.34.

i) Saving the project. Select File > Save All to save your changes.

3.13 (Microwave Oven GUI) Create the GUI for the microwave oven shown in Fig. 3.35.

Figure 3.35 Microwave Oven GUI.

a) Creating a new project. Create a new Windows Application named Microwave.

b) Renaming the Form file. Name the Form file Microwave.vb.

c) Manipulating the Form’s properties. Change the Size property of the Form to 552,
288. Change the Text property of the Form to Microwave Oven. Change the Font
property to Tahoma.

Buttons

Label

Panel

Panel (door)
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d) Adding the microwave oven door. Add a Panel to the Form by double clicking the
Panel ( ) in the Toolbox. Select the Panel and change the BackColor
property to Silver (located in the Web tab) in the Properties window. Then change
the Size to 328, 224. Next, change the BorderStyle property to FixedSingle.

e) Adding another Panel. Add another Panel and change its Size to 152, 224 and its
BorderStyle to FixedSingle. Place the Panel to the right of the door Panel, as
shown in Fig. 3.35. 

f) Adding the microwave oven clock. Add a Label to the right Panel by clicking the
Label in the Toolbox once, then clicking once inside the right Panel. Change the
Label’s Text to 12:00, BorderStyle to FixedSingle and Size to 120, 48. Change
TextAlign to MiddleCenter. Place the clock as shown in Fig. 3.35.
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g) Adding a keypad to the microwave oven. Place a Button in the right Panel by click-
ing the Button control in the Toolbox once, then clicking inside the Panel. Change
the Text to 1 and the Size to 24, 24. Repeat this process for nine more Buttons,
changing the Text property in each to the next number in the keypad. Then add the
Start and Clear Buttons, each of Size 64, 24. Do not forget to set the Text proper-
ties for each of these Buttons. Finally, arrange the Buttons as shown in Fig. 3.35. The
1 Button is located at 40, 80 and the Start Button is located at 8, 192.

h) Saving the project. Select File > Save All to save your changes.

3.14 (Cell Phone GUI) Create the GUI for the cell phone shown in Fig. 3.36.

Figure 3.36 Cell Phone GUI.

a) Creating a new project. Create a new Windows Application named Phone.

b) Renaming the Form file. Name the Form file Phone.vb.

Panel

Label
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c) Manipulating the Form’s properties. Change the Form’s Text property to Phone and
the Size to 160, 488. Change the Font property to Tahoma.

d) Adding the display Label. Add a Label to the Form. Change its BackColor to Aqua
(in the Web tab palette), the Text to Welcome to Deitel Mobile Phone! and the
Size to 136, 184. Change the TextAlign property to MiddleCenter. Then place the
Label as shown in Fig. 3.36.

e) Adding the keypad Panel. Add a Panel to the Form. Change its BorderStyle prop-
erty to FixedSingle and its Size to 104, 136.
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f) Adding the keypad Buttons. Add the keypad Buttons to the Form (12 Buttons in
all). Each Button on the number pad should be of Size 24, 24 and should be placed
in the Panel. Change the Text property of each Button such that numbers 0–9, the
pound (#) and the star (*) keys are represented. Then add the final two Buttons such
that the Text property for one is Talk and the other is End. Change the Size of each
Button to 24, 80, and notice how the small Size causes the Text to align vertically.
Also change each Button’s Font size to 12 points.

g) Placing the controls. Arrange all the controls so that your GUI looks like Fig. 3.36.

h) Saving the project. Select File > Save All to save your changes.

3.15  (Vending Machine GUI) Create the GUI for the vending machine in Fig. 3.37.
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Figure 3.37 Vending Machine GUI.

a) Creating a new project. Create a new Windows Application named Vending-
Machine.

b) Renaming the Form file. Name the Form file VendingMachine.vb.

c) Manipulating the Form’s properties. Set the Text property of the Form to Vending
Machine and the Size to 560, 488. Change the Font property to Tahoma.

d) Adding the food selection Panel. Add a Panel to the Form, and change its Size to
312, 344 and BorderStyle to Fixed3D. Add a PictureBox to the Panel, and change
its Size to 50, 50. Then set the Image property by clicking the ellipsis Button and
choosing a file from the C:\Examples\Tutorial03\ExerciseImages\VendingMa-
chine directory. Repeat this process for 11 more PictureBoxes.

Label

GroupBox

Panel

PictureBoxes
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e) Adding Labels for each vending item. Add a Label under each PictureBox.
Change the Text property of the Label to A1, the TextAlign property to TopCenter
and the Size to 56, 16. Place the Label so that it is located as in Fig. 3.37. Repeat this
process for A2 through C4 (11 Labels).

f) Creating the vending machine door (as a Button). Add a Button to the Form by
dragging the Button control in the Toolbox and dropping it below the Panel.
Change the Button’s Text property to PUSH, its Font Size to 36 and its Size to 312,
56. Then place the Button on the Form as shown in Fig. 3.37.
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g) Adding the selection display Label. Add a Label to the Form, and change the Text
property to B2, BorderStyle to FixedSingle, Font Size to 36, TextAlign to Mid-
dleCenter and Size to 160, 72.

h) Grouping the input Buttons. Add a GroupBox below the Label, and change the Text
property to Please make selection and the Size to 160, 136.
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i) Adding the input Buttons. Finally, add Buttons to the GroupBox. For the seven But-
tons, change the Size property to 24, 24. Then change the Text property of the But-
tons such that each Button has one of the values A, B, C, 1, 2, 3 or 4, as shown in
Fig. 3.37. When you are done, move the controls on the Form so that they are aligned
as shown in the figure.

j) Saving the project. Select File > Save All to save your changes.

Programming Challenge 3.16 (Radio GUI) Create the GUI for the radio in Fig. 3.38. [Note: All colors used in this
exercises are from the Web palette.]

▲
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Figure 3.38 Radio GUI.

In this exercise, you will create this GUI on your own. Feel free to experiment with dif-
ferent control properties. For the image in the PictureBox, use the file (MusicNote.gif)
found in the C:\Examples\Tutorial03\ExerciseImages\Radio directory.

a) Creating a new project. Create a new Windows Application named Radio.

b) Renaming the Form file. Name the Form file Radio.vb.

c) Manipulating the Form’s properties. Change the Form’s Text property to Radio and
the Size to 576, 240. Change the Font property to Tahoma. Set BackColor to Peach-
Puff. 

d) Adding the Pre-set Stations GroupBox and Buttons. Add a GroupBox to the Form.
Set its Size to 232, 64, its Text to Pre-set Stations, its ForeColor to Black and
its BackColor to RosyBrown. Change its Font to bold. Finally, set its Location to 24,
16. Add six Buttons to the GroupBox. Set each BackColor to PeachPuff and each
Size to 24, 23. Change the Buttons’ Text properties to 1, 2, 3, 4, 5, 6, respectively.

e) Adding the Speakers GroupBox and CheckBoxes. Add a GroupBox to the Form. Set
its Size to 160, 72, its Text to Speakers and its ForeColor to Black. Set its Loca-
tion to 280, 16. Add two CheckBoxes to the Form. Set each CheckBox’s Size to 56,
24. Set the Text properties for the CheckBoxes to Rear and Front.

PictureBox

ButtonCheckBoxes

RadioButtonsTrackBar

GroupBox

GroupBoxes
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f) Adding the Power On/Off Button. Add a Button to the Form. Set its Text to Power
On/Off, its BackColor to RosyBrown, its ForeColor to Black and its Size to 72, 64.
Change its Font style to Bold.

g) Adding the Volume Control GroupBox, the Mute CheckBox and the Volume Track-
Bar. Add a GroupBox to the Form. Set its Text to Volume Control, its BackColor to
RosyBrown, its ForeColor to Black and its Size to 200, 80. Set its Font style to
Bold. Add a CheckBox to the GroupBox. Set its Text to Mute and its Size to 56, 24.
Add a TrackBar to the GroupBox.

h) Adding the Tuning GroupBox, the radio station Label and the AM/FM RadioBut-
tons. Add a GroupBox to the Form. Set its Text to Tuning, its ForeColor to Black
and its BackColor to RosyBrown. Set its Font style to Bold and its Size to 216, 80.
Add a Label to the Form. Set its BackColor to PeachPuff, its ForeColor to Black,
its BorderStyle to FixedSingle, its Font style to Bold, its TextAlign to Middle-
Center and its Size to 56, 23. Set its Text to 92.9. Place the Label as shown in the
figure. Add two RadioButtons to the GroupBox. Change the BackColor to Peach-
Puff and change the Size to 40,24. Set one’s Text to AM and the other’s Text to FM.
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i) Adding the image. Add a PictureBox to the Form. Set its BackColor to Transpar-
ent, its SizeMode to StretchImage and its Size to 56, 72. Set its Image property to
C:\Examples\Tutorial03\ExerciseImages\Radio\MusicNote.gif.

j) Saving the project. Select File > Save All to save your changes.
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Instructor’s Manual
Exercise Solutions

Tutorial 4

MULTIPLE-CHOICE
QUESTIONS

4.1 A new Windows application is created by selecting  from the File menu.

4.2 A Label’s BorderStyle property can be set to .

4.3 When creating a Label, you can specify the  of that Label.

4.4 Changing the value stored in the  property will change the name of the Form
file.

4.5  should be used to prefix all TextBox names.

4.6 A(n)  helps the user understand a control’s purpose.

4.7 A  is a control in which the user can enter data from a keyboard.

4.8 A descriptive Label uses .

4.9 You should use the  font in your Windows applications.

4.10  should be used to prefix all Button names.

Answers: 4.1) c.  4.2) a.  4.3) d.  4.4) c.  4.5) a.  4.6) b.  4.7) b.  4.8) d.  4.9) a.  4.10) d.

EXERCISES At the end of each tutorial, you will find a summary of new GUI design tips listed in the 
GUI Design Guidelines section. A cumulative list of GUI design guidelines, organized by 
control appears in Appendix C. In these exercises, you will find Visual Basic .NET Forms 
that do not follow the GUI design guidelines presented in this tutorial. For each exercise, 
you must modify control properties so that your end result is consistent with the guidelines 
presented in the tutorial. Note that these applications do not provide any functionality.

4.11 (Address Book GUI) In this exercise, you apply the GUI design guidelines you have
learned to a graphical user interface for an address book (Fig. 4.24). 

a) New > Program b) New > File… 
c) New > Project… d) New > Application 

a) Fixed3D b) Single 
c) 3D d) All of the above.

a) alignment of the text b) border style
c) size d) All of the above.

a) Name b) File 
c) File Name d) Full Path 

a) txt b) tbx 
c) Frm d) tbn 

a) Button b) descriptive Label 
c) output Label d) title bar

a) Button b) TextBox 
c) Label d) PictureBox 

a) sentence-style capitalization b) book-title capitalization
c) a colon at the end of its text d) Both a and c.

a) Tahoma b) MS Sans Serif
c) Times d) Palatino

a) but b) lbl 
c) Frm d) btn 
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Figure 4.24 Address Book application without GUI design guidelines applied.

a) Copying the template to your working directory. Copy the
C:\Examples\Tutorial04\Exercises\AddressBook directory to your C:\Sim-
plyVB directory. 

b) Opening the application’s template file. Double click AddressBook.sln in the
AddressBook directory to open the application.

c) Applying GUI design guidelines. Rearrange the controls and modify properties so
that the GUI conforms to the design guidelines you have learned.

d) Saving the project. Select File > Save All to save your changes.

Answer:

1. Change the Form’s title (Text property).

2. All TextBoxes should have corresponding Labels.

3. Labels indicating control usage should use sentence-style capitalization.

4. Buttons should use book-title capitalization.

5. Each descriptive Label text should end with a colon.

4.12 (Mortgage Calculator GUI) In this exercise, you apply the GUI design guidelines you
have learned to a graphical user interface for a mortgage calculator (Fig. 4.25). 
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Figure 4.25 Mortgage Calculator application without GUI design guidelines 
applied.

a) Copying the template to your working directory. Copy the
C:\Examples\Tutorial04\Exercises\MortgageCalculator directory to your
C:\SimplyVB directory. 

b) Opening the application’s template file. Double click MortgageCalculator.sln in
the MortgageCalculator directory to open the application.

c) Applying GUI design guidelines. Rearrange the controls and modify properties so
that the GUI conforms to the design guidelines you have learned.

d) Saving the project. Select File > Save All to save your changes.

Answer:

1. Label should be placed above or to the left of the control it is describing.

2. Output Label’s setting should be BorderStyle property Fixed3D.

3. Output Label initially should be blank.

4. Place an application’s output below or to the right of the Form’s input
control.

4.13 (Password GUI) In this exercise, you apply the GUI design guidelines you have
learned to a graphical user interface for a password-protected message application
(Fig. 4.26). 
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Figure 4.26 Password application without GUI design guidelines applied.

a) Copying the template to your working directory. Copy the
C:\Examples\Tutorial04\Exercises\Password directory to your C:\SimplyVB
directory. 

b) Opening the application’s template file. Double click Password.sln in the Pass-
word directory to open the application.

c) Applying GUI design guidelines. Rearrange the controls and modify properties so
that the GUI conforms to the design guidelines you have learned.

d) Saving the project. Select File > Save All to save your changes.

Answer:

1. Keep the Label on the Buttons as short and descriptive as possible.

2. Arrange groups of controls approximately 2 grid units apart on a Form.

3. Leave approximately 2 grid units of space between the edges of the Form
and controls nearest the edge. Increase the Form’s width.

4. Buttons use book-title capitalization.

Programming Challenge 4.14 (Monitor Invoice GUI) In this exercise, you apply the GUI design guidelines you have
learned to a graphical user interface for an invoice application (Fig. 4.27). 

▲
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Figure 4.27 Invoice application without GUI design guidelines applied.

a) Copying the template to your working directory. Copy the
C:\Examples\Tutorial04\Exercises\MonitorInvoice directory to your C:\Sim-
plyVB directory. 

b) Opening the application’s template file. Double click MonitorInvoice.sln in the
MonitorInvoice directory to open the application. 

c) Applying GUI design guidelines. Rearrange the controls and modify properties so
that the GUI conforms to the design guidelines you have learned.

d) Saving the project. Select File > Save All to save your changes.

Answer:

1. Use Tahoma font.

2. Labels indicating control usage should end with colon.

3. The Label and the control it describes should be aligned on the left if
arranged vertically.

4. Label should use sentence-style capitalization.
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5. Buttons should be placed in the top right or bottom right of a Form.

6. Each output Label must have a label that describes it.

7. Output Labels arranged vertically and used to display numbers in a cal-
culation should have the TextAlign property set to MiddleRight.

8. Descriptive Labels that are in the same column vertically should be left
aligned.
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Instructor’s Manual
Exercise Solutions

Tutorial 5

MULTIPLE-CHOICE
QUESTIONS

5.1 A(n)  represents a user action, such as clicking a Button.

5.2 To switch to code view, select .

5.3 Code that performs the functionality of an application .

5.4 Comments .

5.5 The  allows a statement to continue past one line (when that character is pre-
ceded by one or more whitespace characters).

5.6 A(n)  causes an application to produce erroneous results.

5.7 A portion of code that performs a specific task and returns a value is known as a(n)
.

5.8 Visual Basic .NET keywords are .

5.9 Visual Studio .NET allows you to organize code into , which you can expand
or collapse to facilitate code editing.

5.10 An example of a whitespace character is a  character.

Answers: 5.1) b.  5.2) c.  5.3) a.  5.4) d.  5.5) c.  5.6) a.  5.7) b.  5.8) b.  5.9) c.  5.10) d.  

EXERCISES 5.11 (Inventory Enhancement) Extend the Inventory application to include a TextBox in
which the user can enter the number of shipments received in a week. Assume every ship-

a) statement b) event
c) application d) function

a) Code > View b) Design > Code 
c) View > Code d) View > File Code 

a) normally is provided by the programmer
b) can never be in the form of an event handler
c) always creates a graphical user interface
d) is always generated by the IDE

a) help improve program readability
b) are preceded by the single-quote character
c) are ignored by the compiler d) All of the above.

a) single-quote (') character b) hyphen (-) character
c) underscore (_) character d) plus (+) character

a) logic error b) event
c) assignment statement d) syntax error

a) variable b) function
c) operand d) identifier

a) identifiers b) reserved words
c) case sensitive d) properties

a) statements b) operators
c) regions d) keywords

a) space b) tab
c) newline d) All of the above.
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ment has the same number of cartons (each of which has the same number of items). Then
modify the code so that the Inventory application uses that value in its calculation. 

Figure 5.25 Enhanced Inventory application GUI.

a) Copying the template application to your working directory. Copy the C:\Exam-
ples\Tutorial05\Exercises\InventoryEnhancement directory to your C:\Sim-
plyVB directory. 

b) Opening the application’s template file. Double click InventoryEnhancment.sln
in the InventoryEnhancement directory to open the application.

c) Resizing the Form. Resize the Form you used in this tutorial by setting the Size prop-
erty to 296, 144. Move the Button toward the bottom of the Form, as shown in
Fig. 5.25. Its new location should be 184, 78.

d) Adding a Label. Add a Label to the Form and change the Text property to Ship-
ments this week:. Set the Location property to 16, 80. Resize the Label so that
the entire text displays. Set the Label’s Name property to lblShipments.

e) Adding a TextBox. Add a TextBox to the right of the Label. Set its Text property to
0 and the Location property to 128, 80. Set the TextAlign and Size properties to
the same values as for the other TextBoxes in this tutorial’s example. Set the Text-
Box’s Name property to txtShipments.

f) Modifying the code. Modify the Calculate Total Click event handler so that it multi-
plies the number of shipments per week with the product of the number of cartons in
a shipment and the number of items in a carton.

g) Running the application. Select Debug > Start to run your application. Enter values
for the number of cartons per shipment, items per carton and shipments in the cur-
rent week. Click the Calculate Button and verify that the total displayed is equal to
the result when the three values entered are multiplied together. Enter a few sets of
input and verify the total each time.

h) Closing the application. Close your running application by clicking its close box.

i) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 5.11 Solution
2 ' Inventory.vb
3
4 Public Class FrmInventory
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' handles Click event

10    Private Sub btnCalculate_Click(ByVal sender As _
11       System.Object, ByVal e As System.EventArgs) _
12       Handles btnCalculate.Click
13
14       ' multiply values input and display result in Label
15       lblTotalResult.Text = _
16          Val(txtCartons.Text) * _
17          Val(txtItems.Text) * _
18          Val(txtShipments.Text)
19
20    End Sub ' btnCalculate_Click
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5.12 (Counter Application) Create a counter application. Your counter application will
consist of a Label and Button on the Form. The Label initially displays 0, but, each time a
user clicks the Button, the value in the Label is increased by 1. When incrementing the
Label, you will need to write a statement such as lblTotal.Text = Val(lblTotal.Text) +
1.

Figure 5.26 Counter GUI.

a) Creating the application. Create a new project named Counter.

b) Changing the name of the Form file. Change the name of Form1.vb to Counter.vb.

c) Modifying a new Form. Change your Form’s Size property to 168, 144. Modify the
Form so that the title reads Counter. Change the name of the Form to FrmCounter.

d) Changing the startup object. Change the startup object of your application to the
form you modified in Step c.

e) Adding a Label. Add a Label to the Form, and place it as shown in Fig. 5.26. Make
sure that the Label’s Text property is set to 0 and that TextAlign property is set so
that any text will appear in the middle (both horizontally and vertically) of the Label.
This can be done by using the MiddleCenter TextAlign property. Also set the Bor-
derStyle property to Fixed3D. Set the Label’s Name property to lblCountTotal.

f) Adding a Button. Add a Button to the Form so that it appears as shown in Fig. 5.26.
Set the Button’s Text property to contain the text Count. Set the Button’s Name
property to btnCount.

g) Creating an event handler. Add an event handler to the Count Button such that the
value in the Label increases by 1 each time the user clicks the Count Button.

h) Running the application. Select Debug > Start to run your application. Click the
Count Button several times and verify that the output value is incremented each
time.

i) Closing the application. Close your running application by clicking its close box.

j) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

21
22 End Class ' FrmInventory

1 ' Exercise 5.12 Solution
2 ' Counter.vb
3
4 Public Class FrmCounter
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' handles Click event

10    Private Sub btnCount_Click(ByVal sender As _
11       System.Object, ByVal e As System.EventArgs) _
12       Handles btnCount.Click
13
14       ' when button is clicked add one to lblCountTotal
15       lblCountTotal.Text = Val(lblCountTotal.Text) + 1
16
17    End Sub ' btnCount_Click

Button

Label
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5.13 (Account Information Application) Create an application that allows a user to input a
name, account number and deposit amount. The user then clicks the Enter Button, which
causes the name and account number to be copied and displayed in two output Labels. The
deposit amount entered will be added to the deposit amount displayed in another output
Label. The result is displayed in the same output Label. Every time the Enter Button is
clicked, the deposit amount entered is added to the deposit amount displayed in the output
Label, keeping a cumulative total. When updating the Label, you will need to write a state-
ment such as lblDeposits.Text = Val(lblDeposits.Text) + Val(txtDepositAmount).

Figure 5.27 Account Information GUI.

a) Copying the template application to your working directory. Copy C:\Exam-
ples\Tutorial05\Exercises\AccountInformation directory to your C:\Sim-
plyVB directory. 

b) Opening the application’s template file. Double click AccountInformation.sln in
the AccountInformation directory to open the application.

c) Creating an event handler. Add an event handler for the Enter Button’s Click
event.

d) Coding the event handler. Code the event handler to copy information from the
Name: and Account number: TextBoxes to their corresponding output Labels.
Then add the value in the Deposit amount: TextBox to the Deposit amount: output
Label, and display the result in the Deposit amount: output Label.

e) Running the application. Select Debug > Start to run your application. Enter the
values in Fig. 5.27 and click the Enter Button. Verify that the account information is
displayed in the Labels on the right. Enter varying deposit amounts and click the
Enter Button after each. Verify that the deposit amount on the right has the new val-
ues added.

f) Closing the application. Close your running application by clicking its close box.

g) Closing the IDE. Close Visual Studio .NET by clicking its close box. 

Answer:

18
19 End Class ' FrmCounter

1 ' Exercise 5.13 Solution
2 ' AccountInformation.vb
3
4 Public Class FrmAccountInformation
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' handles Click event

10    Private Sub btnEnter_Click(ByVal sender As _
11       System.Object, ByVal e As System.EventArgs) _
12       Handles btnEnter.Click
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What does this code do? 5.14 After entering 10 in the txtPrice TextBox and 1.05 in the txtTax TextBox, a user
clicks the Button named btnEnter. What is the result of the click, given the following code?

Answer: This displays the number 10.5 in a Label. (This is the amount of the sale including 
the tax.)

What’s wrong with this code? 5.15 The following event handler should execute when the user clicks a Calculate Button.
Identify the error(s) in its code.

Answer: The first line of the event handler header is missing the line-continuation character, 
and the second line of the header has a comment after the line-continuation character; both 
are syntax errors. Also, the code should use the Val function. The corrected code should 
read:

Using the Debugger 5.16 (Account Information Debugging Exercise) Copy the folder from C:\Exam-
ples\Tutorial05\Exercises\DebuggingExercise to your work folder, C:\SimplyVB, and
run the Account Information application. Remove any syntax errors, so that the application
runs correctly.

Answer:

13
14       ' copy user input
15       lblCopiedName.Text = txtName.Text
16       lblCopiedAccountNumber.Text = Val(txtAccountNumber.Text)
17       lblBalance.Text = Val(lblBalance.Text) + _
18          Val(txtDepositAmount.Text)
19
20    End Sub ' btnEnter_Click
21
22 End Class ' FrmAccountInformation

▲

1 Private Sub btnEnter_Click(ByVal sender As _
2    System.Object, ByVal e As System.EventArgs) _ 
3    Handles btnCalculate.Click
4
5    lblOutput.Text = Val(txtPrice.Text) * Val(txtTax.Text)
6
7 End Sub ' btnEnter_Click

▲
1 Private Sub btnCalculate_Click(ByVal sender As
2    System.Object, ByVal e As System.EventArgs) _ ' second line
3    Handles btnCalculate.Click
4
5    lblResult.Text = txtPrice.Text * txtTax.Text
6 End Sub ' btnCalculate_Click

1 Private Sub btnCalculate_Click(ByVal sender As 
2    System.Object, ByVal e As System.EventArgs) _
3    Handles btnCalculate.Click
4
5    
6 End Sub ' btnCalculate_Click

_

lblResult.Text = Val(txtPrice.Text) * Val(txtTax.Text)

▲
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Programming Challenge 5.17 (Account Information Enhancement) Modify Exercise 5.13 so that it no longer asks for
the user’s name and account number, but rather asks the user for a withdrawal or deposit
amount. The user can enter both a withdrawal and deposit amount at the same time. When
the Enter Button is clicked, the balance is updated appropriately.

Figure 5.28 Enhanced Account Information GUI.

a) Copying the template application to your working directory. If you have not already
done so, copy the C:\Examples\Tutorial05\Exercises\AccountInformation
directory to your C:\SimplyVB directory.

b) Opening the application’s template file. Double click AccountInformation.sln in
the AccountInformation directory to open the application.

c) Modifying the GUI. Modify the GUI so that it appears as in Fig. 5.28.

d) Setting the default values. Set the default name and account number to the values
shown in Fig. 5.28 using the Properties window.

e) Writing code to add functionality. Update the account balance for every withdrawal
(which decreases the balance) and every deposit (which increases the balance). When
the balance is updated, reset the TextBoxes to zero.

f) Running the application. Select Debug > Start to run your application. Enter vari-
ous withdrawal and deposit amounts, click the Enter Button after each. Verify that
after each time the Enter Button is clicked, the balance on the right of the applica-
tion is updated appropriately.

g) Closing the application. Close your running application by clicking its close box.

h) Closing the IDE. Close Visual Studio .NET by clicking its close box.

1 ' Exercise 5.16 Solution
2 ' AccountInformation.vb
3
4 Public Class FrmAccountInformation
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' Enter button click event

10    Private Sub btnEnter_Click(ByVal sender 
11       System.Object, ByVal e As System.EventArgs) _
12       Handles btnEnter.Click
13
14       lblBalance.Text = Val(txtDepositAmount.Text) _
15          - Val(txtWithdrawalAmount.Text) _
16          + Val( .Text)
17
18    End Sub ' btnEnter_Click
19
20 End Class ' FrmAccountInformation

As _

lblBalance

Line-continuation
character was missing

lblBalance was mispelled

▲
Default name

Default account number
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Answer:

1 ' Exercise 5.17 Solution
2 ' AccountInformation.vb
3
4 Public Class FrmAccountInformation
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' event handler for Enter button

10    Private Sub btnEnter_Click(ByVal sender As _
11       System.Object, ByVal e As System.EventArgs) _
12       Handles btnEnter.Click
13
14       lblBalance.Text = Val(txtDepositAmount.Text) _
15          - Val(txtWithdrawalAmount.Text) _
16          + Val(lblBalance.Text)
17
18       ' reset TextBoxes
19       txtWithdrawalAmount.Text = "0"
20       txtDepositAmount.Text = "0"
21
22    End Sub ' btnEnter_Click
23
24 End Class ' FrmAccountInformation
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Instructor’s Manual
Exercise Solutions

Tutorial 6

MULTIPLE-CHOICE
QUESTIONS

6.1 Parentheses that are added to an expression simply to make it easier to read are known
as  parentheses.

6.2 The  operator performs Integer division.

6.3 Every variable has a .

6.4 In Visual Basic .NET, arithmetic expressions must be written in  form.

6.5 Arithmetic expressions are evaluated .

6.6 Variable declarations in event handlers begin with the keyword .

6.7 Entering a value in a TextBox raises the  event. 

6.8 The  function converts user input from a TextBox to a variable of type Dou-
ble.

6.9 Variables to store integer values should be declared with keyword .

6.10 Keyword  in a variable declaration indicates that the data type is the next
word.  

Answers: 6.1) b.  6.2) a.  6.3) d.  6.4) a.  6.5) c.  6.6) b.  6.7) d.  6.8) c.  6.9) a.  6.10) d.

EXERCISES 6.11 (Simple Encryption Application) This application uses a simple technique to encrypt a
number. Encryption is the process of modifying data so that only those intended to receive
the data can undo the changes and view the original data. The user enters the number to be
encrypted via a TextBox. The application then multiplies the number by 7 and adds 5. The
application displays the encrypted number in a Label as shown in Fig. 6.24.

a) necessary b) redundant
c) embedded d) nested

a) \ b) + 
c) Mod d) ^ 

a) name b) value
c) type d) All of the above.

a) straight-line b) top-bottom
c) left-right d) right-left

a) from right to left b) from left to right
c) according to the rules of operator precedence
d) from the lowest level of precedence to the highest level of precedence

a) Declare b) Dim 
c) Sub d) Integer 

a) TextAltered b) ValueChanged 
c) ValueEntered d) TextChanged 

a) Convert b) MakeDouble

c) Val d) WriteDouble 

a) Integer b) Int

c) IntVariable d) None of the above.

a) IsA b) Type

c) Dim d) As
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Figure 6.24 Result of completed Simple Encryption application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial06\Exercises\SimpleEncryption directory to your C:\SimplyVB
directory. 

b) Opening the application’s template file. Double click SimpleEncryption.sln in
the SimpleEncryption directory to open the application.

c) Coding the Click event handler. Encrypt the number in the Click event handler by
using the preceding technique. The user input should be stored in an Integer vari-
able (intNumber) before it is encrypted. The event handler then should display the
encrypted number.

d) Clearing the result. Add an event handler for the Enter number to encrypt: Text-
Box’s TextChanged event. This event handler should clear the Encrypted number:
TextBox whenever the user enters new input.

e) Running the application. Select Debug > Start to run your application. Enter the
value 25 into the Enter number to encrypt: TextBox and click the Encrypt Button.
Verify that the value 180 is displayed in the Encrypted number: output Label. Enter
other values and click the Encrypt Button after each. Verify that the appropriate
encrypted value is displayed each time.

f) Closing the application. Close your running application by clicking its close box.

g) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 6.11 Solution
2 ' SimpleEncryption.vb
3
4 Public Class FrmEncryption
5    Inherits System.Windows.Forms.Form
6
7    ' handles Click event
8    Private Sub btnEncrypt_Click(ByVal sender As System.Object, _
9       ByVal e As System.EventArgs) Handles btnEncrypt.Click

10
11       Dim intNumber As Integer
12
13       intNumber = Val(txtInput.Text)  ' obtain user input
14
15       intNumber = intNumber * 7 + 5  ' encrypt number
16
17       lblResult.Text = intNumber  ' display encrypted number
18    End Sub ' btnEncrypt_Click
19
20    ' handles TextChanged event
21    Private Sub txtInput_TextChanged(ByVal sender As _
22       System.Object, ByVal e As System.EventArgs) _
23       Handles txtInput.TextChanged
24
25       lblResult.Text = ""
26    End Sub ' txtInput_TextChanged
27
28 End Class ' FrmEncryption
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6.12 (Temperature Converter Application) Write an application that converts a Celsius
temperature, C, to its equivalent Fahrenheit temperature, F. Figure 6.25 displays the com-
pleted application. Use the following formula:

Figure 6.25 Completed Temperature Converter.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial06\Exercises\TemperatureConversion directory to your C:\Sim-
plyVB directory.

b) Opening the application’s template file. Double click TemperatureConver-
sion.sln in the TemperatureConversion directory to open the application. 

c) Coding the Click event handler. Perform the conversion in the Convert Button’s
Click event handler. Define Integer variables to store the user-input Celsius tem-
perature and the result of the conversion. Display the Fahrenheit equivalent of the
temperature conversion.

d) Clearing user input. Clear the result in the Enter a Celsius temperature: TextBox’s
TextChanged event.

e) Running the application. Select Debug > Start to run your application. Enter the
value 20 into the Enter a Celsius temperature: TextBox and click the Convert But-
ton. Verify that the value 68 is displayed in the output Label. Enter other Celsius
temperatures, click the Convert Button after each. Use the formula provided above
to verify that the proper Fahrenheit equivalent is displayed each time.

f) Closing the application. Close your running application by clicking its close box.

g) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 6.12 Solution
2 ' TemperatureConversion.vb
3
4 Public Class FrmTemperatureConverter
5    Inherits System.Windows.Forms.Form
6
7    ' handles Click event
8    Private Sub btnConvert_Click(ByVal sender As System.Object, _
9       ByVal e As System.EventArgs) Handles btnConvert.Click

10
11       ' temperature variables
12       Dim intCelsius As Integer
13       Dim intFahrenheit As Integer
14
15       intCelsius = Val(txtInput.Text) ' obtain user input
16
17       ' perform conversion
18       intFahrenheit = (9 / 5) * intCelsius + 32
19
20       lblResult.Text = intFahrenheit
21    End Sub ' btnConvert_Click
22
23    ' handles TextChanged event
24    Private Sub txtInput_TextChanged(ByVal sender As _

F 9
5
---C 32+=
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6.13 (Simple Calculator Application) In this exercise, you will add functionality to a simple
calculator application. The calculator will allow a user to enter two numbers in the Text-
Boxes. There will be four Buttons labeled +, -, / and *. When the user clicks the Button
labeled as addition, subtraction, multiplication or division, the application will perform that
operation on the numbers in the TextBoxes and displays the result. The calculator also
should clear the calculation result when the user enters new input. Figure 6.26 displays the
completed calculator.

Figure 6.26 Result of Calculator application.

a) Copying the template to your working directory. Copy C:\Exam-
ples\Tutorial06\Exercises\SimpleCalculator directory to your C:\SimplyVB
directory. 

b) Opening the application’s template file. Double click SimpleCalculator.sln in
the SimpleCalculator directory to open the application.

c) Coding the addition Click event handler. This event handler should add the two
numbers and display the result.

d) Coding the subtraction Click event handler. This event handler should subtract the
second number from the first number and display the result.

e) Coding the multiplication Click event handler. This event handler should multiply
the two numbers and display the result.

f) Coding the division Click event handler. This event handler should divide the first
number by the second number and display the result.

g) Clearing the result. Write event handlers for the TextBoxes’ TextChanged events.
Write code to clear the result Label (lblResult) after the user enters new input into
either TextBox.

h) Running the application. Select Debug > Start to run your application. Enter a first
number and a second number, then verify that each of the Buttons works by clicking
each, and viewing the output. Repeat this process with two new values and again ver-
ify that the proper output is displayed based on which Button is clicked.

i) Closing the application. Close your running application by clicking its close box.

j) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

25       System.Object, ByVal e As System.EventArgs) _
26       Handles txtInput.TextChanged
27
28       lblResult.Text = ""
29    End Sub ' txtInput_TextChanged
30
31 End Class ' FrmTemperatureConverter 

1 ' Exercise 6.13 Solution
2 ' SimpleCalculator.vb
3
4 Public Class FrmCalculator
5    Inherits System.Windows.Forms.Form
6
7    ' handles addition Button’s Click event
8    Private Sub btnAdd_Click(ByVal sender As System.Object, _
9       ByVal e As System.EventArgs) Handles btnAdd.Click
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What does this code do? 6.14 This code modifies values intNumber1, intNumber2 and intResult. What are the final
values of these variables?

Answer: intNumber1 gets 50, intNumber2 gets 4; intResult gets 12.

10
11       lblResult.Text = Val(txtFirstNumber.Text) + _
12          Val(txtSecondNumber.Text)
13    End Sub ' btnAdd_Click
14
15    ' handles subtraction Button’s Click event
16    Private Sub btnSubtract_Click(ByVal sender As System.Object, _
17       ByVal e As System.EventArgs) Handles btnSubtract.Click
18
19       lblResult.Text = Val(txtFirstNumber.Text) - _
20          Val(txtSecondNumber.Text)
21    End Sub ' btnSubtract_Click
22
23    ' handles multiplication Button’s Click event
24    Private Sub btnMultiply_Click(ByVal sender As System.Object, _
25       ByVal e As System.EventArgs) Handles btnMultiply.Click
26
27       lblResult.Text = Val(txtFirstNumber.Text) * _
28          Val(txtSecondNumber.Text)
29    End Sub ' btnMultiply_Click
30
31    ' handles division Button’s Click event
32    Private Sub btnDivide_Click(ByVal sender As System.Object, _
33       ByVal e As System.EventArgs) Handles btnDivide.Click
34
35       lblResult.Text = Val(txtFirstNumber.Text) / _
36          Val(txtSecondNumber.Text)
37    End Sub ' btnDivide_Click
38
39    ' handles TextChanged event
40    Private Sub txtFirstNumber_TextChanged(ByVal sender _
41       As System.Object, ByVal e As System.EventArgs) _
42       Handles txtFirstNumber.TextChanged
43
44       lblResult.Text = ""
45    End Sub ' txtFirstNumber_TextChanged
46
47    ' handles TextChanged event
48    Private Sub txtSecondNumber_TextChanged(ByVal sender _
49       As System.Object, ByVal e As System.EventArgs) _
50       Handles txtSecondNumber.TextChanged
51
52       lblResult.Text = ""
53    End Sub ' txtSecondNumber_TextChanged
54
55 End Class ' FrmCalculator

▲

1 Dim intNumber1 As Integer
2 Dim intNumber2 As Integer
3 Dim intResult As Integer
4
5 intNumber1 = 5 * (4 + 6)
6 intNumber2 = 2 ^ 2
7 intResult = intNumber1 \ intNumber2
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What’s wrong with this code? 6.15 Find the error(s) in the following code, which uses variables to perform a calculation.

Answer:  intNumber1’s assignment statement contains a division by zero, which will cause a 
run-time error to occur.

Using the Debugger 6.16 (Average Three Numbers) You have just written an application that takes three num-
bers as input in TextBoxes, stores the three numbers in variables and then finds the average
of the numbers (note that the average is rounded to the nearest integer value). The output is
displayed in a Label (Fig. 6.27, which displays the incorrect output). You soon realize, how-
ever, that the number displayed in the Label is not the average, but rather a number that
does not make sense given the input. Use the debugger to help locate and remove this error.

Figure 6.27 Average Three Numbers application for Exercise 6.16.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial06\Exercises\AverageDebugging directory to your C:\SimplyVB
directory. 

b) Opening the application’s template file. Double click AverageDebugging.sln in
the AverageDebugging directory to open the application.

c) Running the application. Select Debug > Start to run your application. View the
output to observe that the output is incorrect. 

d) Closing the application. Close the application, and view the Average.vb file in code
view.

e) Setting breakpoints. Set a breakpoint in the btnCalculate_Click event handler.
Run the application again, and use the debugger to help find the error(s).

f) Finding and correcting the error(s). Once you have found the error(s), modify the
application so that it correctly calculates the average of three numbers.

g) Running the application. Select Debug > Start to run your application. Enter the
three values from Fig. 6.27 into the input TextBoxes provided and click the Calculate
Button. Verify that the output now accurately reflects the average of these values,
which is 8.

▲

1 Dim intNumber1 As Integer
2 Dim intNumber2 As Integer
3 Dim intResult As Integer
4
5 intNumber1 = (4 * 6 ^ 4) / (10 Mod 4 – 2)
6 intNumber2 = (16 \ 3) ^ 2 * 6 + 1
7 intResult = intNumber1 - intNumber2

1 Dim intNumber1 As Integer
2 Dim intNumber2 As Integer
3 Dim intResult As Integer
4
5
6 intNumber2 = (16 \ 3) ^ 2 * 6 + 1
7 intResult = intNumber1 - intNumber2

' intNumber1 = (4 * 6 ^ 4) / (10 Mod 4 – 2)

▲
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h) Closing the application. Close your running application by clicking its close box.

i) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

Answer: The original code only divided the third number (intNumber3) by 3 when in fact 
the average ought to have been the sum of intNumber1, intNumber2 and intNumber3 
divided by three. To correct the error, we included proper parentheses before intNumber1 
and after intNumber3.

Programming Challenge 6.17 (Digit Extractor Application) Write an application that allows the user to enter a five-
digit number into a TextBox. The application then separates the number into its individual
digits and displays each digit in a Label. The application should look and behave similarly to
Fig. 6.28. [Hint: You can use the Mod operator to extract the ones digit from a number. For
instance, 12345 Mod 10 is 5. You can use integer division (\) to “peel off” digits from a num-
ber. For instance, 12345 \ 100 is 123. This allows you to treat the 3 in 12345 as a ones digit.
Now you can isolate the 3 by using the Mod operator. Apply this technique to the rest of the
digits.]

1 ' Exercise 6.16 Solution
2 ' Average.vb
3
4 Public Class FrmAverageDebugging
5    Inherits System.Windows.Forms.Form
6
7    ' handles Click event
8    Private Sub btnCalculate_Click(ByVal sender As _
9       System.Object, ByVal e As System.EventArgs) _

10       Handles btnCalculate.Click
11
12       ' variables to store user inputs
13       Dim intNumber1 As Integer
14       Dim intNumber2 As Integer
15       Dim intNumber3 As Integer
16       Dim intAverage As Integer
17
18       ' obtain user inputs
19       intNumber1 = Val(txtFirstNumber.Text)
20       intNumber2 = Val(txtSecondNumber.Text)
21       intNumber3 = Val(txtThirdNumber.Text)
22
23       ' average numbers
24       intAverage = (intNumber1 + intNumber2 + intNumber3) / 3
25
26       lblResult.Text = intAverage  ' display result
27    End Sub ' btnCalculate_Click
28
29 End Class ' FrmAverageDebugging

▲
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Figure 6.28 Digit Extractor application GUI.

a) Creating the application. Create a new project named DigitExtractor. Rename
the Form1.vb file DigitExtractor.vb. Change the name of the Form to FrmDigi-
tExtractor and set the startup object to FrmDigitExtractor. Add Labels, a Text-
Box and a Button to the application’s Form. Name the TextBox txtInput and name
the Button btnEnter. Name the other controls logically based on the tips provided
in earlier tutorials.

b) Adding an event handler for btnEnter’s Click event. In design view, double click
btnEnter to create the btnEnter_Click event handler. In this event handler, create
five variables of type Integer. Use the Mod operator to extract each digit. Store the
digits in the five variables created.

c) Adding an event handler for txtInput’s TextChanged event. In design view, double
click txtInput to create the txtInput_TextChanged event handler. In this event
handler, clear the five Labels used to display each digit. This event handler clears the
output whenever new input is entered.

d) Running the application. Select Debug > Start to run your application. Enter a five-
digit number and click the Enter Button. Enter a new five-digit number and verify
that the previous output is cleared.

e) Closing the application. Close your running application by clicking its close box.

f) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 6.17 Solution
2 ' DigitExtractor.vb
3
4 Public Class FrmDigitExtractor
5    Inherits System.Windows.Forms.Form
6
7    ' handles Click event
8    Private Sub btnEnter_Click(ByVal sender As System.Object, _
9       ByVal e As System.EventArgs) Handles btnEnter.Click

10
11       Dim intNumber As Integer  ' five-digit number
12
13       ' five variables for five digits
14       Dim intFirst As Integer
15       Dim intSecond As Integer
16       Dim intThird As Integer
17       Dim intFourth As Integer
18       Dim intFifth As Integer
19
20       intNumber = Val(txtInput.Text)  ' obtain user input
21
22       ' extract each digit
23       intFirst = intNumber \ 10000
24       intSecond = intNumber \ 1000 Mod 10
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25       intThird = intNumber \ 100 Mod 10
26       intFourth = intNumber \ 10 Mod 10
27       intFifth = intNumber Mod 10
28
29       ' display extracted digits
30       lblFirstDigit.Text = intFirst
31       lblSecondDigit.Text = intSecond
32       lblThirdDigit.Text = intThird
33       lblFourthDigit.Text = intFourth
34       lblFifthDigit.Text = intFifth
35    End Sub ' btnEnter_Click
36
37    ' handles TextChanged event
38    Private Sub txtInput_TextChanged(ByVal sender As System.Object, _
39       ByVal e As System.EventArgs) Handles txtInput.TextChanged
40
41       ' clear Labels
42       lblFirstDigit.Text = ""
43       lblSecondDigit.Text = ""
44       lblThirdDigit.Text = ""
45       lblFourthDigit.Text = ""
46       lblFifthDigit.Text = ""
47    End Sub ' txtInput_TextChanged
48
49 End Class ' FrmDigitExtractor
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Instructor’s Manual
Exercise Solutions

Tutorial 7

MULTIPLE-CHOICE
QUESTIONS

7.1 The  operator returns False if the left operand is larger than the right oper-
and.

7.2 A  occurs when an executed statement does not directly follow the previously
executed statement in the written program.

7.3 A variable or an expression that is added to the Watch window is known as a
.

7.4 The If…Then statement is called a  statement because it selects or ignores
one action.

7.5 The three types of control statements are the sequence statement, the selection state-
ment and the  statement.

7.6 In an activity diagram, a rectangle with curved sides represents .

7.7 The If…Then…Else selection statement ends with the keywords .  

7.8 A variable of data type Boolean can be assigned keyword  or keyword
. 

7.9 A variable whose value cannot be changed after its initial declaration is called a
. 

7.10 The  operator assigns the result of adding the left and right operands to the
left operand. 

Answers: 7.1) d.  7.2) d.  7.3) c.  7.4) a.  7.5) d.  7.6) c.  7.7) d.  7.8) a.  7.9) b.  7.10) c. 

EXERCISES 7.11 (Currency Converter Application) Develop an application that functions as a cur-
rency converter as shown in Fig. 7.33. Users must provide a number in the Dollars: TextBox
and a currency name (as text) in the Convert from Dollars to: TextBox. Clicking the Convert
Button will convert the specified amount into the indicated currency and display it in a

a) = b) < 
c) <= d) All of the above. 

a) transition b) flow
c) logical error d) transfer of control

a) watched variable b) watched expression
c) watch d) watched value

a) single-selection b) multiple-selection
c) double-selection d) repetition

a) repeat b) looping
c) redo d) repetition

a) a complete algorithm b) a comment
c) an action d) the termination of the application

a) End If Then Else b) End If Else
c) End Else d) End If

a) True, False b) Off, On 
c) True, NotTrue d) Yes, No 

a) Double b) constant
c) standard d) Boolean 

a) + b) =+ 
c) += d) + = 



Tutorial 7 Wage Calculator Application 52

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

Label. Limit yourself to the following currencies as user input: Dollars, Euros, Yen and
Pesos. Use the following exchange rates: 1 Dollar = 1.02 Euros, 120 Yen and 10 Pesos.

Figure 7.33 Currency Converter GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial07\Exercises\CurrencyConverter directory to your C:\SimplyVB
directory.

b) Opening the application’s template file. Double click CurrencyConverter.sln in
the CurrencyConverter directory to open the application.

c) Add an event handler for the Convert Button’s Click event. Double click the Con-
vert Button to generate an empty event handler for the Button’s Click event. The
code for Steps d–f belongs in this event handler.

d) Obtaining the user input. Use the Val function to convert the user input from the
Dollars: TextBox to a Double. Assign the Double to a Decimal variable decAmount.
Visual Basic .NET implicitly performs this conversion from Double to Decimal.

e) Performing the conversion. Use an If…ElseIf…ElseIf statement to determine
which currency the user entered. Assign the result of the conversion to decAmount.

f) Displaying the result. Display the result using method String.Format with format
specifier F.

g) Running the application. Select Debug > Start to run your application. Enter a
value in dollars to be converted and the name of the currency you wish to convert to.
Click the Convert Button and, using the exchange rates above, verify that the correct
output is displays.

h) Closing the application. Close your running application by clicking its close box.

i) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 7.11 Solution
2 ' CurrencyConverter.vb
3
4 Public Class FrmCurrencyConverter
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form designer generated code
8
9    ' handles Click event

10    Private Sub btnConvert_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnConvert.Click
12
13       Dim decAmount As Decimal
14
15       decAmount = Val(txtValue.Text)  ' obtain dollar amount
16  
17       ' perform currency conversion
18       If txtCurrency.Text = "Euros" Then
19          decAmount *= 1.02
20
21       ElseIf txtCurrency.Text = "Yen" Then
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7.12 (Wage Calculator Application that Performs Tax Calculations) Develop an applica-
tion that calculates an employee’s wages as shown in Fig. 7.34. The user should provide the
hourly wage and number of hours worked per week. When the Calculate Button is clicked,
the gross earnings of the user should display in the Gross earnings: TextBox. The Less
FWT: TextBox should display the amount deducted for Federal taxes and the Net earnings:
TextBox displays the difference between the gross earnings and the Federal tax amount.
Assume overtime wages are 1.5 times the hourly wage and Federal taxes are 15% of gross
earnings. The Clear Button should clear all fields.

Figure 7.34 Wage Calculator GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial07\Exercises\ExpandedWageCalculator directory to your
C:\SimplyVB directory.

b) Opening the application’s template file. Double click WageCalculator.sln in the
ExpandedWageCalculator directory to open the application.

c) Modifying the Calculate Button’s Click event handler. Add the code for Steps d–f
to btnCalculate_Click.

d) Adding a new variable. Declare decFederalTaxes to store the amount deducted for
Federal taxes.

e) Calculating and displaying the Federal taxes deducted. Multiply the total earnings
(decEarnings) by 0.15 (that is, 15%) to determine the amount to be removed for
taxes. Assign the result to decFederalTaxes. Display this value using method
String.Format with format specifier C.

f) Calculating and displaying the employee’s net pay. Subtract decFederalTaxes
from decEarnings to calculate the employee’s net earnings. Display this value using
method String.Format with format specifier C.

g) Creating an event handler for the Clear Button. Double click the Clear Button to
generate an empty event handler for the Click event. This event handler should
clear user input from the two TextBoxes and the results from the three Labels.

h) Running the application. Select Debug > Start to run your application. Enter an
hourly wage and the number of hours worked. Click the Calculate Button and verify
that the appropriate output is displayed for gross earnings, amount taken out for fed-
eral taxes and the net earnings. Click the Clear Button and check that all fields are
cleared.

22          decAmount *= 120
23
24       ElseIf txtCurrency.Text = "Pesos" Then
25          decAmount *= 10
26       End If
27
28       lblConvertedResult.Text = String.Format("{0:F}", decAmount)
29    End Sub ' btnConvert_Click
30
31 End Class ' FrmCurrencyConverter
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i) Closing the application. Close your running application by clicking its close box.

j) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 7.12 Solution
2 ' WageCalculator.vb
3
4 Public Class FrmWageCalculator
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form designer generated code
8
9    ' handles Click event

10    Private Sub btnCalculate_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnCalculate.Click
12
13       ' declare variables
14       Dim dblHours As Double
15       Dim decWage As Decimal
16       Dim decEarnings As Decimal
17       Dim decFederalTaxes As Decimal
18       Const intHOUR_LIMIT As Integer = 40  ' declare constant
19
20       ' assign values from user input
21       dblHours = Val(txtHours.Text)
22       decWage = Val(txtWage.Text)
23
24       ' determine wage amount
25       If dblHours <= intHOUR_LIMIT Then
26
27          ' if under or equal to 40 hours, regular wages
28          decEarnings = dblHours * decWage
29       Else
30
31          ' if over 40 hours, regular wages for first 40
32          decEarnings = intHOUR_LIMIT * decWage
33
34          ' time and a half for the additional hours
35          decEarnings += _
36             (dblHours - intHOUR_LIMIT) * (1.5 * decWage)
37       End If
38
39       ' assign gross pay to the corresponding Label
40       lblEarningsResult.Text = String.Format("{0:C}", decEarnings)
41
42       ' assign federal taxes to the corresponding Label
43       decFederalTaxes = decEarnings * 0.15
44       lblFWTNumber.Text = String.Format("{0:C}", decFederalTaxes)
45
46       ' assign net pay to the corresponding Label
47       lblTotal.Text = String.Format("{0:C}", decEarnings - _
48          decFederalTaxes)
49    End Sub ' btnCalculate_Click
50
51    ' handles Clear Button’s Click event
52    Private Sub btnClear_Click(ByVal sender As System.Object, _
53       ByVal e As System.EventArgs) Handles btnClear.Click
54
55       ' clear each TextBox and output Label
56       txtWage.Text = ""
57       txtHours.Text = ""
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7.13 (Customer Charge Account Analyzer Application) Develop an application (as shown
in Fig. 7.35) that determines whether a department-store customer has exceeded the credit
limit on a charge account. Each customer enters an account number (an Integer), a balance
at the beginning of the month (a Decimal), the total of all items charged this month (a Deci-
mal), the total of all credits applied to the customer’s account this month (a Decimal), and
the customer’s allowed credit limit (a Decimal). The application should input each of these
facts, calculate the new balance (= beginning balance – credits + charges), display the new bal-
ance and determine whether the new balance exceeds the customer's credit limit. If the cus-
tomer’s credit limit is exceeded, the application should display a message (in a Label at the
bottom of the Form) informing the customer of this fact.

Figure 7.35 Credit Checker GUI.

a) Copying the template application to your working directory. Copy the C:\Exam-
ples\Tutorial07\Exercises\CreditChecker directory to your C:\SimplyVB
directory. 

b) Opening the application’s template file. Double click Credit Checker.sln in the
CreditChecker directory to open the application.

c) Adding the Calculate Button’s Click event handler. Double click the Calculate
Balance Button to generate the empty event handler for the Click event. The code
for Steps d–g is added to this event handler.

d) Declaring variables. Declare an Integer variable to store the account number.
Declare four Decimal variables to store the starting balance, charges, credits and
credit limit. Declare a fifth Decimal variable to store the new balance in the account
after the credits and charges have been applied.

e) Obtaining user input. Obtain the user input from the TextBoxes’ Text properties.

f) Calculating and displaying the new balance. Calculate the new balance by adding
the total credits to the starting balance and subtracting the charges. Assign the result
to a variable. Display the result formatted as currency.

g) Determining if the credit limit has been exceeded. If the new balance exceeds the
specified credit limit, a message should be displayed in lblError.

h) Handling the Account number: TextBox’s TextChanged event. Double click the
Account number: TextBox to generate its TextChanged event handler. This event
handler should clear the other TextBoxes, the error message Label and the result
Label.

58       lblEarningsResult.Text = ""
59       lblFWTNumber.Text = ""
60       lblTotal.Text = ""
61    End Sub ‘ btnClear_Click
62
63 End Class ' FrmWageCalculator



Tutorial 7 Wage Calculator Application 56

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

i) Running the application. Select Debug > Start to run your application. Enter an
account number, your starting balance, the amount charged to your account, the
amount credited to your account and your credit limit. Click the Calculate Balance
Button and verify that the new balance displayed is correct. Enter an amount
charged that exceeds your credit limit. Click the Calculate Balance Button and
ensure that a message is displayed in the lower Label.

j) Closing the application. Close your running application by clicking its close box.

k) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 7.13 Solution
2 ' CreditChecker.vb
3
4 Public Class FrmCreditChecker
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form designer generated code
8
9    ' handles Calculate Button's Click event

10    Private Sub btnCalculate_Click(ByVal sender As System.Object, _
11        ByVal e As System.EventArgs) Handles btnCalculate.Click
12
13       ' declare variables 
14       Dim intAccountNumber As Integer
15       Dim decStartBalance As Decimal
16       Dim decTotalCharges As Decimal
17       Dim decTotalCredits As Decimal
18       Dim decCreditLimit As Decimal
19       Dim decNewBalance As Decimal
20
21       intAccountNumber = Val(txtAccountNumber.Text)
22       decStartBalance = Val(txtStartBalance.Text)
23       decTotalCharges = Val(txtTotalCharges.Text)
24       decTotalCredits = Val(txtTotalCredits.Text)
25       decCreditLimit = Val(txtCreditLimit.Text)
26
27       ' calculate balance after credits and charges
28       decNewBalance = decStartBalance - _
29           decTotalCredits + decTotalCharges
30
31       ' display new balance in corresponding Label
32       lblNewBalanceNumber.Text = String.Format("{0:C}", _
33          decNewBalance)
34
35       ' determine if credit limit has been exceeded
36       If decNewBalance > decCreditLimit Then
37
38          ' if credit limit has been exceeded
39          ' display an error message
40          lblError.Text = "Credit Limit Exceeded!"
41
42       End If
43
44    End Sub ' btnCalculate_Click
45
46    ' handles TextChanged event
47    Private Sub txtAccountNumber_TextChanged(ByVal sender _
48        As System.Object, ByVal e As System.EventArgs) _
49        Handles txtAccounttNumber.TextChanged
50
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What does this code do? 7.14 Assume that txtAge is a TextBox control and that the user has entered the value 27
into this TextBox. Determine the action performed by the following code:

Answer: This code prints text when an age is inputted into the txtAge TextBox. In this case, 
the statement txtAge.Text = "Young Adult" executes, because the value of intAge is 
below 30, but not less than 20.

What’s wrong with this code? 7.15 Assume that lblAMPM is a Label control. Find the error(s) in the following code.

Answer: ElseIf cannot appear after an Else within the same If…Then…Else statement. 
The correct code should read:

51       ' clear all fields when account number is changed
52       txtStartBalance.Text = ""
53       txtTotalCharges.Text = ""
54       txtTotalCredits.Text = ""
55       txtCreditLimit.Text = ""
56       lblNewBalanceNumber.Text = ""
57       lblError.Text = ""
58
59    End Sub ' txtAccountNumber_TextChanged
60
61 End Class ' FrmCreditChecker

▲

1 Dim intAge As Integer
2
3 intAge = Val(txtAge.Text)
4
5 If intAge < 0 Then
6    txtAge.Text = "Enter a value greater than or equal to zero."
7 ElseIf intAge < 13 Then
8    txtAge.Text = "Child"
9 ElseIf intAge < 20 Then 

10    txtAge.Text = "Teenager"
11 ElseIf intAge < 30 Then
12    txtAge.Text = "Young Adult"
13 ElseIf intAge < 65 Then
14    txtAge.Text = "Adult"
15 Else
16    txtAge.Text = "Senior Citizen"
17 End If

▲

1 Dim intHour As Integer
2
3 intHour = 14
4
5 If intHour < 11 Then
6    If intHour > 0 Then
7        lblAMPM.Text = "AM"
8    End If
9 Else

10    lblAMPM.Text = "PM"
11 ElseIf intHour > 23 Then
12    lblAMPM.Text = "Time Error."
13 End If
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Using the Debugger 7.16 (Grade Calculator Application) Copy the C:\Examples\Tutorial07\Debugger
directory into your working directory. This directory contains the Grades application, which
takes a number from the user and displays the corresponding letter grade. For values 90–100
it should display A; for 80–89, B, for 70–79, C, for 60–69, D and for anything lower, an F. Run
the application. Enter the value 85 in the TextBox and click Calculate. Notice that the appli-
cation displays D when it ought to display B. Select View > Code to enter the code editor and
set as many breakpoints as you feel necessary. Select Debug > Start to use the debugger to
help you find the error(s). Figure 7.36 shows the incorrect output when the value 85 is input.

Figure 7.36 Incorrect output for Grade application.

Answer:

1 Dim intHour As Integer
2
3 intHour = 14
4
5 If intHour < 11 Then
6    If intHour > 0 Then
7        lblAMPM.Text = "AM"
8    End If
9

10    lblAMPM.Text = "Time Error."
11
12    lblAMPM.Text = "PM"
13 End If

ElseIf intHour > 23 Then

Else

▲

1 ' Exercise 7.16 Solution
2 ' Grades.vb
3
4 Public Class FrmGrade
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form designer generated code
8
9    ' handles Click event

10    Private Sub btnCalculate_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnCalculate.Click
12
13       Dim intGrade As Integer
14
15       intGrade = Val(txtGrade.Text)
16
17       ' display grade corresponding to number
18       If intGrade >= 90 Then
19          lblDisplay.Text = "A"
20        intGrade >= 80 Then
21          lblDisplay.Text = "B"
22        intGrade >= 70 Then
23          lblDisplay.Text = "C"
24        intGrade >= 60 Then

ElseIfIndividual If…End If
statements replaced with one
If…ElseIf…Else statement ElseIf

ElseIf
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Programming Challenge 7.17 (Encryption Application) A company transmits data over the telephone, but it is con-
cerned that its phones could be tapped. All its data is transmitted as four-digit Integers. The
company has asked you to write an application that encrypts its data so that it may be trans-
mitted more securely. Encryption is the process of transforming data for security reasons.
Create a Form similar to Fig. 7.37. Your program should read four-digits entered by the user
and encrypt the information as follows:

a) Replace each digit by (the sum of that digit plus 7) modulo 10. We use the term mod-
ulo to indicate you are to use the modulus (Mod) operator.

b) Swap the first digit with the third, and swap the second digit with the fourth.

Figure 7.37 Encryption application.

Answer:

25          lblDisplay.Text = "D"
26       Else
27          lblDisplay.Text = "F"
28       End If
29
30    End Sub ' btnCalculate_Click
31
32 End Class ' FrmGrade

▲
1 ' Exercise 7.17 Solution 
2 ' Encryption.vb
3
4 Public Class FrmEncryption
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form designer generated code
8
9    ' handles Click event

10    Private Sub btnEncrypt_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnEncrypt.Click
12
13       ' clear previous output
14       lblEncryptedNumber1.Text = ""
15       lblEncryptedNumber2.Text = ""
16       lblEncryptedNumber3.Text = ""
17       lblEncryptedNumber4.Text = ""
18
19       Dim intNumber1 As Integer
20       Dim intNumber2 As Integer
21       Dim intNumber3 As Integer
22       Dim intNumber4 As Integer
23
24       ' retrieve numbers from TextBoxes
25       intNumber1 = Val(txtNumber1.Text)
26       intNumber2 = Val(txtNumber2.Text)



Tutorial 7 Wage Calculator Application 60

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

27       intNumber3 = Val(txtNumber3.Text)
28       intNumber4 = Val(txtNumber4.Text)
29
30       ' convert to 1-digit numbers
31       If intNumber1 > 9 Then
32          intNumber1 = intNumber1 Mod 10
33       ElseIf intNumber2 > 9 Then
34          intNumber2 = intNumber2 Mod 10
35       ElseIf intNumber3 > 9 Then
36          intNumber3 = intNumber3 Mod 10
37       ElseIf intNumber4 > 9 Then
38          intNumber4 = intNumber4 Mod 10
39       End If
40
41       ' display using the following:
42       ' 1st number and third number are swapped
43       ' 2nd number and 4th number are swapped
44       lblEncryptedNumber1.Text = (intNumber3 + 7) Mod 10
45       lblEncryptedNumber2.Text = (intNumber4 + 7) Mod 10
46       lblEncryptedNumber3.Text = (intNumber1 + 7) Mod 10
47       lblEncryptedNumber4.Text = (intNumber2 + 7) Mod 10
48
49    End Sub ' btnEncrypt_Click
50
51 End Class ' FrmEncryption
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Instructor’s Manual
 Exercise Solutions

Tutorial 8

MULTIPLE-CHOICE
QUESTIONS

8.1 How many CheckBoxes in a GUI can be selected at once?

8.2 The text that appears alongside a CheckBox is referred to as the .

8.3 The first argument passed to method MessageBox.Show is .

8.4 You can specify the Button(s) and icon to be displayed in a message dialog by using the
MessageBoxButtons and  constants.

8.5  are used to create complex conditions.

8.6 Operator AndAlso .

8.7 A CheckBox is selected when its Checked property is set to .  

8.8 The condition expression1 AndAlso expression2 evaluates to True when .  

8.9 The condition expression1 OrElse expression2 evaluates to False when .  

8.10 The condition expression1 Xor expression2 evaluates to True when .  

Answers: 8.1) d.  8.2) a.  8.3) c.  8.4) d.  8.5) c.  8.6) a.  8.7) b.  8.8) c.  8.9) d.  8.10) d.

a) 0 b) 1 
c) 4 d) any number

a) CheckBox label b) CheckBox name
c) CheckBox value d) CheckBox data

a) the text displayed in the dialog’s title bar
b) a constant representing the Buttons displayed in the dialog
c) the text displayed inside the dialog
d) a constant representing the icon that appears in the dialog

a) MessageIcon b) MessageBoxImages 
c) MessageBoxPicture d) MessageBoxIcon 

a) Assignment operators b) Activity diagrams
c) Logical operators d) Formatting codes

a) performs short-circuit evaluation b) is not a keyword
c) is a comparison operator
d) evaluates to false if both operands are true

a) On b) True 
c) Selected d) Checked 

a) expression1 is True and expression2 is False 
b) expression1 is False and expression2 is True 
c) both expression1 and expression2 are True 
d) both expression1 and expression2 are False 

a) expression1 is True and expression2 is False 
b) expression1 is False and expression2 is True 
c) both expression1 and expression2 are True 
d) both expression1 and expression2 are False 

a) expression1 is True and expression2 is False 
b) expression1 is False and expression2 is True 
c) both expression1 and expression2 are True 
d) Both a and b. 
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EXERCISES 8.11 (Enhanced Dental Payment Application) Modify the Dental Payment application
from this tutorial to include additional services, as shown in Fig. 8.21. Add the proper func-
tionality (using If…Then structures) to determine whether any of the new CheckBoxes are
selected and, if so, add the price of the service to the total bill.

Figure 8.21 Enhanced Dental Payment application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial08\Exercises\DentalPaymentEnhanced directory to your C:\Sim-
plyVB directory. 

b) Opening the application’s template file. Double click DentalPaymentEn-
hanced.sln in the DentalPaymentEnhanced directory to open the application.

c) Adding CheckBoxes and Labels and a TextBox. Add two CheckBoxes and two
Labels to the Form. The new CheckBoxes should be labelled Fluoride and Root
Canal, respectively. Add these CheckBoxes and Labels beneath the X-Ray CheckBox
and its price Label. The price for a Fluoride treatment is $50; the price for a root
canal is $225. Add a CheckBox labelled Other and a Label containing a dollar sign
($) to the Form, as shown in Fig. 8.21. Then add a TextBox to the right of the $ Label
in which the user can enter the cost of the service performed.

d) Modifying the Click event handler code. Add code to the btnCalculate_Click
event handler that determines whether the new CheckBoxes have been selected. This
can be done using If…Then statements that are similar to the ones already in the
event handler. Use the If…Then statements to update the bill amount.

e) Running the application. Select Debug > Start to run your application. Test your
application by checking one or more of the new services. Click the Calculate Button
and verify that the proper total is displayed. Test the application again by checking
some of the services, then checking the Other CheckBox and entering a dollar value
for this service. Click the Calculate Button and verify that the proper total is dis-
played, and that it includes the price for the “other” service.

f) Closing the application. Close your running application by clicking its close box.

g) Closing the IDE. Close Visual Studio .NET by clicking its close box. 

Answer:

1 ' Exercise 8.11 Solution
2 ' DentalPayment.vb
3
4 Public Class FrmDentalPayment
5    Inherits System.Windows.Forms.Form
6
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7    ' Windows Form Designer generated code
8
9    ' event handler calculates bill

10    Private Sub btnCalculate_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnCalculate.Click
12
13       ' if no CheckBox checked, display message
14       If (txtName.Text = "") OrElse _
15          (chkClean.Checked = False AndAlso _ 
16          chkXRay.Checked = False AndAlso _
17          chkCavity.Checked = False AndAlso _
18          chkFluoride.Checked = False AndAlso _
19          chkRootCanal.Checked = False AndAlso _
20          chkOther.Checked = False) Then
21
22          ' display message in dialog
23          MessageBox.Show( _
24             "Please enter a name and check at least one item", _
25             "Missing information", MessageBoxButtons.OK, _
26             MessageBoxIcon.Warning)
27
28       Else ' add prices 
29
30          ' intTotal contains amount to bill patient
31          Dim intTotal As Integer
32
33          ' if patient had a cleaning
34          If chkClean.Checked = True Then
35             intTotal += 35
36          End If
37
38          ' if patient had cavity filled
39          If chkCavity.Checked = True Then
40             intTotal += 150
41          End If
42
43          ' if patient had x-ray taken
44          If chkXRay.Checked = True Then
45             intTotal += 85
46          End If
47
48          ' if patient had Fluoride treatment
49          If chkFluoride.Checked = True Then
50             intTotal += 50
51          End If
52
53          ' if patient had root canal
54          If chkRootCanal.Checked = True Then
55             intTotal += 225
56          End If
57
58          ' if patient had some other service performed
59          If chkOther.Checked = True Then
60             If txtOtherCost.Text = "" Then
61                MessageBox.Show("Please enter cost of service", _
62                   "No Cost Entered", MessageBoxButtons.OK, _
63                   MessageBoxIcon.Warning)
64
65              Else
66
67             ' add cost entered
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8.12  (Fuzzy Dice Order Form Application) Write an application that allows users to pro-
cess orders for fuzzy dice as shown in Fig. 8.22. The application should calculate the total
price of the order, including tax and shipping. TextBoxes for inputting the order number, the
customer name and the shipping address are provided. Initially, these fields contain text that
describes their purpose. Provide CheckBoxes for selecting the fuzzy-dice color and Text-
Boxes for inputting the quantities of fuzzy dice to order. The application should also contain
a Button that, when clicked, calculates the subtotals for each type of fuzzy dice ordered and
the total of the entire order (including tax and shipping). Use 5% for the tax rate. Shipping
charges are $1.50 for up to 20 pairs of dice. If more than 20 pairs of dice are ordered, shipping
is free.

Figure 8.22 Fuzzy Dice Order Form application.

a) Copying the template to your working directory. Copy the
C:\Examples\Tutorial08\Exercises\FuzzyDiceOrderForm directory to your
C:\SimplyVB directory. 

b) Opening the application’s template file. Double click FuzzyDiceOrderForm.sln in
the FuzzyDiceOrderForm directory to open the application.

c) Adding CheckBoxes to the Form. Add three CheckBoxes to the Form. Label the first
CheckBox White/Black, the second one Red/Black and the third Blue/Black.

d) Adding a Click event handler and its code. Create the Click event handler for the
Calculate Button. For this application, users should not be allowed to specify an
item’s quantity unless the item’s corresponding CheckBox is checked. For the total to
be calculated, the user must enter an order number, a name and a shipping address.
Use logical operators to ensure that these terms are met. If they are not, display a
message in a dialog.

68             intTotal += Val(txtOtherCost.Text)
69          End If
70
71          ' display total
72          lblTotalResult.Text = String.Format("{0:C}", intTotal)
73
74       End If
75
76    End Sub ' btnCalculate_Click
77
78 End Class ' FrmDentalPayment
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e) Calculating the total cost. Calculate the subtotal, tax, shipping and total, and display
the results in their corresponding Labels.

f) Running the application. Select Debug > Start to run your application. Test the
application by providing quantities for checked items. For instance, ensure that your
application is calculating 5% sales tax. If more than 20 pairs of dice are ordered, ver-
ify that shipping is free. Also, determine whether your code containing the logical
operators works correctly by specifying a quantity for an item that is not checked. For
instance, in Fig. 8.22, a quantity is specified for Red/Black dice, but the correspond-
ing CheckBox is not selected. This should cause the message dialog in Fig. 8.22 to
appear.

g) Closing the application. Close your running application by clicking its close box.

h) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 8.12 Solution
2 ' FuzzyDiceOrderForm.vb
3
4 Public Class FrmFuzzyDiceOrderForm
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' check validity of order before calculating totals

10    Private Sub btnCalculate_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnCalculate.Click
12
13       ' display message if user does not check box
14       If (Val(txtWhiteBlackQuantity.Text) > 0 AndAlso _
15          chkWhiteBlack.Checked = False) OrElse _
16          (Val(txtRedBlackQuantity.Text) > 0 AndAlso _
17          chkRedBlack.Checked = False) OrElse _
18          (Val(txtBlueBlackQuantity.Text) > 0 AndAlso _
19          chkBlueBlack.Checked = False) Then
20
21          ' display message in dialog
22          MessageBox.Show( _
23             "Please check item you wish to purchase", _
24             "No Item Selected", MessageBoxButtons.OK, _
25             MessageBoxIcon.Exclamation)
26
27       ' display message if order number, name or address fields
28       ' are empty
29       ElseIf txtOrderNumber.Text = "" _
30          OrElse txtName.Text = "" _
31          OrElse txtAddressLine1.Text = "" _
32          OrElse txtCityStateZip.Text = "" Then
33
34          ' display message in dialog
35          MessageBox.Show( _
36             "Please fill out all information fields", _
37             "Empty Fields", MessageBoxButtons.OK, _
38             MessageBoxIcon.Exclamation)
39
40       Else ' calculate totals
41
42          ' individual totals
43          ' total of white/black dice ordered
44          Dim decWhiteBlackTotals As Decimal = _
45             Val(txtWhiteBlackQuantity.Text) * _
46             lblWhiteBlackPrice.Text



Tutorial 8 Dental Payment Application 67

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

47
48          ' total of red/black dice ordered
49          Dim decRedBlackTotals As Decimal = _
50             Val(txtRedBlackQuantity.Text) * _
51             lblRedBlackPrice.Text
52
53          ' total of blue/black dice ordered
54          Dim decBlueBlackTotals As Decimal = _
55             Val(txtBlueBlackQuantity.Text) * _
56             lblBlueBlackPrice.Text
57
58          ' display totals of dice ordered
59          lblWhiteBlackTotals.Text = _
60             String.Format("{0:C}", decWhiteBlackTotals)
61          lblRedBlackTotals.Text = _
62             String.Format("{0:C}", decRedBlackTotals)
63          lblBlueBlackTotals.Text = _
64             String.Format("{0:C}", decBlueBlackTotals)
65
66          ' calculate and display subtotal
67          Dim decSubtotal As Decimal = decWhiteBlackTotals + _
68             decRedBlackTotals + decBlueBlackTotals
69
70          lblSubtotalResult.Text = _
71             String.Format("{0:C}", decSubtotal)
72
73          ' calculate and display tax
74          Dim decTax As Decimal = decSubtotal * 0.05
75
76          lblTaxResult.Text = String.Format("{0:C}", decTax)
77
78          ' shipping
79          ' $1.50 for up to 20 items
80          ' free after 20 items
81          Dim intNumberOfItems As Integer = _
82             (Val(txtWhiteBlackQuantity.Text) + _
83             Val(txtRedBlackQuantity.Text) + _
84             Val(txtBlueBlackQuantity.Text))
85
86          Dim decShippingCost As Decimal = 0.0
87
88          ' shipping is $1.50 if less than 20 pairs ordered
89          If intNumberOfItems <= 20 Then
90
91             decShippingCost = 1.5
92
93          End If
94
95          ' display shipping cost
96          lblShippingResult.Text = _
97             String.Format("{0:C}", decShippingCost)
98
99          ' calculate and display total
100          Dim decTotalCharge As Decimal = decSubtotal + _
101             decTax + decShippingCost
102
103          lblTotalResult.Text = _
104             String.Format("{0:C}", decTotalCharge)
105
106       End If
107
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8.13 (Modified Fuzzy Dice Order Form Application) Modify the Fuzzy Dice Order Form
application from Exercise 8.12 to determine whether customers should receive a 7% dis-
count off their purchase. Customers ordering more than $500 (before tax and shipping) in
fuzzy dice are eligible for this discount.

Figure 8.23 Modified Fuzzy Dice Order Form application.

a) Opening the application. Open the application you created in Exercise 8.12.

b) Determining whether the total cost is over $500. Use an If…Then statement to
determine if the amount ordered is greater than $500.

c) Displaying the discount and subtracting the discount from the total. If a customer
orders more than $500, display a message dialog as shown in Fig. 8.23 that informs
the user that the customer is entitled to a 7% discount. The message dialog should
contain an Information icon and an OK Button. Calculate 7% of the total amount,
and display the discount amount in the Discount: field. Subtract this amount from
the total, and update the Total: field.

d) Running the application. Select Debug > Start to run your application. Confirm that
your application calculates and displays the discount properly.

e) Closing the application. Close your running application by clicking its close box.

f) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

108    End Sub ' btnCalculate_Click
109
110 End Class ' FrmFuzzyDiceOrderForm

1 ' Exercise 8.13 Solution
2 ' FuzzyDiceOrderFormModified.vb
3
4 Public Class FrmFuzzyDiceOrderFormModified
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    Private Sub btnCalculate_Click(ByVal sender As System.Object, _

10       ByVal e As System.EventArgs) Handles btnCalculate.Click
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11
12       ' display message if user does not check box
13       If (Val(txtWhiteBlackQuantity.Text) > 0 AndAlso _
14          chkWhiteBlack.Checked = False) OrElse _
15          (Val(txtRedBlackQuantity.Text) > 0 AndAlso _
16          chkRedBlack.Checked = False) OrElse _
17          (Val(txtBlueBlackQuantity.Text) > 0 AndAlso _
18          chkBlueBlack.Checked = False) Then
19
20          ' display message in dialog
21          MessageBox.Show( _
22             "Please check item you wish to purchase", _
23             "No Item Selected", MessageBoxButtons.OK, _
24             MessageBoxIcon.Exclamation)
25
26       ' display message if order number, name or address fields
27       ' are empty
28       ElseIf (txtOrderNumber.Text = "") _
29          OrElse (txtName.Text = "") _
30          OrElse (txtAddressLine1.Text = "") _
31          OrElse (txtCityStateZip.Text = "") Then
32
33          ' display message in dialog
34          MessageBox.Show( _
35             "Please fill out all information fields.", _
36             "Empty fields", MessageBoxButtons.OK, _
37             MessageBoxIcon.Exclamation)
38
39       Else ' calculate totals
40
41          ' individual totals
42
43          ' total of white/black dice ordered
44          Dim decWhiteBlackTotals As Decimal = _
45             Val(txtWhiteBlackQuantity.Text) * _
46             lblWhiteBlackPrice.Text
47
48          ' total of red/black dice ordered
49          Dim decRedBlackTotals As Decimal = _
50             Val(txtRedBlackQuantity.Text) * _
51             lblRedBlackPrice.Text
52
53          ' total of blue/black dice ordered
54          Dim decBlueBlackTotals As Decimal = _
55             Val(txtBlueBlackQuantity.Text) * _
56             lblBlueBlackPrice.Text
57
58          ' display totals for dice
59          lblWhiteBlackTotals.Text = _
60             String.Format("{0:C}", decWhiteBlackTotals)
61          lblRedBlackTotals.Text = _
62             String.Format("{0:C}", decRedBlackTotals)
63          lblBlueBlackTotals.Text = _
64             String.Format("{0:C}", decBlueBlackTotals)
65
66          ' calculate and display subtotal
67          Dim decSubtotal As Decimal = decWhiteBlackTotals + _
68             decRedBlackTotals + decBlueBlackTotals
69
70          lblSubtotalResult.Text = _
71             String.Format("{0:C}", decSubtotal)
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72
73          ' if decTotalCharge is greater than $500
74          ' display message box and give 7% discount
75          If decSubtotal > 500 Then
76
77             MessageBox.Show( _
78                "7% discount will be applied", "Discount Offer", _
79                MessageBoxButtons.OK, MessageBoxIcon.Information)
80
81             ' calculate and display new decTotalCharge with discount
82             Dim decDiscount As Decimal = decSubtotal * 0.07
83
84             decSubtotal -= decDiscount
85
86             ' decDiscount is negative to reflect that it is 
87             ' being subtracted from the subtotal during display
88             lblDiscount.Text = String.Format("{0:C}", -decDiscount)
89
90          End If
91
92          ' calculate and display tax
93          Dim decTax As Decimal = decSubtotal * 0.05
94
95          lblTaxResult.Text = String.Format("{0:C}", decTax)
96
97          ' shipping
98          ' $1.50 for up to 20 items
99          ' free after 20 items
100          Dim intNumberOfItems As Integer = _
101             (Val(txtWhiteBlackQuantity.Text) + _
102             Val(txtRedBlackQuantity.Text) + _
103             Val(txtBlueBlackQuantity.Text))
104
105          Dim decShippingCost As Decimal = 0.0
106
107          ' shipping is $1.50 if less than 20 pairs ordered
108          If intNumberOfItems <= 20 Then
109
110             decShippingCost = 1.5
111
112          End If
113
114          ' display shipping charges
115          lblShippingResult.Text = _
116             String.Format("{0:C}", decShippingCost)
117
118          ' calculate total charge
119          Dim decTotalCharge As Decimal = _
120             decSubtotal + decTax + decShippingCost
121
122          ' display total charge
123          lblTotalResult.Text = _
124             String.Format("{0:C}", decTotalCharge)
125
126       End If
127
128    End Sub ' btnCalculate_Click
129
130 End Class ' FrmFuzzyDiceOrderFormModified
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What does this code do? 8.14 Assume that txtName is a TextBox and that chkOther is a CheckBox next to which is a
TextBox txtOther, in which the user should specify a value. What does this code segment
do?

Answer: This code displays a message dialog only if txtName.Text is empty or CheckBox 
chkOther is selected and its corresponding TextBox is left blank.

What’s wrong with this code? 8.15 Assume that txtName is a TextBox. Find the error(s) in the following code:

Answer: The call to method MessageBox.Show is missing arguments. Also, the nature of the 
message indicates that MessageBoxIcon.Information should be used instead of Message-
BoxIcon.Exclamation. The corrected code should read:

Using the Debugger 8.16 (Sibling Survey Application) The Sibling Survey application displays the siblings
selected by the user in a dialog. If the user checks either the Brother(s) or Sister(s) Check-
Box, and the No Siblings CheckBox, the user is asked to verify the selection. Otherwise, the
user’s selection is displayed in a MessageBox. While testing this application, you noticed that
it does not execute properly. Use the debugger to find and correct the logic error(s) in the
code. This exercise is located in the C:\Examples\Tutorial08\Debugger\SiblingSurvey
directory. Figure 8.24 shows the correct output for the application. 

▲

1 If (txtName.Text = "" OrElse _
2    (chkOther.Checked = True AndAlso _
3    txtOther.Text = "")) Then
4
5    MessageBox.Show("Please enter a name or value", _
6       "Input Error", MessageBoxButtons.OK, _
7       MessageBoxIcon.Exclamation)
8
9 End If

▲

1 If txtName.Text = "John Doe" Then
2
3    MessageBox.Show("Welcome, John!", _
4       MessageBoxIcon.Exclamation)
5
6 End If

1 If txtName.Text = "John Doe" Then
2
3    MessageBox.Show("Welcome, John!", _
4       
5       
6
7 End If

"Welcome", MessageBoxButtons.OK, _
MessageBoxIcon.Information)       

▲
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Figure 8.24 Correct output for the Sibling Survey application.

Answer:

1 ' Exercise 8.16 Solution
2 ' SiblingSurvey.vb
3
4 Public Class FrmSiblingSurvey
5    Inherits System.Windows.Forms.Form
6
7    ' Visual Studio .NET generated code
8
9    ' display what siblings user selects

10    Private Sub btnSubmit_Click(ByVal sender As _
11       System.Object, ByVal e As System.EventArgs) _
12       Handles btnSubmit.Click
13
14       ' check if user selects brothers or sisters
15       ' and no siblings
16       If (chkNone.Checked = True) AndAlso _
17          (chkBrother.Checked = True  _
18          chkSister.Checked = True) Then
19
20          MessageBox.Show("Selected combination is not possible", _
21             "Invalid Input", MessageBoxButtons.OK, _
22             MessageBoxIcon.Exclamation)
23
24       ' check if user selects CheckBox
25       ElseIf chkNone.Checked = False AndAlso _
26          chkBrother.Checked = False AndAlso _
27          chkSister.Checked = False Then
28
29          MessageBox.Show("Please check at least one CheckBox", _
30             "Invalid Input", MessageBoxButtons.OK, _
31             MessageBoxIcon.Exclamation)
32
33       ' check if user has brothers and sisters
34       ElseIf chkBrother.Checked = True  _
35          chkSister.Checked = True Then
36          MessageBox.Show("You have brothers and sisters", _
37             "Siblings", MessageBoxButtons.OK, _
38             MessageBoxIcon.Information)
39
40       ' check if user has brothers
41       ElseIf chkBrother.Checked = True Then
42          MessageBox.Show("You have at least one brother", _
43             "Siblings", MessageBoxButtons.OK, _
44             MessageBoxIcon.Information)
45
46       ' check if user has sisters

Replaced AndAlso with OrElse OrElse

Replaced OrElse with AndAlso AndAlso
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Programming Challenge 8.17 (Enhanced Fuzzy Dice Order Form Application) Enhance the Fuzzy Dice Order
Form application from Exercise 8.12 by replacing the Calculate Button with a Clear Button.
The application should update the total cost, tax and shipping when the user changes any one
of the three Quantity field’s values (Fig. 8.25). The Clear Button should return all fields to
their original values. [Hint: You will need to use the CheckBox CheckedChanged event for
each CheckBox. This event is raised when the state of a CheckBox changes. Double click a
CheckBox in design view to create an event handler for that CheckBox’s CheckedChanged
event. You also will need to assign Boolean values to the CheckBoxes’ Checked properties to
control their states.]

Figure 8.25 Enhanced Fuzzy Dice Order Form application.

Answer:

47       ElseIf chkSister.Checked = True Then
48          MessageBox.Show("You have at least one sister", _
49             "Siblings", MessageBoxButtons.OK, _
50             MessageBoxIcon.Information)
51
52       ' user has no siblings
53       Else
54          MessageBox.Show("You have no siblings", _
55             "Siblings", MessageBoxButtons.OK, _
56             MessageBoxIcon.Information)
57
58       End If
59
60    End Sub ' btnSubmit_Click
61
62 End Class ' FrmSiblingSurvey

▲

1 ' Exercise 8.17 Solution
2 ' FuzzyDiceOrderFormEnhanced.vb
3
4 Public Class FrmFuzzyDiceOrderFormEnhanced
5    Inherits System.Windows.Forms.Form
6
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7    ' Windows Form Designer generated code
8
9    Private Sub txtWhiteBlackQuantity_TextChanged(ByVal sender As _

10      System.Object, ByVal e As System.EventArgs) Handles _
11      txtWhiteBlackQuantity.TextChanged
12
13       ' store quantity entered as Integer
14       Dim intNumberOfWhiteBlack As Integer = _
15          Val(txtWhiteBlackQuantity.Text)
16
17       ' display message if user tries to enter a value
18       ' without selecting CheckBox
19       If (intNumberOfWhiteBlack <> 0 _
20          AndAlso chkWhiteBlack.Checked = False) Then
21
22          ' keep white/black quantity at 0
23          txtWhiteBlackQuantity.Text = 0
24
25          ' display message in dialog
26          MessageBox.Show( _
27             "Please check item you wish to purchase", _
28             "No Item Selected", MessageBoxButtons.OK, _
29             MessageBoxIcon.Exclamation)
30
31       ' display message if shipping information is not supplied
32       ElseIf _
33          (txtOrderNumber.Text = "") _
34          OrElse (txtName.Text = "") _
35          OrElse (txtAddressLine1.Text = "") _
36          OrElse (txtCityStateZip.Text = "") Then
37
38          ' display message in dialog
39          MessageBox.Show( _
40             "Please fill out all information fields.", _
41             "Empty Fields", MessageBoxButtons.OK, _
42             MessageBoxIcon.Exclamation)
43
44       ' display message if negative number entered
45       ElseIf _
46          (intNumberOfWhiteBlack < 0) Then
47          txtWhiteBlackQuantity.Text = 0
48          MessageBox.Show( _
49             "Please enter a positive quantity", _
50             "Bad Input", MessageBoxButtons.OK, _
51             MessageBoxIcon.Exclamation)
52
53       Else ' calculate totals
54
55          ' individual totals
56          ' total of white/black dice
57          Dim decWhiteBlackTotals As Decimal = _
58             Val(txtWhiteBlackQuantity.Text) * lblWhiteBlackPrice.Text
59
60          ' total of red/black dice
61          Dim decRedBlackTotals As Decimal = _
62             Val(txtRedBlackQuantity.Text) * lblRedBlackPrice.Text
63
64          ' total of blue/black dice
65          Dim decBlueBlackTotals As Decimal = _
66             Val(txtBlueBlackQuantity.Text) * lblBlueBlackPrice.Text
67
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68          ' display individual totals
69          lblWhiteBlackTotals.Text = _
70             String.Format("{0:C}", decWhiteBlackTotals)
71          lblRedBlackTotals.Text = _
72             String.Format("{0:C}", decRedBlackTotals)
73          lblBlueBlackTotals.Text = _
74             String.Format("{0:C}", decBlueBlackTotals)
75
76          ' subtotal, before tax and shipping
77          Dim decSubtotal As Decimal = decWhiteBlackTotals _
78             + decRedBlackTotals + decBlueBlackTotals
79
80          lblSubtotalResult.Text = String.Format("{0:C}", decSubtotal)
81
82          ' calculate and display tax
83          Dim decTax As Decimal = decSubtotal * 0.05
84
85          lblTaxResult.Text = String.Format("{0:C}", decTax)
86
87          ' shipping
88          ' $1.50 for up to 20 items
89          ' free after 20 items
90          Dim intNumberOfItems As Integer = _
91             (Val(txtWhiteBlackQuantity.Text) + _
92             Val(txtRedBlackQuantity.Text) + _
93             Val(txtBlueBlackQuantity.Text))
94
95          Dim decShippingCost As Decimal = 0.0
96
97          ' shipping is $1.50 if under 20 items ordered
98          If (intNumberOfItems <= 20) AndAlso _
99             (intNumberOfItems > 0) Then
100
101             decShippingCost = 1.5
102
103          End If
104
105          ' display shipping cost
106          lblShippingResult.Text = _
107             String.Format("{0:C}", decShippingCost)
108
109          ' calculate and display total charge
110          Dim decTotalCharge As Decimal = decSubtotal + decTax + _
111             decShippingCost
112
113          lblTotalResult.Text = String.Format("{0:C}", decTotalCharge)
114
115       End If
116
117    End Sub ' txtWhiteBlackQuantity_TextChanged
118
119    Private Sub txtRedBlackQuantity_TextChanged(ByVal sender As _
120       System.Object, ByVal e As System.EventArgs) Handles _
121       txtRedBlackQuantity.TextChanged
122
123       ' store quantity entered as Integer
124       Dim intNumberOfRedBlack As Integer = _
125          Val(txtRedBlackQuantity.Text)
126
127       ' check validity of order before calculating totals
128       ' and display message for invalid orders
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129
130       ' display message if user tries to enter a value
131       ' without selecting CheckBox
132       If intNumberOfRedBlack <> 0 AndAlso _
133          chkRedBlack.Checked = False Then
134
135          ' keep red/black quantity at 0
136          txtRedBlackQuantity.Text = 0
137
138          ' display message in dialog
139          MessageBox.Show( _
140             "Please check item you wish to purchase", _
141             "No Item Selected", MessageBoxButtons.OK, _
142             MessageBoxIcon.Exclamation)
143
144       ' display message if shipping information is not supplied
145       ElseIf _
146          (txtOrderNumber.Text = "") _
147          OrElse (txtName.Text = "") _
148          OrElse (txtAddressLine1.Text = "") _
149          OrElse (txtCityStateZip.Text = "") Then
150
151          ' display message in dialog
152          MessageBox.Show( _
153             "Please fill out all information fields", _
154             "Empty Fields", MessageBoxButtons.OK, _
155             MessageBoxIcon.Exclamation)
156
157       ' display message if negative number entered
158       ElseIf _
159          (intNumberOfRedBlack < 0) Then
160          txtRedBlackQuantity.Text = 0
161          MessageBox.Show( _
162             "Please enter a positive quantity", _
163             "Bad Input", MessageBoxButtons.OK, _
164             MessageBoxIcon.Exclamation)
165
166       Else ' calculate totals
167
168          ' individual totals
169          ' total of white/black dice
170          Dim decWhiteBlackTotals As Decimal = _
171             Val(txtWhiteBlackQuantity.Text) * lblWhiteBlackPrice.Text
172
173          ' total of red/black dice
174          Dim decRedBlackTotals As Decimal = _
175             Val(txtRedBlackQuantity.Text) * lblRedBlackPrice.Text
176
177          ' total of blue/black dice
178          Dim decBlueBlackTotals As Decimal = _
179             Val(txtBlueBlackQuantity.Text) * lblBlueBlackPrice.Text
180
181          ' display individual totals
182          lblWhiteBlackTotals.Text = _
183             String.Format("{0:C}", decWhiteBlackTotals)
184          lblRedBlackTotals.Text = _
185             String.Format("{0:C}", decRedBlackTotals)
186          lblBlueBlackTotals.Text = _
187             String.Format("{0:C}", decBlueBlackTotals)
188
189          ' subtotal, before tax and shipping



Tutorial 8 Dental Payment Application 77

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

190          Dim decSubtotal As Decimal = decWhiteBlackTotals _
191             + decRedBlackTotals + decBlueBlackTotals
192
193          lblSubtotalResult.Text = String.Format("{0:C}", decSubtotal)
194
195          ' calculate and display tax
196          Dim decTax As Decimal = decSubtotal * 0.05
197
198          lblTaxResult.Text = String.Format("{0:C}", decTax)
199
200          ' shipping
201          ' $1.50 for up to 20 items
202          ' free after 20 items
203          Dim intNumberOfItems As Integer = _
204             (Val(txtWhiteBlackQuantity.Text) + _
205             Val(txtRedBlackQuantity.Text) + _
206             Val(txtBlueBlackQuantity.Text))
207
208          Dim decShippingCost As Decimal = 0.0
209
210          ' shipping if $1.50 if under 20 items ordered
211          If intNumberOfItems <= 20 AndAlso _
212             intNumberOfItems > 0 Then
213
214             decShippingCost = 1.5
215
216          End If
217
218          ' display shipping cost
219          lblShippingResult.Text = _
220             String.Format("{0:C}", decShippingCost)
221
222          ' calculate and display total charge
223          Dim decTotalCharge As Decimal = decSubtotal + decTax + _
224             decShippingCost
225
226          lblTotalResult.Text = String.Format("{0:C}", decTotalCharge)
227
228       End If
229
230    End Sub ' txtRedBlackQuantity_TextChanged
231
232    Private Sub txtBlueBlackQuantity_TextChanged(ByVal sender As _
233       System.Object, ByVal e As System.EventArgs) Handles _
234       txtBlueBlackQuantity.TextChanged
235
236       ' store quantity entered as Integer
237       Dim intNumberOfBlueBlack As Integer = _
238          Val(txtBlueBlackQuantity.Text)
239
240       ' check validity of order before calculating totals
241       ' and display message for invalid orders
242
243       ' display message if user tries to enter a value
244       ' without selecting CheckBox
245       If intNumberOfBlueBlack <> 0 AndAlso _
246          chkBlueBlack.Checked = False Then
247
248          ' keep blue/black quantity at 0
249          txtBlueBlackQuantity.Text = 0
250
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251          ' display message in dialog
252          MessageBox.Show( _
253             "Please check item you wish to purchase", _
254             "No Item Selected", MessageBoxButtons.OK, _
255             MessageBoxIcon.Exclamation)
256
257       ' display message if shipping information is not supplied
258       ElseIf _
259          (txtOrderNumber.Text = "") _
260          OrElse (txtName.Text = "") _
261          OrElse (txtAddressLine1.Text = "") _
262          OrElse (txtCityStateZip.Text = "") Then
263
264          ' display message in dialog
265          MessageBox.Show( _
266             "Please fill out all information fields", _
267             "Empty Fields", MessageBoxButtons.OK, _
268             MessageBoxIcon.Exclamation)
269
270       ' display message if negative number is entered
271       ElseIf _
272          (intNumberOfBlueBlack < 0) Then
273
274          txtBlueBlackQuantity.Text = 0
275          MessageBox.Show( _
276             "Please enter a positive quantity", _
277             "Bad Input", MessageBoxButtons.OK, _
278             MessageBoxIcon.Exclamation)
279
280       Else ' calculate totals
281
282          ' individual totals
283          ' total of white/black dice
284          Dim decWhiteBlackTotals As Decimal = _
285             Val(txtWhiteBlackQuantity.Text) * lblWhiteBlackPrice.Text
286
287          ' total of red/black dice
288          Dim decRedBlackTotals As Decimal = _
289             Val(txtRedBlackQuantity.Text) * lblRedBlackPrice.Text
290
291          ' total of blue/black dice
292          Dim decBlueBlackTotals As Decimal = _
293             Val(txtBlueBlackQuantity.Text) * lblBlueBlackPrice.Text
294
295          ' display individual totals
296          lblWhiteBlackTotals.Text = _
297             String.Format("{0:C}", decWhiteBlackTotals)
298          lblRedBlackTotals.Text = _
299             String.Format("{0:C}", decRedBlackTotals)
300          lblBlueBlackTotals.Text = _
301             String.Format("{0:C}", decBlueBlackTotals)
302
303          ' subtotal, before tax and shipping
304          Dim decSubtotal As Decimal = decWhiteBlackTotals _
305             + decRedBlackTotals + decBlueBlackTotals
306
307          lblSubtotalResult.Text = String.Format("{0:C}", decSubtotal)
308
309          ' calculate and display tax
310          Dim decTax As Decimal = decSubtotal * 0.05
311
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312          lblTaxResult.Text = String.Format("{0:C}", decTax)
313
314          ' shipping
315          ' $1.50 for up to 20 items
316          ' free after 20 items
317          Dim intNumberOfItems As Integer = _
318             Val(txtWhiteBlackQuantity.Text) + _
319             Val(txtRedBlackQuantity.Text) + _
320             Val(txtBlueBlackQuantity.Text)
321
322          Dim decShippingCost As Decimal = 0.0
323
324          ' shipping is $1.50 if under 20 items ordered
325          If intNumberOfItems <= 20 AndAlso _
326             intNumberOfItems > 0 Then
327
328             decShippingCost = 1.5
329
330          End If
331
332          ' display shipping cost
333          lblShippingResult.Text = _
334             String.Format("{0:C}", decShippingCost)
335
336          ' calculate and display total charge
337          Dim decTotalCharge As Decimal = decSubtotal + decTax + _
338             decShippingCost
339
340          lblTotalResult.Text = String.Format("{0:C}", decTotalCharge)
341
342       End If
343
344    End Sub ' txtBlueBlackQuantity_TextChanged
345
346    ' clear all fields
347    Private Sub btnClear_Click(ByVal sender As System.Object, _
348       ByVal e As System.EventArgs) Handles btnClear.Click
349
350       ' set all fields to their original values
351       txtOrderNumber.Text = "0"
352       txtName.Text = "Enter name here"
353       txtAddressLine1.Text = "Address Line 1"
354       txtAddressLine2.Text = "Address Line 2"
355       txtCityStateZip.Text = "City, State, zip"
356       txtWhiteBlackQuantity.Text = "0"
357       txtRedBlackQuantity.Text = "0"
358       txtBlueBlackQuantity.Text = "0"
359       lblWhiteBlackTotals.Text = "$0.00"
360       lblRedBlackTotals.Text = "$0.00"
361       lblBlueBlackTotals.Text = "$0.00"
362       lblSubtotalResult.Text = "$0.00"
363       lblTaxResult.Text = "$0.00"
364       lblShippingResult.Text = "$0.00"
365       lblTotalResult.Text = "$0.00"
366       chkWhiteBlack.Checked = False
367       chkRedBlack.Checked = False
368       chkBlueBlack.Checked = False
369
370    End Sub ' btnClear_Click
371
372    Private Sub chkWhiteBlack_CheckedChanged(ByVal sender As _
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373       System.Object, ByVal e As System.EventArgs) Handles _
374       chkWhiteBlack.CheckedChanged
375
376       txtWhiteBlackQuantity.Text = "0"
377       lblWhiteBlackTotals.Text = "0"
378
379       ' individual totals
380       ' total of white/black dice
381       Dim decWhiteBlackTotals As Decimal = _
382          Val(txtWhiteBlackQuantity.Text) * _
383          lblWhiteBlackPrice.Text
384
385       ' total of red/black dice
386       Dim decRedBlackTotals As Decimal = _
387          Val(txtRedBlackQuantity.Text) * _
388          lblRedBlackPrice.Text
389
390       ' total of blue/black dice
391       Dim decBlueBlackTotals As Decimal = _
392          Val(txtBlueBlackQuantity.Text) * _
393          lblBlueBlackPrice.Text
394
395       ' display individual totals
396       lblWhiteBlackTotals.Text = _
397          String.Format("{0:C}", decWhiteBlackTotals)
398       lblRedBlackTotals.Text = _
399          String.Format("{0:C}", decRedBlackTotals)
400       lblBlueBlackTotals.Text = _
401          String.Format("{0:C}", decBlueBlackTotals)
402
403       ' subtotal, before tax and shipping
404       Dim decSubtotal As Decimal = decWhiteBlackTotals + _
405          decRedBlackTotals + decBlueBlackTotals
406
407       lblSubtotalResult.Text = String.Format("{0:C}", decSubtotal)
408
409       ' calculate and display tax
410       Dim decTax As Decimal = decSubtotal * 0.05
411
412       lblTaxResult.Text = String.Format("{0:C}", decTax)
413
414       ' shipping
415       ' $1.50 for up to 20 items
416       ' free after 20 items
417       Dim intNumberOfItems As Integer = _
418          Val(txtWhiteBlackQuantity.Text) + _
419          Val(txtRedBlackQuantity.Text) + _
420          Val(txtBlueBlackQuantity.Text)
421
422       Dim decShippingCost As Decimal = 0.0
423
424       ' shipping is $1.50 if under 20 items ordered
425       If intNumberOfItems <= 20 AndAlso _
426          intNumberOfItems > 0 Then
427
428          decShippingCost = 1.5
429
430       End If
431
432       ' display shipping cost
433       lblShippingResult.Text = _
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434          String.Format("{0:C}", decShippingCost)
435
436       ' calculate and display total charge
437       Dim decTotalCharge As Decimal = decSubtotal + decTax + _
438          decShippingCost
439
440       lblTotalResult.Text = String.Format("{0:C}", decTotalCharge)
441
442    End Sub ' chkWhiteBlack_CheckedChanged
443
444    Private Sub chkRedBlack_CheckedChanged(ByVal sender As _
445       System.Object, ByVal e As System.EventArgs) Handles _
446       chkRedBlack.CheckedChanged
447
448       txtRedBlackQuantity.Text = "0"
449       lblRedBlackTotals.Text = "0"
450
451       ' individual totals
452       ' total of white/black dice
453       Dim decWhiteBlackTotals As Decimal = _
454          Val(txtWhiteBlackQuantity.Text) * _
455          lblWhiteBlackPrice.Text
456
457       ' total of red/black dice
458       Dim decRedBlackTotals As Decimal = _
459          Val(txtRedBlackQuantity.Text) * _
460          lblRedBlackPrice.Text
461
462       ' total of blue/black dice
463       Dim decBlueBlackTotals As Decimal = _
464          Val(txtBlueBlackQuantity.Text) * _
465          lblBlueBlackPrice.Text
466
467       ' display individual totals
468       lblWhiteBlackTotals.Text = _
469          String.Format("{0:C}", decWhiteBlackTotals)
470       lblRedBlackTotals.Text = _
471          String.Format("{0:C}", decRedBlackTotals)
472       lblBlueBlackTotals.Text = _
473          String.Format("{0:C}", decBlueBlackTotals)
474
475       ' subtotal, before tax and shipping
476       Dim decSubtotal As Decimal = decWhiteBlackTotals + _
477          decRedBlackTotals + decBlueBlackTotals
478
479       lblSubtotalResult.Text = String.Format("{0:C}", decSubtotal)
480
481       ' calculate and display tax
482       Dim decTax As Decimal = decSubtotal * 0.05
483
484       lblTaxResult.Text = String.Format("{0:C}", decTax)
485
486       ' shipping
487       ' $1.50 for up to 20 items
488       ' free after 20 items
489       Dim intNumberOfItems As Integer = _
490          Val(txtWhiteBlackQuantity.Text) + _
491          Val(txtRedBlackQuantity.Text) + _
492          Val(txtBlueBlackQuantity.Text)
493
494       Dim decShippingCost As Decimal = 0.0
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495
496       If intNumberOfItems <= 20 AndAlso intNumberOfItems > 0 Then
497          decShippingCost = 1.5
498
499       End If
500
501       ' display shipping cost
502       lblShippingResult.Text = _
503          String.Format("{0:C}", decShippingCost)
504
505       ' calculate and display total charge
506       Dim decTotalCharge As Decimal = decSubtotal + decTax + _
507          decShippingCost
508
509       lblTotalResult.Text = String.Format("{0:C}", decTotalCharge)
510
511    End Sub ' chkRedBlack_CheckedChanged
512
513    Private Sub chkBlueBlack_CheckedChanged(ByVal sender As _
514       System.Object, ByVal e As System.EventArgs) Handles _
515       chkBlueBlack.CheckedChanged
516
517       txtBlueBlackQuantity.Text = "0"
518       lblBlueBlackTotals.Text = "0"
519
520       ' individual totals
521       ' total of white/black dice
522       Dim decWhiteBlackTotals As Decimal = _
523          Val(txtWhiteBlackQuantity.Text) * _
524          lblWhiteBlackPrice.Text
525
526       ' total of red/black dice
527       Dim decRedBlackTotals As Decimal = _
528          Val(txtRedBlackQuantity.Text) * _
529          lblRedBlackPrice.Text
530
531       ' total of blue/black dice
532       Dim decBlueBlackTotals As Decimal = _
533          Val(txtBlueBlackQuantity.Text) * _
534          lblBlueBlackPrice.Text
535
536       ' display individual totals
537       lblWhiteBlackTotals.Text = _
538          String.Format("{0:C}", decWhiteBlackTotals)
539       lblRedBlackTotals.Text = _
540          String.Format("{0:C}", decRedBlackTotals)
541       lblBlueBlackTotals.Text = _
542          String.Format("{0:C}", decBlueBlackTotals)
543
544       ' subtotal, before tax and shipping
545       Dim decSubtotal As Decimal = decWhiteBlackTotals + _
546          decRedBlackTotals + decBlueBlackTotals
547
548       lblSubtotalResult.Text = String.Format("{0:C}", decSubtotal)
549
550       ' calculate and display tax
551       Dim decTax As Decimal = decSubtotal * 0.05
552
553       lblTaxResult.Text = String.Format("{0:C}", decTax)
554
555       ' shipping
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556       ' $1.50 for up to 20 items
557       ' free after 20 items
558       Dim intNumberOfItems As Integer = _
559          Val(txtWhiteBlackQuantity.Text) + _
560          Val(txtRedBlackQuantity.Text) + _
561          Val(txtBlueBlackQuantity.Text)
562       Dim decShippingCost As Decimal = 0.0
563
564       ' shipping is $1.50 if under 20 items ordered
565       If intNumberOfItems <= 20 AndAlso _
566          intNumberOfItems > 0 Then
567
568          decShippingCost = 1.5
569
570       End If
571
572       ' display shipping cost
573       lblShippingResult.Text = _
574          String.Format("{0:C}", decShippingCost)
575
576       ' calculate and display total charge
577       Dim decTotalCharge As Decimal = decSubtotal + decTax + _
578          decShippingCost
579
580       lblTotalResult.Text = String.Format("{0:C}", decTotalCharge)
581
582    End Sub ' chkBlueBlack_CheckedChanged
583
584 End Class ' FrmFuzzyDiceOrderFormEnhanced
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9
Car Payment Calculator 

Application
Introducing the Do While…Loop and Do 
Until…Loop Repetition Statements

Solutions
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Instructor’s Manual
Exercise Solutions

Tutorial 9

MULTIPLE-CHOICE
QUESTIONS

9.1 The  statement executes until its loop-continuation condition becomes True.

9.2 The  statement executes until its loop-continuation condition becomes False.

9.3 A(n)  loop occurs when a condition in a Do While…Loop never becomes
False.

9.4 A  is a variable that helps control the number of times that a set of statements
will execute.

9.5 The  control allows users to add and view items in a list.

9.6 In a UML activity diagram, a(n)  symbol joins two flows of activity into one
flow of activity.

9.7 Property  returns an object containing all the values in a ListBox. 

9.8 Method  deletes all the values in a ListBox. 

9.9 Items’s method  adds an item to a ListBox. 

9.10 Method  calculates monthly payments on a loan based on a fixed interest
rate. 

Answers: 9.1) b.  9.2) a.  9.3) a.  9.4) b.  9.5) c.  9.6) a.  9.7) d.  9.8) c.  9.9) c.  9.10) d.

EXERCISES 9.11 (Table of Powers Application) Write an application that displays a table of numbers
from 1 to an upper limit, along with each number’s squared value (for example, the number n
to the power 2, or n ^ 2) and cubed value (the number n to the power 3, or n ^ 3). The users
should specify the upper limit, and the results should be displayed in a ListBox, as in
Fig. 9.20.

a) Do While…Loop b) Do Until…Loop 
c) Do d) Loop 

a) Do While…Loop b) Do Until…Loop 
c) Do d) Do While 

a) infinite b) undefined
c) nested d) indefinite

a) repeater b) counter
c) loop d) repetition control statement

a) ListItems b) SelectBox 
c) ListBox d) ViewBox 

a) merge b) combine
c) action state d) decision

a) All b) List 
c) ListItemValues d) Items 

a) Remove b) Delete

c) Clear d) Del

a) Include b) Append

c) Add d) Insert

a) MonPmt b) Payment

c) MonthlyPayment d) Pmt
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Figure 9.20 Table of Powers application’s Form.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial09\Exercises\TableOfPowers directory to your C:\SimplyVB
directory.

b) Opening the application’s template file. Double click TableOfPowers.sln in the
TableOfPowers directory to open the application.

c) Adding a ListBox. Add a ListBox to the application, as shown in Fig. 9.20. Name
the ListBox lstResults.

d) Adding the Upper limit: TextBox event handler. Double click the Upper limit: Text-
Box to generate an event handler for this TextBox’s TextChanged event. In this event
handler, clear the ListBox.

e) Adding the Calculate Button event handler. Double click the Calculate Button to
generate the empty event handler btnCalculate_Click. Add the code specified by
the remaining steps to this event handler.

f) Clearing the ListBox. Use method Clear on the Items property to clear the List-
Box from any previous data.

g) Obtaining the upper limit supplied by the user. Assign the value entered by the user
in the Upper limit: TextBox to a variable. Note that the TextBox’s Name property is
set to txtInput.

h) Adding a header. Use method Add on the Items property to insert a header in the
ListBox. The header should label three columns—N, N^2 and N^3. Column headings
should be separated by tab characters.

i) Calculating the powers from 1 to the specified upper limit. Use a Do Until…Loop to
calculate the squared value and the cubed value of each number from 1 to the upper
limit, inclusive. Add an item to the ListBox containing the current number being
analyzed, its squared value and its cubed value.

j) Incrementing the counter. Remember to increment the counter appropriately each
time through the loop.

k) Running the application. Select Debug > Start to run your application. Enter an
upper limit and click the Calculate Button. Verify that the table of powers displayed
contains the correct values.

l) Closing the application. Close your running application by clicking its close box.

m)Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 9.11 Solution
2 ' TableOfPowers.vb
3
4 Public Class FrmTableOfPowers
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' handles Click event

10    Private Sub btnCalculate_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnCalculate.Click
12
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9.12 (Mortgage Calculator Application) A bank offers mortgages that can be repaid in 5,
10, 15, 20, 25 or 30 years. Write an application that allows a user to enter the price of a house
(the amount of the mortgage) and the annual interest rate. When the user clicks a Button,
the application displays a table of the mortgage length in years together with the monthly
payment, as shown in Fig. 9.21.

Figure 9.21 Mortgage Calculator application’s Form.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial09\Exercises\MortgageCalculator directory to your C:\Sim-
plyVB directory.

b) Opening the application’s template file. Double click MortgageCalculator.sln in
the MortgageCalculator directory to open the application.

c) Adding a ListBox to display the results. Add a ListBox as shown in Fig. 9.21. Name
the ListBox lstResults. 

13       Dim intLimit As Integer = 0   ' upper limit set by user
14       Dim intCounter As Integer = 1 ' counter begins at 1
15
16       ' clear ListBox
17       lstResults.Items.Clear()
18
19       ' retrieve user input
20       intLimit = Val(txtInput.Text)
21
22       ' add header 
23       lstResults.Items.Add(“N” & ControlChars.Tab & “N^2” & _
24          ControlChars.Tab & “N^3”)
25
26       ' calculate and display square and cube of 1 to intLimit
27       Do Until intCounter > intLimit
28
29          lstResults.Items.Add(intCounter & ControlChars.Tab & _
30             intCounter ^ 2 & ControlChars.Tab & intCounter ^ 3)
31
32          ' increment counter
33          intCounter += 1
34       Loop
35
36    End Sub ' btnCalculate_Click
37
38    ' handles TextChanged event
39    Private Sub txtInput_TextChanged(ByVal sender As System.Object, _
40       ByVal e As System.EventArgs) Handles txtInput.TextChanged
41
42       lstResults.Items.Clear()
43    End Sub ' txtInput_TextChanged
44
45 End Class ' FrmTableOfPowers
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d) Adding a Calculate Button event handler. Double click the Calculate Button to
generate the empty event handler btnCalculate_Click. Add the code specified in
the remaining steps to your event handler.

e) Converting the annual interest rate to the monthly interest rate. To convert the
annual interest rate from a percent value into its Double equivalent, divide the
annual rate by 100. Then divide the Double annual rate by 12 to obtain the monthly
rate.

f) Clearing the ListBox. Use method Clear on the Items property to clear the List-
Box from any previous data.

g) Displaying a header. Use method Add to display a header in the ListBox. The
header should be the column headers “Mortgage Length (Years)” and “Monthly
Payment”, separated by a tab character.

h) Using a repetition statement. Add a Do While…Loop repetition statement to calcu-
late six monthly payment options for the user’s mortgage. Each option has a different
number of years that the mortgage can last. For this exercise, use the following num-
ber of years: 5, 10, 15, 20, 25 and 30.

i) Converting the length of the mortgage from years to months. Convert the number of
years to months.

j) Calculating the monthly payments for six different mortgages. Use the Pmt function
to compute the monthly payments. Pass to the function the monthly interest rate, the
number of months in the mortgage and the mortgage amount. Remember that the
mortgage amount must be negative, as it represents an amount of money being paid
out by the lender.

k) Displaying the results. Use method Add on the Items property to display the length
of the mortgage in years and the monthly payment in the ListBox. You will need to
use three tab characters to ensure that the monthly payment appears in the second
column.

l) Running the application. Select Debug > Start to run your application. Enter a
mortgage amount and annual interest rate, then click the Calculate Button. Verify
that the monthly payments displayed contain the correct values.

m)Closing the application. Close your running application by clicking its close box.

n) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 9.12 Solution
2 ' MortgageCalculator.vb
3
4 Public Class FrmMortgageCalculator
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' handles Calculate Button’s Click event

10    Private Sub btnCalculate_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnCalculate.Click
12
13       Dim intMortgageAmount As Integer = 0  ' mortgage amount
14       Dim dblAnnualRate As Double = 0       ' annual interest rate
15       Dim dblMonthlyRate As Double = 0      ' monthly interest rate
16       Dim decPayment As Decimal = 0         ' monthly payment amount
17       Dim intYears As Integer = 5           ' years in mortgage
18       Dim intMonths As Integer = 0          ' months in mortgage
19
20       ' obtain user input
21       intMortgageAmount = Val(txtMortgageAmount.Text)
22       dblAnnualRate = Val(txtRate.Text) / 100
23
24       ' calculate monthly interest rate
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9.13 (Office Supplies Application) Create an application that allows a user to make a list of
office supplies to buy, as shown in Fig. 9.22. The user should enter the supply in a TextBox
and click the Buy Button to add it to the ListBox. The Clear Button removes all the items
from the ListBox.

 
Figure 9.22 Office Supplies application’s Form. 

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial09\Exercises\OfficeSupplies directory to your C:\SimplyVB
directory.

b) Opening the application’s template file. Double click OfficeSupplies.sln in
OfficeSupplies directory to open the application.

c) Adding a ListBox. Add a ListBox to the Form. Name the ListBox lstSupplies.
Place and size it as shown in Fig. 9.22.

d) Adding an event handler for the Buy Button. Double click the Buy Button to gener-
ate the event handler btnBuy_Click. The event handler should obtain the user input

25       dblMonthlyRate = dblAnnualRate / 12
26
27       ' clear previous results from ListBox
28       lstResults.Items.Clear()
29
30       ' add header to ListBox
31       lstResults.Items.Add(“Mortgage Length (Years)” & _
32          ControlChars.Tab & “Monthly Payment”)
33
34       ' perform Pmt calculation and display result for
35       ' 5, 10, 15, 20, 25 and 30 years
36       Do While intYears <= 30
37
38          ' convert years to months for the calculation
39          intMonths = intYears * 12
40
41          ' perform calculation
42          decPayment = Convert.ToDecimal( _
43             Pmt(dblMonthlyRate, intMonths, -intMortgageAmount))
44
45          ' display result
46          lstResults.Items.Add(intYears & ControlChars.Tab & _
47             ControlChars.Tab & ControlChars.Tab & _
48             String.Format(“{0:C}”, decPayment))
49
50          ' increment counter
51          intYears += 5
52       Loop
53
54    End Sub ' btnCalculate_Click
55
56 End Class ' FrmMortgageCalculator
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from the TextBox. The user input is then added as an item into the ListBox. After
the input is added to the ListBox, clear the Supply: TextBox.

e) Adding an event handler for the Clear Button. Double click the Clear Button to
generate the event handler btnClear_Click. The event handler should use the
Clear method on the Items property to clear the ListBox.

f) Running the application. Select Debug > Start to run your application. Enter sev-
eral items into the Supply: TextBox and click the Buy Button after entering each
item. Verify that each item is added to the ListBox. Click the Clear Button and ver-
ify that all items are removed from the ListBox.

g) Closing the application. Close your running application by clicking its close box.

h) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

What does this code do? 9.14 What is the result of the following code?

Answer: intX = 6, intMysteryValue = 120.

What’s wrong with this code? 9.15 Find the error(s) in the following code:

a) Assume that the variable intX is declared and initialized to 1. The loop should total
the numbers from 1 to 10.

1 ' Exercise 9.13 Solution
2 ' OfficeSupplies.vb
3
4 Public Class FrmOfficeSupplies
5    Inherits System.Windows.Forms.Form
6
7    ' handles Buy Button's Click event
8    Private Sub btnBuy_Click(ByVal sender As System.Object, _
9       ByVal e As System.EventArgs) Handles btnBuy.Click

10
11       ' add supply item to ListBox, clear input TextBox
12      lstSupplies.Items.Add(txtOfficeSupply.Text)
13       txtOfficeSupply.Text = ""
14    End Sub ' btnBuy_Click
15
16    ' handles Clear Button's Click event
17    Private Sub btnClear_Click(ByVal sender As System.Object, _
18       ByVal e As System.EventArgs) Handles btnClear.Click
19
20       lstSupplies.Items.Clear() ' clear supply items
21    End Sub ' btnClear_Click
22
23 End Class ' FrmOfficeSupplies

▲

1 Dim intX As Integer = 1
2 Dim intMysteryValue As Integer = 1
3
4 Do While intX < 6
5
6    intMysteryValue *= intX
7    intX += 1
8 Loop
9

10 lblDisplay.Text = intMysteryValue

▲
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Answer:  This loop will never execute, as intX is already less than or equal to 10. The code 
should use > instead of <=. An alternative solution would be to convert the loop to a Do 
While…Loop.

b) Assume that the variable intCounter is declared and initialized to 1. The loop
should sum the numbers from 1 to 100.

Answer: This is an infinite loop, as intCounter will never be greater than 100. The state-
ment that increments intCounter must be placed within the Do While…Loop statement.

c) Assume that the variable intCounter is declared and initialized to 1000. The loop
should iterate from 1000 to 1. 

Answer: The values must decrease. The value 1 should be subtracted from, rather than 
added to, intCounter.

1 Dim intTotal As Integer = 0
2
3 Do Until intX <= 10
4
5    intTotal += intX
6    intX += 1
7 Loop

1 Dim intTotal As Integer = 0
2
3
4
5    intTotal += intX
6    intX += 1
7 Loop

1 Do While intCounter <= 100
2
3    intTotal += intCounter
4 Loop
5
6 intCounter += 1

1 Do While intCounter <= 100
2
3    intTotal += intCounter
4    
5 Loop

1 Do While intCounter > 0
2
3    lblDisplay.Text = intCounter
4    intCounter += 1
5 Loop

1 Do While intCounter > 0
2
3    lblDisplay.Text = intCounter
4    
5 Loop

Do Until intX > 10

intCounter += 1

intCounter -= 1
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d) Assume that the variable intCounter is declared and initialized to 1. The loop
should execute five times, adding the numbers 1–5 to a ListBox.

 

Answer: This loop will execute only four times. To fix the application, the loop-continuation 
condition should use the <= operator, rather than the < operator.

Using the Debugger 9.16 (Odd Numbers Application) The Odd Numbers application should display all of the
odd integers between one and the number input by the user. Copy the Odd Numbers appli-
cation from C:/Examples/Tutorial09/Debugger to your working directory. Run the appli-
cation. Notice that, after you enter a value into the Upper limit: TextBox and click the View
Button, an infinite loop occurs. Use the debugger to find and fix the error(s) in the applica-
tion. Figure 9.23 displays the correct output for the application.

Figure 9.23 Correct output for the Odd Numbers application.

1 Do While intCounter < 5
2
3    lstNumbers.Items.Add(intCounter)
4    intCounter += 1
5 Loop

1
2
3    lstNumbers.Items.Add(intCounter)
4    intCounter += 1
5 Loop

Do While intCounter <= 5

▲

1 ' Exercise 9.16 Solution
2 ' OddNumbers.vb
3
4 Public Class FrmOddNumbers
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Forms Designer generated code
8
9    ' display odd numbers from one to number input by user

10    Private Sub btnView_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnView.Click
12
13       Dim intLimit As Integer = 0 ' upper limit set by user
14       Dim intCounter As Integer = 1 ' counter begins at 1
15
16       lstResults.Items.Clear() ' clear ListBox
17       intLimit = Val(txtLimit.Text) ' retrieve upper limit
18       lstResults.Items.Add("Odd numbers:") ' display header
19
20       Do While intCounter < intLimit
21
22          ' determine and display odd numbers
23          If intCounter Mod 2 <> 0 Then
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Programming Challenge 9.17 (To Do List Application) Use a ListBox as a to do list. Enter each item in a TextBox,
and add it to the ListBox by clicking a Button. The item should be displayed in a numbered
list as in Fig. 9.24. To do this, we introduce property Count, which returns the number of
items in a ListBox’s Items property. The following is a sample call to assign the number of
items displayed in the lstSample ListBox to an Integer variable:

intCount = lstSample.Items.Count

Figure 9.24 To Do List application’s Form. 

24             lstResults.Items.Add(intCounter)
25          End If
26
27          
28       Loop
29
30    End Sub ' btnView_Click
31
32 End Class ' FrmOddNumbers

intCounter += 1 ' increment counter

Incorrect code given to
students incremented
intLimit instead of

intCounter

▲
1 ' Exercise 9.17 Solution
2 ' ToDoList.vb
3
4 Public Class FrmToDoList
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    Private Sub btnAdd_Click(ByVal sender As System.Object, _

10       ByVal e As System.EventArgs) Handles btnAdd.Click
11
12       Dim intItemNumber As Integer
13
14       ' set number of item
15       intItemNumber = lstOutput.Items.Count + 1
16
17       ' add input with number to ListBox 
18       lstOutput.Items.Add(intItemNumber & ". " & _
19          txtInput.Text)
20
21       ' clear TextBox
22       txtInput.Text = ""
23    End Sub ' btnAdd_Click
24
25 End Class ' FrmToDoList
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10
Class Average 
Application 

Introducing the Do…Loop While and 
Do…Loop Until Repetition Statements

Class Average 
Application 

Introducing the Do…Loop While and 
Do…Loop Until Repetition Statements

Solutions
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Instructor’s Manual
Exercise Solutions

Tutorial 10

MULTIPLE-CHOICE
QUESTIONS

10.1 A(n)  occurs when a loop-continuation condition in a Do…Loop While never
becomes False.

10.2 Set property  to True to enable a Button.

10.3 The  statement executes at least once and continues executing until its loop-
termination condition becomes True.

10.4 The  statement executes at least once and continues executing until its loop-
continuation condition becomes False.

10.5 Method  transfers the focus to a control.

10.6 A  contains the sum of a series of values.

10.7 Property  of  contains the number of items in a ListBox.

10.8 A(n)  occurs when a loop executes for one more or one less iteration than is
necessary.

10.9 A Do…Loop Until repetition statement’s loop-termination condition is evaluated
.

10.10 If its continuation condition is initially False, a Do…Loop While repetition statement
.

Answers: 10.1) a.  10.2) c.  10.3) b.  10.4) d.  10.5) b.  10.6) a.  10.7) d.  10.8) c.  10.9) c.  10.10) d. 

a) infinite loop b) counter-controlled loop
c) control statement d) nested control statement

a) Disabled b) Focus 
c) Enabled d) ButtonEnabled 

a) Do While…Loop b) Do…Loop Until 
c) Do…Loop While d) Do Until…Loop 

a) Do…Loop Until b) Do Until…Loop 
c) Do While…Loop d) Do…Loop While 

a) GetFocus b) Focus 
c) Transfer d) Activate 

a) total b) counter
c) condition d) loop

a) Count, ListBox b) ListCount, Items 
c) ListCount, ListBox d) Count, Items 

a) infinite loop b) counter-controlled loop
c) off-by-one error d) nested control statement

a) only the first time the body executes b) before the body executes
c) after the body executes d) None of the above

a) never executes b) executes until the condition becomes 
True

c) executes until the condition becomes 
True

d) executes only once
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EXERCISES 10.11 (Modified Class Average Application) Modify the Class Average application, as in
Fig. 10.18, so that the Average Button is disabled until 10 grades have been entered.

Figure 10.18 Modified Class Average application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial10\Exercises\ModifiedClassAverage directory to your C:\Sim-
plyVB directory. 

b) Opening the application’s template file. Double click ClassAverage.sln in the
ModifiedClassAverage directory to open the application.

c) Initially disabling the Average Button. Use the Properties window to modify the
Average Button in the Form so that it is disabled when the application first executes
by initially setting its Enabled property to False.

d) Enabling the Average Button after 10 grades have been entered. Add code to the
btnAdd_Click event handler so that the Average Button becomes enabled when 10
grades have been entered.

e) Disabling the Average Button after the calculation has been performed. Add code
to the btnAverage_Click event handler so that the Average Button is disabled once
the calculation result has been displayed.

f) Running the application. Select Debug > Start to run your application. Enter 10
grades and ensure that the Average Button is disabled until all 10 grades are
entered. Verify that the Add Grade Button is disabled after 10 grades are entered.
Once the Average Button is enabled, click it and verify that the average displayed is
correct. The Average Button should then become disabled again, and the Add
Grade Button should be enabled.

g) Closing the application. Close your running application by clicking its close box.

h) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 10.11 Solution
2 ' ClassAverage.vb
3
4 Public Class FrmClassAverage
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' handles Add Grade Button’s Click event

10    Private Sub btnAdd_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnAdd.Click
12
13       ' clear previous grades and calculation result
14       If lblOutput.Text <> "" Then
15          lblOutput.Text = ""
16          lstGrades.Items.Clear()
17       End If
18
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10.12 (Class Average Application That Handles Any Number of Grades) Rewrite the
Class Average application to handle any number of grades, as in Fig. 10.19. Note that,
because the application does not know how many grades the user will enter, the Buttons
must be enabled at all times.

Figure 10.19 Modified Class Average application handling an unspecified 
number of grades.

19       ' display grade in ListBox
20       lstGrades.Items.Add(Val(txtInput.Text))
21       txtInput.Clear()  ' clear grade from TextBox
22       txtInput.Focus()  ' transfer focus to TextBox
23
24       ' prohibit users from entering more than 10 grades
25       If lstGrades.Items.Count >= 10 Then
26          btnAdd.Enabled = False  ' disable Add Grade Button
27          btnAverage.Enabled = True  ' enable Average Button
28          btnAverage.Focus()      ' transfer focus to Average Button
29       End If

30
31    End Sub ' btnAdd_Click
32
33    ' handles Average Button’s Click event
34    Private Sub btnAverage_Click(ByVal sender As System.Object, _
35       ByVal e As System.EventArgs) Handles btnAverage.Click
36
37       ' initialization phase
38       Dim intTotal As Integer = 0
39       Dim intGradeCounter As Integer = 0
40       Dim intGrade As Integer = 0
41       Dim dblAverage As Double = 0
42
43       ' sum grades in ListBox
44       Do
45
46          ' read grade from ListBox
47          intGrade = lstGrades.Items.Item(intGradeCounter)
48          intTotal += intGrade    ' add grade to total
49          intGradeCounter += 1    ' increment counter
50       Loop Until intGradeCounter >= 10
51
52       dblAverage = intTotal / 10   ' calculate average
53       lblOutput.Text = String.Format(“{0:F}”, dblAverage)
54       btnAdd.Enabled = True        ' enable Add Grade Button
55       btnAverage.Enabled = False   ' disable Average Button
56       txtInput.Focus()  ' reset focus to Enter grade: TextBox
57    End Sub ' btnAverage_Click
58
59 End Class ' FrmClassAverage
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a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial10\Exercises\UndeterminedClassAverage directory to your
C:\SimplyVB directory. 

b) Opening the application’s template file. Double click ClassAverage.sln in the
UndeterminedClassAverage directory to open the application.

c) Never disabling the Add Grade Button. Remove code from the btnAdd_Click
event handler so that the Add Grade Button is not disabled after entering 10 grades. 

d) Summing the grades in the ListBox. Modify code in the btnAverage_Click event
handler so that intGradeCounter is incremented until it is equal to the number of
grades entered. Use lstGrades.Items.Count to determine the number of items in
the ListBox. The number returned by the Count property will be zero if there are no
grades entered. Use an If…Then selection statement to avoid division by zero and
display a message dialog to the user if there are no grades entered when the user
clicks the Average Button.

e) Calculating the class average. Modify the code in the btnAverage_Click event han-
dler so that dblAverage is computed by using intGradeCounter rather than the
value 10. 

f) Running the application. Select Debug > Start to run your application. Enter 10
grades and click the Average Button. Verify that the average displayed is correct. Fol-
low the same actions but this time for 15 grades, then for 5 grades. Each time, verify
that the appropriate average is displayed.

g) Closing the application. Close your running application by clicking its close box.

h) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 10.12 Solution
2 ' ClassAverage.vb
3
4 Public Class FrmClassAverage
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' handles Add Grade Button’s Click event

10    Private Sub btnAdd_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnAdd.Click
12
13       ' clear previous grades and calculation result
14       If lblOutput.Text <> "" Then
15          lblOutput.Text = ""
16          lstGrades.Items.Clear()
17       End If
18
19       ' display grade in ListBox
20       lstGrades.Items.Add(Val(txtInput.Text))
21       txtInput.Clear()  ' clear grade from TextBox
22       txtInput.Focus()  ' transfer focus to TextBox
23    End Sub ' btnAdd_Click
24
25    ' handles Average Button’s Click event
26    Private Sub btnAverage_Click(ByVal sender As System.Object, _
27       ByVal e As System.EventArgs) Handles btnAverage.Click
28
29       ' initialization phase
30       Dim intTotal As Integer = 0
31       Dim intGradeCounter As Integer = 0
32       Dim intGrade As Integer = 0
33       Dim dblAverage As Double = 0
34
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10.13 (Arithmetic Calculator Application) Write an application that allows users to enter a
series of numbers and manipulate them. The application should provide users with the
option of adding or multiplying the numbers. Users should enter each number in a TextBox.
After entering each number, users should click a Button and the number should be inserted
in a ListBox. The GUI should behave as in Fig. 10.20.

Figure 10.20 Arithmetic Calculator application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial10\Exercises\ArithmeticCalculator directory to your C:\Sim-
plyVB directory. 

35       ' no grades entered
36       If lstGrades.Items.Count = 0 Then
37          MessageBox.Show("Please enter at least one grade", _
38             "Enter Grade", MessageBoxButtons.OK, _
39             MessageBoxIcon.Exclamation)
40       Else
41
42          ' sum grades in ListBox
43          Do
44
45             ' read grade from ListBox
46             intGrade = lstGrades.Items.Item(intGradeCounter)
47             intTotal += intGrade    ' add grade to total
48             intGradeCounter += 1    ' increment counter
49          Loop Until intGradeCounter >= lstGrades.Items.Count
50
51          dblAverage = intTotal / intGradeCounter  ' calculate average
52          lblOutput.Text = String.Format(“{0:F}”, dblAverage)
53          txtInput.Focus()  ' reset focus to Enter grade: TextBox
54       End If
55    End Sub ' btnAverage_Click
56
57 End Class ' FrmClassAverage
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b) Opening the application’s template file. Double click ArithmeticCalculator.sln
in the ArithmeticCalculator directory to open the application. 

c) Add a ListBox to display the entered numbers. Add a ListBox. Place and size it as
in Fig. 10.22.

d) Creating an event handler for the Enter Button. Create the Click event handler for
the Enter Button. If the result of a previous calculation is displayed, this event han-
dler should clear the result and disable the addition and multiplication Buttons. It
should then insert the current number in the Operands list: ListBox. When the
ListBox contains at least two numbers, the event handler should then enable the
addition and multiplication Buttons.

e) Summing the grades in the ListBox. Define the Click event handler for the Add
Button. This event handler should compute the sum of all of the values in the Oper-
ands list: ListBox and display the result in a Label lblResult.

f) Define the Click event handler for the Multiply Button. This event handler should
compute the product of all of the values in the Operands list: ListBox and display
the result in the Label lblResult.

g) Running the application. Select Debug > Start to run your application. Enter two
values, then click the Add and Multiply Buttons. Verify that the results displayed are
correct. Also, make sure that the Add and Multiply Buttons are not enabled until two
values have been entered.

h) Closing the application. Close your running application by clicking its close box.

i) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 10.13 Solution
2 ' ArithmeticCalculator.vb
3
4 Public Class FrmArithmeticCalculator
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8    
9    ' handles Enter Button's Click event

10    Private Sub btnEnter_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnEnter.Click
12
13       ' clear ListBox and lblResult if necessary
14       If lblResult.Text <> "" Then
15          lblResult.Text = ""
16          lstNumbers.Items.Clear()
17          btnAdd.Enabled = False ' disable operation Buttons
18          btnMultiply.Enabled = False
19       End If
20
21       lstNumbers.Items.Add(txtInput.Text) ' add number to ListBox
22
23       ' enable binary operation Buttons when 
24       ' user has entered two numbers
25       If lstNumbers.Items.Count = 2 Then
26          btnAdd.Enabled = True
27          btnMultiply.Enabled = True
28       End If
29
30       txtInput.Clear() ' clear TextBox
31       txtInput.Focus() ' set focus to TextBox
32    End Sub ' btnEnter_Click
33
34    ' handles addition Button's Click event
35    Private Sub btnAdd_Click(ByVal sender As System.Object, _
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What does this code do? 10.14 What is the result of the following code?

Answer: The value displayed in lblResult is 11.

What’s wrong with this code? 10.15 Find the error(s) in the following code. This code should add 10 to the value in intY
and store it in intZ. It then should reduce the value of intY by one and repeat until intY is
less than 10. The output Label lblResult should display the final value of intZ.

36       ByVal e As System.EventArgs) Handles btnAdd.Click
37
38       ' initialize total and counter
39       Dim dblTotal As Double = 0
40       Dim intCounter As Integer = 0
41
42       ' sum numbers in ListBox
43       Do
44          dblTotal += Val(lstNumbers.Items.Item(intCounter))
45          intCounter += 1
46       Loop While intCounter < lstNumbers.Items.Count
47
48       lblResult.Text = dblTotal
49    End Sub ' btnAdd_Click
50
51    ' handles multiplication Button's Click event
52    Private Sub btnMultiply_Click(ByVal sender As System.Object, _
53       ByVal e As System.EventArgs) Handles btnMultiply.Click
54
55       ' initialize dblTotal and intCounter
56       Dim dblTotal As Double = 1
57       Dim intCounter As Integer = 0
58
59       ' multiply numbers in ListBox
60       Do
61          dblTotal *= Val(lstNumbers.Items.Item(intCounter))
62          intCounter += 1
63       Loop While intCounter < lstNumbers.Items.Count
64
65       lblResult.Text = dblTotal
66    End Sub ' btnMultiply_Click
67
68 End Class ' FrmArithmeticCalculator

▲

1 Dim intY As Integer
2 Dim intX As Integer
3 Dim intMysteryValue As Integer
4
5 intX = 1
6 intMysteryValue = 0
7
8 Do 
9    intY = intX ^ 2

10    lstDisplay.Items.Add(intY)
11    intMysteryValue += 1
12    intX += 1
13 Loop While intX <= 10
14
15 lblResult.Text = intMysteryValue

▲
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Answer: This code will loop infinitely because the statement that decrements intY (line 8) is 
not inside the repetition statement. Correct the code as follows:

Using the Debugger 10.16 (Factorial Application) The Factorial application calculates the factorial of an inte-
ger input by the user. The factorial of an integer is the product of the integers from one to
that number. For example, the factorial of 3 is 6 ( ). While testing the application
you noticed that it does not execute correctly. Use the debugger to find and fix the logic
error(s) in the application. Figure 10.21 displays the correct output for the Factorial applica-
tion.

Figure 10.21 Correct output for the Factorial application.

Answer:

1 Dim intY As Integer = 10
2 Dim intZ As Integer = 2
3
4 Do
5    intZ = intY + 10
6 Loop Until intY < 10
7
8 intY -= 1
9

10 lblResult.Text = intZ

1 Dim intY As Integer = 10
2 Dim intZ As Integer = 2
3
4 Do
5    intZ = intY + 10
6    
7 Loop Until intY < 10
8
9 lblResult.Text = intZ

intY -= 1

▲

1 ' Exercise 10.16 Solution
2 ' Factorial.vb
3
4 Public Class FrmFactorial
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' calculate factorial of user input number

10    Private Sub btnCalculate_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnCalculate.Click
12
13       Dim intInput As Integer ' user input
14       Dim intFactorial As Integer = 1 ' holds factorial
15

1 2× 3×
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Programming Challenge 10.17 (Restaurant Bill Application) Develop an application that calculates a restaurant bill.
The user should be able to enter the item ordered, the quantity of the item ordered and the
price per item. When the user clicks the Add Item Button, your application should display
the number ordered, the item ordered and the price per unit in three ListBoxes as shown in
Fig. 10.22. When the user clicks the Total Bill Button, the application should calculate the
total cost. For each entry in the ListBox, multiply the cost of each item by the number of
items ordered.

Figure 10.22 Restaurant Bill application’s Form.

Answer:

16       intInput = Val(txtFactorial.Text) ' get user input
17
18       ' loop until intInput equals zero
19       Do
20          intFactorial *= intInput ' calculate factorial
21          intInput -= 1 ' decrement counter
22       Loop  intInput > 1 ' test condition
23
24       lblResult.Text = intFactorial ' display factorial
25    End Sub ' btnCalculate_Click
26
27 End Class ' FrmFactorial

Replaced Until with While While

▲

1 ' Exercise 10.17 Solution
2 ' RestaurantBill.vb
3
4 Public Class FrmRestaurantBill
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' handles Add Item Button's Click event

10    Private Sub btnAddItem_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnAddItem.Click
12
13       ' display user input in ListBoxes
14       lstQuantity.Items.Add(Val(txtQuantity.Text))
15       lstItem.Items.Add(txtItem.Text)
16       lstPrice.Items.Add(Val(txtPrice.Text))
17
18       ' clear TextBoxes
19       txtItem.Clear()
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20       txtQuantity.Clear()
21       txtPrice.Clear()
22
23       txtQuantity.Focus() ' set the focus to Quantity: TextBox
24    End Sub ' btnAddItem_Click
25
26    ' handles Total Bill Button's Click event
27    Private Sub btnTotal_Click(ByVal sender As System.Object, _
28       ByVal e As System.EventArgs) Handles btnTotal.Click
29
30       Dim intCounter As Integer = 0
31       Dim decCost As Decimal = 0
32
33       ' calculate bill
34       Do
35          decCost += lstPrice.Items.Item(intCounter) * _
36             lstQuantity.Items.Item(intCounter)
37          intCounter += 1
38       Loop While intCounter < lstPrice.Items.Count()
39
40       ' display result
41       lblTotalCost.Text = String.Format("{0:C}", decCost)
42    End Sub ' btnTotal_Click
43
44 End Class ' FrmRestaurantBill
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Instructor’s Manual
Exercises Solutions

Tutorial 11

MULTIPLE-CHOICE
QUESTIONS

11.1 “Hello” has data type .

11.2 A  provides the ability to enter or display multiple lines of text in the same
control.

11.3 The NumericUpDown control allows you to specify .   

11.4  is optional in a For…Next header when the control variable’s increment is 1.

11.5 Setting TextBox property ScrollBars to  creates a vertical scrollbar.

11.6  is used to determine whether a For…Next loop continues to iterate.

11.7 In a For…Next loop, the control variable is incremented (or decremented) .

11.8 Setting a NumericUpDown control’s  property to True ensures that the user
cannot enter invalid values in the control.

11.9 The  and  properties limit the values users can select in the
NumericUpDown control. 

11.10 For…Next header  can be used to vary the control variable over the odd
numbers between 1 and 10. 

Answers: 11.1) a.  11.2) a.  11.3) d.  11.4) c.  11.5) b or d.  11.6) d.  11.7) a. 11.8) c.  11.9) a.  
11.10) b.

EXERCISES 11.11 (Present Value Calculator Application) A bank wants to show its customers how
much they would need to invest to achieve a specified financial goal (future value) in 5, 10,

a) String b) StringLiteral 
c) Character d) StringText 

a) TextBox b) NumericUpDown 
c) MultilineTextBox d) multiline NumericUpDown 

a) a maximum value the user can select b) a minimum value the user can select
c) an increment for the values presented 

to the user
d) All of the above.

a) Keyword To b) The initial value of the control variable
c) Keyword Step d) The final value of the control variable

a) True b) Vertical 
c) Up d) Both 

a) The initial value of the control variable b) Keyword For 
c) Keyword Step d) The control variable

a) after the body of the loop executes b) when keyword To is reached
c) while the loop-continuation condition 

is False 
d) while the body of the loop executes

a) Increment b) ScrollBars 
c) ReadOnly d) InValid 

a) Maximum, Minimum b) Top, Bottom 
c) High, Low d) Max, Min 

a) For intI = 1 To 10 Step 1 b) For intI = 1 To 10 Step 2
c) For intI = 1 To 10 Step -1 d) For intI = 1 To 10 Step -2
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15, 20, 25 or 30 years. Users must provide their financial goal (the amount of money desired
after the specified number of years has elapsed), an interest rate and the length of the invest-
ment in years. Create an application that calculates and displays the principal (initial amount
to invest) needed to achieve the user’s financial goal. Your application should allow the user
to invest money for 5, 10, 15, 20, 25 or 30 years. For example, if a customer wants to reach the
financial goal of $15,000 over a period of 5 years when the interest rate is 6.6%, the customer
would need to invest $10,896.96 as shown in Fig. 11.16.

Figure 11.16 Present Value Calculator GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial11\Exercises\PresentValue directory to your C:\SimplyVB direc-
tory. 

b) Opening the application’s template file. Double click PresentValue.sln in the
PresentValue directory to open the application. 

c) Adding the NumericUpDown control. Place and size the NumericUpDown so that it fol-
lows the GUI Design Guidelines. Set the NumericUpDown control’s Name property to
updYear. Set the NumericUpDown control to allow only multiples of five for the num-
ber of years. Also, allow the user to select only a duration that is in the specified
range of values.

d) Adding a multiline TextBox. Add a TextBox to the Form below the NumericUpDown
control. Change the size to 272, 88, and position the TextBox on the Form so that it
follows the GUI Design Guidelines. Then set that TextBox to display multiple lines
and a vertical scrollbar. Also ensure that the user cannot modify the text in the Text-
Box.

e) Adding a Click event handler and adding code. Add a Click event handler for the
Calculate Button. Once in code view, add code to the application such that, when
the Calculate Button is clicked, the multiline TextBox displays the necessary princi-
pal for each five-year interval. Use the following version of the present-value calcula-
tion formula:

p = a / (1 + r) n

where
p is the amount needed to achieve the future value
r is the annual interest rate (for example, .05 is equivalent to 5%)
n is the number of years
a is the future-value amount.

f) Running the application. Select Debug > Start to run your application. Enter
amounts for the future value, interest rate and number of years. Click the Calculate
Button and verify that the year intervals and the amount on deposit needed for each
is correct. Test the application again, this time entering 30 for the number of years.
Verify that the vertical scrollbar appears to display all of the output.

g) Closing the application. Close your running application by clicking its close box.

h) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:  
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11.12 (Compound Interest: Comparing Rates Application) Write an application that cal-
culates the amount of money in an account after 10 years for interest rate amounts of 5%–
10%. For this application, users must provide the initial principal.

1 ' Exercise 11.11 Solution
2 ' PresentValue.vb
3
4 Public Class FrmPresentValue
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' handles Calculate Button’s Click event

10    Private Sub btnCalculate_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnCalculate.Click
12
13       ' clear txtResult from previous results
14       txtResult.Clear()
15
16       ' declare variables
17       Dim decFutureValue As Decimal
18       Dim dblRate As Double
19       Dim intYears As Integer
20       Dim decPresentValue As Decimal
21
22       ' retrieve values from user input
23       decFutureValue = Val(txtFutureValue.Text)
24       dblRate = Val(txtRate.Text)
25       intYears = updYear.Text
26
27       ' set initial output line
28       txtResult.Text = "Year" & ControlChars.Tab & _ 
29          "Amount on Deposit Needed" & ControlChars.CrLf
30
31       ' calculate principal and display result
32       Dim intCounter As Integer
33
34       For intCounter = 5 To intYears Step 5
35          decPresentValue = _
36             decFutureValue / ((1 + (dblRate / 100)) ^ intCounter)
37
38          ' append result to txtResult’s text property
39          txtResult.Text &= intCounter & ControlChars.Tab & _
40             String.Format("{0:C}", decPresentValue) & _ 
41             ControlChars.CrLf
42
43       Next
44
45    End Sub ' btnCalculate_Click
46
47 End Class ' FrmPresentValue
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Figure 11.17 Comparing Rates GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial11\Exercises\ComparingRates directory to your C:\SimplyVB
directory. 

b) Opening the application’s template file. Double click ComparingRates.sln in the
ComparingRates directory to open the application.

c) Adding a multiline TextBox. Add a TextBox to the Form below the Result: Label
control. Change the size to 256, 104, and position the TextBox on the Form so that it
follows the GUI Design Guidelines (Fig. 11.17). Then set that TextBox to display
multiple lines. Also ensure that the user cannot modify the text in the TextBox.

d) Adding a Click event handler and adding code. Add a Click event handler for the
Calculate Button. Once in code view, add code to the application such that, when
the Calculate Button is clicked, the multiline TextBox displays the amount in the
account after 10 years for interest rates of 5, 6, 7, 8, 9 and 10 percent. Use the follow-
ing version of the interest-calculation formula:

a = p (1 + r) n

where
p is the original amount invested (the principal)
r is the annual interest rate (for example, .05 is equivalent to 5%)
n is the number of years
a is the investment’s value at the end of the nth year.

e) Running the application. Select Debug > Start to run your application. Enter the
principal amount for an account and click the Calculate Button. Verify that the cor-
rect amounts after 10 years are then displayed, based on interest rate amounts of
5%–10%.

f) Closing the application. Close your running application by clicking its close box.

g) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 11.12 Solution
2 ' ComparingRates.vb
3
4 Public Class FrmComparingRates
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' invoke when Calculate Button is pressed

10    Private Sub btnCalculate_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnCalculate.Click
12
13       ' declare local variables
14       Dim strOutput As String
15       Dim intRateCounter As Integer
16       Dim decPrincipal As Decimal = Val(txtPrincipal.Text)
17       Dim decAmount As Decimal = 0
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11.13 (Validating Input to the Interest Calculator Application) Enhance the Interest Cal-
culator application with error checking. Test for whether the user has entered valid values
for the principal and interest rate. If the user enters an invalid value, display a message in the
multiline TextBox. Figure 11.18 demonstrates the application handling an invalid input.

Figure 11.18 Interest Calculator application with error checking.

a) Copying the template to your working directory. Copy the
C:\Examples\Tutorial11\Exercises\InterestCalculatorEnhancement direc-
tory to your C:\SimplyVB directory. 

b) Opening the application’s template file. Double click InterestCalculator.sln in
the InterestCalculatorEnhancement directory to open the application.

c) Adding a Click event handler and adding code. Add a Click event handler for the
Calculate Button. Once in code view, modify the code to validate the input. The
principal should be a positive amount greater than 0. Also, the interest rate should be
greater than 0, but less than 100.

d) Displaying the error message. Display the text “The information was not within
the correct range of values.” in txtResult if the values are not valid. 

e) Running the application. Select Debug > Start to run your application. Enter
invalid data for the principal and interest rate. The invalid data can include negative
numbers and letters. Verify that entering invalid data and clicking the Calculate But-
ton results in the error message displayed in Fig. 11.18.

f) Closing the application. Close your running application by clicking its close box.

g) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

18
19       ' set output header
20       strOutput = "Rate(%)" & ControlChars.Tab & ControlChars.Tab _
21          & "Amount after 10 years" & ControlChars.CrLf
22
23       ' calculate amount for each rate and append to string
24       For intRateCounter = 5 To 10
25          decAmount = _
26             decPrincipal * ((1 + intRateCounter / 100) ^ 10)
27
28          strOutput &= (intRateCounter & ControlChars.Tab & _
29             ControlChars.Tab & String.Format("{0:C}", decAmount) _
30             & ControlChars.CrLf)
31       Next
32
33       txtResult.Text = strOutput ' display result
34    End Sub ' btnCalculate_Click
35
36 End Class ' FrmComparingRates



Tutorial 11 Interest Calculator Application 111

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

What does this code do? 11.14 What is the value of intResult after the following code executes? Assume that
intPower, intI, intResult and intNumber are all declared as Integers.

1 ' Exercise 11.13 Solution
2 ' InterestCalculator.vb
3
4 Public Class FrmInterestCalculator
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' handles Calculate Button’s Click event 

10    Private Sub btnCalculate_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnCalculate.Click
12
13       ' declare variables to store user input
14       Dim decPrincipal As Decimal
15       Dim dblRate As Double
16       Dim intYear As Integer
17       Dim decAmount As Decimal ' store each calculation
18       Dim strOutput As String ' store output
19
20       ' retrieve user input
21       decPrincipal = Val(txtPrincipal.Text)
22       dblRate = Val(txtRate.Text)
23       intYear = updYear.Text
24
25       If decPrincipal > 0 AndAlso dblRate > 0 _
26          AndAlso dblRate < 100 Then
27
28          ' set output header
29          strOutput = "Year" & ControlChars.Tab _
30             & "Amount on Deposit" & ControlChars.CrLf
31
32          ' calculate amount after each year and append to string
33          For intYear = 1 To intYear
34
35             decAmount = decPrincipal * _ 
36                (1 + dblRate / 100) ^ intYear
37             strOutput &= (intYear & ControlChars.Tab & _
38                String.Format("{0:C}", decAmount) & _ 
39                ControlChars.CrLf)
40
41          Next
42
43       Else
44          strOutput = "The information input was not within the" _
45              & " correct range of values."
46       End If
47
48       txtResult.Text = strOutput ' display result
49    End Sub ' btnCalculate_Click
50
51 End Class ' FrmInterestCalculator

▲

1 intPower = 5
2 intNumber = 10
3 intResult = intNumber
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Answer: This code segment raises intNumber to the intPower power. In this case, intRe-
sult gets 105 (100000).

What’s wrong with this code? 11.15 Assume that the variable intCounter is declared as an Integer for both a and b.
Identify and correct the error(s) in each of the following:

a) This statement should display in a ListBox all numbers from 100 to 1 in decreasing
order.

Answer: The code needs Step -1 at the end of the For…Next header.

b) The following code should display in a ListBox the odd Integers from 19 to 1 in
decreasing order.

Answer: By –1 should be Step –2 and lstDisplay.Add(intCounter) should be 
lstDisplay.Items.Add(intCounter).

Using the Debugger 11.16 (Savings Calculator Application) The Savings Calculator application calculates the
amount that the user will have on deposit after one year. The application gets the initial
amount on deposit from the user, and assumes that the user will add $100 dollars to the
account every month for the entire year. No interest is added to the account. While testing
the application, you noticed that the amount calculated by the application was incorrect. Use
the debugger to locate and correct any logic error(s). Figure 11.19 displays the correct output
for this application.

Figure 11.19 Correct output for the Savings Calculator application.

Answer:

4
5 For intI = 1 To (intPower - 1)
6    intResult *= intNumber
7 Next

▲

1 For intCounter = 100 To 1
2    lstDisplay.Items.Add(intCounter)
3 Next

1 For intCounter = 100 To 1 
2    lstDisplay.Items.Add(intCounter)
3 Next

1 For intCounter = 19 To 1 By -1
2    lstDisplay.Add(intCounter)
3 Next

1 For intCounter = 19 To 1 
2    
3 Next

Step -1

Step -2
lstDisplay.Items.Add(intCounter)

▲
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Programming Challenge 11.17 (Pay Raise Calculator Application) Develop an application that computes the
amount of money an employee makes each year over a user-specified number of years. The
employee receives an hourly wage and a pay raise once every year. The user specifies the
hourly wage and the amount of the raise (in percentages per year) in the application. 

Figure 11.20 Pay Raise application’s GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial11\Exercises\PayRaise directory to your C:\SimplyVB directory. 

b) Opening the application’s template file. Double click PayRaise.sln in the
PayRaise directory to open the application.

c) Adding controls to the Form. Add two NumericUpDown controls to the Form. The first
NumericUpDown control should be provided to allow the user to specify the pay raise
percentage. The user should only be able to specify percentages in the range of 3–8
percent. Create the second NumericUpDown control for users to select the number of
years in the range 1–50. Then add a multiline TextBox control to the application.
Ensure that the user cannot modify the text in the NumericUpDown and TextBox con-

1 ' Exercise 11.16 Solution
2 ' Savings.vb
3
4 Public Class FrmSavings
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' calculate amount in account after one year

10    Private Sub btnCalculate_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnCalculate.Click
12
13       Dim intTotal As Integer = 0 ' amount on deposit
14       Dim intCounter As Integer = 1 ' counter starts at 1
15
16       intTotal = Val(txtStartAmount.Text) ' get amount on deposit
17
18       ' add $100 a month for one year 
19       For intCounter =  To 12
20          intTotal += 100 ' add money
21       Next
22
23       lblTotal.Text = intTotal ' display total after 12 months
24    End Sub ' btnCalculate_Click
25
26 End Class ' FrmSavings

Incorrect code given to
students looped 13 times

(0-12), instead of 12 (1-12)
1

▲
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trols. Resize and move the controls you created so that they follow the GUI Design
Guidelines as in Fig. 11.20. 

d) Adding a Click event handler and adding code. Add a Click event handler for the
Calculate Button. Once in code view, add code to use the For…Next statement to
compute the yearly salary amounts, based on the yearly pay raise.

e) Running the application. Select Debug > Start to run your application. Enter a
starting wage per hour, the size of the yearly raise and the number of years worked.
Click the Calculate Button and verify that the correct amount after each year is dis-
played in the Yearly amount earned: TextBox.

f) Closing the application. Close your running application by clicking its close box.

g) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 11.17 Solution
2 ' PayRaise.vb
3
4 Public Class FrmPayRaise
5    Inherits System.Windows.Forms.Form
6
7    ' Window Form Designer generated code
8
9    ' invoke when btnCalculate Button is clicked 

10    Private Sub btnCalculate_Click(ByVal sender As _
11       System.Object, ByVal e As System.EventArgs) _
12       Handles btnCalculate.Click
13
14       Dim intYears As Integer = updYears.Text
15       Dim intCounter As Integer
16       Dim decWage As Decimal = Val(txtWage.Text)
17       Dim intCurrentYear As Integer = 0
18       Dim decTotal As Decimal = 0
19
20       ' create headers to display in txtResult
21       txtResult.Text = "Year" & ControlChars.Tab & _
22          "Amount" & ControlChars.CrLf
23
24       ' calculate first year’s total
25       decTotal += (decWage * 40 * 52)
26
27       ' display wages per year with raise
28       For intCounter = 1 To intYears Step 1
29
30          ' determine if raise should be applied
31          If intCounter <> 1 Then
32
33             ' calculate total with raise amount
34             decTotal *= 1 + ((updRaise.Text)/100)
35          End If
36
37          intCurrentYear += 1 ' increment intYear count
38
39          ' append amounts to string displayed in
40          ' txtResult TextBox
41          txtResult.Text &= (intCurrentYear & _
42             ControlChars.Tab & _
43             String.Format("{0:C}", decTotal) & _
44             ControlChars.CrLf)
45       Next
46
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47    End Sub ' btnCalculate_Click
48
49 End Class ' FrmPayRaise
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Instructor’s Manual
Exercise Solutions

 Tutorial 12

MULTIPLE-CHOICE
QUESTIONS

12.1 The  keywords signify the end of a Select Case statement.

12.2 The expression  returns the current system time and date.

12.3 You can hide information entered into a TextBox by setting that TextBox’s
 property to a character; that character will be displayed for every character

entered by the user. 

12.4 Which of the following is a syntax error?

12.5 Keyword  is used to specify a range in a Case statement.

12.6  separates multiple values tested in a Case statement.

12.7 The  method inserts a value in a ListBox.

12.8 If the value on the left of the To keyword in a Case statement is larger than the value on
the right, .

12.9 The expression following the keywords Select Case is called a(n) .

12.10 To prevent a user from modifying text in a TextBox, set its  property to
False.

Answers: 12.1) b.  12.2) c.  12.3) d.  12.4) c.  12.5) c.  12.6) a.  12.7) d.  12.8) c.  12.9) b.  12.10) a.  

a) End Case b) End Select 
c) End Select Case d) Case End 

a) Date.DateTime b) Date.SystemDateTime 
c) Date.Now d) Date.SystemTimeDate 

a) PrivateChar b) Mask 
c) MaskingChar d) PasswordChar 

a) Having duplicate Case statements in the same Select Case statement
b) Having a Case statement in which the value to the left of a To keyword is larger than 

the value to the right
c) Preceding a Case statement with the Case Else statement in a Select Case 

statement
d) Using keyword Is in a Select Case statement

a) Also b) Between 
c) To d) From  

a) A comma b) An underscore
c) Keyword Also d) A semicolon

a) Append b) Items.Insert 
c) Insert d) Items.Add 

a) a syntax error occurs b) the body of the Case statement executes 
c) the body of the Case statement never executes 
d) the statement causes a runtime error

a) guard condition b) controlling expression
c) selection expression d) case expression 

a) Enabled b) Text 
c) TextChange d) Editable 



Tutorial 12 Security Panel Application 118

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

EXERCISES 12.11 (Sales Commission Calculator Application) Develop an application that calculates
a salesperson’s commission from the number of items sold (Fig. 12.17). Assume that all items
have a fixed price of 10 dollars per unit. Use a Select Case statement to implement the fol-
lowing sales commission schedule:

Fewer than 10 items sold = 1% commission
Between 10 and 40 items sold = 2% commission
Between 41 and 100 items sold = 4% commission
More than 100 items sold = 8% commission

Figure 12.17 Sales Commission Calculator GUI.

a) Copying the template to your working directory. Copy the
C:\Examples\Tutorial12\Exercises\SalesCommissionCalculator directory to
your C:\SimplyVB directory. 

b) Opening the application’s template file. Double click SalesCommissionCalcula-
tor.sln in the SalesCommissionCalculator directory to open the application.

c) Defining an event handler for the Button’s Click event. Create an event handler for
the Calculate Button’s Click event.

d) Display the salesperson’s gross sales. In your new event handler, multiply the num-
ber of items that the salesperson has sold by 10, and display the resulting gross sales
as a monetary amount.

e) Calculate the salesperson’s commission percentage. Use a Select Case statement to
compute the salesperson’s commission percentage, from the number of items sold.
The rate that is selected is applied to all the items the salesperson sold.

f) Display the salesperson’s earnings. Multiply the salesperson’s gross sales by the com-
mission percentage determined in the previous step to calculate the salesperson’s
earnings. Remember to divide by 100 to obtain the percentage.

g) Running the application. Select Debug > Start to run your application. Enter a
value for the number of items sold and click the Calculate Button. Verify that the
gross sales displayed is correct, that the percentage of commission is correct and that
the earnings displayed is correct based on the commission assigned.

h) Closing the application. Close your running application by clicking its close box.

i) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 12.11 Solution
2 ' SalesCommissionCalculator.vb
3
4 Public Class FrmSalesCommission
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' invoked when Calculate Button is clicked

10    Private Sub btnCalculate_Click(ByVal sender As _
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12.12 (Cash Register Application) Use the numeric keypad from the Security Panel appli-
cation to build a Cash Register application (Fig. 12.18). In addition to numbers, the cash reg-
ister should include a decimal point Button. Apart from this numeric operation, there should
be Enter, Delete, Clear and Total Buttons. Sales tax should be calculated on the amount pur-
chased. Use a Select Case statement to compute sales tax. Add the tax amount to the subto-
tal to calculate the total. Display the tax and total for the user. Use the following sales-tax
percentages, which are based on the amount of money spent:

Amounts under $100 = 5% (.05) sales tax
Amounts between $100 and $500 = 7.5% (.075) sales tax
Amounts above $500 = 10% (.10) sales tax

11       System.Object, ByVal e As System.EventArgs) _
12       Handles btnCalculate.Click
13
14       lblGrossSalesResult.Text = String.Format("{0:C}", _
15          Val(txtItemsSold.Text) * 10)
16
17       Dim intItemsSold As Integer = Val(txtItemsSold.Text)
18
19       ' Select Case used to determine commission percentage 
20       Select Case intItemsSold
21
22          Case Is < 10
23             lblCommissionPercentageResult.Text = 1
24
25          Case 10 To 40
26             lblCommissionPercentageResult.Text = 2
27
28          Case 41 To 100
29             lblCommissionPercentageResult.Text = 4
30
31          Case Is > 100
32             lblCommissionPercentageResult.Text = 8
33
34       End Select
35
36       ' calculate the earnings
37       lblEarningsResult.Text = String.Format("{0:C}", _
38          lblGrossSalesResult.Text * _
39          (lblCommissionPercentageResult.Text / 100))
40
41    End Sub ' btnCalculate_Click
42
43 End Class ' FrmSalesCommission
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Figure 12.18 Cash Register GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial12\Exercises\CashRegister directory to your C:\SimplyVB direc-
tory. 

b) Opening the application’s template file. Double click CashRegister.sln in the
CashRegister directory to open the application.

c) Define event handlers for the numeric Buttons and decimal point in the keypad.
Create event handlers for each of these Button’s Click events. Have each event han-
dler concatenate the proper value to the TextBox at the top of the Form.

d) Define an event handler for the Enter Button’s Click event. Create an event han-
dler for this Button’s Click event. Have this event handler add the current amount
to the subtotal and display the new subtotal.

e) Define an event handler for the Total Button’s Click event. Create an event handler
for this Button’s Click event. Have this event handler use the subtotal to compute
the tax amount. 

f) Define an event handler for the Clear Button’s Click event. Create an event handler
for this Button’s Click event. Have this event handler clear the user input and dis-
play the value $0.00 for the subtotal, sales tax and total.

g) Define an event handler for the Delete Button’s Click event. Create an event han-
dler for this Button’s Click event. Have this event handler clear only the data in the
TextBox.

h) Running the application. Select Debug > Start to run your application. Use the key-
pad to enter various dollar amounts, clicking the Enter Button after each. After sev-
eral amounts have been entered, click the Total Button and verify that the
appropriate sales tax and total are displayed. Enter several values again and click the
Delete Button to clear the current input. Click the Clear Button to clear all the out-
put values.

i) Closing the application. Close your running application by clicking its close box.

j) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 12.12 Solution
2 ' CashRegister.vb
3
4 Public Class FrmCashRegister
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' invoked when btnOne is clicked

10    Private Sub btnOne_Click(ByVal sender As _
11       System.Object, ByVal e As System.EventArgs) _
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12       Handles btnOne.Click
13
14       txtCurrentPrice.Text &= "1"
15    End Sub ' btnOne_Click
16
17    ' invoked when btnTwo is clicked
18    Private Sub btnTwo_Click(ByVal sender As _
19       System.Object, ByVal e As System.EventArgs) _
20       Handles btnTwo.Click
21
22       txtCurrentPrice.Text &= "2"
23    End Sub ' btnTwo_Click
24
25    ' invoked when btnThree is clicked
26    Private Sub btnThree_Click(ByVal sender As _
27       System.Object, ByVal e As System.EventArgs) _
28       Handles btnThree.Click
29
30       txtCurrentPrice.Text &= "3"
31    End Sub ' btnThree_Click
32
33    ' invoked when btnFour is clicked
34    Private Sub btnFour_Click(ByVal sender As _
35       System.Object, ByVal e As System.EventArgs) _
36       Handles btnFour.Click
37
38       txtCurrentPrice.Text &= "4"
39    End Sub ' btnFour_Click
40
41    ' invoked when btnFive is clicked
42    Private Sub btnFive_Click(ByVal sender As _
43       System.Object, ByVal e As System.EventArgs) _
44       Handles btnFive.Click
45
46       txtCurrentPrice.Text &= "5"
47    End Sub ' btnFive_Click
48
49    ' invoked when btnSix is clicked
50    Private Sub btnSix_Click(ByVal sender As _
51       System.Object, ByVal e As System.EventArgs) _
52       Handles btnSix.Click
53
54       txtCurrentPrice.Text &= "6"
55    End Sub ' btnSix_Click
56
57    ' invoked when btnSeven is clicked
58    Private Sub btnSeven_Click(ByVal sender As _
59       System.Object, ByVal e As System.EventArgs) _
60       Handles btnSeven.Click
61
62       txtCurrentPrice.Text &= "7"
63    End Sub ' btnSeven_Click
64
65    ' invoked when btnEight is clicked
66    Private Sub btnEight_Click(ByVal sender As _
67       System.Object, ByVal e As System.EventArgs) _
68       Handles btnEight.Click
69
70       txtCurrentPrice.Text &= "8"
71    End Sub ' btnEight_Click
72
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73    ' invoked when btnNine is clicked
74    Private Sub btnNine_Click(ByVal sender As _
75       System.Object, ByVal e As System.EventArgs) _
76       Handles btnNine.Click
77
78       txtCurrentPrice.Text &= "9"
79    End Sub ' btnNine_Click
80
81    ' invoked when btnZero is clicked
82    Private Sub btnZero_Click(ByVal sender As _
83       System.Object, ByVal e As System.EventArgs) _
84       Handles btnZero.Click
85
86       txtCurrentPrice.Text &= "0"
87    End Sub ' btnZero_Click
88
89    ' invoked when btnPoint is clicked
90    Private Sub btnPoint_Click(ByVal sender As _
91       System.Object, ByVal e As System.EventArgs) _
92       Handles btnPoint.Click
93
94       txtCurrentPrice.Text &= "."
95    End Sub ' btnPoint_Click
96
97    ' invoked when btnEnter is clicked
98    Private Sub btnEnter_Click(ByVal sender As _
99       System.Object, ByVal e As System.EventArgs) _
100       Handles btnEnter.Click
101
102       ' variable to store new value
103       Dim decAmount As Decimal
104
105       ' store value in txtCurrentPrice to decAmount
106       decAmount = Val(txtCurrentPrice.Text)
107
108       ' add input amount to dblTotal and clear TextBox
109       lblSubTotalValue.Text = String.Format("{0:C}", _
110          lblSubTotalValue.Text + decAmount)
111
112       txtCurrentPrice.Clear() ' clear the TextBox
113    End Sub ' btnEnter_Click
114
115    ' invoked when btnTotal is clicked
116    Private Sub btnTotal_Click(ByVal sender As _
117       System.Object, ByVal e As System.EventArgs) _
118       Handles btnTotal.Click
119
120       Dim dblTaxRate As Double
121
122       ' determines tax rate based on subtotal
123       Select Case lblSubTotalValue.Text
124
125          Case Is < 100
126             dblTaxRate = 0.05
127
128          Case 100 To 500
129             dblTaxRate = 0.075
130
131          Case Is > 500
132             dblTaxRate = 0.1
133
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12.13 (Income Tax Calculator Application) Create an application that computes the
amount of income tax that a person must pay, depending upon that person’s salary. Your
application should perform as shown in Fig. 12.19. Use the following income ranges and cor-
responding tax rates:

Under $20,000 = 2% income tax
$20,000 –$50, 000 = 5% income tax
$50,001 – $75,000 = 10% income tax
$75,001 – $100,000= 15% income tax
Over $100,000 = 20% income tax

Figure 12.19 Income Tax Calculator GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial12\Exercises\IncomeTaxCalculator directory to your C:\Sim-
plyVB directory. 

134       End Select
135
136       ' display subtotal, tax and total 
137       lblSubTotalValue.Text = String.Format("{0:C}", _
138          lblSubTotalValue.Text)
139
140       lblTaxValue.Text = String.Format("{0:C}", _
141          lblSubTotalValue.Text * dblTaxRate)
142
143       lblTotalValue.Text = String.Format("{0:C}", _
144          (lblSubTotalValue.Text + _
145          lblSubTotalValue.Text * dblTaxRate))
146    End Sub ' btnTotal_Click
147
148    ' invoked when btnClear is clicked
149    Private Sub btnClear_Click(ByVal sender As _
150       System.Object, ByVal e As System.EventArgs) _
151       Handles btnClear.Click
152
153       ' clear txtCurrentPrice and set remaining Labels to $0.00
154       txtCurrentPrice.Clear()
155       lblSubTotalValue.Text = "$0.00"
156       lblTaxValue.Text = "$0.00"
157       lblTotalValue.Text = "$0.00"
158    End Sub ' btnClear_Click
159
160    ' invoked when btnDelete is clicked
161    Private Sub btnDelete_Click(ByVal sender As _
162       System.Object, ByVal e As System.EventArgs) _
163       Handles btnDelete.Click
164
165       txtCurrentPrice.Clear() ' clear the TextBox
166    End Sub ' btnDelete_Click
167
168 End Class ' FrmCashRegister
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b) Opening the application’s template file. Double click IncomeTaxCalculator.sln
in the IncomeTaxCalculator directory to open the application.

c) Define an event handler for the Calculate Button’s Click event. Use the designer to
create an event handler for this Button’s Click event. Have this event handler use a
Select Case statement to determine the user’s income-tax percentage. For simplic-
ity, this value should then be multiplied by the user’s salary and displayed in the out-
put Label. 

d) Running the application. Select Debug > Start to run your application. Enter a
yearly salary and click the Calculate Button. Verify that the appropriate income tax
is displayed, based on the ranges listed in the exercise description.

e) Closing the application. Close your running application by clicking its close box.

f) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 12.13 Solution
2 ' IncomeTax.vb
3
4 Public Class FrmIncomeTax
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' invoked when Calculate Button is clicked

10    Private Sub btnCalculate_Click(ByVal sender As _
11       System.Object, ByVal e As System.EventArgs) _
12       Handles btnCalculate.Click
13
14       Dim dblPercent As Double
15       Dim intSalary As Integer = Val(txtSalary.Text)
16
17       ' determine income percentage
18       Select Case intSalary
19
20          Case Is < 20000
21             dblPercent = 0.02
22
23          Case 20000 To 50000
24             dblPercent = 0.05
25
26          Case 50001 To 75000
27             dblPercent = 0.1
28
29          Case 75001 To 100000
30             dblPercent = 0.15
31
32          Case Is > 100000
33             dblPercent = 0.2
34
35       End Select
36
37       ' display result in currency format
38       lblResult.Text = String.Format("{0:C}", _
39          intSalary * dblPercent)
40
41       txtSalary.Clear() ' clear the TextBox
42    End Sub ' btnCalculate_Click
43
44 End Class ' FrmIncomeTax
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What does this code do? 12.14 What is output by the following code? Assume that btnDonation is a Button, txt-
Donation is a TextBox and lblMessage is an output Label.

Answer: The output Label lblMessage displays “Please consider donating to our 
cause” if the user inputs 0 for a donation amount, “Thank you for your donation” if the 
user enters a dollar amount between 1 and 100, “Thank you very much for your donation” 
if the user enters a value greater than 100 dollars and “Please enter a valid amount” if the 
user enters invalid data.

What’s wrong with this code? 12.15 This Select Case statement should determine whether an Integer is even or odd.
Find the error(s) in the following code:

Answer: Line 4 and line 7 should be swapped.

▲

1 Private Sub btnDonation_Click(ByVal sender As _
2    System.Object, ByVal e As System.EventArgs) _
3    Handles btnDonation.Click
4
5    Select Case Val(txtDonationAmount.Text)
6
7       Case 0
8          lblMessage.Text = "Please consider donating to our cause.”
9

10       Case 1 To 100
11          lblMessage.Text = "Thank you for your donation.”
12
13       Case Is > 100
14          lblMessage.Text = "Thank you very much for your donation!”
15
16       Case Else
17          lblMessage.Text = "Please enter a valid amount.”
18
19    End Select
20
21 End Sub

▲

1 Select Case intValue Mod 2
2
3    Case 0
4       lblOutput.Text = "Odd Integer"
5
6    Case 1
7       lblOutput.Text = "Even Integer"
8
9 End Select

1 Select Case intValue Mod 2
2
3    Case 0
4       
5
6    Case 1
7       
8
9 End Select

lblOutput.Text = "Even Integer"

lblOutput.Text = "Odd Integer"
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Using the Debugger 12.16 (Discount Calculator Application) The Discount Calculator application determines
the discount the user will receive, based on how much money the user spends. A 15% dis-
count is received for purchases over $200, a 10% discount is received for purchases between
$150–$199, a 5% discount is received for purchases between $100–$149 and a 2% discount is
received for purchases between $50–$99. While testing your application, you notice that the
application is not calculating the discount properly for some values. Use the debugger to find
and fix the logic error(s) in the application. Figure 12.20 displays the correct output for the
application.

Figure 12.20 Correct output for the Discount Calculator application.

Answer:
 

▲

1 ' Exercise 12.16 Solution
2 ' Discount.vb
3
4 Public Class FrmDiscountCalculator
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' display user’s discount

10    Private Sub btnView_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnView.Click
12
13       Dim intTotal As Integer ' amount spent
14       Dim strOutput As String ' displays discount

15
16       intTotal = Val(txtAmount.Text) ' get user’s total
17
18       Select Case intTotal
19
20          Case 50 To 99 ' user spent between $50-99
21             strOutput = "Your discount is:  2%"
22
23          Case 100 To  ' user spent between $100-149
24             strOutput = "Your discount is:  5%"
25
26          Case 150 To 199 ' user spent between $150-199
27             strOutput = "Your discount is:  10%"
28
29          Case Is >= 200 ' user spent over $200
30             strOutput = "Your discount is:  15%"
31
32          Case Else ' user spent less than $50
33             strOutput = "No discount"
34
35       End Select
36
37       ' display discount to user
38       MessageBox.Show(strOutput, "Discount", _
39          MessageBoxButtons.OK, MessageBoxIcon.Information)
40
41    End Sub ' btnView_Click 

Removed superfluous
Case Is > 200 statement that

prevented correct
Case Is > 200 statement from

executing

Incorrect code given to
students displayed a 5%

discount for values between
100 and 150 inclusive

149
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Programming Challenge 12.17 (Enhanced Cash Register Application) Modify the Cash Register application
(Exercise 12.12) to include the operations addition, subtraction and multiplication. Remove
the Enter Button, and replace it with the addition (+), subtraction (–) and multiplication (*)
Buttons. These Buttons should take the value displayed in the Subtotal: field and the value
displayed in the upper Label and perform the operation of the clicked Button. The result
should be displayed in the Subtotal: field. Figure 12.21 displays the enhanced Cash Register
application GUI.

Figure 12.21 Enhanced Cash Register GUI.

Answer:

42
43 End Class ' FrmDiscountCalculator

▲

1 ' Exercise 12.17 Solution
2 ' CashRegister.vb
3
4 Public Class FrmCashRegister
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' invoked when btnOne is clicked

10    Private Sub btnOne_Click(ByVal sender As _
11       System.Object, ByVal e As System.EventArgs) _
12       Handles btnOne.Click
13
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14       txtCurrentPrice.Text &= "1"
15    End Sub ' btnOne_Click
16
17    ' invoked when btnTwo is clicked
18    Private Sub btnTwo_Click(ByVal sender As _
19       System.Object, ByVal e As System.EventArgs) _
20       Handles btnTwo.Click
21
22       txtCurrentPrice.Text &= "2"
23    End Sub ' btnTwo_Click
24
25    ' invoked when btnThree is clicked
26    Private Sub btnThree_Click(ByVal sender As _
27       System.Object, ByVal e As System.EventArgs) _
28       Handles btnThree.Click
29
30       txtCurrentPrice.Text &= "3"
31    End Sub ' btnThree_Click
32
33    ' invoked when btnFour is clicked
34    Private Sub btnFour_Click(ByVal sender As _
35       System.Object, ByVal e As System.EventArgs) _
36       Handles btnFour.Click
37
38       txtCurrentPrice.Text &= "4"
39    End Sub ' btnFour_Click
40
41    ' invoked when btnFive is clicked
42    Private Sub btnFive_Click(ByVal sender As _
43       System.Object, ByVal e As System.EventArgs) _
44       Handles btnFive.Click
45
46       txtCurrentPrice.Text &= "5"
47    End Sub ' btnFive_Click
48
49    ' invoked when btnSix is clicked
50    Private Sub btnSix_Click(ByVal sender As _
51       System.Object, ByVal e As System.EventArgs) _
52       Handles btnSix.Click
53
54       txtCurrentPrice.Text &= "6"
55    End Sub ' btnSix_Click
56
57    ' invoked when btnSeven is clicked
58    Private Sub btnSeven_Click(ByVal sender As _
59       System.Object, ByVal e As System.EventArgs) _
60       Handles btnSeven.Click
61
62       txtCurrentPrice.Text &= "7"
63    End Sub ' btnSeven_Click
64
65    ' invoked when btnEight is clicked
66    Private Sub btnEight_Click(ByVal sender As _
67       System.Object, ByVal e As System.EventArgs) _
68       Handles btnEight.Click
69
70       txtCurrentPrice.Text &= "8"
71    End Sub ' btnEight_Click
72
73    ' invoked when btnNine is clicked
74    Private Sub btnNine_Click(ByVal sender As _
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75       System.Object, ByVal e As System.EventArgs) _
76       Handles btnNine.Click
77
78       txtCurrentPrice.Text &= "9"
79    End Sub ' btnNine_Click
80
81    ' invoked when btnZero is clicked
82    Private Sub btnZero_Click(ByVal sender As _
83       System.Object, ByVal e As System.EventArgs) _
84       Handles btnZero.Click
85
86       txtCurrentPrice.Text &= "0"
87    End Sub ' btnZero_Click
88
89    ' invoked when btnPoint is clicked
90    Private Sub btnPoint_Click(ByVal sender As _
91       System.Object, ByVal e As System.EventArgs) _
92       Handles btnPoint.Click
93
94       txtCurrentPrice.Text &= "."
95    End Sub ' btnPoint_Click
96
97    ' invoked when btnTotal is clicked
98    Private Sub btnTotal_Click(ByVal sender As _
99       System.Object, ByVal e As System.EventArgs) _
100       Handles btnTotal.Click
101
102       Dim dblTaxRate As Double
103
104       ' determines tax rate based on subtotal
105       Select Case lblSubTotalValue.Text
106
107          Case Is < 100
108             dblTaxRate = 0.05
109
110          Case 100 To 500
111             dblTaxRate = 0.075
112
113          Case Is > 500
114             dblTaxRate = 0.1
115
116       End Select
117
118       ' display subtotal, tax and total in Labels
119       lblSubTotalValue.Text = String.Format("{0:C}", _
120          lblSubTotalValue.Text)
121
122       lblTaxValue.Text = String.Format("{0:C}", _
123          lblSubTotalValue.Text * dblTaxRate)
124
125       lblTotalValue.Text = String.Format("{0:C}", _
126          lblSubTotalValue.Text + (lblSubTotalValue.Text * _
127          dblTaxRate))
128    End Sub ' btnTotal_Click
129
130    ' invoked when btnClear is clicked
131    Private Sub btnClear_Click(ByVal sender As _
132       System.Object, ByVal e As System.EventArgs) _
133       Handles btnClear.Click
134
135       ' clear all Labels and set total and tax to $0.00
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136       txtCurrentPrice.Clear()
137       lblSubTotalValue.Text = "$0.00"
138       lblTaxValue.Text = "$0.00"
139       lblTotalValue.Text = "$0.00"
140    End Sub ' btnClear_Click
141
142    ' invoked when btnDelete is clicked
143    Private Sub btnDelete_Click(ByVal sender As _
144       System.Object, ByVal e As System.EventArgs) _
145       Handles btnDelete.Click
146
147       txtCurrentPrice.Clear() ' clear the TextBox
148    End Sub ' btnDelete_Click
149
150    ' invoked when plus Button is pressed
151    Private Sub btnPlus_Click(ByVal sender As _
152       System.Object, ByVal e As System.EventArgs) _
153       Handles btnPlus.Click
154
155       Dim decAmount As Decimal
156
157       ' store txtCurrentPrice value for adding
158       decAmount = Val(txtCurrentPrice.Text)
159
160       ' add input amount to dblTotal and clear Label
161       lblSubTotalValue.Text = String.Format("{0:C}", _
162          lblSubTotalValue.Text + decAmount)
163
164       txtCurrentPrice.Clear() ' clear the TextBox
165    End Sub ' btnPlus_Click
166
167    ' invoked when minus Button clicked
168    Private Sub btnMinus_Click(ByVal sender As _
169       System.Object, ByVal e As System.EventArgs) _
170       Handles btnMinus.Click
171
172       Dim decAmount As Decimal
173
174       ' store txtCurrentPrice to subtract from lblSubTotalValue
175       decAmount = Val(txtCurrentPrice.Text)
176
177       ' subtract decAmount from lblSubTotalValue 
178       lblSubTotalValue.Text = String.Format("{0:C}", _
179          lblSubTotalValue.Text - decAmount)
180
181       txtCurrentPrice.Clear() ' clear txtCurrentPrice
182    End Sub ' btnMinus_Click
183
184    ' invoked when multiply Button is clicked
185    Private Sub btnMultiply_Click(ByVal sender As _
186       System.Object, ByVal e As System.EventArgs) _
187       Handles btnMultiply.Click
188
189       Dim decAmount As Decimal ' store price entered
190
191       ' store amount to multiply 
192       decAmount = Val(txtCurrentPrice.Text)
193
194       ' multiply subtotal amount with decAmount
195       lblSubTotalValue.Text = String.Format("{0:C}", _
196          lblSubTotalValue.Text * decAmount)
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197
198       txtCurrentPrice.Clear() ' clear the TextBox
199    End Sub ' btnMultiply_Click
200
201 End Class ' FrmCashRegister
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Instructor’s Manual
Exercise Solutions

Tutorial 13

MULTIPLE-CHOICE
QUESTIONS

13.1 A procedure defined with keyword Sub .

13.2 The technique of developing large applications from small, manageable pieces is known
as .

13.3 What is the difference between Sub and Function procedures?

13.4 What occurs after a procedure call is made?

13.5 Functions can return  value(s).

13.6 Which of the following must be true when making a procedure call?

13.7 Which of the following statements correctly returns the variable intValue from a
Function procedure?

13.8 The  Button executes the next statement in the application. If the next state-
ment to execute contains a procedure call, the called procedure executes in its entirety.

13.9 The first line of a procedure (including the keyword Sub or Function, the procedure
name, the parameter list and the Function procedure return type) is known as the procedure

.

a) must specify a return type b) does not accept parameters
c) returns a value d) does not return a value

a) divide and conquer b) returning a value
c) click and mortar d) a building-block algorithm

a) Sub procedures return values, Function procedures do not.
b) Function procedures return values, Sub procedures do not.
c) Sub procedures accept parameters, Function procedures do not.
d) Function procedures accept parameters, Sub procedures do not.

a) Control is given to the called procedure. After the procedure is run, the application 
continues execution at the point where the procedure call was made.

b) Control is given to the called procedure. After the procedure is run, the application 
continues execution with the statement after the called procedure’s definition.

c) The statement before the procedure call is executed.
d) The application terminates.

a) zero b) exactly one
c) one or more d) any number of

a) The number of arguments in the procedure call must match the number of parame-
ters in the procedure header.

b) The argument types must be compatible with their corresponding parameter types.
c) Both a and b. d) None of the above.

a) Return Dim intValue b) Return intValue As Integer
c) intValue Return d) Return intValue

a) Step Into b) Step Out
c) Step Over d) Steps

a) body b) title
c) call d) header
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13.10 Method  of class Math calculates the square root of the value passed as an
argument.

Answers: 13.1) d.  13.2) a.  13.3) b.  13.4) a.  13.5) b.  13.6) c.  13.7) d.  13.8) c.  13.9) d.  13.10) c.

EXERCISES 13.11 (Temperature Converter Application) Write an application that performs various
temperature conversions (Fig. 13.28). The application should be capable of performing two
types of conversions: degrees Fahrenheit to degrees Celsius and degrees Celsius to degrees
Fahrenheit.

Figure 13.28 Temperature Converter GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial13\Exercises\TemperatureConversion directory to your
C:\SimplyVB directory.

b) Opening the application’s template file. Double click TemperatureConver-
sion.sln in the TemperatureConversion directory to open the application.

c) Convert Fahrenheit to Celsius. To convert degrees Fahrenheit to degrees Celsius, use
this formula:

dblCelsius = (5 / 9) * (dblFahrenheit - 32)

d) Convert Celsius to Fahrenheit. To convert degrees Celsius to degrees Fahrenheit, use
this formula:

dblFahrenheit = (9 / 5) * dblCelsius + 32

e) Adding event handlers to your application. Double click each Button to add the
proper event handlers to your application. These event handlers will call procedures
(that you will define in the next step) to convert the degrees entered to either Fahren-
heit or Celsius. Each event handler will display the result in the application’s output
Label.

f) Adding Function procedures to your application. Create Function procedures to
perform each conversion, using the formulas above. The user should provide the tem-
perature to convert.

g) Formatting the temperature output. To format the temperature information, use the
String.Format method. Use F as the formatting code to limit the temperature to
two decimal places.

h) Running the application. Select Debug > Start to run your application. Enter a tem-
perature value. Click the Convert to Fahrenheit Button and verify that correct out-
put is displayed based on the formula given. Click the Convert to Celsius Button
and again verify that the output is correct.

i) Closing the application. Close your running application by clicking its close box.

j) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

a) SquareRoot b) Root

c) Sqrt d) Square

1 ' Exercise 13.11 Solution
2 ' TemperatureConversion.vb
3
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13.12 (Display Square Application) Write an application that displays a solid square com-
posed of a character input by the user (Fig. 13.29). The user also should input the size.

4 Public Class FrmTemperatureConverter
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' converts degrees to Fahrenheit

10    Private Sub btnConvertFahrenheit_Click(ByVal sender As _
11       System.Object, ByVal e As System.EventArgs) _
12       Handles btnConvertFahrenheit.Click
13
14       Dim dblDegree As Double = Val(txtDegrees.Text)
15
16       lblOutput.Text = dblDegree & _
17          " degrees Celsius is equal to " & _
18          ControlChars.CrLf & String.Format("{0:F}", _
19          ConvertToFahrenheit(dblDegree)) & _
20          " degrees Fahrenheit."
21
22    End Sub ' btnConvertFahrenheit_Click
23
24    ' converts degrees to Celsius
25    Private Sub btnConvertCelsius_Click(ByVal sender As _
26       System.Object, ByVal e As System.EventArgs) _
27       Handles btnConvertCelsius.Click
28
29       Dim dblDegree As Double = Val(txtDegrees.Text)
30
31       lblOutput.Text = dblDegree & _
32          " degrees Fahrenheit is equal to " & _
33          ControlChars.CrLf & String.Format("{0:F}", _
34          ConvertToCelsius(dblDegree)) & _
35          " degrees Celsius."
36
37    End Sub ' btnConvertCelsius_Click
38
39    ' convert degree to Fahrenheit
40    Function ConvertToFahrenheit(ByVal dblDegree As Double) As Double
41
42       Return (9 / 5) * dblDegree + 32
43    End Function ' ConvertToFahrenheit
44
45    ' convert degree to Celsius
46    Function ConvertToCelsius(ByVal dblDegree As Double) As Double
47
48       Return (5 / 9) * (dblDegree - 32)
49    End Function ' ConvertToCelsius
50
51 End Class ' FrmTemperatureConverter
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Figure 13.29 Display Square application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial13\Exercises\DisplaySquare directory to your C:\SimplyVB
directory.

b) Opening the application’s template file. Double click DisplaySquare.sln in the
DisplaySquare directory to open the application.

c) Adding a Sub procedure. Write a Sub procedure DisplaySquare to display the solid
square. The size should be specified by the Integer parameter intSize. The charac-
ter that fills the square should be specified by the String parameter strFillChar-
acter. You should use a For…Next statement nested within another For…Next
statement to create the square. The outer For…Next specifies what row is currently
being displayed. The inner For…Next appends all the characters that form the row to
a display String.

d) Adding an event handler for your Button’s Click event. Double click the Display
Square Button to create the event handler. Program the event handler to call proce-
dure DisplaySquare.

e) Displaying the output. Use the multiline TextBox provided to display the square. For
example, if intSize is 8 and strFillCharacter is #, the application should look
similar to Fig. 13.29.

f) Running the application. Select Debug > Start to run your application. Enter a size
for the square (the length of each side) and a fill character. Click the Display Square
Button. A square should be displayed of the size you specified, using the character
you specified.

g) Closing the application. Close your running application by clicking its close box.

h) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 13.12 Solution
2 ' DisplaySquare.vb
3
4 Public Class FrmDisplaySquare
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code 
8
9    ' display square in TextBox 

10    Sub DisplaySquare(ByVal intSize As Integer, _
11       ByVal strFillCharacter As String)
12
13       ' declare loop variables
14       Dim intRow As Integer    ' number of rows counter
15       Dim intColumn As Integer ' number of columns counter
16       Dim strOutput As String  ' output String
17
18       ' loop until intRow reaches value of first argument (intSize)
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13.13 (Miles Per Gallon Application) Drivers often want to know the miles per gallon their
cars get so they can estimate gasoline costs. Develop an application that allows the user to
input the numbers of miles driven and the number of gallons used for a tank of gas.

Figure 13.30 Miles Per Gallon application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial13\Exercises\MilesPerGallon directory to your C:\SimplyVB
directory.

b) Opening the application’s template file. Double click MilesPerGallon.sln in the
MilesPerGallon directory to open the application.

c) Calculating the miles per gallon. Write a Function procedure MilesPerGallon that
takes the number of miles driven and gallons used (entered by the user), calculates
the amount of miles per gallon and returns the miles per gallon for a tankful of gas.

19       For intRow = 1 To intSize
20
21          ' loop until intColumn reaches value of intSize
22          For intColumn = 1 To intSize
23             strOutput &= strFillCharacter
24          Next
25
26          strOutput &= ControlChars.CrLf ' add line to output
27       Next
28
29       txtOutput.Text = strOutput ' display square in output area
30    End Sub ' DisplaySquare
31
32    ' handles Display Square Button's Click event
33    Private Sub btnDisplaySquare_Click(ByVal sender As _
34       System.Object, ByVal e As System.EventArgs) _
35       Handles btnDisplaySquare.Click
36
37       ' if valid input is entered
38       If txtSideSize.Text <> "" AndAlso _
39          txtFillCharacter.Text <> "" Then
40
41          DisplaySquare(Val(txtSideSize.Text), _
42             txtFillCharacter.Text)
43       Else  
44          MessageBox.Show("Square size and fill character needed", _
45             "Incorrect Input", MessageBoxButtons.OK, _
46             MessageBoxIcon.Exclamation)
47       End If
48
49    End Sub ' btnDisplaySquare_Click
50
51 End Class ' FrmDisplaySquare
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d) Displaying the result. Create a Click event handler for the Calculate MPG Button
that invokes the Function procedure MilesPerGallon and displays the result
returned from the procedure as in Fig. 13.30.

e) Running the application. Select Debug > Start to run your application. Enter a
value for the number of miles driven and the amount of gallons used. Click the Cal-
culate MPG Button and verify that the correct output is displayed.

f) Closing the application. Close your running application by clicking its close box.

g) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

What does this code do? 13.14 What does the following code do? Assume this procedure is invoked by using Mys-
tery(70, 80).

1 ' Exercise 13.13 Solution
2 ' MilesPerGallon.vb
3
4 Public Class FrmMilesPerGallon
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code 
8
9    ' calculate and return miles per gallon

10    Function MilesPerGallon( _
11       ByVal dblMilesDriven As Double, _
12       ByVal dblGallonsUsed As Double) As Double
13
14       Return dblMilesDriven / dblGallonsUsed
15    End Function ' MilesPerGallon
16
17    ' handles CalculateMPG Button's Click event
18    Private Sub btnCalculateMPG_Click(ByVal sender As _
19       System.Object, ByVal e As System.EventArgs) _
20       Handles btnCalculateMPG.Click
21
22       ' display miles per gallon
23       lblOutputValue.Text = String.Format("{0:F}", _
24          MilesPerGallon(Val(txtMilesDriven.Text), _
25          Val(txtGallonsUsed.Text)))
26
27    End Sub ' btnCalculateMPG_Click
28
29 End Class ' FrmMilesPerGallon

▲

1 Sub Mystery(ByVal intNumber1 As Integer, ByVal _
2    intNumber2 As Integer)
3
4    Dim intX As Integer
5    Dim dblY As Double
6
7    intX = intNumber1 + intNumber2
8    dblY = intX / 2
9

10    If dblY <= 60 Then
11       lblResult.Text = "<= 60 "
12    Else
13       lblResult.Text = "Result is " & dblY
14    End If
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Answer: This code calculates the average of two numbers. The user is informed of the aver-
age, but only if the average is above 60. In this case the two numbers entered are 70 and 80, 
which results in an average of 75, which will be displayed.

What’s wrong with this code? 13.15 Find the error(s) in the following code, which should take an Integer value as an
argument and return the value of that argument multiplied by two.

Answer: A Function procedure should Return a value. The default return value for a Func-
tion procedure with an Integer return type is 0. This Function procedure will always 
return 0. Corrected code:

Using the Debugger 13.16 (Gas Pump Application) The Gas Pump application calculates the cost of gas at a
local gas station. This gas station charges $1.41 per gallon for Regular grade gas, $1.47 per
gallon for Special grade gas and $1.57 per gallon for Super+ grade gas. The user enters the
number of gallons to purchase and clicks the desired grade. The application calls a Sub proce-
dure to compute the total cost from the number of gallons entered and the selected grade.
While testing your application, you noticed that one of your totals was incorrect, given the
input.

Figure 13.31 Gas Pump application executing correctly.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial13\Debugger\GasPumpIncorrect directory to your C:\Sim-
plyVB directory. 

b) Opening the application’s template file. Double click GasPump.sln in the GasPump-
Incorrect directory to open the application.

c) Running the application. Select Debug > Start to run your application. Determine
which total is incorrect.

15
16 End Sub ' Mystery

▲

1 Function TimesTwo(ByVal intNumber As Integer) As Integer
2
3    Dim intResult As Integer
4
5    intResult = intNumber * 2
6 End Function ' TimesTwo

1 Function TimesTwo(ByVal intNumber As Integer) As Integer
2
3    Dim intResult As Integer
4
5    intResult = intNumber * 2
6
7    
8 End Function ' TimesTwo

Return intResult

▲
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d) Setting a breakpoint. Set a breakpoint at the beginning of the event handler that is
providing incorrect output. For instance, if the Regular Button is providing incorrect
output when clicked, add a breakpoint at the beginning of that Button’s Click event
handler. Use the debugger to help find any logic error(s) in the application.

e) Modifying the application. Once you have located the error(s), modify the applica-
tion so that it behaves correctly.

f) Running the application. Select Debug > Start to run your application. Enter a
number of gallons and click the Regular, Special and Super+ Buttons. After each
Button is clicked, verify that the total displayed is correct based on the prices given
in this exercise’s description.

g) Closing the application. Close your running application by clicking its close box.

h) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 13.16 Solution
2 ' GasPump.vb
3
4 Public Class FrmGasPump
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code 
8
9    Dim intGallons As Integer = 0 ' number of gallons

10
11    ' handles Regular Button’s Click event
12    Private Sub btnRegular_Click(ByVal sender As System.Object, _
13       ByVal e As System.EventArgs) Handles btnRegular.Click
14
15       intGallons = Val(txtNumberGallons.Text)
16
17       ' call procedure to determine total
18       ' first argument is Button’s Text
19       Total(btnRegular.Text, intGallons)
20    End Sub ' btnRegular_Click
21
22    ' handles Special Button’s Click event
23    Private Sub btnSpecial_Click(ByVal sender As System.Object, _
24       ByVal e As System.EventArgs) Handles btnSpecial.Click
25
26       intGallons = Val(txtNumberGallons.Text)
27
28       ' call procedure to determine total
29       ' first argument is Button’s Text
30       Total(btnSpecial.Text, intGallons)
31    End Sub ' btnSpecial_Click
32
33    ' handles Super Button’s Click event
34    Private Sub btnSuper_Click(ByVal sender As System.Object, _
35       ByVal e As System.EventArgs) Handles btnSuper.Click
36
37       intGallons = Val(txtNumberGallons.Text)
38
39       ' call procedure to determine total
40       ' first argument is Button’s Text
41       Total(btnSuper.Text, intGallons)
42    End Sub ' btnSuper_Click
43
44    ' calculate total cost of gas
45    Sub Total(ByVal strGrade As String, ByVal intGallons As Integer)



141 Enhancing the Wage Calculator Application Tutorial 13

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

Programming Challenge 13.17 (Prime Numbers Application) An Integer greater than 1 is said to be prime if it is
divisible by only 1 and itself. For example, 2, 3, 5 and 7 are prime numbers, but 4, 6, 8 and 9
are not. Write an application that takes two numbers (representing a lower bound and an
upper bound) and determines all of the prime numbers within the specified bounds, inclu-
sive.

Figure 13.32 Prime Numbers application.

a) Creating the application. Create an application named PrimeNumbers and have its
GUI appear as shown in Fig. 13.32. Add an event handler for the Calculate Primes
Button’s Click event.

b) Checking for prime numbers. Write a Function procedure Prime that returns True if
a number is prime, False otherwise.

c) Limiting user input. Allow users to enter a lower bound (intLower) and an upper
bound (intUpper). Prevent the user from entering bounds less than or equal to 1, or
an upper bound that is smaller than the lower bound.

d) Displaying the prime numbers. Call Function procedure Prime from your event
handler to determine which numbers between the lower and upper bounds are prime.
Then have the event handler display the prime numbers in a multiline, scrollable
TextBox, as in Fig. 13.32.

e) Running the application. Select Debug > Start to run your application. Enter a
lower bound and an upper bound that is smaller than the lower bound. Click the Cal-
culate Primes Button. You should receive an error message. Enter negative bounds

46
47       ' determine grade selected and output total
48       Select Case strGrade
49
50          Case "Regular"
51             lblTotalResult.Text = _
52                String.Format("{0:C}", 1.41 * intGallons)
53
54          Case "Special"
55             lblTotalResult.Text = _
56                String.Format("{0:C}",  * intGallons)
57
58          Case "Super+"
59             lblTotalResult.Text = _
60                String.Format("{0:C}", 1.57 * intGallons)
61
62       End Select
63
64    End Sub ' Total
65
66 End Class ' FrmGasPump

1.47
Code provided to student had

value 1.91 in place of 1.47

▲
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and click the Calculate Primes Button. Again, you should receive an error message.
Enter valid bounds and click the Calculate Primes Button. This time, the primes
within that range should be displayed.

f) Closing the application. Close your running application by clicking its close box.

g) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 13.17 Solution
2 ' PrimeNumbers.vb
3
4 Public Class FrmPrimeNumbers
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' determine if number is prime

10    Function Prime(ByVal intNumber As Integer) As Boolean
11
12       Dim intCount As Integer ' declare counter
13
14       ' set square root of intNumber as limit
15       Dim intLimit As Integer = Math.Sqrt(intNumber)
16
17       ' loop until intCount reaches square root of intNumber
18       For intCount = 2 To intLimit
19
20          If intNumber Mod intCount = 0 Then
21             Return False ' number is not prime
22          End If
23
24       Next
25
26       Return True ' number is prime
27    End Function ' Prime
28
29    ' handles Calculate Primes Button's Click event
30    Private Sub btnCalculatePrimes_Click(ByVal sender As _
31       System.Object, ByVal e As System.EventArgs) _
32       Handles btnCalculatePrimes.Click
33
34       ' declare variables
35       Dim intLowerBound As Integer = Val(txtLowerBound.Text)
36       Dim intUpperBound As Integer = Val(txtUpperBound.Text)
37       Dim intCounter As Integer
38       Dim strOutput As String
39
40       If intLowerBound <= 1 OrElse intUpperBound <= 1 Then
41          MessageBox.Show("Bounds must be greater than 1", _
42             "Invalid Bounds", MessageBoxButtons.OK, _
43             MessageBoxIcon.Exclamation)
44       ElseIf intUpperBound < intLowerBound Then
45          MessageBox.Show("Upper bound cannot be less than " & _
46             "lower bound", "Invalid Bounds", MessageBoxButtons.OK, _
47             MessageBoxIcon.Exclamation)
48       Else
49
50          ' loop from lower bound to upper bound
51          For intCounter = intLowerBound To intUpperBound
52
53             ' if prime number, display in TextBox
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54             If Prime(intCounter) = True Then
55                strOutput &= (intCounter & ControlChars.CrLf)
56             End If
57
58          Next
59
60       End If
61
62       txtPrimeNumbers.Text = strOutput
63    End Sub ' btnCalculatePrimes_Click
64
65 End Class ' FrmPrimeNumbers
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Instructor’s Manual
Exercises Solutions

Tutorial 14

MULTIPLE-CHOICE
QUESTIONS

14.1 The  allows you to store and manipulate date information easily. 

14.2 You can  to a Date variable. 

14.3 To subtract one day from Date variable dtmDay’s value, assign the value returned by
 to dtmDay. 

14.4 The time 3:45 and 35 seconds in the afternoon would be formatted as 03:45:35 PM
according to the format string . 

14.5 A(n)  event occurs before the Form is displayed.

14.6 Timer property Interval sets the rate at which Tick events occur in .  

14.7 To set Date dtmNow’s time five hours earlier, use . 

14.8 A(n)  is a container. 

14.9 A Date variable stores hour values in the range . 

14.10 A DateTimePicker’s  property specifies the format string with which to
display the date. 

Answers: 14.1) a.  14.2) d.  14.3) d.  14.4) b.  14.5) c.  14.6) c.  14.7) b.  14.8) d.  14.9) d.  14.10) a.

EXERCISES 14.11 (World Clock Application) Create an application that displays the current time in
Los Angeles, Atlanta, London and Tokyo. Use a Timer to update the clock every second.
Assume that your local time is the time in Atlanta. Atlanta is three hours later than Los
Angeles. London is five hours later than Atlanta. Tokyo is eight hours later than London.
The application should look similar to Fig. 14.20.

a) Date structure b) DatePicker control 
c) GroupBox control d) Now property

a) add hours b) add days
c) subtract hours d) All of the above.

a) dtmDay.AddHours(-24) b) dtmDay.SubtractDays(1) 
c) dtmDay.AddDays(-1) d) Both a and c.

a) "hh:mm:ss" b) "hh:mm:ss tt" 
c) "hh:mm:ss am:pm" d) "h:m:s tt" 

a) LoadForm b) InitializeForm 
c) Load d) FormLoad 

a) nanoseconds b) microseconds
c) milliseconds d) seconds

a) dtmNow = dtmNow.SubtractHours(5) b) dtmNow = dtmNow.AddHours(-5) 
c) dtmNow = dtmNow.AddHours(5) d) dtmNow.AddHours(-5) 

a) GroupBox b) Form 
c) Timer d) Both a and b. 

a) 1 to 12 b) 0 to 12 
c) 0 to 24 d) 0 to 23 

a) CustomFormat b) FormatString 
c) Format d) Text 
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Figure 14.20 World Clock GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial14\Exercises\WorldClock directory to your C:\SimplyVB direc-
troy. 

b) Opening the application’s template file. Double click WorldClock.sln in the
WorldClock directory to open the application.

c) Adding a Timer to the Form. Add a Timer control to the World Clock application.
Set the Timer control’s name property to tmrClock. 

d) Adding a Tick event handler for tmrClock. Add a Tick event handler for Timer
tmrClock. The event handler should calculate and display the current times for Los
Angeles, Atlanta, London and Tokyo. Use the Date variable’s ToShortDateString
and ToLongTimeString methods to create the display text.

e) Running the application. Select Debug > Start to run your application. Look at the
clock on your machine to verify that the time for Los Angeles is three hours earlier,
the time in Atlanta is the same as what your clock says, the time in London is five
hours later, and the time in Tokyo is 13 hours later (eight hours later than London).

f) Closing the application. Close your running application by clicking its close box.

g) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 14.11 Solution
2 ' WorldClock.vb
3
4 Public Class FrmWorldClock
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' update times

10    Private Sub tmrClock_Tick(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles tmrClock.Tick
12
13       ' retrieve current time 
14       Dim dtmNow As Date = Date.Now
15
16       ' display Los Angeles time
17       lblLATime.Text = dtmNow.AddHours(-3).ToShortDateString & _
18          " " & dtmNow.AddHours(-3).ToLongTimeString
19
20       ' display Atlanta time
21       lblAtlantaTime.Text = dtmNow.ToShortDateString & _
22          " " & dtmNow.ToLongTimeString
23
24       ' display London time
25       lblLondonTime.Text = dtmNow.AddHours(5).ToShortDateString & _
26          " " & dtmNow.AddHours(5).ToLongTimeString
27
28       ' display Tokyo time
29       lblTokyoTime.Text = dtmNow.AddHours(13).ToShortDateString & _
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14.12 (Shipping Time Application Enhancement) During the winter, a distribution center
in Denver, Colorado needs to receive seafood shipments to supply the local ski resorts.
Enhance the Shipping Time application by adding Denver, Colorado as another shipping
destination. Denver is two time zones west of Portland, meaning time is two hours earlier
than Portland, Maine. Because there are no direct flights to Denver, shipments from Portland
will take 8 hours.

Figure 14.21  Enhanced Shipping Time GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial14\Exercises\ShippingTimeEnhanced directory to your C:\Sim-
plyVB directory. 

b) Opening the application’s template file. Double click ShippingTime.sln in the
ShippingTimeEnhanced directory to open the application.

c) Inserting a GroupBox. Resize the Form to fit the Express Shipping to Denver
GroupBox as shown in Fig. 14.21. Add a GroupBox to the Form. Change the Text
property of the GroupBox to indicate that it will contain the delivery time in Denver.
Resize and move the GroupBox so that it resembles the GUI shown in Fig. 14.21. 

d) Inserting Labels. In the GroupBox you just created, add an output Label to display
the delivery time for a seafood shipment to Denver and a corresponding descriptive
Label.

e) Inserting code to the DisplayDeliveryTime procedure. Add code to Display-
DeliveryTime procedure to compute and display the delivery time in Denver.

f) Running the application. Select Debug > Start to run your application. Select vari-
ous drop off times and ensure the delivery times are correct for both Las Vegas and
Denver.

g) Closing the application. Close your running application by clicking its close box.

h) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

30          " " & dtmNow.AddHours(13).ToLongTimeString
31
32    End Sub ' tmrClock_Tick
33
34 End Class ' FrmWorldClock

1 ' Exercise 14.12 Solution
2 ' ShippingTime.vb
3
4 Public Class FrmShippingTime
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
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9    ' update current time every second
10    Private Sub tmrClock_Tick(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles tmrClock.Tick
12
13       ' print current time
14       lblCurrentTime.Text = String.Format("{0:hh:mm:ss tt}", _
15          Date.Now)
16
17    End Sub ' tmrClock_Tick
18
19    ' initialize DateTimePicker status when Form loads
20    Private Sub FrmShippingTime_Load(ByVal sender As _
21       System.Object, ByVal e As System.EventArgs) Handles _
22       MyBase.Load
23
24       Dim dtmCurrentTime As Date = Date.Now ' store current time
25
26       ' set range of possible drop-off times
27       dtpDropOff.MinDate = New Date(dtmCurrentTime.Year, _
28          dtmCurrentTime.Month, dtmCurrentTime.Day, 0, 0, 0)
29
30       dtpDropOff.MaxDate = dtpDropOff.MinDate.AddDays(1)
31
32       ' display the delivery time
33       DisplayDeliveryTime()
34
35    End Sub ' FrmShippingTime_Load 
36
37    ' update ship time on change of drop-off time
38    Private Sub dtpDropOff_ValueChanged(ByVal sender As _
39       System.Object, ByVal e As System.EventArgs) Handles _
40       dtpDropOff.ValueChanged
41
42       ' display the delivery time
43       DisplayDeliveryTime()
44
45    End Sub ' dtpDropOff_ValueChanged
46
47    ' calculates and displays the delivery time
48    Sub DisplayDeliveryTime() As Date
49
50       ' print initial delivery time
51       Dim dtmDelivery As Date = DepartureTime()
52
53       ' add 3 hours to departure and display result
54       dtmDelivery = dtmDelivery.AddHours(3)
55       lblLasVegasTime.Text = dtmDelivery.ToLongDateString _
56          & " at " & dtmDelivery.ToShortTimeString          
57
58       ' add 6 hours to departure and display result
59       dtmDelivery = dtmDelivery.AddHours(6)
60       lblDenverTime.Text = dtmDelivery.ToLongDateString _
61          & " at " & dtmDelivery.ToShortTimeString          
62
63    End Sub ' DisplayDeliveryTime
64
65    ' returns flight departure time for selected drop-off time
66    Function DepartureTime() As Date
67
68       Dim dtmCurrentDate As Date = Date.Now ' store current date
69       Dim dtmDepartureTime As Date          ' store departure time
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14.13 (Alarm Application) Create an application that allows the user to set an alarm clock.
The application should allow the user to set the exact time of the alarm by using a DateTime-
Picker. While the alarm is set, the user should not be able to modify the DateTimePicker. If
the alarm is set and the current time matches or exceeds the time in the DateTimePicker,
play the computer’s “beep” sound. (Your computer must have the necessary hardware for
sound.) The user should be able to cancel an alarm by using a Reset Button. This Button is
disabled when the application starts.

Figure 14.22 Alarm GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial14\Exercises\AlarmClock directory to your C:\SimplyVB direc-
tory. 

b) Opening the application’s template file. Double click AlarmClock.sln in the
AlarmClock directory to open the application.

c) Inserting a DateTimePicker. Add a DateTimePicker control to the Form. Set the
DateTimePicker to display only the time, as is shown in Fig. 14.22. Set the
DateTimePicker control’s Size property to 80, 20, and move the control so that it
appears as it does in Fig. 14.22.

70
71       ' determine which flight the shipment takes
72       Select Case dtpDropOff.Value.Hour
73
74          ' seafood will be on the noon flight
75          Case 0 To 10
76             dtmDepartureTime = New Date(dtmCurrentDate.Year, _
77                dtmCurrentDate.Month, dtmCurrentDate.Day, 12, 0, 0)
78
79          ' seafood will be on tomorrow's noon flight
80          Case 23
81             dtmCurrentDate = dtmCurrentDate.AddDays(1)
82             dtmDepartureTime = New Date(dtmCurrentDate.Year, _
83                dtmCurrentDate.Month, dtmCurrentDate.Day, 12, 0, 0)
84
85          ' seafood will be on midnight flight
86          Case Else
87             dtmCurrentDate = dtmCurrentDate.AddDays(1)
88             dtmDepartureTime = New Date(dtmCurrentDate.Year, _
89                dtmCurrentDate.Month, dtmCurrentDate.Day, 0, 0, 0)
90
91       End Select
92
93       Return dtmDepartureTime ' return the flight's departure time
94    End Function ' DepartureTime
95
96 End Class ' FrmShippingTime
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d) Coding the Set Button’s Click event handler. Add a Click event handler for the
Set Button. This event handler should disable the Set Button and the DateTime-
Picker and enable the Reset Button.

e) Coding the Timer’s Tick event handler. Define the Tick event handler for the Timer.
A Tick event should occur every 1000 milliseconds (one second). If the alarm is set
and the current time matches or exceeds the time in the DateTimePicker, play the
computer’s “beep” sound by calling the Beep function. To call the Beep function, type
Beep() on its own line in your code.

f) Coding the Reset Button’s Click event handler. Define the Click event handler for
the Reset Button. When the Reset Button is clicked, the GUI should be set back to
its original state.

g) Running the application. Select Debug > Start to run your application. Use the
DateTimePicker and the Set Button to set a time for the alarm to go off. Wait for
that time to verify that the alarm will make beeping sounds. Click the Reset Button
to set a new time for the alarm to go off.

h) Closing the application. Close your running application by clicking its close box.

i) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 14.13 Solution
2 ' AlarmClock.vb
3
4 Public Class FrmAlarmClock
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' set time for alarm to go off

10    Private Sub btnSetTime_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnSetTime.Click
12
13       ' disable user input
14       btnSetTime.Enabled = False
15       dtpAlarmTime.Enabled = False
16
17       btnReset.Enabled = True ' enable reset
18    End Sub ' btnSetTime_Click
19
20    ' timer ticks once every minute
21    Private Sub tmrTimerAlarm_Tick(ByVal sender As System.Object, _
22       ByVal e As System.EventArgs) Handles tmrTimerAlarm.Tick
23
24       ' sound the alarm
25       If dtpAlarmTime.Value.Hour = Date.Now.Hour AndAlso _
26          dtpAlarmTime.Value.Minute = Date.Now.Minute AndAlso _
27          btnReset.Enabled = True Then
28
29          ' call the Beep function
30          Beep()
31       End If
32
33    End Sub ' tmrTimerAlarm_Tick
34
35    ' return to initial state
36    Private Sub btnReset_Click(ByVal sender As System.Object, _
37       ByVal e As System.EventArgs) Handles btnReset.Click
38
39       ' return all GUI controls to initial state
40       btnSetTime.Enabled = True
41       btnReset.Enabled = False
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What does this code do? 14.14 This code creates a Date variable. What date does this variable contain?

Dim dtmTime As Date = New Date(2003, 1, 2, 3, 4, 5)

Answer:  This variable contains the date January 2, 2003 at 3:04:05 A.M.

What’s wrong with this code? 14.15 The following lines of code are supposed to create a Date variable and increment its
hour value by two. Find the error(s) in the code.

Dim dtmNow As Date = Date.Now
dtmNow.AddHours(2)

Answer: Method AddHours does not actually increment the Date variable, but instead 
returns a new Date variable with the updated value. Thus, the preceding code will not suc-
cessfully add two hours to dtmNow. Correct the code as follows:

Dim dtmNow As Date = Date.Now
dtmNow = dtmNow.AddHours(2)

Programming Challenge 14.16 (Parking Garage Fee Calculator) Create an application that computes the fee for
parking a car in a parking garage (Fig. 14.23). The user should provide the Time In: and Time
Out: values by using DateTimePickers. The application should calculate the cost of parking
in the garage for the specified amount of time. Assume that parking costs three dollars an
hour. When calculating the total time spent in the garage, you can ignore the seconds value,
but treat the minutes value as a fraction of an hour (1 minute is 1/60 of an hour). For simplic-
ity, assume that no overnight parking is allowed, so each car leaves the garage on the same
day in which it arrives.

Figure 14.23 Parking Garage Fee Calculator GUI.

a) Copying the template to your working directory. Copy the
C:\Examples\Tutorial14\Exercises\ParkingGarageFeeCalculator directory
to your C:\SimplyVB directory. 

b) Opening the application’s template file. Double click ParkingGarageFeeCalcula-
tor.sln in the ParkingGarageFeeCalculator directory to open the application

c) Inserting the DateTimePicker controls. Add two DateTimePicker controls to the
Form. Set the DateTimePickers so that they show the time only. Set the Size prop-
erty of each DateTimePicker control to 80, 20, and move the DateTimePickers so
that they are positioned as in Fig. 14.23.

d) Writing the Function procedure Fee. Define a Function procedure Fee that
accepts four Integers as parameters—the hour value of the Time In:, the hour value
of the Time Out:, the minute value of the Time In: and the minute value of the Time
Out:. Using this information, procedure Fee should calculate the fee for parking in
the garage. The Function procedure should then return this value as a Decimal.

42       dtpAlarmTime.Enabled = True
43    End Sub ' btnReset_Click
44
45 End Class ' FrmAlarmClock

▲
▲

▲
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e) Coding the Calculate Button’s Click event handler. Add the Click event handler
for the Calculate Button. This event handler should call Fee to obtain the amount
due. It should then display the amount (formatted as currency) in a Label.

f) Running the application. Select Debug > Start to run your application. Use the
DateTimePickers’ up and down arrows to select a time the car was placed in the
garage and the time the car was taken out of the garage. Click the Calculate Button
and verify that the correct fee is displayed.

g) Closing the application. Close your running application by clicking its close box.

h) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 14.16 Solution
2 ' ParkingGarageFeeCalculator.vb
3
4 Public Class FrmParkingGarageFeeCalculator
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' calculates cost of parking in garage

10    Function Fee(ByVal intTimeOutHour As Integer, _
11        ByVal intTimeInHour As Integer, ByVal intTimeOutMinute _
12        As Integer, ByVal intTimeInMinute As Integer) As Decimal
13
14       ' determines number of elapsed hours
15       Dim intHours As Integer = intTimeOutHour - intTimeInHour
16
17       ' determines number of elapsed minutes
18       Dim intMinutes As Integer = intTimeOutMinute - intTimeInMinute
19
20       If intMinutes < 0 Then
21          intHours -= 1
22          intMinutes += 60
23       End If
24
25       Return (intHours + (intMinutes / 60)) * 3
26    End Function ' Fee
27
28    ' called when Calculate Button is clicked
29    Private Sub btnCalculate_Click(ByVal sender As System.Object, _
30       ByVal e As System.EventArgs) Handles btnCalculate.Click
31
32       Dim intFee As Decimal = 0
33
34       ' calls procedure Fee
35       intFee = Fee(dtpTimeOut.Value.Hour, _
36          dtpTimeIn.Value.Hour, dtpTimeOut.Value.Minute, _
37          dtpTimeIn.Value.Minute)
38
39       ' output fee as currency
40       lblFeeResult.Text = String.Format("{0:C}", intFee)
41    End Sub ' btnCalculate_Click
42
43 End Class ' FrmParkingGarageFeeCalculator



153

T U T O R I A L

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

15
Fund Raiser Application
Introducing Scope, Pass-by-Reference 

and Option Strict
Solutions
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Instructor’s Manual
Exercise Solutions

Tutorial 15

MULTIPLE-CHOICE
QUESTIONS

15.1 In the Property Pages dialog,  must be selected to access Option Strict.

15.2 When Option Strict is set to On, variables .

15.3 A variable declared inside a class, but outside a procedure, is called a(n) .

15.4 Visual Basic .NET provides methods in class  to convert from one data type
to another.

15.5 When Option Strict is , the conversion attempt intX = dblPercent results
in an error.

15.6 Keyword  indicates pass-by-reference.

15.7 With , changes made to a parameter variable’s value do not affect the value
of the variable in the calling procedure.

15.8 Instance variables .

15.9 Assigning a “smaller” type to a “larger” type is a  conversion.

15.10 A value of type Boolean can be implicitly converted to .

Answers: 15.1) a.  15.2) c.  15.3) c.  15.4) b.  15.5) a.  15.6) b.  15.7) b.  15.8) d.  15.9) c.  15.10) c.

EXERCISES 15.11 (Task List Application) Create an application that allows users to add items to a daily
task list. The application should also display the number of tasks to be performed. Use
method Convert.ToString to display the number of tasks in a Label. The application
should look like the GUI in Fig. 15.29.

a) Build b) Designer Defaults 
c) General d) Imports 

a) are passed by value b) are passed by reference
c) might need to be converted explicitly to a different type to avoid errors
d) are used only within the block in which the variables are declared

a) local variable b) hidden variable
c) instance variable d) constant variable

a) ChangeTo b) Convert 
c) ConvertTo d) ChangeType 

a) On b) True 
c) Off d) False 

a) ByReference b) ByRef 
c) Ref d) Reference 

a) Option Strict b) pass-by-value
c) pass-by-reference d) None of the above.

a) are members of class b) are prefixed by m_ 
c) can be accessed by a procedure in the same class 
d) All of the above.

a) narrowing b) shortening
c) widening d) lengthening

a) Integer b) String 
c) Object d) Double 
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Figure 15.29 Task List application’s GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial15\Exercises\TaskList directory to your C:\SimplyVB directory.

b) Opening the application’s template file. Double click TaskList.sln in the
TaskList directory to open the application. 

c) Setting Option Strict to On. Use the directions provided in the box, Enabling
Option Strict, to set Option Strict to On.

d) Adding the Add Task Button’s Click event handler. Double click the Add Task
Button to generate the empty event handler btnAdd_Click. This event handler
should display the user input in the ListBox and clear the user input from the Text-
Box. The event handler should also update the Label that displays the number of
tasks. Use method Convert.ToString to display the number of tasks in the Label.
Finally, the event handler should transfer the focus to the TextBox.

e) Running the application. Select Debug > Start to run your application. Enter sev-
eral tasks, click the Add Task Button after each. Verify that each task is added to the
Task list: ListBox, and that the number of tasks is incremented with each new task.

f) Closing the application. Close your running application by clicking its close box.

g) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

15.12 (Quiz Average Application) Develop an application that computes a student’s aver-
age quiz score for all of the quiz scores entered. The application should look like the GUI in
Fig. 15.30. Use method Convert.ToInt32 to convert the user input to an Integer. Use

1 ' Exercise 15.11 Solution
2 ' TaskList.vb
3
4 Public Class FrmTaskList
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' handles Add Task Button's Click event

10    Private Sub btnAdd_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnAdd.Click
12
13       lstTasks.Items.Add(txtTask.Text)  ' insert task into ListBox
14
15       txtTask.Clear()  ' clear TextBox of user input
16
17       ' convert Integer to String to display number of tasks
18       lblOutput.Text = Convert.ToString(lstTasks.Items.Count)
19
20       txtTask.Focus() ' transfer the focus to the TextBox
21    End Sub ' btnAdd_Click
22
23 End Class ' FrmTaskList
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instance variables with module scope to keep track of the sum of all the quiz scores entered
and the number of quiz scores entered.

Figure 15.30 Quiz Average application’s GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial15\Exercises\QuizAverage directory to your C:\SimplyVB direc-
tory. 

b) Opening the application’s template file. Double click QuizAverage.sln in the
QuizAverage directory to open the application.

c) Setting Option Strict to On. Use the directions provided in the box, Enabling
Option Strict, to set Option Strict to On.

d) Adding instance variables. Add two instance variables—m_intTotalScore, which
keeps track of the sum of all the quiz scores entered, and m_intTaken, which keeps
track of the number of quiz scores entered.

e) Adding the Grade Quiz Button’s event handler. Double click the Submit Score
Button to generate the empty event handler btnCalculate_Click. The code
required in Steps f–k should be placed in this event handler.

f) Obtaining user input. Use method Convert.ToInt32 to convert the user input from
the TextBox to an Integer.

g) Updating the number of quiz scores entered. Increment the number of quiz scores
entered.

h) Updating the sum of all the quiz scores entered. Add the current quiz score to the
current total to update the sum of all the quiz scores entered.

i) Calculating the average score. Divide the sum of all the quiz scores entered by the
number of quiz scores entered to calculate the average score.

j) Displaying the average score. Use method Convert.ToString to display the aver-
age quiz grade in the Average: field.

k) Displaying the number of quizzes taken. Use method Convert.ToString to display
the number of quiz scores entered in the Number taken: field.

l) Running the application. Select Debug > Start to run your application. Enter sev-
eral quiz scores, clicking the Submit Score Button after each. With each new score,
verify that the Number taken: field is incremented and that the average is updated
correctly.

m)Closing the application. Close your running application by clicking its close box.

n) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 15.12 Solution
2 ' QuizAverage.vb
3
4 Public Class FrmQuizAverage
5    Inherits System.Windows.Forms.Form
6
7    ' instance variables store total score and number quizzes taken
8    Dim m_intTotalScore As Integer = 0
9    Dim m_intTaken As Integer = 0

10
11    ' Windows Form Designer generated code
12
13    ' handles Submit Score Button’s Click event
14    Private Sub btnCalculate_Click(ByVal sender As System.Object, _
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15.13 (Maximum Application) Modify the Maximum application from Chapter 13
(Fig. 15.31) to use keyword ByRef to pass a fourth argument to procedure Maximum by refer-
ence. Also, use methods from class Convert to perform any necessary type conversions.

Figure 15.31 Maximum application’s GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial15\Exercises\Maximum directory to your C:\SimplyVB directory. 

b) Opening the application’s template file. Double click Maximum.sln in the Maximum
directory to open the application.

c) Setting Option Strict to On. Use the directions provided in the box, Enabling
Option Strict, to set Option Strict to On.

d) Adding a local variable. Add local variable dblMaximum of type Double to event
handler btnMaximum_Click. The code required in Steps d–f should be placed in this
event handler. Variable dblMaximum will store the result of procedure Maximum.

e) Passing four arguments to procedure Maximum. Use method Convert.ToDouble to
convert the user input from the TextBoxes to Doubles. Pass these three values as the
first three arguments to procedure Maximum. Pass local variable dblMaximum as the
fourth argument to procedure Maximum.

f) Displaying the maximum value. Use method Convert.ToString to display local
variable dblMaximum in the Maximum: field. 

15       ByVal e As System.EventArgs) Handles btnCalculate.Click
16
17       Dim intScore As Integer
18       Dim intAverage As Integer
19
20       ' obtain and convert user input
21       intScore = Convert.ToInt32(Val(txtScore.Text))
22
23       ' update number of quizzes taken
24       m_intTaken += 1
25
26       ' update total score
27       m_intTotalScore += intScore
28
29       ' calculate average score
30       intAverage = m_intTotalScore \ m_intTaken
31
32       ' display average score
33       lblAverage.Text = Convert.ToString(intAverage)
34
35       ' display number of quizzes taken
36       lblTaken.Text = Convert.ToString(m_intTaken)
37
38    End Sub ' btnCalculate_Click
39
40 End Class ' FrmQuizAverage
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g) Changing procedure Maximum to a Sub procedure. Change procedure Maximum to a
Sub procedure. Make sure that Sub procedure Maximum no longer returns a value and
does not specify a return type. The modifications required in Steps g–h should be per-
formed on this Sub procedure.

h) Adding a fourth parameter to procedure Maximum. Add a fourth parameter dblFi-
nalMaximum of type Double to Maximum’s procedure header. Use keyword ByRef to
specify that this argument will be passed by reference. Remove the declaration of
variable dblFinalMaximum from the body of procedure Maximum.

i) Running the application. Select Debug > Start to run your application. Enter three
different values into the input fields and click the Maximum Button. Verify that the
largest value is displayed in the Maximum: field.

j) Closing the application. Close your running application by clicking its close box.

k) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

What does this code do? 15.14 What is displayed in Label lblDisplay when the following code is executed?
  

1 ' Exercise 15.13 Solution
2 ' Maximum.vb
3
4 Public Class FrmMaximum
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' obtain values in each TextBox, call procedure Maximum

10    Private Sub btnMaximum_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnMaximum.Click
12
13       Dim dblMaximum As Double
14
15       Maximum(Convert.ToDouble(Val(txtFirst.Text)), _
16          Convert.ToDouble(Val(txtSecond.Text)), _
17          Convert.ToDouble(Val(txtThird.Text)), dblMaximum)
18
19       lblOutput.Text = Convert.ToString(dblMaximum)
20    End Sub ' btnMaximum_Click
21
22    ' find maximum of three parameter values
23    Sub Maximum(ByVal dblOne As Double, ByVal dblTwo _
24       As Double, ByVal dblThree As Double, _
25       ByRef dblFinalMaximum As Double)
26
27       Dim dblTemporaryMaximum As Double
28
29       dblTemporaryMaximum = Math.Max(dblOne, dblTwo)
30       dblFinalMaximum = Math.Max(dblTemporaryMaximum, dblThree)
31    End Sub ' Maximum
32
33 End Class ' FrmMaximum

▲

1 Public Class FrmScopeTest
2    Inherits System.Windows.Forms.Form
3    
4    Dim intValue2 As Integer = 5
5
6    Private Sub btnEnter_Click(ByVal sender As System.Object, _
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Answer: Label lblDisplay displays the value of variable intValue1 (50). When the code 
invokes Sub procedure Test, it passes intValue1 pass-by-reference. Any changes made to 
intValue1 in Sub procedure Test are reflected in btnEnter_Click’s local variable 
intValue1. When Sub procedure Test multiplies intValue1 by intValue2, intValue2 is 
the class instance variable, whose value is 5. Procedure Test does not have access to 
btnEnter_Click’s local variable intValue2.

What’s wrong with this code? 15.15 Find the error(s) in the following code (the procedure should assign the value 14 to
variable intResult).

Answer: The code must explicitly convert strNumber to Integer:

Programming Challenge 15.16 (Schedule Book Application) Develop an application that allows a user to enter a
schedule of appointments and their respective times. Create the Form in Fig. 15.32 and name
the application Schedule Book. Add a Function procedure called TimeTaken that returns a
Boolean value. Each time a user enters a new appointment, Function procedure TimeTaken
determines if the user has scheduled more than one appointment at the same time. If Time-
Taken returns True, the user will be notified via a message dialog. Otherwise, the appoint-
ment should be added to the ListBoxes. Set Option Strict to On and use methods from
class Convert as necessary. 

7      ByVal e As System.EventArgs) Handles btnEnter.Click
8
9       Dim intValue1 As Integer = 10

10       Dim intValue2 As Integer = 3
11
12       Test(intValue1)
13       lblDisplay.Text = Convert.ToString(intValue1)
14    End Sub ' btnEnter_Click
15
16    Sub Test(ByRef intValue1 As Integer)
17       intValue1 *= intValue2
18    End Sub ' Test
19
20 End Class ' FrmScopeTest

▲

1  Sub Sum()
2    Dim strNumber As String = "4"
3    Dim intNumber As Integer = 10
4    Dim intResult As Integer
5
6    intResult = strNumber + intNumber
7 End Sub ' Sum

1  Sub Sum()
2    Dim strNumber As String = "4"
3    Dim intNumber As Integer = 10
4    Dim intResult As Integer
5
6    
7 End Sub ' Sum

intResult = Convert.ToInt32(strNumber) + intNumber

▲
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Figure 15.32 Schedule Book application’s GUI.

1 ' Exercise 15.16 Solution
2 ' ScheduleBook.vb
3
4 Public Class FrmScheduleBook
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form designer generated code
8
9    ' handles Add Appointment Button’s Click event

10    Private Sub btnAdd_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnAdd.Click
12
13       ' appointment scheduled for given time
14       Dim blnTimeTaken As Boolean = TimeTaken()
15
16       ' display message if appointment conflict
17       If blnTimeTaken = True Then
18
19          MessageBox.Show("You already have an appointment " & _
20              "at this time", "Cannot Add Appointment", _
21              MessageBoxButtons.OK, MessageBoxIcon.Exclamation)
22
23       ' otherwise add appointment and time to ListBoxes
24       Else
25          lstAppointments.Items.Add(txtAppointment.Text)
26          lstTimes.Items.Add(dtpTime.Value.ToShortTimeString())
27       End If
28
29       ' clear user input from TextBoxes
30       txtAppointment.Clear()
31    End Sub ' btnAdd_Click
32
33    ' determines if an appointment already exists at specified time
34    Function TimeTaken() As Boolean
35
36       ' determine number of appointments
37       Dim intItems As Integer = lstTimes.Items.Count()
38
39       ' determines if items are in time ListBox 
40       If intItems <> 0 Then
41
42          Dim intCounter As Integer
43
44          ' search ListBox to determine if an appointment 
45          ' has been made for that time
46          For intCounter = 0 To intItems - 1
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47
48             ' compare times in ListBox with user entry
49             If Convert.ToString(lstTimes.Items.Item( _
50                intCounter)) = dtpTime.Value.ToShortTimeString() Then
51
52                Return True
53             End If
54
55          Next
56
57       End If
58
59       Return False
60
61    End Function ' TimeTaken
62
63 End Class ' FrmScheduleBook
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Instructor’s Manual
Exercise Solutions

Tutorial 16

MULTIPLE-CHOICE
QUESTIONS

16.1 A Random object can generate pseudorandom numbers of type .

16.2 A  is a group of related classes in the Framework Class Library.

16.3 Object variable names should be prefixed with .

16.4 The Next method of class Random can be called using .

16.5 The statement  assigns intValue a random number in the range from 5 to
20.

16.6 The  method specifies the file from which an image is loaded.

16.7 The System.IO namespace contains classes and methods to .

16.8 The values returned by the  method of class Random are actually pseudo-ran-
dom numbers.

16.9 When creating random numbers, the second argument passed to the Next method is
.

16.10 A(n)  is a group of related, named constants.

Answers: 16.1) d.  16.2) c.  16.3) b.  16.4) d.  16.5) a.  16.6) b.  16.7) a. 16.8) c.  16.9) b.  16.10) c.

EXERCISES 16.11 (Guess the Number Application) Develop an application that generates a random
number and prompts the user to guess the number (Fig. 16.21). When the user clicks the New
Game Button, the application chooses a number in the range 1 to 100 at random. The user

a) Integer b) Single 
c) Double d) Both a and c. 

a) classpace b) directory
c) namespace d) library

a) var b) obj 
c) ran d) ojt 

a) one argument b) no arguments
c) two arguments d) All of the above.

a) intValue = objRandom.Next(5, 21) b) intValue = objRandom.Next(4, 20) 
c) intValue = objRandom.Next(5, 20) d) intValue = objRandom.Next(4, 21) 

a) Next in class Random b) FromFile in class Image
c) GetCurrentDirectory in class 

Directory
d) None of the above.

a) access files and directories b) display graphics in an application 
c) insert multimedia into an application d) All of the above.

a) NextRandom b) PseudoRandom 
c) Next d) Pseudo 

a) equal to the maximum value you wish to be generated
b) equal to one more than the maximum value you wish to be generated
c) equal to one less than the maximum value you wish to be generated
d) equal to the minimum value you wish to be generated

a) namespace b) variable 
c) enumeration d) None of the above. 
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enters guesses into the Guess: TextBox and clicks the Enter Button. If the guess is correct,
the game ends, and the user can start a new game. If the guess is not correct, the application
should indicate if the guess is higher or lower than the correct number.

Figure 16.21 Guess the Number application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial16\Exercises\GuessNumber directory to your C:\SimplyVB direc-
tory. 

b) Opening the application’s template file. Double click GuessNumber.sln in the
GuessNumber directory to open the application (Fig. 16.21).

c) Creating a Random object. Create two instance variables. The first variable should
store a Random object and the second variable should store a random-generated num-
ber. 

d) Adding a Click event handler for the Enter Button. Add a Click event handler for
the Enter Button that retrieves the value entered by the user and compares that
value to the random-generated number. If the guess is correct, display Correct! in the
output Label. Then disable the Enter Button, and enable the New Game Button. If
the user’s guess is higher than the correct answer, display Too high... in the output
Label. If the user’s guess is lower than the correct answer, display Too low... in the
output Label.

e) Adding a Click event handler for the New Game Button. Add a Click event han-
dler for the New Game Button that generates a new random number for the
instance variable. The event handler should then disable the New Game Button,
enable the Enter Button and clear the Result: TextBox.

f) Running the application. Select Debug > Start to run your application. Enter
guesses (clicking the Enter Button after each) until you have successfully determined
the answer. Click the New Game Button and test the application again.

g) Closing the application. Close your running application by clicking its close box.

h) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 16.11 Solution
2 ' GuessNumber.vb
3
4 Public Class FrmGuessNumber
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    Dim m_objRandom As Random = New Random

10    Dim m_intNumber As Integer = m_objRandom.Next(1, 101)
11
12    ' handles Enter button click event
13    Private Sub btnEnter_Click(ByVal sender As System.Object, _
14       ByVal e As System.EventArgs) Handles btnEnter.Click
15
16       ' check answer
17       If Val(txtGuessNumber.Text) = m_intNumber Then
18          lblOutput.Text = "Correct!"
19          btnEnter.Enabled = False
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16.12 (Dice Simulator Application) Develop an application that simulates rolling two six-
sided dice. Your application should have a Roll Button that, when clicked, displays two dice
images corresponding to random numbers. It should also display the number of times each
face has appeared. Your application should appear similar to Fig. 16.22.

Figure 16.22 Dice Simulator application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial16\Exercises\DiceSimulator directory to your C:\SimplyVB
directory. 

b) Opening the application’s template file. Double click DiceSimulator.sln in the
DiceSimulator directory to open the application.

c) Displaying the die image. Create a Sub procedure named DisplayDie that takes a
PictureBox control as an argument. This method should generate a random number
to simulate a die roll. Then display the die image in the corresponding PictureBox
control on the Form. The die image should correspond to the random number that
was generated. To set the image, refer to the code presented in Fig. 16.20.

d) Adding a Click event handler for the Roll Button. Add a Click event handler for
the Roll Button. Call method DisplayDie in this event handler to display the images
for both dice.

e) Displaying the frequency. Add a Sub procedure called DisplayFrequency that uses
a Select Case statement to update the number of times each face has appeared. Cre-
ate an enumeration for the dice faces which will be used in the Select Case state-
ment.

20          btnNewGame.Enabled = True
21       ElseIf Val(txtGuessNumber.Text) > m_intNumber Then
22          lblOutput.Text = "Too high..."
23       Else
24          lblOutput.Text = "Too low..."
25       End If
26
27       txtGuessNumber.Clear()
28       txtGuessNumber.Focus()
29    End Sub ' btnEnter_Click
30
31    ' restart game with new number 
32    Private Sub btnNewGame_Click(ByVal sender As System.Object, _
33       ByVal e As System.EventArgs) Handles btnNewGame.Click
34
35       ' generate new random number
36       m_intNumber = m_objRandom.Next(1, 101)
37       btnEnter.Enabled = True
38       btnNewGame.Enabled = False
39       lblOutput.Text = "" ' clear result
40    End Sub ' btnNewGame_Click
41
42 End Class ' FrmGuessNumber
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f) Running the application. Select Debug > Start to run your application. Click the
Roll Button several times. Each time, two die faces should be displayed at random.
Verify after each roll that the appropriate face values on the left are incremented.

g) Closing the application. Close your running application by clicking its close box.

h) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 16.12 Solution
2 ' DiceSimulator.vb
3
4 Imports System.IO
5
6 Public Class FrmDiceSimulator
7    Inherits System.Windows.Forms.Form
8
9    ' Windows Form Designer generated code

10
11    ' die face constants
12    Enum FaceNames
13       ONE = 1
14       TWO = 2
15       THREE = 3
16       FOUR = 4
17       FIVE = 5
18       SIX = 6
19    End Enum
20
21    ' declare Random object reference
22    Dim m_objRandomNumber As Random = New Random
23
24    ' display results of roll
25    Private Sub btnRoll_Click(ByVal sender As System.Object, _
26       ByVal e As System.EventArgs) Handles btnRoll.Click
27
28       ' method randomly assigns a face to each die
29       DisplayDie(picDie1)
30       DisplayDie(picDie2)
31    End Sub ' btnRoll_Click
32
33    ' get a random die image
34    Sub DisplayDie(ByVal picDie As PictureBox)
35
36       ' generate random integer in range 1 to 6
37       Dim intFace As Integer = m_objRandomNumber.Next(1, 7)
38
39       ' load corresponding image
40       picDie.Image = Image.FromFile( _
41          Directory.GetCurrentDirectory & "/Images/die" & _
42          intFace & ".png")
43
44       ' method displays rolls frequency
45       DisplayFrequency(intFace)
46    End Sub ' DisplayDie
47
48    ' display the rolls frequency
49    Sub DisplayFrequency(ByVal intFace As Integer)
50
51       ' increment and display frequency values
52       Select Case intFace
53
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16.13 (Lottery Numbers Picker Application) A lottery commission offers four different
lottery games to play: Three number, Four number, Five number and Five number + 1 lotter-
ies. Each game has independent numbers. Develop an application that randomly picks num-
bers for all four games and displays the generated numbers in a GUI (Fig. 16.23). The games
are played as follows

■ Three-number lotteries require players to choose three numbers in the range
of 0–9.

■ Four-number lotteries require players to choose four numbers, in the range of
0–9.

■ Five-number lotteries require players to choose five numbers in the range of
1–39.

■ Five-number + 1 lotteries require players to choose five numbers in the range
of 1–49 and an additional number in the range of 1–42.

Figure 16.23 Lottery Picker application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial16\Exercises\LotteryPicker directory to your C:\SimplyVB
directory. 

54          Case FaceNames.ONE
55             lblOutput1.Text = _
56                Convert.ToString(Convert.ToInt32(lblOutput1.Text) + 1)
57
58          Case FaceNames.TWO
59             lblOutput2.Text = _
60                Convert.ToString(Convert.ToInt32(lblOutput2.Text) + 1)
61
62          Case FaceNames.THREE
63             lblOutput3.Text = _
64                Convert.ToString(Convert.ToInt32(lblOutput3.Text) + 1)
65
66          Case FaceNames.FOUR
67             lblOutput4.Text = _
68                Convert.ToString(Convert.ToInt32(lblOutput4.Text) + 1)
69
70          Case FaceNames.FIVE
71             lblOutput5.Text = _
72                Convert.ToString(Convert.ToInt32(lblOutput5.Text) + 1)
73
74          Case FaceNames.SIX
75             lblOutput6.Text = _
76                Convert.ToString(Convert.ToInt32(lblOutput6.Text) + 1)
77
78       End Select
79
80    End Sub ' DisplayFrequency
81
82 End Class ' FrmDiceSimulator
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b) Opening the application’s template file. Double click LotteryPicker.sln in the
LotteryPicker directory to open the application.

c) Generating random numbers. Create a Function procedure that will generate the
random numbers for all four games.

d) Drawing numbers for the games. Add code into your application to generate num-
bers for all four games. To make the applications simple, allow repetition of numbers.

e) Running the application. Select Debug > Start to run your application. Click the
Generate Button multiple times. Make sure the values displayed are within the
ranges described in the exercise description.

f) Closing the application. Close your running application by clicking its close box.

g) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 16.13 Solution
2 ' LotteryPicker.vb
3
4 Public Class FrmLotteryPicker
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    Public m_objRandom As Random = New Random

10
11    ' display random lottery numbers
12    Private Sub btnGenerate_Click(ByVal sender As _
13       System.Object, ByVal e As System.EventArgs) _
14       Handles btnGenerate.Click
15
16       ' generate three numbers
17       lblOutput3.Text = Generate(0, 10) & " " & _
18          Generate(0, 10) & " " & Generate(0, 10)
19
20       ' generate four numbers
21       lblOutput4.Text = Generate(0, 10) & " " & _
22          Generate(0, 10) & " " & Generate(0, 10) & " " _
23          & Generate(0, 10)
24
25       ' generate five numbers
26       lblOutput5.Text = Generate(1, 40) & " " & _
27          Generate(1, 40) & " " & Generate(1, 40) & _
28          " " & Generate(1, 40) & " " & Generate(1, 40)
29
30       ' generate five plus one numbers
31       lblOutput5Plus1.Text = Generate(1, 50) & " " & _
32          Generate(1, 50) & " " & Generate(1, 50) & " " & _
33          Generate(1, 50) & " " & Generate(1, 50)
34
35       lblOutputExtra1.Text = Generate(1, 43)
36
37    End Sub ' btnGenerate_Click
38
39    ' generate random numbers
40    Function Generate(ByVal intLow As Integer, _
41       ByVal intHigh As Integer) As String
42
43       Return String.Format("{0:D2}", _
44          m_objRandom.Next(intLow, intHigh))
45
46    End Function ' Generate
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Answer:

What does this code do? 16.14 What does the following code do?

Answer: intNumber1 gets a positive integer (between 0 and Int32.MaxValue), dblNumber 
gets a floating-point number between 0 and 5 (not including 5) and intNumber2 gets an inte-
ger between 1 and 10 (not including 10).

What’s wrong with this code? 16.15 This Sub procedure should assign a random Decimal number (in the range 0 to
Int32.MaxValue) to Decimal decNumber. (Assume that Option Strict is On.) Find the
error(s) in the following code.

Answers: Random objects can produce Integers and Doubles only; this will yield only an 
Integer random number. [There is no way to have the Random class generate a Decimal ran-
dom value, so the solution is a bit contrived. The closest approximation is to use 
NextDouble.] 

47
48 End Class ' FrmLotteryPicker

▲

1 Sub PickRandomNumbers()
2
3    Dim intNumber1 As Integer
4    Dim dblNumber As Double
5    Dim intNumber2 As Integer
6    Dim objRandom As Random = New Random
7       
8    intNumber1 = objRandom.Next()
9    dblNumber = 5 * objRandom.NextDouble()

10    intNumber2 = objRandom.Next(1, 10)
11    lblInteger1.Text = Convert.ToString(intNumber1)
12    lblDouble1.Text = Convert.ToString(dblNumber)
13    lblInteger2.Text = Convert.ToString(intNumber2)
14 End Sub ' PickRandomNumbers

▲
1 Sub RandomDecimal()
2
3    Dim decNumber As Decimal
4    Dim objRandom As Random = New Random
5
6    decNumber = objRandom.Next()
7    lblDisplay.Text = Convert.ToString(decNumber)
8
9 End Sub ' RandomDecimal

1 Sub RandomDecimal()
2
3    Dim decNumber As Decimal
4    Dim objRandom As Random = New Random
5
6    
7    
8    lblDisplay.Text = Convert.ToString(decNumber)
9

10 End Sub ' RandomDecimal

decNumber = Int32.MaxValue * _              
   Convert.ToDecimal(objRandom.NextDouble())
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Programming Challenge 16.16 (Multiplication Teacher Application) Develop an application that helps children
learn multiplication. Use random-number generation to produce two positive one-digit inte-
gers that display in a question, such as “How much is 6 times 7?” The student should type the
answer into a TextBox. If the answer is correct, then the application randomly displays one
of three messages: Very Good!, Excellent! or Great Job! in a Label and displays the next
question. If the student is wrong, the Label displays the message No. Please try again.

Figure 16.24 Multiplication Teacher application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial16\Exercises\MultiplicationTeacher directory to your C:\Sim-
plyVB directory. 

b) Opening the application’s template file. Double click Multiplication-
Teacher.sln in the MultiplicationTeacher directory to open the application.

c) Generating the questions. Add a method into your application (Fig. 16.24) to gener-
ate each new question. 

d) Determining whether the right answer was entered. Add code into your application
to call the method created in the previous step. After this method has been called,
determine whether the student answered the question correctly, and display the
appropriate message.

e) Displaying a random message. Add a procedure GenerateOutput that displays a
random message congratulating the student for answering correctly. This method
should be called if the student answered the question correctly.

f) Running the application. Select Debug > Start to run your application. Enter sev-
eral correct answers and at least one incorrect answer. Verify that No. Please try
again is displayed when you are incorrect, and one of the other responses is dis-
played at random when you are correct.

g) Closing the application. Close your running application by clicking its close box.

h) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

▲

1 ' Exercise 16.16 Solution
2 ' MultiplicationTeacher.vb
3
4 Public Class FrmMultiplicationTeacher
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' create new random object

10    Dim m_objRandomObject As Random = New Random
11
12    ' random numbers for questions
13    Dim m_intRandomNumber1 As Integer
14    Dim m_intRandomNumber2 As Integer
15    Dim m_strQuestion As String ' String for the question being asked
16    Dim m_intCorrectAnswer As Integer ' correct answer to question
17
18    ' handles load event for FrmMultiplicationTeacher
19    Private Sub FrmMultiplicationTeacher_Load(ByVal sender As _
20       System.Object, ByVal e As System.EventArgs) _
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21       Handles MyBase.Load
22
23       GenerateQuestion() ' generate a question
24    End Sub ' FrmMultiplicationTeacher_Load
25
26    ' handles click event for btnSubmit Button
27    Private Sub btnSubmit_Click(ByVal sender As _
28       System.Object, ByVal e As System.EventArgs) _
29       Handles btnSubmit.Click
30
31       ' retrieve user’s answer
32       Dim intAnswer As Integer = Convert.ToInt32(Val(txtAnswer.Text))
33
34       txtAnswer.Clear() ' clear the TextBox
35
36       ' check if user answer is correct
37       If intAnswer = m_intCorrectAnswer Then
38          GenerateOutput() ' display correct message
39          GenerateQuestion() ' create another question
40
41       Else ' answer was wrong, try again
42          lblResponse.Text = "No. Please try again."
43       End If
44
45    End Sub ' btnSubmit_Click
46
47    ' generates a new question
48    Sub GenerateQuestion()
49
50       ' create two random numbers
51       m_intRandomNumber1 = m_objRandomObject.Next(0, 10)
52       m_intRandomNumber2 = m_objRandomObject.Next(0, 10)
53
54       ' record the correct answer
55       m_intCorrectAnswer = m_intRandomNumber1 * m_intRandomNumber2
56
57       ' construct the question
58       m_strQuestion = "How much is " & _
59          m_intRandomNumber1.ToString() & " times " & _
60          m_intRandomNumber2.ToString() & "?"
61
62       ' display the question
63       lblQuestion.Text = m_strQuestion
64    End Sub ' GenerateQuestion
65
66    ' generates correct message
67    Sub GenerateOutput()
68       Dim intNumber As Integer = m_objRandomObject.Next(0, 3)
69
70       ' show random message
71       Select Case intNumber
72
73          Case 0
74             lblResponse.Text = "Very Good!"
75
76          Case 1
77             lblResponse.Text = "Excellent!"
78
79          Case 2
80             lblResponse.Text = "Great Job!"
81
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82       End Select
83
84    End Sub ' GenerateOutput
85
86 End Class ' FrmMultiplicationTeacher



173

T U T O R I A L

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

17
Flag Quiz Application 
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Instructor’s Manual
Exercise Solutions

Tutorial 17

MULTIPLE-CHOICE
QUESTIONS

17.1 Arrays can be declared to hold values of .

17.2 The elements of an array are related by the fact that they have the same name and
.

17.3 Method  returns the largest index in the array.

17.4 The first element in every array is the .

17.5 Arrays .

17.6 The initializer list can .

17.7 Which method call sorts array strWords in ascending order? 

17.8 The ComboBox control combines a TextBox with a  control.

17.9 To search for a period (.) in a String called strTest, call method .

17.10 Property  contains the size of an array. 

Answers: 17.1) d.  17.2) c.  17.3) a.  17.4) b.  17.5) d.  17.6) d.  17.7) a. 17.8) b.  17.9) c.  17.10) c. 

EXERCISES 17.11 (Enhanced Flag Quiz Application) Enhance the Flag Quiz application by counting
the number of questions that were answered correctly (Fig. 17.31). After all the questions
have been answered, display a message in a Label that describes how well the user per-
formed. The following table shows which messages to display:

a) type Double b) type Integer
c) type String d) any data type

a) constant value b) subscript
c) type d) value

a) GetUpperBound b) GetUpperLimit 
c) GetLargestIndex d) GetUpperSubscript 

a) subscript b) zeroth element
c) length of the array d) smallest value in the array

a) are controls b) always have one dimension 
c) keep data in sorted order at all times d) are objects 

a) be used to determine the size of the array
b) contain a comma-separated list of initial values for the array elements
c) be empty d) All of the above.

a) Array.Sort(strWords) b) strWords.SortArray() 
c) Array.Sort(strWords, 1) d) Sort(strWords) 

a) DateTimePicker b) ListBox 
c) NumericUpDown d) Label 

a) String.Search(strTest, ".") b) String.IndexOf(strTest, ".") 
c) strTest.IndexOf(".") d) strTest.Search(".") 

a) Elements b) ArraySize 
c) Length d) Size 

Number of correct answers Message

5 Excellent!
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Figure 17.31 Enhanced Flag Quiz application’s GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial17\Exercises\FlagQuiz2 directory to your C:\SimplyVB directory.

b) Opening the application’s template file. Double click FlagQuiz.sln in the
FlagQuiz2 directory to open the application.

c) Adding a variable to count the number of correct answers. Add an instance variable
m_intNumberCorrect, and initialize it to 0. You will use this variable to count the
number of correct answers submitted by the user.

d) Counting the correct answers. Increment m_intNumberCorrect in the Submit But-
ton’s event handler whenever the submitted answer is correct.

e) Displaying the message. Write a procedure DisplayMessage that displays a message
in lblScore depending on the value of m_intNumberCorrect. Call this procedure
from the Submit Button’s event handler when the quiz is completed. 

f) Running the application. Select Debug > Start to run your application. The finished
application should behave as in Fig. 17.31. Run the application a few times, enter a
different number of correct answers each time to verify that the correct feedback is
displayed.

g) Closing the application. Close your running application by clicking its close box.

h) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

4 Very good

3 Good

2 Poor

1 or 0 Fail

1 ' Exercise 17.11 Solution
2 ' FlagQuiz.vb
3
4 Public Class FrmFlagQuiz
5    Inherits System.Windows.Forms.Form
6
7    ' String array stores country names
8    Dim m_strOptions As String() = New String() { _     
9       "Russia", "China", "United States", "Italy", _ 

10       "Australia", "South Africa", "Brazil", "Spain"}
11
12    ' Boolean array tracks displayed flags
13    Dim m_blnUsed As Boolean() = _                                           
14       New Boolean(m_strOptions.GetUpperBound(0)) {}
15
16    Dim m_intCount As Integer = 1  ' number of flags shown
17    Dim m_strCountry As String     ' current flag’s country
18
19    Dim m_intNumberCorrect As Integer = 0 
20
21    ' Windows Form Designer generated code
22
23    ' handles Flag Quiz Form’s Load event
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24    Private Sub FrmFlagQuiz_Load(ByVal sender As System.Object, _
25       ByVal e As System.EventArgs) Handles MyBase.Load
26
27       Array.Sort(m_strOptions)  ' alphabetize country names  
28
29       ' display country names in ComboBox
30       cboOptions.DataSource = m_strOptions 
31
32       DisplayFlag()  ' display first flag in PictureBox
33    End Sub ' FrmFlagQuiz_Load
34
35    ' return full path name of image file as a String
36    Function BuildPathName() As String
37
38       ' begin with country name
39       Dim strOutput As String = m_strCountry
40
41       ' locate space character if there is one
42       Dim intSpace As Integer = strOutput.IndexOf(“ “)
43
44       ' remove space from country name if there is one
45       If intSpace > 0 Then
46          strOutput = strOutput.Remove(intSpace, 1)
47       End If
48
49       strOutput = strOutput.ToLower() ' make characters lowercase
50       strOutput &= ".png" ' add file extension
51
52       ' add path name
53       strOutput = strOutput.Insert(0, _                   
54          System.Environment.CurrentDirectory & "\images\")
55
56       Return strOutput  ' return full path name
57    End Function ' BuildPathName
58
59    ' return an unused random number
60    Function GetUniqueRandomNumber() As Integer
61
62       Dim objRandom As Random = New Random()
63       Dim intRandom As Integer
64
65       ' generate random numbers until unused flag is found
66       Do
67          intRandom = objRandom.Next(0, m_blnUsed.Length)
68       Loop Until m_blnUsed(intRandom) = False
69
70       ' indicate that flag has been used
71       m_blnUsed(intRandom) = True 
72
73       Return intRandom  ' return index for new flag
74    End Function ' GetUniqueRandomNumber
75
76    ' display random flag in PictureBox
77    Sub DisplayFlag()
78
79       ' unique index ensures that a flag is used no more than once
80       Dim intRandom As Integer = GetUniqueRandomNumber()
81
82       ' retrieve country name from array m_strOptions
83       m_strCountry = m_strOptions(intRandom)
84
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85       ' get image’s full path name
86       Dim strPath As String = BuildPathName()
87       picFlag.Image = Image.FromFile(strPath) ' display image
88    End Sub ' DisplayFlag
89
90    ' handles Submit Button’s Click event
91    Private Sub btnSubmit_Click(ByVal sender As System.Object, _
92       ByVal e As System.EventArgs) Handles btnSubmit.Click
93
94       ' retrieve answer from ComboBox
95       Dim strResponse As String = _
96          Convert.ToString(cboOptions.SelectedValue)
97
98       ' verify answer
99       If strResponse = m_strCountry Then
100          lblFeedback.Text = "Correct!"
101          m_intNumberCorrect += 1  ' update correct answers counter
102       Else
103          lblFeedback.Text = "Sorry, incorrect."
104       End If
105
106       ' inform user if quiz is over
107       If m_intCount >= 5 Then  ' quiz is over 
108          lblFeedback.Text &= "   Done!"
109          btnNext.Enabled = False
110          btnSubmit.Enabled = False
111          cboOptions.Enabled = False
112
113          DisplayScore()
114       Else  ' quiz is not over 
115          btnSubmit.Enabled = False
116          btnNext.Enabled = True
117       End If
118
119    End Sub ' btnSubmit_Click
120
121    ' handles Next Flag Button’s Click event
122    Private Sub btnNext_Click(ByVal sender As System.Object, _
123       ByVal e As System.EventArgs) Handles btnNext.Click
124
125       DisplayFlag()  ' display next flag
126       lblFeedback.Text = ""  ' clear output
127
128       ' change selected country to first in ComboBox
129       cboOptions.SelectedIndex = 0 
130
131       m_intCount += 1  ' update number of flags shown
132
133       btnSubmit.Enabled = True
134       btnNext.Enabled = False
135    End Sub ' btnNext_Click
136
137    ' displays message about number of correct answers
138    Sub DisplayScore()
139
140       Select Case m_intNumberCorrect
141
142          Case 5
143             lblScore.Text = "Excellent"
144
145          Case 4
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17.12 (Salary Survey Application) Use a one-dimensional array to solve the following
problem: A company pays its salespeople on a commission basis. The salespeople receive
$200 per week, plus 9% of their gross sales for that week. For example, a salesperson who
grosses $5000 in sales in a week receives $200 plus 9% of $5000, a total of $650. Write an
application (using an array of counters) that determines how many of the salespeople earned
salaries in each of the following ranges (assuming that each salesperson’s salary is truncated
to an integer amount): $200–$299, $300–$399, $400–$499, $500–$599, $600–$699, $700–$799,
$800–$899, $900–$999 and over $999.

Allow the user to enter the sales for each employee in a TextBox. The user should click
the Calculate Button to calculate that salesperson’s salary. When the user is done entering
this information, clicking the Show Totals Button should display how many of the salespeo-
ple earned salaries in each of the above ranges. The finished application should behave like
Fig. 17.32.

Figure 17.32 Salary Survey GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial17\Exercises\SalarySurvey directory to your C:\SimplyVB direc-
tory.

b) Opening the application’s template file. Double click SalarySurvey.sln in the
SalarySurvey directory to open the application.

c) Creating an array of salary ranges. Create a String array, and initialize it to contain
the salary ranges (the Strings displayed in the ListBox’s first column).

d) Create an array that represents the number of salaries in each range. Create an
empty Decimal array to store the number of employees who earn salaries in each
range.

146             lblScore.Text = "Very good"
147
148          Case 3
149             lblScore.Text = "Good"
150
151          Case 2
152             lblScore.Text = "Poor"
153
154          Case Else
155             lblScore.Text = "Fail"
156
157       End Select
158
159    End Sub ' DisplayScore
160
161 End Class ' FrmFlagQuiz
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e) Creating an event handler for the Calculate Button. Write event handler
btnCalculate_Click. Obtain the user input from the Enter sales: TextBox. Calcu-
late the commission due to the employee and add that amount to the base salary.
Increment the element in array decSalaries that corresponds to the employee’s sal-
ary range. This event handler should also display the employee’s salary in the Total
salary: Label.

f) Writing an event handler for the Show Totals Button. Create event handler
btnShowTotals_Click to display the salary distribution in the ListBox. Use a
For…Next statement to display the range (an element in strSalaryRanges) and the
number of employees whose salary falls in that range (an element in decSalaries).

g) Running the application. Select Debug > Start to run your application. Enter sev-
eral sales amounts using the Calculate Button. Click the Show Totals Button and
verify that the proper amounts are displayed for each salary range, based on the sala-
ries calculate from your input.

h) Closing the application. Close your running application by clicking its close box.

i) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 17.12 Solution
2 ' SalarySurvey.vb
3
4 Public Class FrmSalarySurvey
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' salary ranges

10    Dim m_strSalaryRanges As String() = New String() { _
11       “$200 - $299”, “$300 - $399”, “$400 - $499”, _
12       “$500 - $599”, “$600 - $699”, “$700 - $799”, _
13       “$800 - $899”, “$900 - $999”, “$1000 +  “}
14
15    ' number of employees in each salary range
16    Dim m_intSalaries As Integer() = New Integer( _
17       m_strSalaryRanges.GetUpperBound(0)) {}
18
19    ' handles Calculate Button’s Click event
20    Private Sub btnCalculate_Click(ByVal sender As System.Object, _
21       ByVal e As System.EventArgs) Handles btnCalculate.Click
22
23       ' obtain total sales
24       Dim decSales As Decimal = Convert.ToDecimal( _
25          Val(txtInputSales.Text))
26
27       ' employee’s base salary
28       Dim decTotalSalary As Decimal = 200
29
30       ' add commission to total salary
31       decTotalSalary += Convert.ToDecimal(decSales * 0.09)
32
33       ' display salary in a Label
34       lblTotalSalary.Text = String.Format(“{0:C}”, decTotalSalary)
35
36       ' increment the correct counter in array intSalaries
37       Select Case decTotalSalary
38
39          Case Is < 300
40             m_intSalaries(0) += 1
41
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17.13 (Cafeteria Survey Application) Twenty students were asked to rate, on the scale
from 1 to 10, the quality of the food in the student cafeteria, with 1 being “awful” and 10
being “excellent.” Allow the user input to be entered using a ComboBox. Place the 20
responses in an Integer array, and determine the frequency of each rating. Display the fre-
quencies as a histogram in a multiline, scrollable TextBox. Figure 17.33 demonstrates the
completed application.

42          Case Is < 400
43             m_intSalaries(1) += 1
44
45          Case Is < 500
46             m_intSalaries(2) += 1
47
48          Case Is < 600
49             m_intSalaries(3) += 1
50
51          Case Is < 700
52             m_intSalaries(4) += 1
53
54          Case Is < 800
55             m_intSalaries(5) += 1
56
57          Case Is < 900
58             m_intSalaries(6) += 1
59
60          Case Is < 1000
61             m_intSalaries(7) += 1
62
63          Case Is >= 1000
64             m_intSalaries(8) += 1
65
66       End Select
67
68       txtInputSales.Clear()  ' clear TextBox
69    End Sub ' btnCalculate_Click
70
71    ' handles click event for btnShowTotals Button
72    Private Sub btnShowTotals_Click(ByVal sender As System.Object, _
73       ByVal e As System.EventArgs) Handles btnShowTotals.Click
74       
75       Dim intIndex As Integer = 0  ‘ counter
76
77       ' clear all items in the ListBox
78       lstSalaryTotals.Items.Clear()
79
80       ' add header to ListBox
81       lstSalaryTotals.Items.Add(“Salary range:” & _
82          ControlChars.Tab & “Total:”)
83
84       ' displays total for each salary range
85       For intIndex = 0 To m_strSalaryRanges.GetUpperBound(0)
86          lstSalaryTotals.Items.Add(m_strSalaryRanges(intIndex) & _
87             ControlChars.Tab & m_intSalaries(intIndex))
88       Next
89
90    End Sub ' btnShowTotals_Click
91
92 End Class ' FrmSalarySurvey
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Figure 17.33 Cafeteria Survey GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial17\Exercises\CafeteriaSurvey directory to your C:\SimplyVB
directory.

b) Opening the application’s template file. Double click CafeteriaSurvey.sln in the
CafeteriaSurvey directory.

c) Creating an array of the possible ratings. Create an array of 10 consecutive integers,
called m_intChoices to contain the integers in the range 1–10, inclusive.

d) Adding a ComboBox. Add a ComboBox to the GUI as in Fig. 17.33. The ComboBox will
display the possible ratings. Set property DropDownStyle to DropDownList.

e) Displaying the possible ratings when the application starts. Write the event handler
for the Load event so that the DataSource of the ComboBox is set to intChoices
when the application starts.

f) Creating an array to store the responses. Create an Integer array of length 11
named m_intResponses. This will be used to store the number of responses in each
of the 10 categories (element 0 will not be used).

g) Counting the number of responses. Create an Integer variable named
m_intResponseCounter to keep track of how many responses have been input.

h) Storing the responses. Write the event handler btnSubmit_Click to increment
m_intResponseCounter. Store the response in array m_intResponses. Call proce-
dure DisplayHistogram to display the results.

i) Creating procedure DisplayHistogram. Add a header to the TextBox. Use nested
For…Next loops to display the ratings in the first column. The second column uses
asterisks to indicate how many students surveyed submitted the corresponding rat-
ing.

j) Running the application. Select Debug > Start to run your application. Enter 20
responses using the Submit Rating Button. Verify that the resulting histogram dis-
plays the responses entered.

k) Closing the application. Close your running application by clicking its close box.

l) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 17.13 Solution
2 ' CafeteriaSurvey.vb
3
4 Public Class FrmCafeteriaSurvey
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' possible answers

10    Dim m_intChoices As Integer() = { _
11       1, 2, 3, 4, 5, 6, 7, 8, 9, 10}
12
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13    ' counter for number of responses
14    Dim m_intResponseCounter As Integer = 0
15
16    ' array to keep track of all responses
17    Dim m_intResponses As Integer() = New Integer(11) {}
18
19    ' handles Submit Rating Button’s Click event
20    Private Sub btnSubmit_Click(ByVal sender As System.Object, _
21       ByVal e As System.EventArgs) Handles btnSubmit.Click
22
23       ' retrieve user input
24       Dim intResponse As Integer = _
25          Convert.ToInt32(cboInput.SelectedItem)
26
27       If m_intResponseCounter < 20 Then
28          m_intResponses(intResponse) += 1
29       End If
30
31       m_intResponseCounter += 1
32
33       If m_intResponseCounter = 20 Then
34
35          ' disable btnSubmit Button so no more 
36          ' responses can be entered
37          btnSubmit.Enabled = False
38
39          DisplayHistogram()
40       End If
41
42    End Sub ' btnSubmit_Click
43
44    ' handles Cafeteria Survey Form’s Load event
45    Private Sub FrmCafeteriaSurvey_Load(ByVal sender As  _
46       System.Object, ByVal e As System.EventArgs) Handles MyBase.Load
47
48       cboInput.DataSource = m_intChoices
49    End Sub ' FrmCafeteriaSurvey_Load
50
51    ' displays histogram
52    Sub DisplayHistogram()
53
54       ' construct output String with the frequencies as a histogram
55       Dim strOutput As String = "Rating" & ControlChars.Tab & _
56          "Frequency" & ControlChars.CrLf
57
58       Dim intRatings As Integer
59       Dim intCounter As Integer
60
61       ' add entry to TextBox for each rating
62       For intRatings = 1 To 10
63
64          strOutput &= (intRatings.ToString & ControlChars.Tab)
65
66          ' display asterisk for each user who gave this rating
67          For intCounter = 1 To m_intResponses(intRatings)
68             strOutput &= “*”
69          Next
70
71          strOutput &= ControlChars.CrLf
72       Next
73
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What does this code do? 17.14 This procedure declares intNumbers as its parameter. What does it return?

Answer: This procedure takes the contents of parameter intNumbers and reverses the order 
of its contents, returning the reversed array to the caller.

What’s wrong with this code? 17.15 The code that follows uses a For…Next loop to sum the elements in an array. Find the
error(s) in the following code:

Answer: Array intNumbers does have intNumbers.Length number of elements, but the 
indices are zero through intNumbers.Length – 1. The For…Next loop increments 
intCounter beyond the highest index in the array which results in a run-time error. The cor-
rect code is as follows:

74       txtOutput.Text = strOutput  ' display results in TextBox
75    End Sub ' DisplayHistogram
76
77 End Class ' FrmHistogram

▲

1 Function Mystery(ByVal intNumbers As Integer()) As Integer()
2
3    Dim intI As Integer
4    Dim intLength As Integer = intNumbers.Length - 1
5    Dim intTempArray As Integer() = _
6       New Integer(intLength) {}
7
8    For intI = intLength To 0 Step -1
9       intTempArray(intLength - intI) = intNumbers(intI)

10    Next
11
12    Return intTempArray
13 End Function ' Mystery

▲
1 Sub SumArray()
2
3    Dim intSum As Integer
4    Dim intCounter As Integer
5    Dim intNumbers As Integer() = _
6       New Integer() {1, 2, 3, 4, 5, 6, 7, 8}
7
8    For intCounter = 0 To intNumbers.Length
9       intSum += intNumbers(intCounter)

10    Next
11
12 End Sub ' SumArray

1 Sub SumArray()
2    Dim intSum As Integer
3    Dim intCounter As Integer
4    Dim intNumbers As Integer() = _
5       New Integer() {1, 2, 3, 4, 5, 6, 7, 8}
6
7    
8       intSum += intNumbers(intCounter)
9    Next

10
11 End Sub ' SumArray

For intCounter = 0 To intNumbers.GetUpperBound(0)
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Programming Challenge 17.16 (Road Sign Test Application) Write an application that will test the user’s knowledge
of road signs. Your application should display a random sign image and ask the user to select
the sign name from a ComboBox. This application should look like Fig. 17.34. Hint: The appli-
cation is similar to the Flag Quiz application. You can find the images in C:\Exam-
ples\Tutorial17\Exercises\images. Remember to set Option Strict to On.

Figure 17.34 Road Sign Test GUI.

Answer:

▲

1 ' Exercise 17.16 Solution
2 ' RoadSignTest.vb
3
4 Public Class FrmRoadSignTest
5    Inherits System.Windows.Forms.Form
6
7    ' String array stores sign names
8    Dim m_strOptions As String() = New String() { _
9       "Do Not Enter", "Narrow bridge", "No bicycles", _

10       "No left turn", "No Pedestrians", "No U-turn", _
11       "Road Narrows", "Stop", "Stop sign ahead", _
12       "Traffic signals ahead", "Winding road ahead", _
13       "Yield"}
14
15    ' Boolean array tracks displayed signs
16    Dim m_blnUsed As Boolean() = _
17       New Boolean(m_strOptions.GetUpperBound(0) {}
18
19    Dim m_intCount As Integer = 1 ' number of signs shown
20    Dim m_intCorrectAnswer As Integer ' index of current sign
21
22    ' Windows Form Designer generated code
23
24    ' handles Road Sign Test Form’s Load event
25    Private Sub FrmRoadSignTest_Load(ByVal sender As System.Object, _
26       ByVal e As System.EventArgs) Handles MyBase.Load
27
28       Array.Sort(m_strOptions)  ' alphabetize sign names
29
30       ' display sign names in ComboBox
31       cboOptions.DataSource = m_strOptions
32
33       DisplaySign()  ' display first sign in PictureBox
34    End Sub ' FrmRoadSignTest_Load
35
36    ' return full path name of image file as a String
37    Function BuildPathName() As String
38
39       ' return full path name
40       Return System.Environment.CurrentDirectory & _
41          "\images\sign" & m_intCorrectAnswer & ".png"
42    End Function ' BuildPathName
43
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44    ' return an unused random number
45    Function GetUniqueRandomNumber() As Integer
46       Dim objRandom As Random = New Random()
47       Dim intRandom As Integer
48
49       ' generate random numbers until unused sign is found
50       Do
51          intRandom = objRandom.Next(0, m_blnUsed.Length)
52       Loop Until m_blnUsed(intRandom) = False
53
54       ' indicate that sign has been used
55       m_blnUsed(intRandom) = True
56
57       Return intRandom  ' return index for new sign
58    End Function ' GetUniqueRandomNumber
59
60    ' display random sign in PictureBox
61    Sub DisplaySign()
62
63       ' unique index ensures that a sign is used no more than once
64       m_intCorrectAnswer = GetUniqueRandomNumber()
65
66       ' get image’s full path name
67       Dim strPath As String = BuildPathName()
68
69       picSign.Image = Image.FromFile(strPath)  ' display image
70    End Sub ' DisplaySign
71
72    ' handles Submit Button’s Click event
73    Private Sub btnSubmit_Click(ByVal sender As System.Object, _
74       ByVal e As System.EventArgs) Handles btnSubmit.Click
75
76       ' retrieve answer from ComboBox
77       Dim strResponse As String = _ 
78          Convert.ToString(cboOptions.SelectedValue)
79
80       ' verify answer
81       If strResponse = m_strOptions(m_intCorrectAnswer) Then
82          lblFeedback.Text = "Correct!"
83       Else
84          lblFeedback.Text = "Incorrect."
85       End If
86
87       ' inform user if test is over
88       If m_intCount >= 5 Then  ' test is over
89          lblFeedback.Text &= "   Done!"
90          btnNext.Enabled = False
91          btnSubmit.Enabled = False
92          cboOptions.Enabled = False
93       Else  ' test is not over
94          btnSubmit.Enabled = False
95          btnNext.Enabled = True
96       End If
97
98    End Sub ' btnSubmit_Click
99
100    ' handles Next Sign Button’s Click event
101    Private Sub btnNext_Click(ByVal sender As System.Object, _
102       ByVal e As System.EventArgs) Handles btnNext.Click
103
104       DisplaySign()  ' display next sign
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105       lblFeedback.Text = ""  ' clear output
106
107       ' change selected sign to first in ComboBox
108       cboOptions.SelectedIndex = 0
109
110       m_intCount += 1  ' update number of signs shown
111
112       btnSubmit.Enabled = True
113       btnNext.Enabled = False
114    End Sub ' btnNext_Click
115
116 End Class ' FrmRoadSignTest
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18
Sales Data Application 
Introducing Two-Dimensional Arrays, 
RadioButtons and the MSChart 

Control
Solutions
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Instructor’s Manual
Exercise Solutions

Tutorial 18

MULTIPLE-CHOICE
QUESTIONS

18.1 RadioButton controls should be prefixed with .

18.2 A two-dimensional array in which each row contains the same number of columns is
called a  array.

18.3 In an m-by-n array, the m stands for .

18.4 The statement  assigns an array of three columns and five rows to two-
dimensional Integer array intArray.

18.5 To change the MSChart graph’s title size, use the  tab of the MSChart Prop-
erties dialog.

18.6 Use a  to group RadioButtons on the Form.

18.7 Use the  tab of the MSChart Properties dialog to access properties to
include a border around your chart.

18.8 A point of height is approximately equal to .

18.9 The Chart Type GroupBox of the MSChart control’s Properties dialog is located in the
 tab.

18.10 The Fonts tab of the MSChart control’s Properties dialog allows you to change the
font .

Answers: 18.1) a.  18.2) b.  18.3) c.  18.4) b.  18.5) c.  18.6) a.  18.7) b. 18.8) a. 18.9) a. 18.10) d.

EXERCISES 18.11 (Stock Price Application) It is often useful to track a company’s stock price over
time by using a line graph. You will learn to create a line graph by using an MSChart control
in this exercise. Create an application that allows users to enter values for a company’s stock

a) rad b) rbn 
c) btn d) radbtn 

a) data b) rectangular
c) tabular d) All of the above.

a) the number of columns in the array b) the total number of array elements
c) the number of rows in the array d) the number of elements in each row

a) intArray = New Integer(5, 3) b) intArray = New Integer(4, 2) 
c) intArray = New Integer(4, 3) d) intArray = New Integer(5, 2) 

a) Size b) Title 
c) Fonts d) Font Size 

a) GroupBox control b) ComboBox control 
c) ListBox control d) None of the above. 

a) Border b) Backdrop 
c) BorderStyle d) Background 

a) 1/72"  b) 1" 
c) 1/4" d) 1/36" 

a) Chart  b) Graph 
c) Series d) ChartType 

a) Style  b) Width 
c) Color d) All of the above.
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price at the end of six consecutive quarters and graph that data, using an MSChart control
(Fig. 18.23).

Figure 18.23 Stock Price application GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial18\Exercises\StockPrice directory to your C:\SimplyVB direc-
tory. 

b) Opening the application’s template file. Double click StockPrice.sln in the
StockPrice directory to open the application. 

c) Changing the graph type and color. To change the graph type and color, click the
chart in Design View and select the ActiveX -Properties hyperlink from the Proper-
ties window to display the Properties dialog. In the Chart tab’s Chart Type Group-
Box, select Line (if it is not already selected), and make sure the RadioButton is set
to 2D. Click the Series Color tab, and, in the Edge/Line GroupBox, change the color
to red (if this color is not already selected).

d) Inserting code in the Graph Button’s Click event handler. Double click the Graph
Button in Design view to generate the Graph Button Click event handler. Insert an
If…Then statement that verifies that the user entered a stock name. If the value in
the TextBox is the empty string, the application should display a message dialog.

e) Checking the remaining NumericUpDowns. For the chart to function properly, the
user must enter values in all NumericUpDowns. Add If…ElseIf…Else statements to
verify that there is a value greater than zero in each NumericUpDown (using the Value
property), and display an error message in a MessageBox if any values are missing
(contain the zero). 

f) Calculating the average. Calculate the average of all of the values from the Numeri-
cUpDowns, and output the result in the output Label lblAverage. 

g) Inserting data into an array. Create a 6-by-2 array from the data that will display the
week number on the x-axis and prices on the y-axis. (The week number should be in
the first column, and the stock price should be in the second column.) Use the
NumericUpDown’s Text property to retrieve the value stored in the control as a
String.

h) Displaying the chart. Assign the array to the ChartData property to display the data
in the array. Remember to set Label lblMessage’s Visible property to False and
set the MSChart control’s Visible property to True. A control’s Visible property
determines if the control is displayed on the Form (True) or hidden (False).

i) Running the application. Select Debug > Start to run your application. Enter the
name of a stock, and the stock’s price for each week. Click the Graph Button. Verify
that the average displayed is correct, and that the graph displayed shows the proper
data. Also, make sure your graph’s labels appear as in Fig. 18.23.

j) Closing the application. Close your running application by clicking its close box.

k) Closing the IDE. Close Visual Studio .NET by clicking its close box.
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Answer:

1 ' Exercise 18.11 Solution
2 ' StockPrice.vb
3
4 Public Class FrmStockPrice
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    Private Sub btnGraph_Click(ByVal sender As _

10       System.Object, ByVal e As System.EventArgs) _
11       Handles btnGraph.Click
12
13       ' declaring two-dimensional array
14       Dim strPrice(,) As String = New String(5, 1) {}
15       Dim dblAverage As Double = 0 ' average stock price
16       Dim intCounter As Integer = 0 ' missing stock price counter
17
18       ' if stock name is missing
19       If txtStockName.Text = "" Then
20          MessageBox.Show("Stock name is required", _
21             "Stock Name Missing", MessageBoxButtons.OK, _
22             MessageBoxIcon.Error)
23
24       ' if stock prices were missing
25       ElseIf updFirst.Value = 0 OrElse updSecond.Value = 0  
26          OrElse updThird.Value = 0 OrElse updFourth.Value = 0
27          OrElse updFifth.Value = 0 OrElse updSixth.Value = 0 Then
28
29          MessageBox.Show("Please fill in all weekly values", _
30             "Missing Price", MessageBoxButtons.OK, _
31             MessageBoxIcon.Exclamation)
32       Else
33          lblMessage.Visible = False
34          chStock.Visible = True
35
36          ' calculate average
37          dblAverage = (updFirst.Value + updSecond.Value + _
38             updThird.Value + updFourth.Value + _
39             updFifth.Value + updSixth.Value) / 6
40
41          ' output average price
42          lblAverage.Text = String.Format("{0:F}", dblAverage)
43
44          ' put all data in a two-dimensional array
45          strPrice = New String(,) {{"Week 1", txtFirst.Text}, _
46             {"Week 2", txtSecond.Text}, _
47             {"Week 3", txtThird.Text}, _
48             {"Week 4", txtFourth.Text}, _
49             {"Week 5", txtFifth.Text}, _
50             {"Week 6", txtSixth.Text}}
51
52          ' bind data to chart
53          chStock.ChartData = strPrice
54
55       End If
56
57    End Sub ' btnGraph_Click
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18.12 (Enhanced Lottery Picker) A lottery commission offers four different lottery games
to play: three-number, four-number, five-number and five-number + 1 lotteries. In
Tutorial 16, your Lottery Picker application could select duplicate numbers for each lottery.
In this exercise, you enhance the Lottery Picker to prevent duplicate numbers for the five-
number and five-number + 1 lotteries (Fig. 18.24). According to this new requirement the
games are now played as follows:

■ Three-number lotteries require players to choose three numbers in the range
of 0–9.

■ Four-number lotteries require players to choose four numbers, in the range of
0–9.

■ Five-number lotteries require players to choose five unique numbers in the
range of 1–39.

■ Five-number + 1 lotteries require players to choose five unique numbers in
the range of 1–49 and an additional unique number in the range of 1–42.

Figure 18.24 Enhanced Lottery Numbers Picker application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial18\Exercises\EnhancedLotteryPicker directory to your C:\Sim-
plyVB directory. 

b) Opening the application’s template file. Double click EnhancedLotteryP-
icker.sln in the EnhancedLotteryPicker directory to open the application.

c) Declaring a two-dimensional array to maintain unique random numbers. Declare
an instance variable m_blnNumbers that stores a 2-by-50 Boolean array. You will use
this array later in this exercise to test whether a lottery number has already been cho-
sen.

d) Initializing the array. Each time the user clicks the Generate Button, the applica-
tion should initialize the array by declaring its rows and setting the initial values.
Write a ClearArray procedure that uses a For…Next statement to assign each value
in the m_blnNumbers array to False.

e) Modifying the Generate Function procedure. You will modify the Generate Func-
tion procedure to use the Boolean array to pick unique random numbers. Begin by
writing a statement that generates a random number and assigns its value to an
Integer variable intNumber.

f) Determining whether the random number has already been selected. Use an
If…Then statement to determine whether the maximum lottery number is less than
40. (This happens when the upper limit on the random number equals 40.) In this
case, you will examine the first row of the array. To maintain unique numbers, you
will set the value of the element in that row whose index equals the random number
to True (indicating that it has been picked). For example, if the random number 34
has been picked, blnNumbers(0)(34) would contain the value True. To test whether
a number has been picked, use a Do While…Loop statement inside the If…Then
statement to access that element of the array. If the array element’s value is True, use
the body of the loop to assign a new random number to intNumber. If the value in
the array is False, use the condition in the Do While…Loop header to ignore the

58
59 End Class ' FrmStockPrice
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body of the loop. Just outside the Do While…Loop, include a statement that modifies
the array to indicate that the number has now been picked.

g) Completing the application. Use a second If…Then statement to determine
whether the maximum lottery number is greater than 40. In this case, you will exam-
ine the second row of the array. Repeat the process in the previous step. Remember
to return the value stored in intNumber at the end of the Generate Function
procedure.

h) Running the application. Select Debug > Start to run your application. Click the
Generate Button and verify that the values displayed fall into the ranges specified in
the exercise’s description.

i) Closing the application. Close your running application by clicking its close box.

j) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:
.

1 ' Exercise 18.12 Solution
2 ' LotteryPicker.vb
3
4 Public Class FrmLotteryPicker
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    Dim m_objRandom As Random = New Random  ' create Random object

10
11    ' declare new array to store chosen lottery numbers
12    Dim m_blnNumbers As Boolean(,) = New Boolean(1, 49) {}
13
14    ' display random lottery numbers
15    Private Sub btnGenerate_Click(ByVal sender As _
16       System.Object, ByVal e As System.EventArgs) _
17       Handles btnGenerate.Click
18
19       ClearArray() ' clear array values
20
21       ' generate three numbers
22       lblOutput3.Text = Generate(0, 10) & " " & _
23          Generate(0, 10) & " " & Generate(0, 10)
24
25       ' generate four numbers
26       lblOutput4.Text = Generate(0, 10) & " " & _
27          Generate(0, 10) & " " & Generate(0, 10) & " " _
28          & Generate(0, 10)
29
30       ' generate five numbers
31       lblOutput5.Text = Generate(1, 40) & " " & _
32          Generate(1, 40) & " " & Generate(1, 40) & _
33          " " & Generate(1, 40) & " " & Generate(1, 40)
34
35       ' generate five plus one numbers
36       lblOutput5Plus1.Text = Generate(1, 50) & " " & _
37          Generate(1, 50) & " " & Generate(1, 50) & " " & _
38          Generate(1, 50) & " " & Generate(1, 50)
39
40       lblOutputExtra1.Text = Generate(1, 43) ' generate extra numbers
41    End Sub ' btnGenerate_Click
42
43    ' generate random numbers
44    Function Generate(ByVal intLow As Integer, _
45       ByVal intHigh As Integer) As String
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18.13 (Student Grades Application) A teacher needs an application that computes each
student’s grade average (on a scale of 0 to 100 points) and the class average for ten students.
The application should add a student’s name and test average (separated by a tab character)
to a ListBox and calculate the class grade average each time the user clicks the Submit
Grades Button (Fig. 18.25). The Submit Grades Button should be disabled after ten stu-
dents’ grades have been entered.

46
47       ' generate random number with given boundaries
48       Dim intNumber As Integer = _
49          m_objRandom.Next(intLow, intHigh)
50
51       ' use first row for five-number lottery
52       If intHigh = 40 Then
53
54          ' select new random number
55          Do While m_blnNumbers(0, intNumber) = True
56             intNumber = m_objRandom.Next(intLow, intHigh)
57          Loop
58
59          m_blnNumbers(0, intNumber) = True ' mark number as used
60       End If
61
62       ' use second row for five-number + 1 lottery
63       If intHigh > 40 Then
64
65          ' select another random number that is not used
66          Do While m_blnNumbers(1, intNumber) = True
67             intNumber = m_objRandom.Next(intLow, intHigh)
68          Loop
69
70          m_blnNumbers(1, intNumber) = True ' mark number as used
71       End If
72
73       Return String.Format("{0:D2}", intNumber)
74    End Function ' Generate
75
76    ' assigns all values in array to False
77    Sub ClearArray()
78
79       Dim intI As Integer = 0
80
81       ' assign all row 0 cells False
82       For intI = 0 To 39
83          m_blnNumbers(0, intI) = False
84       Next
85
86       ' assign all row 1 cells False
87       For intI = 0 To 49
88          m_blnNumbers(1, intI) = False
89       Next
90
91    End Sub ' ClearArray
92
93 End Class ' FrmLotteryPicker
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Figure 18.25 Student Grades application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial18\Exercises\StudentGrades directory to your C:\SimplyVB
directory. 

b) Opening the application’s template file. Double click StudentGrades.sln in the
StudentGrades directory to open the application.

c) Declare instance variables. Declare an Integer counter and a 10-by-2 String array
as instance variables. 

d) Coding the Submit Grades Button’s Click event handler. Double click the Submit
Grades Button to generate its Click event handler. Write code in the event handler
to retrieve input from the TextBoxes. Then store the student’s name in the first col-
umn of the two-dimensional String array and the student’s test average in the sec-
ond column of the array. Use a Function procedure to calculate the student’s test
average.

e) Computing the class average. Add the student’s name and the student’s test average
(separated by a tab character) to the ListBox. Then calculate and display the class
average, using a Function procedure. [Hint: You should use the two-dimensional
String array and the Integer counter to calculate the class average.]

f) Completing the event handler. Increment the counter by one after calculating the
class average. If ten students’ grades have been entered, disable the Submit Grades
Button.

g) Running the application. Select Debug > Start to run your application. Enter 10 stu-
dents and their grades. Make sure that all averages are correct, and that the Submit
Grades Button is disabled after 10 students’ grades have been entered.

h) Closing the application. Close your running application by clicking its close box.

i) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 18.13 Solution
2 ' StudentGrades.vb
3
4 Public Class FrmStudentGrades
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' array of students and test averages

10    Dim m_strStudents As String(,) = New String(9, 1) {}
11
12    ' counter for number of grades in array
13    Dim m_intCounter As Integer = 0
14
15    ' handles click event for btnSubmit Button
16    Private Sub btnSubmit_Click(ByVal sender As System.Object, _
17       ByVal e As System.EventArgs) Handles btnSubmit.Click
18
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What does this code do? 18.14 What is returned by the following code? Assume that GetStockPrices is a Function
procedure that returns a 2-by-31 array, with the first row containing the stock price at the

19       ' extract user input
20       Dim dblTest1 As Double = Val(txtTest1.Text)
21       Dim dblTest2 As Double = Val(txtTest2.Text)
22       Dim dblTest3 As Double = Val(txtTest3.Text)
23
24       ' add student name and test average
25       ' to the array of students
26       m_strStudents(m_intCounter, 0) = txtName.Text
27       m_strStudents(m_intCounter, 1) = _
28          String.Format("{0:F}", _
29             StudentAverage(dblTest1, dblTest2, dblTest3))
30
31       ' display student name and average in ListBox
32       lstNames.Items.Add(m_strStudents(m_intCounter, 0) & _
33          ControlChars.Tab & m_strStudents(m_intCounter, 1))
34
35       ' display class average
36       lblClassOutput.Text = _
37          String.Format("{0:F}", ClassAverage())
38
39       ' increment grade counter
40       m_intCounter += 1
41
42       ' maximum of ten students
43       If m_intCounter = 10 Then
44          btnSubmit.Enabled = False
45       End If
46
47    End Sub ' btnSubmit_Click
48
49    ' returns student average
50    Function StudentAverage(ByVal intTest1 As Double, _
51       ByVal intTest2 As Double, ByVal intTest3 As Double) _
52       As Double
53
54       ' return the average of 3 test scores
55       Return ((intTest1 + intTest2 + intTest3) / 3)
56    End Function ' StudentAverage
57
58    ' returns class average
59    Function ClassAverage() As Double
60       Dim intCounter As Integer = 0 ' counter variable 
61       Dim dblTotal As Double = 0.0 ' total test score
62
63       ' iterate through array of students
64       For intCounter = 0 To m_intCounter
65          dblTotal += _
66             Convert.ToDouble(m_strStudents(intCounter, 1))
67       Next
68
69       ' return the class average
70       Return (dblTotal / (m_intCounter + 1))
71    End Function ' ClassAverage
72
73 End Class ' FrmStudentGrades

▲
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beginning of the day and the last row containing the stock price at the end of the day, for each
day of the month.

Answer: The Function procedure returns a one-dimensional array containing the daily 
stock price change for each day of the month.

What’s wrong with this code? 18.15 Find the error(s) in the following code. The TwoDArrays procedure should create a
two-dimensional array and initialize all its values to one.

Answer: To assign each element in a two-dimensional array two nested For…Next loops 
should be used. The corrected code is as follows:

1 Function Mystery() As Integer()
2    Dim intPrices As Integer(,) = New Integer(1, 30) {}
3
4    intPrices = GetStockPrices()
5
6    Dim intResult As Integer() = New Integer(30) {}
7    Dim intI As Integer
8
9    For intI = 0 To 30

10       intResult(intI) = intPrices(0, intI) - intPrices(1, intI)
11    Next
12
13    Return intResult
14 End Function ' Mystery

▲

1 Sub TwoDArrays()
2    Dim intArray As Integer(,)
3
4    intArray = New Integer(3, 3) {}
5
6    Dim intI As Integer
7
8    ' assign 1 to all cell values
9    For intI = 0 To 3

10       intArray(intI, intI) = 1
11    Next
12
13 End Sub ' TwoDArrays

1 Sub TwoDArrays()
2    Dim intArray As Integer(,)
3    intArray = New Integer(3, 3) {}
4    Dim intI As Integer
5    Dim intJ As Integer
6
7    ' assign 1 to all cell values
8    For intI = 0 To 3
9

10       
11       
12       
13
14    Next
15
16 End Sub ' TwoDArrays

For intJ = 0 To 3          
   intArray(intI, intJ) = 1
Next                       
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Programming Challenge 18.16 (Enhanced Student Grades Application) Modify the application in Exercise 18.13 to
include a bar graph that displays each student’s grade and the class average. The chart should
display only after the user enters the grades for ten students (Fig. 18.26). Until then, a Label
should display the text, “Enter ten grades to display the chart.” Student names and the text
Class Average should display on the x-axis, and grades should display on the y-axis. Also
write code that ensures that the user has entered values in each TextBox when the Submit
Grades Button is clicked.

Figure 18.26 Enhanced Student Grades application.

▲
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a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial18\Exercises\EnhancedStudentGrades directory to your C:\Sim-
plyVB directory. 

b) Opening the application’s template file. Double click EnhancedStudent-
Grades.sln in the EnhancedStudentGrades directory to open the application. If
you have not completed Exercise 18.13, follow the steps in Exercise 18.13 before pro-
ceeding to the next step. If you have completed Exercise 18.13, copy the code you
wrote into this application.

c) Completing the application design. Place a Label on the Form that reads “Enter ten
grades to display the chart.” Then insert an MSChart control at the bottom of the
Form. Set its Visible property to False to hide the graph initially. A control’s Visi-
ble property determines if the control is displayed on the Form (True) or hidden
(False). Open the MSChart control’s Properties dialog, set the Chart Type to a 2D
Bar/PictoGraph and set the Series Interior Color property (under the Series Color
tab) to yellow.

d) Inserting code to check input. Write code that determines whether the user has
entered values in each TextBox. If the student name is missing, display a MessageBox
indicating that the user must enter a student name. If any grades are missing, display
a MessageBox indicating that three grades are required.

e) Enhancing the user interface. Write code to clear each TextBox after the user clicks
the Submit Grades Button. Then insert code to set the focus of the application to
the Student Name: TextBox.

f) Displaying the chart. Write a procedure that displays each of the ten students’ test
averages and the class average in the MSChart control. Recall that student names and
the text Class Average should display on the x-axis, and grades should display on the
y-axis. Finally, set the chart’s Visible property to True, and set the Visible prop-
erty of the Label you added in Step b to False.

g) Running the application. Select Debug > Start to run your application. Enter 10 sets
of grades. Verify that the resulting chart displays the proper data, and that the chart is
formatted as in Fig. 18.26.

h) Closing the application. Close your running application by clicking its close box.

i) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 18.16 Solution
2 ' StudentGrades.vb
3
4 Public Class FrmStudentGrades
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' array of students and test averages

10    Dim m_strStudents As String(,) = New String(10, 1) {}
11
12    ' counter for number of grades in array
13    Dim m_intCounter As Integer = 0
14
15    ' handles click event for btnSubmit Button
16    Private Sub btnSubmit_Click(ByVal sender As System.Object, _
17       ByVal e As System.EventArgs) Handles btnSubmit.Click
18
19       ' if student name is missing
20       If txtName.Text = "" Then
21          MessageBox.Show("Student Name is required", _
22             "Student Name Missing", MessageBoxButtons.OK, _
23             MessageBoxIcon.Exclamation)
24
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25          ' if a test grade is missing
26       ElseIf txtTest1.Text = "" _
27          OrElse txtTest2.Text = "" _
28          OrElse txtTest3.Text = "" Then
29
30          MessageBox.Show("Test grade is missing", _
31             "Grade Missing", MessageBoxButtons.OK, _
32             MessageBoxIcon.Exclamation)
33
34          ' if all the conditions are satisfied
35          ' then perform calculations and display chart
36       Else
37
38          ' extract user input
39          Dim dblTest1 As Double = Val(txtTest1.Text)
40          Dim dblTest2 As Double = Val(txtTest2.Text)
41          Dim dblTest3 As Double = Val(txtTest3.Text)
42
43          ' add student name and test average
44          ' to the array of students
45          m_strStudents(m_intCounter, 0) = txtName.Text
46          m_strStudents(m_intCounter, 1) = _
47             String.Format("{0:F}", _
48                StudentAverage(dblTest1, dblTest2, dblTest3))
49
50          ' display student name and average in ListBox
51          lstNames.Items.Add(m_strStudents(m_intCounter, 0) & _
52             ControlChars.Tab & m_strStudents(m_intCounter, 1))
53
54          ' display class average
55          lblClassOutput.Text = _
56             String.Format("{0:F}", ClassAverage())
57
58          ' increment grade counter
59          m_intCounter += 1
60
61          ' maximum of ten students
62          If m_intCounter = 10 Then
63             btnSubmit.Enabled = False
64             ShowChart()
65          End If
66
67          ' clear TextBoxes and set focus
68          txtName.Clear()
69          txtTest1.Clear()
70          txtTest2.Clear()
71          txtTest3.Clear()
72          txtName.Focus()
73       End If
74
75    End Sub ' btnSubmit_Click
76
77    ' returns student average
78    Function StudentAverage(ByVal intTest1 As Double, _
79       ByVal intTest2 As Double, ByVal intTest3 As Double) _
80       As Double
81
82       Return ((intTest1 + intTest2 + intTest3) / 3)
83    End Function ' StudentAverage
84
85    ' returns class average
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86    Function ClassAverage() As Double
87       Dim intCounter As Integer = 0 ' counter variable
88       Dim dblTotal As Double = 0.0 ' store total test scores
89
90       ' iterate through array of students
91       For intCounter = 0 To m_intCounter
92          dblTotal += _
93             Convert.ToDouble(m_strStudents(intCounter, 1))
94       Next
95
96       ' return average test score for the class
97       Return (dblTotal / (m_intCounter + 1))
98    End Function ' ClassAverage
99
100    ' places data in Chart and displays it
101    Sub ShowChart()
102       lblChart.Visible = False ' hide the Label
103       chGrades.Visible = True ' display the grade chart
104       m_strStudents(10, 0) = "Class Average"
105       m_strStudents(10, 1) = String.Format("{0:F}", ClassAverage())
106       chGrades.ChartData = m_strStudents
107    End Sub ' ShowChart
108
109 End Class ' FrmStudentGrades
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Instructor’s Manual
Exercise Solutions

Tutorial 19

MULTIPLE-CHOICE
QUESTIONS

19.1 A Button appears flat if its  property is set to Flat.

19.2 Keyword  introduces a class definition.

19.3 Keyword  is used to create an object.

19.4 String characters are of data type .

19.5 The  is used to retrieve the value of an instance variable.

19.6 When you enter the header for a constructor in Visual Studio .NET then press Enter,
the keywords  are created for you.

19.7 An important difference between constructors and other methods is that .

19.8 A class can yield many , just as a primitive data type can yield many
variables.

19.9 The Set accessor enables you to .

19.10 Instance variables declared Private are not accessible .

Answers: 19.1) b.  19.2) d.  19.3) d.  19.4) a.  19.5) a.  19.6) c.  19.7) a.  19.8) b.  19.9) d.  19.10) a.

EXERCISES 19.11 (Triangle Creator Application) Create an application that allows the user to enter the
lengths for the three sides of a triangle as Integers. The application should then determine
whether the triangle is a right triangle (two sides of the triangle form a 90 degree angle), an
equilateral triangle (all sides of equal length) or neither. The application’s GUI is completed
for you (Fig. 19.49). You must create a class to represent a triangle object and define the
event handler for the Create Button.

a) BorderStyle b) FlatStyle

c) Style d) BackStyle

a) NewClass b) ClassDef

c) VBClass d) Class

a) CreateObject b) Instantiate

c) Create d) New

a) Char b) StringCharacter

c) Character d) strCharacter

a) Get accessor of a property b) Retrieve method of a class
c) Client method of a class d) Set accessor of a property

a) End Public Class b) End Procedure
c) End Sub d) End

a) constructors cannot specify a return data type
b) constructors cannot specify any parameters
c) other methods are implemented as Sub procedures
d) constructors can assign values to instance variables

a) names b) objects
c) values d) types

a) provide range checking b) modify data
c) provide data validation d) All of the above.

a) outside the class b) by other methods of the same class
c) by other members of the same class d) inside the same class
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Figure 19.49 Triangle Creator application with all possible outputs

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial19\Exercises\Triangle directory to your C:\SimplyVB directory. 

b) Opening the application’s template file. Double click Triangle.sln in the Trian-
gle directory to open the application.

c) Creating the Triangle class. Add a class to the project, and name it Triangle. This
is where you will define the properties of the Triangle class.

d) Defining the necessary properties. Define a constructor that will take the lengths of
the three sides of the triangle as arguments. Create three properties that enable cli-
ents to access and modify the lengths of the three sides. If the user enters a negative
value, that side should be assigned the value zero.

e) Adding additional features. Create two more properties in the Triangle class: One
determines whether the sides form a right triangle, the other an equilateral triangle.
These properties are considered read-only, because you would naturally define only
the Get accessor. There is no simple Set accessor that can make a triangle a right tri-
angle or an equilateral triangle without first modifying the lengths of the triangle’s
sides. To create a read-only property (where the Set accessor is omitted), precede
keyword Property with the keyword ReadOnly.

f) Adding code to event handler. Now that you have created your Triangle class, you
can use it to create objects in your application. Double click the Create Button in
Design View to generate the event handler. Create new variables to store the three
lengths from the TextBoxes; then, use those values to create a new Triangle object.

g) Displaying the result. Use an If…ElseIf statement to determine if the triangle is a
right triangle, an equilateral triangle or neither. Display the result in a Label.

h) Running the application. Select Debug > Start to run your application. Create vari-
ous inputs until you have create an equilateral triangle, a right triangle and a triangle
that is neither right nor equilateral. Verify that the proper output is displayed for
each.

i) Closing the application. Close your running application by clicking its close box.

j) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 19.11 Solution
2 ' Triangle.vb
3 ' Represent a triangle
4
5 Public Class Triangle
6
7    ' declare three private side values
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8    Private m_intSide1 As Integer
9    Private m_intSide2 As Integer

10    Private m_intSide3 As Integer
11
12    ' Triangle constructor (side1, side2 and side3)
13    Public Sub New(ByVal side1Value As Integer, _
14       ByVal side2Value As Integer, _
15       ByVal side3Value As Integer)
16
17       Side1 = side1Value
18       Side2 = side2Value
19       Side3 = side3Value
20    End Sub ' New
21
22    ' get and set Side1
23    Public Property Side1() As Integer
24
25       ' return m_intSide1 value
26       Get
27          Return m_intSide1 ' return length of side1
28       End Get ' end of Get accessor
29
30       ' set side value
31       Set(ByVal Value As Integer)
32
33          ' make sure value is non-negative
34          If Value > 0 Then
35             m_intSide1 = Value
36          Else
37             m_intSide1 = 0 ' set to zero
38          End If
39
40       End Set ' end of Set accessor
41
42    End Property ' Side1
43
44    ' get and set Side2
45    Public Property Side2() As Integer
46
47       ' return m_intSide2 value
48       Get
49          Return m_intSide2 ' return length of side2
50       End Get ' end of Get accessor
51
52       ' set m_intSide2 value
53       Set(ByVal Value As Integer)
54
55          ' check if value is negative
56          If Value > 0 Then
57             m_intSide2 = Value ' set value
58          Else
59             m_intSide2 = 0
60          End If
61
62       End Set ' end of Set accessor
63
64    End Property ' Side2
65
66    ' get and set Side3
67    Public Property Side3() As Integer
68
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69       ' return m_intSide3 value
70       Get
71          Return m_intSide3 ' return length of side3
72       End Get ' end of Get accessor
73
74       ' set m_intSide3
75       Set(ByVal Value As Integer)
76
77          ' make sure value is nonnegative
78          If Value > 0 Then
79             m_intSide3 = Value ' set value
80          Else
81             m_intSide3 = 0 ' set to zero 
82          End If
83
84       End Set ' end of Set accessor
85
86    End Property ' Side3
87
88    ' test if triangle is equilateral
89    Public ReadOnly Property Equilateral() As Boolean
90
91       ' check sides, return True or False
92       Get
93
94          ' test if sides are equal
95          If m_intSide1 = m_intSide2 _
96             AndAlso m_intSide1 = m_intSide3 Then
97
98             Return True ' indicate that sides are equal
99          Else
100             Return False ' indicate triangle is not equal sided
101          End If
102
103       End Get ' end of Get accessor
104
105    End Property ' Equilateral
106
107    ' check if sides create right triangle
108    Public ReadOnly Property RightTriangle() As Boolean
109
110       ' check sides, return True or False
111       Get
112
113          ' check length
114          If (m_intSide1 ^ 2) + _
115             (m_intSide2 ^ 2) = _
116             (m_intSide3 ^ 2) Then
117
118             Return True ' it is a right triangle
119
120             ' check another length combination
121          ElseIf (m_intSide1 ^ 2) + _
122             (m_intSide3 ^ 2) = _
123             (m_intSide2 ^ 2) Then
124
125             Return True ' it is a right triangle
126
127             ' check last length combination
128          ElseIf (m_intSide2 ^ 2) + _
129             (m_intSide3 ^ 2) = _
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130             (m_intSide1 ^ 2) Then
131
132             Return True  ' it is a right triangle
133
134          Else
135             Return False ' it is not a right triangle
136
137          End If
138
139       End Get ' end of Get accessor
140
141    End Property ' RightTriangle
142
143 End Class ' Triangle

1 ' Exercise 19.11 Solution
2 ' TriangleCreator.vb
3
4 Public Class FrmTriangleCreator
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' create and test triangle properties

10    Private Sub btnCreate_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnCreate.Click
12
13       Dim objTriangle As Triangle ' create Triangle reference
14
15       ' values for three sides
16       Dim intSide1 As Integer = Convert.ToInt32(Val(txtSide1.Text))
17       Dim intSide2 As Integer = Convert.ToInt32(Val(txtSide2.Text))
18       Dim intSide3 As Integer = Convert.ToInt32(Val(txtSide3.Text))
19
20       lblDisplay.Text = "" ' clear display Label
21
22       ' create triangle object
23       objTriangle = New Triangle(intSide1, intSide2, intSide3)
24
25       ' test for right triangle
26       If (objTriangle.RightTriangle = True) Then
27          lblDisplay.Text = "You created a right triangle!"
28
29          ' test for equilateral triangle
30       ElseIf (objTriangle.Equilateral = True) Then
31          lblDisplay.Text = "You created an equilateral triangle!"
32       Else
33
34          ' triangle is neither right nor equilateral
35          lblDisplay.Text = ("You created a triangle that is " & _
36             "neither right nor equilateral!")
37       End If
38
39    End Sub ' btnCreate_Click
40
41 End Class  ' FrmTriangleCreator
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19.12 (Modified Microwave Oven Application) Modify the tutorial’s Microwave Oven
application to include an additional digit, which would represent the hour. Allow the user to
enter up to 9 hours, 59 minutes, and 59 seconds (Fig. 19.50).

Figure 19.50 Microwave Oven application’s GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial19\Exercises\MicrowaveOven2 directory to your C:\SimplyVB
directory. 

b) Opening the application’s template file. Double click MicrowaveOven2.sln in the
MicrowaveOven2 directory to open the application.

c) Adding the hour variable. To allow cooking time that includes the hour digit, you will
need to modify the Time class. Define a new Private instance variable to represent
the hour. Change the Time constructor to take in as its first argument (now Time
should have three arguments) the hour amount. You will also have to modify the
Start Button event handler and the DisplayTime method to include an hour vari-
able.

d) Adding the Hour property. Use the Minute and Second properties as your template
to create the property for the hour. Remember, we are allowing an additional digit to
represent the hour (hour < 10).

e) Changing the padding amount. Change the calls to the PadLeft method to be con-
sistent with the new time format.

f) Extracting the hour. Add a call to the Substring method so that hour gets the first
digit in the m_strTime String. Also, change the calls to the Substring method for
minute and second so that they extract the proper digits from the m_strTime String.

g) Accessing the first five digits. Change the If…Then statement from the Display-
Time method to take and display the first five digits entered by the user.

h) Edit the Timer object. Edit the tmrClock_Tick event handler to provide changes to
hours and its corresponding minutes and seconds.

i) Displaying the time. Edit the Format String so that the display Label includes the
hour. 

j) Running the application. Select Debug > Start to run your application. Enter vari-
ous times and verify that the application counts down properly. Enter an amount of
time that is 10 hours or longer, and verify that the application handles invalid input
correctly.

k) Closing the application. Close your running application by clicking its close box.

l) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 19.12 Solution
2 ' Time.vb
3 ' Represents time in 24-hour format and contains properties
4
5 Public Class Time
6



Tutorial 19 Microwave Oven Application 208

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

7    ' declare Integers for hour, minute and second
8    Private m_intHour As Integer
9    Private m_intMinute As Integer

10    Private m_intSecond As Integer
11
12    ' Time constructor (hour, minute and second supplied)
13    Public Sub New(ByVal hourValue As Integer, _
14       ByVal minuteValue As Integer, _
15       ByVal secondValue As Integer)
16
17       Hour = hourValue     ' invokes Hour set accessor
18       Minute = minuteValue ' invokes Minute set accessor
19       Second = secondValue ' invokes Second set accessor
20    End Sub ' New
21
22    Public Property Hour() As Integer
23
24       ' return value
25       Get
26          Return m_intHour
27       End Get ' Get accessor
28
29       ' set m_intHour value
30       Set(ByVal Value As Integer)
31
32          ' if hour value is valid
33          If (Value < 10) Then
34             m_intHour = Value
35          Else
36             m_intHour = 0 ' set invalid input to 0
37          End If
38
39       End Set ' Set accessor
40
41    End Property ' Hour
42
43    ' property Minute
44    Public Property Minute() As Integer
45
46       ' return m_intMinute value
47       Get
48          Return m_intMinute
49       End Get ' end of Get accessor
50
51       ' set m_intMinute value
52       Set(ByVal Value As Integer)
53
54          ' if minute value entered is valid
55          If (Value < 60) Then
56             m_intMinute = Value
57          Else
58             m_intMinute = 0 ' set invalid input to 0
59          End If
60
61       End Set ' end of Set accessor
62
63    End Property ' Minute
64
65    ' property Second
66    Public Property Second() As Integer
67
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68       ' return m_intSecond value
69       Get
70          Return m_intSecond
71       End Get ' Get accessor
72
73       ' set m_intSecond value
74       Set(ByVal Value As Integer)
75
76          ' if second value entered are invalid
77          If (Value < 60) Then
78             m_intSecond = Value
79          Else
80             m_intSecond = 0 ' set invalid input to 0
81          End If
82
83       End Set ' Set accessor
84
85    End Property ' Second
86
87 End Class ' Time

1 ' Exercise 19.12 Solution
2 ' MicrowaveOven.vb
3
4 Public Class FrmMicrowaveOven
5    Inherits System.Windows.Forms.Form
6
7    ' contains time entered as a String
8    Private m_strTime As String = ""
9

10    ' holds the time
11    Private m_objTime As Time
12
13    ' Windows Form Designer generated code
14
15    ' event handler appends 1 to time string
16    Private Sub btnOne_Click(ByVal sender As System.Object, _
17       ByVal e As System.EventArgs) Handles btnOne.Click
18
19       Beep()             ' sound beep
20       m_strTime &= "1"   ' append digit to time input
21       DisplayTime()      ' display time input properly
22    End Sub ' btnOne_Click
23
24    ' event handler appends 2 to time string
25    Private Sub btnTwo_Click(ByVal sender As System.Object, _
26       ByVal e As System.EventArgs) Handles btnTwo.Click
27
28       Beep()             ' sound beep
29       m_strTime &= "2"   ' append digit to time input
30       DisplayTime()      ' display time input properly
31    End Sub ' btnTwo_Click
32
33    ' event handler appends 3 to time string
34    Private Sub btnThree_Click(ByVal sender As System.Object, _
35       ByVal e As System.EventArgs) Handles btnThree.Click
36
37       Beep()             ' sound beep
38       m_strTime &= "3"   ' append digit to time input
39       DisplayTime()      ' display time input properly
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40    End Sub ' btnThree_Click
41
42    ' event handler appends 4 to time string
43    Private Sub btnFour_Click(ByVal sender As System.Object, _
44       ByVal e As System.EventArgs) Handles btnFour.Click
45
46       Beep()             ' sound beep
47       m_strTime &= "4"   ' append digit to time input
48       DisplayTime()      ' display time input properly
49    End Sub ' btnFour_Click
50
51    ' event handler appends 5 to time string
52    Private Sub btnFive_Click(ByVal sender As System.Object, _
53       ByVal e As System.EventArgs) Handles btnFive.Click
54
55       Beep()             ' sound beep
56       m_strTime &= "5"   ' append digit to time input
57       DisplayTime()      ' display time input properly
58    End Sub ' btnFive_Click
59
60    ' event handler appends 6 to time string
61    Private Sub btnSix_Click(ByVal sender As System.Object, _
62       ByVal e As System.EventArgs) Handles btnSix.Click
63
64       Beep()             ' sound beep
65       m_strTime &= "6"   ' append digit to time input
66       DisplayTime()      ' display time input properly
67    End Sub ' btnSix_Click
68
69    ' event handler appends 7 to time string
70    Private Sub btnSeven_Click(ByVal sender As System.Object, _
71       ByVal e As System.EventArgs) Handles btnSeven.Click
72
73       Beep()             ' sound beep
74       m_strTime &= "7"   ' append digit to time input
75       DisplayTime()      ' display time input properly
76    End Sub ' btnSeven_Click
77
78    ' event handler appends 8 to time string
79    Private Sub btnEight_Click(ByVal sender As System.Object, _
80       ByVal e As System.EventArgs) Handles btnEight.Click
81
82       Beep()             ' sound beep
83       m_strTime &= "8"   ' append digit to time input
84       DisplayTime()      ' display time input properly
85    End Sub ' btnEight_Click
86
87    ' event handler appends 9 to time string
88    Private Sub btnNine_Click(ByVal sender As System.Object, _
89       ByVal e As System.EventArgs) Handles btnNine.Click
90
91       Beep()             ' sound beep
92       m_strTime &= "9"   ' append digit to time input
93       DisplayTime()      ' display time input properly
94    End Sub ' btnNine_Click
95
96    ' event handler appends 0 to time string
97    Private Sub btnZero_Click(ByVal sender As System.Object, _
98       ByVal e As System.EventArgs) Handles btnZero.Click
99
100       Beep()             ' sound beep
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101       m_strTime &= "0"   ' append digit to time input
102       DisplayTime()      ' display time input properly
103    End Sub ' btnZero_Click
104
105    ' event handler starts the microwave oven's cooking process
106    Private Sub btnStart_Click(ByVal sender As System.Object, _
107       ByVal e As System.EventArgs) Handles btnStart.Click
108
109       Dim intHour As Integer
110       Dim intSecond As Integer
111       Dim intMinute As Integer
112
113       ' pad extra spaces in m_strTime with zero
114       m_strTime = m_strTime.PadLeft(5, Convert.ToChar("0"))
115
116       ' extract seconds, minutes and hours
117       intSecond = Convert.ToInt32(m_strTime.Substring(3))
118       intMinute = Convert.ToInt32(m_strTime.Substring(1, 2))
119       intHour = Convert.ToInt32(m_strTime.Substring(0, 1))
120
121       ' create Time object to contain time entered by user
122       m_objTime = New Time(intHour, intMinute, intSecond)
123
124       ' display the time
125       lblDisplay.Text = String.Format("{0:D1}:{1:D2}:{2:D2}", _
126          m_objTime.Hour, m_objTime.Minute, m_objTime.Second)
127
128       m_strTime = "" ' clear m_strTime for future input
129       tmrClock.Enabled = True            ' begin timer
130       pnlWindow.BackColor = Color.Yellow ' turn "light" on
131    End Sub ' btnStart_Click
132
133    ' event handler to clear input
134    Private Sub btnClear_Click(ByVal sender As System.Object, _
135       ByVal e As System.EventArgs) Handles btnClear.Click
136
137       ' reset each method or variable to its initial setting
138       lblDisplay.Text = "Microwave Oven"
139       m_strTime = ""
140       m_objTime = New Time(0, 0, 0)
141       tmrClock.Enabled = False           ' turn timer off
142       pnlWindow.BackColor = pnlWindow.DefaultBackColor
143
144       btnStart.Enabled = True ' enable Start Button
145    End Sub ' btnClear_Click
146
147    ' method to display formatted time in timer window
148    Private Sub DisplayTime()
149
150       Dim intSecond As Integer
151       Dim intMinute As Integer
152       Dim intHour As Integer
153       Dim strDisplay As String ' the display String
154
155       ' disallow extra input if number of hours > 9
156       If m_strTime.Length > 5 Then
157
158          ' take only the first 5 digits
159          m_strTime = m_strTime.Substring(0, 5)
160       End If
161
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19.13 (Account Information Application) The local bank wants you to create an applica-
tion that will allow them to view their clients’ information. The interface is created for you;
you need to implement the class (Fig. 19.51). Once the application is completed, the bank
manager should be able to click the Next or Previous Button to run through each client’s
information. The information is stored in four arrays containing first names, last names,
account numbers and account balances.

162       ' pad the empty spaces of the display String with "0"
163       strDisplay = m_strTime.PadLeft(5, Convert.ToChar("0"))
164
165       ' extract seconds and minutes and hours
166       intSecond = Convert.ToInt32(strDisplay.Substring(3))
167       intMinute = Convert.ToInt32(strDisplay.Substring(1, 2))
168       intHour = Convert.ToInt32(strDisplay.Substring(0, 1))
169
170       ' display number of hours, minutes, and seconds
171       lblDisplay.Text = String.Format("{0:D1}:{1:D2}:{2:D2}", _
172          intHour, intMinute, intSecond)
173    End Sub ' DisplayTime
174
175    ' event handler displays new time each second
176    Private Sub tmrClock_Tick(ByVal sender As System.Object, _
177       ByVal e As System.EventArgs) Handles tmrClock.Tick
178
179       ' perform countdown, subtract one second
180       If m_objTime.Second > 0 Then
181          m_objTime.Second -= 1
182       ElseIf m_objTime.Minute > 0 Then
183          m_objTime.Minute -= 1 ' subtract one minute
184          m_objTime.Second = 59 ' reset seconds for new minute
185       ElseIf m_objTime.Hour > 0 Then
186          m_objTime.Hour -= 1   ' subtract one hour
187          m_objTime.Minute = 59 ' reset minutes for new hour
188          m_objTime.Second = 59 ' reset seconds for new minute
189       Else                                  ' no more seconds
190          tmrClock.Enabled = False           ' stop the timer
191          Beep()                             ' sound beep
192          lblDisplay.Text = "Done!"          ' display "Done" message
193          pnlWindow.BackColor = pnlWindow.DefaultBackColor
194
195          Return
196       End If
197
198       ' refresh the display time
199       lblDisplay.Text = String.Format("{0:D1}:{1:D2}:{2:D2}", _
200          m_objTime.Hour, m_objTime.Minute, m_objTime.Second)
201    End Sub ' tmrTimer_Tick
202
203 End Class ' FrmMicrowaveOven
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Figure 19.51 Account Information application GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial19\Exercises\AccountInformation directory to your C:\Sim-
plyVB directory. 

b) Opening the application’s template file. Double click AccountInformation.sln in
the AccountInformation directory to open the application.

c) Determining variables for the class. Examine the code from AccountInforma-
tion.vb, including all the properties that the Client object uses to retrieve the infor-
mation.

d) Creating the Client class. Create a new class, and call it Client. Add this class to
the project. Define four Private instance variables to represent each property value,
to ensure that each Client object contains all the required information about each
client. Use those variables to define a constructor.

e) Defining each property. Each Private variable should have a corresponding prop-
erty, allowing the user to set or get each Private variable’s value.

f) Adding more information. In the FrmAccountInformation_Load event handler,
add two more accounts. Include names, account numbers, and balances for each cor-
responding array. 

g) Running the application. Select Debug > Start to run your application. Enter infor-
mation for multiple accounts. Click the Previous and Next Buttons to ensure that
each account’s information is stored properly.

h) Closing the application. Close your running application by clicking its close box.

i) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 19.13 Solution
2 ' Client.vb
3 ' represent client balance information 
4
5 Public Class Client
6
7    Private m_strFirstName As String ' first name
8    Private m_strLastName As String  ' last name
9    Private m_intAccount As Integer  ' account number

10    Private m_intbalance As Decimal  ' account balance
11
12    ' Client constructor, first and last names, account number
13    ' and account balance supplied
14    Public Sub New(ByVal strFirstName As String, _
15       ByVal strLastName As String, ByVal intAccount As Integer, _
16       ByVal decBalance As Decimal)
17
18       First = strFirstName
19       Last = strLastName
20       Account = intAccount
21       Balance = decBalance
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22    End Sub ' New
23
24    ' property First
25    Public Property First() As String
26
27       ' return m_strFirstName
28       Get
29          Return m_strFirstName ' return first name
30       End Get ' end of Get accessor
31
32       ' set first name
33       Set(ByVal Value As String)
34          m_strFirstName = Value
35       End Set ' end of Set accessor
36
37    End Property ' First
38
39    ' property Last
40    Public Property Last() As String
41
42       ' return m_strLastName
43       Get
44          Return m_strLastName ' return last name
45       End Get ' end of Get accessor
46
47       ' set last name
48       Set(ByVal Value As String)
49          m_strLastName = Value
50       End Set ' end of Set accessor
51
52    End Property ' Last
53
54    ' account number
55    Public Property Account() As Integer
56
57       ' return m_intAccount
58       Get
59          Return m_intAccount ' return account number
60       End Get ' end of Get accessor
61
62       ' set account number
63       Set(ByVal intAccountValue As Integer)
64
65          ' account number can not be negative
66          If intAccountValue > -1 Then
67             m_intAccount = intAccountValue
68          Else
69             m_intAccount = 0 ' default to zero
70          End If
71
72       End Set ' end of Set accessor
73
74    End Property ' Account
75
76    ' account balance
77    Public Property Balance() As Decimal
78
79       ' return m_intbalance
80       Get
81          Return m_intbalance ' return account balance
82       End Get ' end of Get accessor
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83
84       ' set the account balance
85       Set(ByVal Value As Decimal)
86          m_intbalance = Value
87       End Set ' end of Set accessor
88
89    End Property ' Balance
90
91 End Class ' Client

1 ' Exercise 19.13 Solution
2 ' AccountInformation.vb
3
4 Public Class FrmAccountInformation
5    Inherits System.Windows.Forms.Form
6
7    Private m_objName(9) As Client       ' Client object
8    Private m_intPosition As Integer = 0 ' current account
9

10    ' Windows Form Designer generated code
11
12    ' create array of Client objects
13    Private Sub FrmAccountInformation_Load(ByVal sender As _
14       System.Object, ByVal e As System.EventArgs) _
15       Handles MyBase.Load
16
17       Dim intCount As Integer ' counter variable
18
19       ' array of first names
20       Dim strFirstName() As String = _
21          New String() {"John", "Sarah", "Jack", "Adam", "Diane", _
22             "David", "Kristin", "Jennifer", "", ""}
23
24       ' array of last names
25       Dim strLastName() As String = _
26          New String() {"Blue", "White", "Red", "Brown", _
27             "Yellow", "Black", "Green", "Orange", "", ""}
28
29       ' array of account numbers 
30       Dim intAccount() As Integer = _
31          New Integer() {1234652, 1234666, 1234678, 1234681, _
32             1234690, 1234770, 1234787, 1234887, 0, 0}
33
34       ' array of account balances
35       Dim decBalance() As Decimal = _
36          New Decimal() {Convert.ToDecimal(1000.78), _
37             Convert.ToDecimal(2056.24), Convert.ToDecimal(978.65), _
38             Convert.ToDecimal(990.0), Convert.ToDecimal(432.75), _
39             Convert.ToDecimal(780.78), Convert.ToDecimal(4590.63), _
40             Convert.ToDecimal(7910.11), 0, 0}
41
42       ' loop and create 10 Client objects
43       For intCount = 0 To m_objName.GetUpperBound(0) 
44
45          ' create new object and store into Client array
46          m_objName(intCount) = New Client(strFirstName(intCount), _
47             strLastName(intCount), intAccount(intCount), _
48             decBalance(intCount))
49       Next
50
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What does this code do? 19.14 What does the following code do? The first code listing contains the definition of class
Shape. Each Shape object represents a closed shape with a number of sides. The second code
listing contains a method (Mystery) created by a client of class Shape. What does this
method do?

51    End Sub ' FrmAccountInformation_Load
52
53    ' display next object
54    Private Sub btnNext_Click(ByVal sender As System.Object, _
55       ByVal e As System.EventArgs) Handles btnNext.Click
56
57       m_intPosition += 1 ' increment position
58
59       ' if position is last (top) object
60       If m_intPosition > m_objName.GetUpperBound(0) Then
61          m_intPosition = 0    ' set to first position in array
62          DisplayInformation() ' display information
63       Else
64          DisplayInformation()
65       End If
66
67    End Sub ' btnNext_Click
68
69    ' display previous object
70    Private Sub btnPrevious_Click(ByVal sender As System.Object, _
71       ByVal e As System.EventArgs) Handles btnPrevious.Click
72
73       m_intPosition -= 1 ' decrement position
74
75       ' if position is last (bottom) object
76       If m_intPosition < 0 Then
77
78          ' set to last position in array
79          m_intPosition = m_objName.GetUpperBound(0)    
80          DisplayInformation()
81       Else
82          DisplayInformation() ' display information
83       End If
84
85    End Sub ' btnPrevious_Click
86
87    ' display information
88    Private Sub DisplayInformation()
89
90       ' use m_intPosition as index for each object
91       txtFirst.Text = m_objName(m_intPosition).First
92       txtLast.Text = m_objName(m_intPosition).Last
93       txtAccount.Text = _
94          Convert.ToString(m_objName(m_intPosition).Account) 
95
96       ' format as currency
97       txtBalance.Text = _
98          String.Format("{0:C}", m_objName(m_intPosition).Balance)
99
100    End Sub ' DisplayInformation
101
102 End Class  ' FrmAccountInformation

▲



217 Microwave Oven Application Tutorial 19

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

Answer: The Shape class defines a shape with a given number of sides. Method Mystery 
determines the shape of it’s Shape and returns the name of the shape. Method Mystery takes 
a Shape object as an argument. 

1 Public Class Shape
2
3    Private m_intSides As Integer
4
5    ' constructor with number of sides
6    Public Sub New(ByVal intSides As Integer)
7       Side = intSides
8    End Sub ' New
9

10    ' set and get side value
11    Public Property Side() As Integer
12
13       ' return m_intSides
14       Get
15          Return m_intSides
16       End Get ' end of Get accessor
17
18       ' set m_intSides
19       Set(ByVal Value As Integer)
20
21          If Value > 0 Then
22             m_intSides = Value
23          Else
24             m_intSides = 0
25          End If
26
27       End Set ' end of Set accessor
28
29    End Property ' Side
30
31 End Class ' Shape

1 Public Function Mystery(ByVal objShape As Shape) As String
2    Dim strShape As String
3
4    ' determine case with objShape.Side
5    Select Case objShape.Side
6
7       Case Is < 3
8          strShape = "Not a Shape"
9

10       Case 3
11          strShape = "Triangle"
12
13       Case 4
14          strShape = "Square"
15
16       Case Else
17          strShape = "Polygon"
18
19    End Select
20
21    Return strShape
22 End Function ' Mystery
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What’s wrong with this code? 19.15 Find the error(s) in the following code. The following method should create a new
Shape object with intNumberSides sides. Assume the Shape class from Exercise 19.14.

Answer: The method should create a Shape object with intNumberSides sides—not a 
Shape object with 3 sides. Also, a Private variable (m_intSides) cannot be accessed from 
outside the class. The correct code is as follows:

Using the Debugger 19.16 (View Name Application) The View Name application allows the user to enter the
user's first and last name. When the user clicks the View Name Button, a MessageBox that
displays the user’s first and last name appears. The application creates an instance of Class
Name. This class uses its property definitions to set the first-name and last-name instance vari-
ables. Copy the Names directory from C:\Examples\Tutorial19\Exercises\Debugger to
your Debugger directory. Open and run the application. While testing your application, you
noticed that the MessageBox did not display the correct output. Use the debugger to find the
logic error(s) in the application. The application with the correct output is displayed in
Fig. 19.52.

Figure 19.52 View Name application with correct output.

Answer:

▲

1 Private Sub ManipulateShape(ByVal intNumberSides As Integer)
2    Dim objShape As Shape = New Shape(3)
3
4    Shape.m_intSides = intNumberSides
5 End Sub ' ManipulateShape

1 Private Sub ManipulateShape(ByVal intNumberSides As Integer)
2
3    
4
5    ' or
6
7    'Dim objShape As Shape
8    'objShape.Side = intNumberSides
9 End Sub ' ManipulateShape

Dim objShape As Shape = New Shape(intNumberSides)

▲

1 ' Exercise 19.16 Solution
2 ' Name.vb
3 ' Name class definition
4
5 Public Class Name
6
7    Private m_strFirstName As String
8    Private m_strLastName As String
9

10    ' Name constructor, first and last names supplied
11    Public Sub New(ByVal strFirstName As String, _
12       ByVal strLastName As String)
13
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14       First = strFirstName
15       Last = strLastName
16    End Sub ' New
17
18    ' property First
19    Public Property First() As String
20
21       ' return first name
22       Get
23          Return m_strFirstName
24       End Get
25
26       ' set first name
27       Set(ByVal Value As String)
28
29          
30       End Set
31
32    End Property ' First
33
34    ' property Last
35    Public Property Last() As String
36
37       ' return last name
38       Get
39          Return m_strLastName
40       End Get
41
42       ' set last name
43       Set(ByVal Value As String)
44
45          
46       End Set
47
48    End Property ' Second
49
50 End Class ' Name

1 ' Exercise 19.16 Solution
2 ' ViewName.vb
3
4 Public Class FrmViewName
5    Inherits System.Windows.Forms.Form
6
7    Private m_objName As Name ' Name object
8
9    ' Windows Form Designer generated code

10
11    Private Sub btnView_Click(ByVal sender As System.Object, _
12       ByVal e As System.EventArgs) Handles btnView.Click
13
14       Dim strOutput As String ' holds first name and last name
15
16       ' create new Name
17       m_objName = New Name(txtFirst.Text, txtLast.Text)
18
19       ' assign user's name to strOutput
20       strOutput = "First name: " & m_objName.First & _
21          ControlChars.CrLf & "Last name: " & m_objName.Last
22

m_strFirstName = Value
Original line assigned

m_strFirstName to Value

m_strLastName = Value
Original line assigned data
to m_strFirstName, rather

than to m_strLastName
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Programming Challenge 19.17 (DVD Burner Application) Create an application that simulates a DVD burner. Users
create a DVD with their choice of title and bonus materials. The GUI is provided for you
(Fig. 19.53). You will create a class (DVDObject) to represent the DVD object and another
class (Bonus) to represent bonus materials for a DVD object.

Figure 19.53 DVD Burner application’s GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial19\Exercises\DVDBurner directory to your C:\SimplyVB directory. 

b) Opening the application’s template file. Double click DVDBurner.sln in the DVD-
Burner directory to open the application.

c) Creating the bonus-material object. Create a class, and name it Bonus. The class’s
objects will each represent one bonus-material item on the DVD. Each Bonus object
should have a name (description) and a length (in minutes). Use this tutorial’s Time
class as your guide in creating the properties for the name and length of each bonus
material.

d) Creating the DVD class. Create a class, and name it DVDObject. This class contains
the movie title and the length of the movie. The class should also include an array of
three Bonus items.

e) Creating the necessary variables. Before you define the Create Button’s event han-
dler, create an DVDObject class instance variable. Inside the Create Button’s event
handler, create the necessary variables to store the information from the TextBoxes
on the GUI. Also, this is where you need to create the array of Bonus objects to store
the bonus materials.

f) Adding bonus-material information. Add the description and length of each bonus
item to the Bonus array you created from the previous step.

g) Creating a DVD object. Use information about the movie, its title, length and the
array of bonus materials to make your DVD object.

h) Displaying the output. The Information Button’s Click event is already defined for
you. Locate the event handler, add a String containing the complete information on
the DVD object that you created earlier and display this String to a MessageBox.

i) Running the application. Select Debug > Start to run your application. Enter infor-
mation for several DVDs. After information is entered for each, click the Create
Button. Then, click the Information Button and verify that the information being
displayed is correct for your newly created DVD.

j) Closing the application. Close your running application by clicking its close box.

k) Closing the IDE. Close Visual Studio .NET by clicking its close box.

23       ' output name 
24       MessageBox.Show(strOutput, "Name", _
25          MessageBoxButtons.OK, MessageBoxIcon.Information)
26    End Sub ' btnView_Click
27
28 End Class  ' FrmViewName

▲
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Answer:

1 ' Exercise 19.17 Solution
2 ' Bonus.vb
3 ' represent bonus items on a DVD
4
5 Public Class Bonus
6
7    ' name of bonus material
8    Private m_strName As String
9

10    ' length of the bonus material
11    Private m_intItemLength As Integer
12
13    ' Bonus constructor, name and item length
14    Public Sub New(ByVal nameValue As String, _
15       ByVal lengthValue As Integer)
16
17       Name = nameValue
18       ItemLength = lengthValue
19    End Sub ' New
20
21    ' set or get name of bonus material
22    Public Property Name() As String
23
24       ' return m_strName
25       Get
26          Return m_strName ' return name
27       End Get ' end of Get accessor
28
29       ' set description name
30       Set(ByVal Value As String)
31
32          ' if description is greater than 20 characters
33          If Value.Length > 20 Then
34
35             ' take first 20 characters
36             Value = Value.Substring(0, 20)
37             m_strName = Value
38          Else
39
40             ' set name
41             m_strName = Value
42          End If
43
44       End Set ' end of Set accessor
45
46    End Property ' Name
47
48    ' set or get amount of items
49    Public Property ItemLength() As Integer
50
51       ' return m_intItemLength
52       Get
53          Return m_intItemLength ' return length
54       End Get ' end of Get accessor
55
56       ' set minute value
57       Set(ByVal Value As Integer)
58
59          ' make sure minute is non-negative
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60          If Value > 0 Then
61             m_intItemLength = Value
62          Else
63             m_intItemLength = 0
64          End If
65
66       End Set ' end of Set accessor
67
68    End Property ' ItemLength
69
70 End Class ' Bonus

1 ' Exercise 19.17 Solution
2 ' DVDObject.vb
3 ' represent items on a DVD
4
5 Public Class DVDObject
6    Private m_strMovieTitle As String      ' name of movie
7    Private m_objBonusMaterial() As Bonus  ' array of Bonus objects
8    Private m_intMovieLength As Integer    ' length of movie
9

10    ' DVDObject constructor
11    Public Sub New(ByVal nameValue As String, _
12       ByVal bonusValue() As Bonus, _
13       ByVal movieLengthValue As Integer)
14
15       ' call property to set values
16       MovieTitle = nameValue
17       MovieLength = movieLengthValue
18
19       ' assign bonusValue array to m_objBonusMaterial
20       m_objBonusMaterial = bonusValue
21
22    End Sub ' New
23
24    ' set or get movie title
25    Public Property MovieTitle() As String
26
27       ' return m_strMovieTitle
28       Get
29          Return m_strMovieTitle ' return movie title
30       End Get ' end of Get accessor
31
32       ' set movie title
33       Set(ByVal Value As String)
34
35          ' if title is greater than 20 characters
36          If Value.Length > 20 Then
37
38             ' take first 20 characters
39             Value = Value.Substring(0, 20)
40             m_strMovieTitle = Value
41          Else
42
43             ' set title
44             m_strMovieTitle = Value
45          End If
46
47       End Set ' end of Set accessor
48
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49    End Property ' MovieTitle
50
51    ' ReadOnly get property 
52    Public ReadOnly Property BonusMaterials() As String
53
54       ' display bonus material information
55       Get
56
57          ' information on bonus materials
58          Dim strBonusMaterial As String = ""
59          Dim intCount As Integer ' counter variable
60
61          ' loop through each bonus material
62          For intCount = 0 To (m_objBonusMaterial.Length - 1)
63
64             ' format String to contain minutes and seconds
65             strBonusMaterial &= _
66                m_objBonusMaterial(intCount).Name() & ": " & _
67                m_objBonusMaterial(intCount).ItemLength & _
68                " minute(s)." & ControlChars.CrLf
69          Next
70
71          Return strBonusMaterial ' return String
72       End Get ' end of Get accessor
73
74    End Property ' BonusMaterials
75
76    ' set and get movie length
77    Public Property MovieLength() As Integer
78
79       ' return m_intMovieLength
80       Get
81          Return m_intMovieLength ' return length of movie
82       End Get ' end of Get accessor
83
84       ' set minutes for movie
85       Set(ByVal Value As Integer)
86
87          ' make sure minute is nonegative
88          If Value > 0 Then
89             m_intMovieLength = Value
90          Else
91             m_intMovieLength = 0
92          End If
93
94       End Set ' end of Set accessor
95
96    End Property ' MovieLength
97
98 End Class ' DVDObject

1 ' Exercise 19.17 Solution
2 ' DVDBurner.vb
3
4 Public Class FrmDVDBurner
5    Inherits System.Windows.Forms.Form
6
7    Private m_objDVD As DVDObject  ' create instance variable
8
9    ' Windows Form Designer generated code
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10
11    Private Sub btnCreate_Click(ByVal sender As System.Object, _
12       ByVal e As System.EventArgs) Handles btnCreate.Click
13
14       Dim objBonus(2) As Bonus      ' array of Bonus
15       Dim intBonusLength As Integer ' bonus material minutes 
16
17       ' store movie name
18       Dim strMovieTitle As String = txtTitle.Text
19
20       ' movie minutes
21       Dim intMovieMinutes As Integer = _
22          Convert.ToInt32(Val(txtMovieMinute.Text))
23
24       ' bonus material description (name)
25       Dim strBonus1 As String = txtDescription1.Text
26       Dim strBonus2 As String = txtDescription2.Text
27       Dim strBonus3 As String = txtDescription3.Text
28
29       ' store minutes from TextBox
30       intBonusLength = Convert.ToInt32(Val(txtMinutes1.Text))
31
32       ' add bonus material name and time to array
33       objBonus(0) = New Bonus(strBonus1, intBonusLength)
34
35       ' store minutes from TextBox
36       intBonusLength = Convert.ToInt32(Val(txtMinutes2.Text))
37
38       ' add bonus material name and time to array
39       objBonus(1) = New Bonus(strBonus2, intBonusLength)
40
41       ' store minutes from TextBox
42       intBonusLength = Convert.ToInt32(Val(txtMinutes3.Text))
43
44       ' add bonus material name and time to array
45       objBonus(2) = New Bonus(strBonus3, intBonusLength)
46
47       ' call constructor for new object
48       m_objDVD = _
49          New DVDObject(strMovieTitle, objBonus, intMovieMinutes)
50
51       ' let the user know about progress
52       lblDisplay.Text = "Your DVD was created successfully!"
53
54       ' enable Information Button
55       btnInformation.Enabled = True
56
57    End Sub ' btnCreate_Click
58
59    ' display information about DVD
60    Private Sub btnInformation_Click(ByVal sender As System.Object, _
61       ByVal e As System.EventArgs) Handles btnInformation.Click
62
63       Dim strInformation As String ' output String
64
65       lblDisplay.Text = ""         ' clear Label
66
67       ' add title and length to String
68       ' add information about bonus materials
69       strInformation = m_objDVD.MovieTitle & ": " & _
70          m_objDVD.MovieLength & " minute(s)" & _
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71          ControlChars.CrLf & "Bonus Materials:" & _
72          ControlChars.CrLf & m_objDVD.BonusMaterials
73
74       ' display output in a MessageBox
75       MessageBox.Show(strInformation, "DVD Description", _
76          MessageBoxButtons.OK, MessageBoxIcon.Information)
77    End Sub ' btnInformation_Click
78
79 End Class ' FrmDVDBurner
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20
Shipping Hub 
Application

Introducing Collections, the For 
Each…Next Statement and Access 

Keys
Solutions
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Instructor’s Manual
Exercise Solutions

Tutorial 20

MULTIPLE-CHOICE
QUESTIONS

20.1  are specifically designed to store groups of values.

20.2 The  key provides a quick and convenient way to navigate through controls
on a Form.

20.3 An ArrayList differs from an array in that an ArrayList can .

20.4 The element in a For Each…Next statement .

20.5 The control that receives the focus the first time Tab is pressed has a TabIndex prop-
erty set to .

20.6 Users should be able to use the Tab key to transfer the focus to .

20.7 To ensure that the proper controls obtain the focus when the Tab key is pressed, use the
.

20.8 To add a value to the end of an ArrayList, call the  method.

20.9 To remove a value from a specific index in the ArrayList, use method .

20.10 To display an ampersand character on a control, type a  in its Text property.

Answers: 20.1) a.  20.2) a. 20.3) b.  20.4) b.  20.5) b.  20.6) d.  20.7) b.  20.8) a.  20.9) b.  20.10) c.

EXERCISES 20.11 (Modified Salary Survey Application) Modify the Salary Survey application you cre-
ated in Exercise 17.12 by using a For Each…Next loop to replace the For…Next loop that is
used in Tutorial 17 (Fig. 20.27).

a) Collections b) Properties
c) Accessors d) None of the above.

a) Tab b) Enter 
c) Caps Lock d) Alt 

a) store objects of any type b) resize dynamically
c) be accessed programmatically d) All of the above.

a) must be of type Integer 
b) must be of (or convertible to) the same type as the collection or array type
c) must be of type ArrayList d) None of the above.

a) First b) 0 
c) Next d) 1 

a) only Buttons b) only TextBoxes
c) only controls that have an AcceptTab property
d) only the controls that receive user input

a) TabIndex property b) TabStop and TabIndex properties
c) TabStop property d) Focus property

a) Add b) AddToEnd 
c) AddAt d) InsertAt 

a) Remove b) RemoveAt 
c) Delete d) DeleteAt 

a) &_ b) & 
c) && d) _& 
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Figure 20.27 Modified Salary Survey GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial20\Exercises\SalarySurveyModified directory to your C:\Sim-
plyVB directory. 

b) Opening the application’s template file. Double click SalarySurveyModified.sln
in the SalarySurvey directory to open the application.

c) Locating the event handler. In Design View, double click the Show Totals Button to
bring up the event handler. The code to handle the Click event should include two
statements, one to clear the items in the ListBox and the other to add a header.

d) Creating a counter variable. The For Each…Next loop allows you to loop through
each element in a specified collection. The For…Next loop from Exercise 17.12 han-
dles the String (m_strSalaryRanges) and Integer (m_intSalaries) arrays. This
presents a problem. You cannot loop through both of these arrays using the same ele-
ment reference. (One is an Integer, and the other is a String.) To handle this you
need to create a common counter variable, one that you will use to loop through the
indices of both arrays. This is possible because the lengths of both arrays are the
same.

e) Adding an element reference. It does not matter which array you decide to use in this
exercise, because these arrays are of the same length. Declare an element reference
with the correct data type.

f) Create the For Each…Next loop. Use the new element reference that you have cre-
ated along with the array of your choice to create the For Each…Next loop state-
ment.

g) Adding text to the ListBox. Adding the statement to output to the ListBox is
exactly the same as the one from Exercise 17.12. The only difference will be the name
of the counter variable that you decide to use.

h) Increment the counter variable. To successfully loop through both arrays and output
the data, you need to increment the counter variable. This ensures that the proper
data is added to the ListBox through each iteration.

i) Running the application. Select Debug > Start to run your application. Enter sev-
eral sales amounts using the Calculate Button. Click the Show Totals Button and
verify that the proper amounts are displayed for each salary range, based on the sala-
ries calculate from your input.

j) Closing the application. Close your running application by clicking its close box.

k) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 20.11 Solution
2 ' SalarySurvey.vb
3
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4 Public Class FrmSalarySurvey
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code 
8
9    ' salary ranges

10    Private m_strSalaryRanges As String() = New String() { _
11       "$200 - $299", "$300 - $399", "$400 - $499", _
12       "$500 - $599", "$600 - $699", "$700 - $799", _
13       "$800 - $899", "$900 - $999", "$1000 +  "}
14
15    ' number of employees in each salary range
16    Private m_intSalaries As Integer() = New Integer( _
17       m_strSalaryRanges.GetUpperBound(0)) {}
18
19    ' handles Calculate Button's Click event
20    Private Sub btnCalculate_Click(ByVal sender As System.Object, _
21       ByVal e As System.EventArgs) Handles btnCalculate.Click
22
23       ' obtain total sales
24       Dim decSales As Decimal = Convert.ToDecimal( _
25          Val(txtInputSales.Text))
26
27       ' employee's base salary
28       Dim decTotalSalary As Decimal = 200
29
30       ' add commision to total salary
31       decTotalSalary += Convert.ToDecimal(decSales * 0.09)
32
33       ' display salary in a Label
34       lblTotalSalary.Text = String.Format("{0:C}", decTotalSalary)
35
36       ' increment the correct counter in array m_intSalaries
37       Select Case decTotalSalary
38
39          Case Is < 300
40             m_intSalaries(0) += 1
41
42          Case Is < 400
43             m_intSalaries(1) += 1
44
45          Case Is < 500
46             m_intSalaries(2) += 1
47
48          Case Is < 600
49             m_intSalaries(3) += 1
50
51          Case Is < 700
52             m_intSalaries(4) += 1
53
54          Case Is < 800
55             m_intSalaries(5) += 1
56
57          Case Is < 900
58             m_intSalaries(6) += 1
59
60          Case Is < 1000
61             m_intSalaries(7) += 1
62
63          Case Is >= 1000
64             m_intSalaries(8) += 1



230 Shipping Hub Application Tutorial 20

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

20.12 (Modified Shipping Hub Application) Modify the Shipping Hub application created
in this tutorial, so that the user can double click a package in the lstPackages ListBox.
When a package number is double clicked, the package’s information should be displayed in
a MessageBox (Fig. 20.28).

Figure 20.28 Modified Shipping Hub application GUI.

65
66       End Select
67
68       ' clear TextBox
69       txtInputSales.Clear()
70    End Sub ' btnCalculate_Click
71
72    ' handles click event for btnShowTotals Button
73    Private Sub btnShowTotals_Click(ByVal sender As System.Object, _
74       ByVal e As System.EventArgs) Handles btnShowTotals.Click
75
76       Dim intCounter As Integer = 0 ' counter variable
77       Dim strRange As String  ' each range in m_strSalaryRanges
78
79       ' clear all items in the ListBox
80       lstSalaryTotals.Items.Clear()
81
82       ' add header to ListBox
83       lstSalaryTotals.Items.Add("Salary range:" & _
84          ControlChars.Tab & "Total:")
85
86       ' add each element from two arrays to the ListBox
87       For Each strRange In m_strSalaryRanges
88          lstSalaryTotals.Items.Add(m_strSalaryRanges(intCounter) & _
89             ControlChars.Tab & m_intSalaries(intCounter))
90          intCounter += 1 ' increment the counter
91       Next
92
93    End Sub ' btnShowTotals_Click
94
95 End Class ' FrmSalarySurvey
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a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial20\Exercises\ShippingHubModified directory to your C:\Sim-
plyVB directory. 

b) Opening the application’s template file. Double click ShippingHubModified.sln
in the ShippingHubModified directory to open the application.

c) Viewing the event handler. Click ShippingHub.vb in the Solution Explorer and
select View > Code. Scroll to the end of code listing to locate the ListBox’s Double-
Click event handler.

d) Initializing necessary variables. To loop through the packages in the ArrayList of
Packages, you need to create a reference of type Package. It is also helpful to create
a String variable to store the information about the given package. Write code in
the DoubleClick event handler to declare the String strPackage. A ListBox’s
DoubleClick event is raised when the control is double clicked.

e) Check whether the user has selected a valid item. To determine whether the user has
selected a valid item (and not an empty element in the ListBox), write an If…Then
statement to make sure that the ListBox is not empty when the user selected an
item. [Hint: A SelectedIndex value of -1 means that no item is currently selected.]

f) Writing a For Each…Next loop. Use the Package reference you declared in Step c to
create a For Each…Next loop with the m_objList collection.

g) Determining whether the current selected package is correct. Insert an If…Then
statement to determine whether the current object that is selected from the
m_objList collection matches the selected item from the ListBox. Because the
packages are listed in the ListBox by their package number, use that information in
your If…Then statement. Once the correct package is matched, store that package’s
information in the strPackage String.

h) Inserting the Else statement. Make sure to notify the user if an invalid item has been
selected from the ListBox. If this occurs, add a message to the strPackage String
that will be displayed in the MessageBox.

i) Displaying the MessageBox. Call the MessageBox’s Show method to display the text
you have added to the strPackage String. This displays either the information for
the package they have selected or the message telling them they have selected an
invalid package.

j) Running the application. Select Debug > Start to run your application. Add several
packages. In the Packages by State GroupBox, select a state for which there are
packages being sent. Double click one of the packages listed in the Packages by
State ListBox, and verify that the correct information is displayed in a MessageBox.

k) Closing the application. Close your running application by clicking its close box.

l) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 20.12 Solution
2 ' ShippingHub.vb
3
4 Public Class FrmShippingHub
5    Inherits System.Windows.Forms.Form
6
7    Private m_objList As Collections.ArrayList ' list of packages
8    Private m_objPackage As Package   ' current package
9    Private m_intPosition As Integer  ' position of current package

10    Private m_objRandom As Random     ' random number for package id
11    Private m_intPackageID As Integer ' individual package number
12
13    ' Windows Form Designer generated code 
14
15    ' Form Load event
16    Private Sub FrmShippingHub_Load(ByVal sender As _
17       System.Object, ByVal e As System.EventArgs) _
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18       Handles MyBase.Load
19
20       m_intPosition = 0          ' set initial position to zero
21       m_objRandom = New Random ' create new Random object
22       m_intPackageID = m_objRandom.Next(1, 100000) ' new package ID
23
24       ' show first state in ComboBox (using the Items property)
25       cboState.Text = Convert.ToString(cboState.Items.Item(0))
26       m_objList = New Collections.ArrayList ' list of packages
27    End Sub ' FrmShippingHub_Load
28
29    ' Scan New Button Click event
30    Private Sub btnNew_Click(ByVal sender As System.Object, _
31       ByVal e As System.EventArgs) Handles btnNew.Click
32
33       m_intPackageID += 1 ' increment package id
34       m_objPackage = New Package(m_intPackageID) ' create package
35
36       ClearControls() ' clear fields
37       lblPackageNumber.Text = _
38          m_objPackage.PackageNumber.ToString ' package number
39       lblArrivalTime.Text = _
40          m_objPackage.ArrivalTime.ToString ' display arrival time
41
42       ' only allow user to add package
43       fraAddress.Enabled = True ' disable GroupBox and its controls
44       SetButtons(False) ' enable/disable Buttons
45       btnAdd.Enabled = True  ' enable Add Button
46       btnNew.Enabled = False ' disable Scan New Button
47       txtAddress.Focus() ' transfer the focus to txtAddress TextBox
48    End Sub ' btnNew_Click
49
50    ' Add Button Click event
51    Private Sub btnAdd_Click(ByVal sender As System.Object, _
52       ByVal e As System.EventArgs) Handles btnAdd.Click
53
54       SetPackage() ' set Package properties from TextBoxes
55       m_objList.Add(m_objPackage) ' add package to ArrayList
56
57       fraAddress.Enabled = False ' disable GroupBox and its controls
58       SetButtons(True) ' enable appropriate Buttons
59
60       ' package cannot be added until Scan New is clicked
61       btnAdd.Enabled = False ' disable Add Button
62
63       ' if package's state displayed, add ID to ListBox
64       If cboState.Text = cboViewPackages.Text Then
65          lstPackages.Items.Add(m_objPackage.PackageNumber)
66       End If
67
68       cboViewPackages.Text = m_objPackage.State ' list packages
69       btnNew.Enabled = True ' enable Scan New Button
70    End Sub ' btnAdd_Click
71
72    ' Back Button Click event
73    Private Sub btnBack_Click(ByVal sender As System.Object, _
74       ByVal e As System.EventArgs) Handles btnBack.Click
75
76       ' move backward one package in the list
77       If m_intPosition > 0 Then
78          m_intPosition -= 1
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79       Else ' wrap to end of list
80          m_intPosition = m_objList.Count - 1
81       End If
82
83       LoadPackage() ' load package data from item in list
84    End Sub ' btnBack_Click
85
86    ' Next Button Click event
87    Private Sub btnNext_Click(ByVal sender As System.Object, _
88       ByVal e As System.EventArgs) Handles btnNext.Click
89
90       ' move forward one package in the list
91       If m_intPosition < m_objList.Count - 1 Then
92          m_intPosition += 1
93       Else
94          m_intPosition = 0 ' wrap to beginning of list
95       End If
96
97       LoadPackage() ' load package data from item in list
98    End Sub ' btnNext_Click
99
100    ' Remove Button click event
101    Private Sub btnRemove_Click(ByVal sender As _
102       System.Object, ByVal e As System.EventArgs) _
103       Handles btnRemove.Click
104
105       ' remove ID from ListBox if state displayed
106       If cboState.Text = cboViewPackages.Text Then
107          lstPackages.Items.Remove(m_objPackage.PackageNumber)
108       End If
109
110       m_objList.RemoveAt(m_intPosition) ' remove package from list
111
112       ' load next package in list if there is one
113       If m_objList.Count > 0 Then
114
115          ' if not at first position, go to previous one
116          If m_intPosition > 0 Then
117             m_intPosition -= 1
118          End If
119
120          LoadPackage() ' load package data from item in list
121       Else
122          ClearControls() ' clear fields
123       End If
124
125       SetButtons(True) ' enable appropriate Buttons
126    End Sub ' btnRemove_Click
127
128    ' Edit/Update Button Click event
129    Private Sub btnEditUpdate_Click(ByVal sender As _
130       System.Object, ByVal e As System.EventArgs) _
131       Handles btnEditUpdate.Click
132
133       ' when Button reads "Edit", allow user to
134       ' edit package information only
135       If btnEditUpdate.Text = "&Edit" Then
136          fraAddress.Enabled = True
137          SetButtons(False)
138          btnEditUpdate.Enabled = True
139
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140          ' change Button text from "Edit" to "Update"
141          btnEditUpdate.Text = "&Update"
142       Else
143
144          ' when Button reads "Update" remove the old package
145          ' data and add new data from TextBoxes
146          SetPackage()
147          m_objList.RemoveAt(m_intPosition)
148          m_objList.Insert(m_intPosition, m_objPackage)
149
150          ' display state in ComboBox
151          cboViewPackages.Text = m_objPackage.State
152
153          ' when done, return to normal operating state
154          fraAddress.Enabled = False  ' disable GroupBox
155          SetButtons(True) ' enable appropriate Buttons
156
157          ' change Button text from "Update" to "Edit"
158          btnEditUpdate.Text = "&Edit"
159       End If
160
161    End Sub ' btnEditUpdate_Click
162
163    ' set package properties
164    Private Sub SetPackage()
165       m_objPackage.Address = txtAddress.Text
166       m_objPackage.City = txtCity.Text
167       m_objPackage.State = _
168         Convert.ToString(cboState.SelectedItem)
169       m_objPackage.Zip = Convert.ToInt32(Val(txtZip.Text))
170    End Sub ' SetPackage
171
172    ' load package information into Form
173    Private Sub LoadPackage()
174
175       ' retrieve package from list
176       m_objPackage = CType(m_objList.Item(m_intPosition), _
177          Package)
178
179       ' display package data
180       txtAddress.Text = m_objPackage.Address
181       txtCity.Text = m_objPackage.City
182       cboState.Text = m_objPackage.State
183       txtZip.Text = m_objPackage.Zip.ToString("00000")
184       lblArrivalTime.Text = _
185          m_objPackage.ArrivalTime.ToString
186       lblPackageNumber.Text = _
187          m_objPackage.PackageNumber.ToString
188    End Sub ' LoadPackage
189
190    ' clear all the input controls on the Form
191    Private Sub ClearControls()
192       txtAddress.Clear()
193       txtCity.Clear()
194       txtZip.Clear()
195       cboState.SelectedText = ""
196       lblArrivalTime.Text = ""
197       lblPackageNumber.Text = ""
198    End Sub ' ClearControls
199
200    ' enable/disable Buttons
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201    Private Sub SetButtons(ByVal blnState As Boolean)
202       btnRemove.Enabled = blnState
203       btnEditUpdate.Enabled = blnState
204       btnNext.Enabled = blnState
205       btnBack.Enabled = blnState
206
207       ' disable navigation if not multiple packages
208       If m_objList.Count < 2 Then
209          btnNext.Enabled = False
210          btnBack.Enabled = False
211       End If
212
213       ' if no items, disable Remove and Edit/Update Buttons
214       If m_objList.Count = 0 Then
215          btnEditUpdate.Enabled = False
216          btnRemove.Enabled = False
217       End If
218
219    End Sub ' SetButtons
220
221    ' event raised when user selects a new state in ComboBox
222    Private Sub cboViewPackages_SelectedIndexChanged( _
223       ByVal sender As System.Object, ByVal e As System.EventArgs) _
224       Handles cboViewPackages.SelectedIndexChanged
225
226       Dim objViewPackage As Package ' control variable package
227       Dim strState As String = _
228          Convert.ToString(cboViewPacakges.SelectedItem)
229
230       lstPackages.Items.Clear() ' clear ListBox
231
232       ' list all packages for current state in ListBox
233       For Each objViewPackage In m_objList
234
235          ' determine if state package is being shipped to
236          ' matches the state selected in the ComboBox
237          If objViewPackage.State = strState Then
238
239             ' add package number to the ListBox
240             lstPackages.Items.Add(objViewPackage.PackageNumber)
241          End If
242
243       Next
244
245    End Sub ' cboViewPackages_SelectedIndexChanged
246
247    ' display package information for selected package
248    Private Sub lstPackages_DoubleClick(ByVal sender As _
249       System.Object, ByVal e As System.EventArgs) _
250       Handles lstPackages.DoubleClick
251
252       Dim objPackageInformation As Package ' temporary package
253       Dim strPackage As String = "" ' String for package information
254
255       ' check if the lstPackages ListBox is empty
256       If lstPackages.SelectedIndex <> -1 Then
257
258          For Each objPackageInformation In m_objList
259
260             ' if the package currently in objPackageInformation
261             ' matches the user's selected package
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20.13 (Controls Collection Application) Visual Basic .NET provides many different types
of collections. One such collection is the Controls collection, which is used to provide access
to all of the controls on a Form. Create an application that uses the Controls collection and a
For Each…Next loop to iterate through each control on the Form. As each control is encoun-
tered, add the control’s name to a ListBox, and change the control’s background color (in
Fig. 20.29, Color.Wheat is used).

Figure 20.29 Controls Collection GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial20\Exercises\ControlsCollection directory to your C:\Sim-
plyVB directory. 

262             If objPackageInformation.PackageNumber = _
263                Convert.ToInt32(lstPackages.SelectedItem) Then
264                strPackage &= ("Package " & _
265                   objPackageInformation.PackageNumber & _
266                   ControlChars.CrLf & _
267                   "Arrived at: " & _
268                   objPackageInformation.ArrivalTime & _
269                   ControlChars.CrLf & _
270                   "Address: " & _
271                   objPackageInformation.Address & _
272                   ControlChars.CrLf & _
273                   "City: " & _
274                   objPackageInformation.City & _
275                   ControlChars.CrLf & _
276                   "State: " & objPackageInformation.State & _
277                   ControlChars.CrLf & _
278                   "Zip code: " & _ 
279                   objPackageInformation.Zip).ToString("00000")
280
281             End If
282
283          Next
284
285       Else
286
287          ' if the user select a blank item in the ListBox
288          strPackage = "Please select a package"
289       End If
290
291       MessageBox.Show(strPackage, "Package Information", _
292          MessageBoxButtons.OK, MessageBoxIcon.Information)
293
294    End Sub ' lstPackages_DoubleClick
295
296 End Class ' FrmShippingHub
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b) Opening the application’s template file. Double click ControlsCollection.sln in
the ControlsCollection directory to open the application. 

c) Generating an event handler. Switch to Design view. Double click the Submit But-
ton in design view to create an event handler for the click event.

d) Declaring a control variable. Declare a reference of type Control. This reference
represents each element in the For Each…Next statement as it iterates through each
Control on the Form. 

e) Clearing the ListBox. To ensure that the information in the ListBox is updated each
time the Submit Button is clicked, clear the ListBox of all items.

f) Writing a For Each…Next loop. To create the For Each…Next loop, use the control
variable that you created to iterate through the Form’s Controls collection.

g) Adding each control’s name to the ListBox. Use the ListBox’s Add method to insert
the name of each control on the Form. Recall that a control’s Name property contains
the name of the control.

h) Changing the control’s background color. Use the Control’s BackColor property to
change the control’s background color. Set the property to a new color using a mem-
ber of the Color structure. [Hint: Type the word Color followed by the member-
access operator to display a list of predefined colors using the Intellisense feature.]
Note that the color of the PictureBox does not appear to change because its image
displays in the control’s foreground.

i) Running the application. Select Debug > Start to run your application. Click the
Submit Button. Verify that the controls’ background colors change, and that all the
controls are listed in the List of controls: ListBox.

j) Closing the application. Close your running application by clicking its close box.

k) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 20.13 Solution
2 ' ControlsCollection.vb
3
4 Public Class FrmControlsCollection
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    Private Sub btnSubmit_Click(ByVal sender As System.Object, _

10       ByVal e As System.EventArgs) Handles btnSubmit.Click
11
12       Dim objControl As Control
13
14       lstList.Items.Clear() ' clear ListBox
15
16       ' iterate through controls collection
17       For Each objControl In Controls
18
19          ' list name of each control
20          lstList.Items.Add(objControl.Name)
21
22          ' change background color
23          objControl.BackColor = Color.Wheat
24       Next
25
26    End Sub ' btnSubmit_Click
27
28 End Class ' FrmControlsCollection
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What does this code do? 20.14 What is the result of the following code?

Answer: This code creates an ArrayList and adds to it the values 1, 3 and 5. The values are 
then appended to each other (separated by spaces) using a For Each…Next statement, and 
the result is displayed in a MessageBox.

What’s wrong with this code? 20.15 This code should iterate through an array of Packages in ArrayList objList and
print each package’s number in Label lblDisplay. Find the error(s) in the following code.

Answer: The reference that specifies the element is of the wrong type to iterate through this 
list of Packages. The element reference should be of type Package. The corrected code is 
listed below:

Programming Challenge 20.16 (Enhanced Shipping Hub Application) Enhance the Shipping Hub application cre-
ated in Exercise 20.12 to allow the user to move a maximum of five packages from the ware-
house to a truck for shipping (Fig. 20.30). If you have not completed Exercise 20.12, follow
the steps in Exercise 20.12 before proceeding to the next step. If you have completed
Exercise 20.12, copy the code you added to the lstPackages ListBox DoubleClick event
handler to the same event handler in this application before beginning the exercise.

▲

1 Dim intList As Collections.ArrayList
2 Dim intListItems As Integer
3 Dim strOutput As String
4
5 intList = New ArrayList
6 intList.Add(1)
7 intList.Add(3)
8 intList.Add(5)
9

10 For Each intListItems In intList
11    strOutput &= (" " & intListItems.ToString)
12 Next
13
14 MessageBox.Show(strOutput, "Mystery", _
15    MessageBoxButtons.OK, MessageBoxIcon.Information)

▲

1 Dim objValue As Collections.ArrayList
2
3 For Each objValue In objList
4   lblDisplay.Text &= (" " & objValue.PackageNumber)
5 Next

1
2
3 For Each objValue In objList
4   lblDisplay.Text &= (" " & objValue.PackageNumber)
5 Next

Dim objValue As Package

▲
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Figure 20.30 Enhanced Shipping Hub GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial20\Exercises\ShippingHubEnhanced directory to your C:\Sim-
plyVB directory. 

b) Opening the application’s template file. Double click ShippingHubEnhanced.sln
in the ShippingHubEnhanced directory to open the application.

c) Enabling the Ship Button. The Ship Button should not be enabled until a package
is selected in the lstPackage ListBox. Double click the lstPackage ListBox from
design view to define the event handler. Use the Button’s Enabled property to
enable the Button if the SelectedIndex of the ListBox is not -1. This means that
when the user selects a package from the ListBox, the user can send the package to
the truck by clicking the Ship Button. Also, insert a line of code after the For
Each…Next statement in the SelectedIndexChanged event handler to disable the
Ship Button when a user chooses a different state.

d) Defining the Ship Button’s Click Event. Double click the Ship Button in Design
View to define the Click event. 

e) Incrementing the counter. Because you are only allowing five packages to be
“shipped,” declare an instance variable that will track how many packages have been
placed onto the truck. Increment the variable each time the Ship Button is clicked.

f) Creating temporary variables. Create two temporary Package references to store
the correct package’s information. Use objTempPackage as the reference to the ele-
ment in the collection type of a For Each…Next statement, and the objTruckPack-
age as a reference to the package added to the truck.

g) Using the If…Then…Else statement. Use an If…Then…Else statement to allow
packages to be placed onto the truck if the number of packages on the truck is less
than five.

h) Using the For Each…Next loop. Use a For Each…Next loop to iterate through the
values in m_objList. Each iteration should determine whether the current package
is the one selected from the ListBox.

i) Adding the package to the truck. When the For Each…Next loop has located the
correct package, add that package to the truck by adding the reference to objTemp-
Package to the truck’s ArrayList, m_objTruckList. Then assign the value in
objTempPackage (the package sent to the truck) to objTruckPackage.

j) Removing the package. When the For Each…Next loop completes, remove the pack-
age meant for the truck from m_objList and the lstPackages ListBox.

k) Displaying the package in the ListBox. Use a For Each…Next loop that iterates
through each package in the m_objTruckList ArrayList and displays each package
in the lstTruck ListBox.
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l) Refreshing the GUI. Call the ClearControls and SetButtons methods to clear the
TextBoxes and enable the appropriate Buttons. Also, set the Ship Button’s Enabled
property to False.

m)Coding the Else statement. Display a MessageBox that notifies the user if the num-
ber of packages on the truck is already five. Then disable the Ship Button.

n) Running the application. Select Debug > Start to run your application. Add several
packages. In the Packages by State GroupBox, select several packages and add them
to the Packages to Ship ListBox. Verify that you can add only 5 packages to this
ListBox.

o) Closing the application. Close your running application by clicking its close box.

p) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 20.16 Solution
2 ' ShippingHub.vb
3
4 Public Class FrmShippingHub
5    Inherits System.Windows.Forms.Form
6
7    Private m_objList As Collections.ArrayList ' list of packages
8    Private m_objPackage As Package   ' current package
9    Private m_intPosition As Integer  ' position of current package

10    Private m_objRandom As Random     ' random number for package id
11    Private m_intPackageID As Integer ' individual package number
12    Private m_objTruckList As Collections.ArrayList  ' shipment list
13    Private m_intCounter As Integer = 0 ' count packages on truck
14
15    ' Windows Form Designer generated code 
16
17    ' Form Load event
18    Private Sub FrmShippingHub_Load(ByVal sender As _
19       System.Object, ByVal e As System.EventArgs) _
20       Handles MyBase.Load
21
22       m_intPosition = 0 ' set initial position to zero
23       m_objRandom = New Random ' create new Random object
24       m_intPackageID = m_objRandom.Next(1, 100000) ' new package ID
25
26       ' show first state in ComboBox (using the Items property)
27       cboState.Text = Convert.ToString(cboState.Items.Item(0))
28       m_objList = New Collections.ArrayList ' list of packages
29       m_objTruckList = New Collections.ArrayList ' truck list
30    End Sub ' FrmShippingHub_Load
31
32    ' Scan New Button Click event
33    Private Sub btnNew_Click(ByVal sender As System.Object, _
34       ByVal e As System.EventArgs) Handles btnNew.Click
35
36       m_intPackageID += 1 ' increment package ID
37       m_objPackage = New Package(m_intPackageID) ' create package
38
39       ClearControls() ' clear fields
40       lblPackageNumber.Text = _
41          m_objPackage.PackageNumber.ToString ' package number
42       lblArrivalTime.Text = _
43          m_objPackage.ArrivalTime.ToString ' display arrival time
44
45       ' only allow user to add package
46       fraAddress.Enabled = True ' disable GroupBox and its controls
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47       SetButtons(False) ' enable/disable Buttons
48       btnAdd.Enabled = True  ' enable Add Button
49       btnNew.Enabled = False ' disable Scan New Button
50       txtAddress.Focus() ' transfer the focus to txtAddress TextBox
51    End Sub ' btnNew_Click
52
53    ' Add Button Click event
54    Private Sub btnAdd_Click(ByVal sender As System.Object, _
55       ByVal e As System.EventArgs) Handles btnAdd.Click
56
57       SetPackage() ' set Package properties from TextBoxes
58       m_objList.Add(m_objPackage) ' add package to ArrayList
59
60       fraAddress.Enabled = False ' disable GroupBox and its controls
61       SetButtons(True) ' enable appropriate Buttons
62
63       ' package cannot be added until Scan New is clicked
64       btnAdd.Enabled = False ' disable Add Button
65
66       ' if package's state displayed, add ID to ListBox
67       If cboState.Text = cboViewPackages.Text Then
68          lstPackages.Items.Add(m_objPackage.PackageNumber)
69       End If
70
71       cboViewPackages.Text = m_objPackage.State ' list packages
72       btnNew.Enabled = True ' enable Scan New Button
73    End Sub ' btnAdd_Click
74
75    ' Back Button Click event
76    Private Sub btnBack_Click(ByVal sender As System.Object, _
77       ByVal e As System.EventArgs) Handles btnBack.Click
78
79       ' move backward one package in the list
80       If m_intPosition > 0 Then
81          m_intPosition -= 1
82       Else ' wrap to end of list
83          m_intPosition = m_objList.Count - 1
84       End If
85
86       LoadPackage() ' load package data from item in list
87    End Sub ' btnBack_Click
88
89    ' Next Button Click event
90    Private Sub btnNext_Click(ByVal sender As System.Object, _
91       ByVal e As System.EventArgs) Handles btnNext.Click
92
93       ' move forward one package in the list
94       If m_intPosition < m_objList.Count - 1 Then
95          m_intPosition += 1
96       Else
97          m_intPosition = 0 ' wrap to beginning of list
98       End If
99
100       LoadPackage() ' load package data from item in list
101    End Sub ' btnNext_Click
102
103    ' Remove Button click event
104    Private Sub btnRemove_Click(ByVal sender As _
105       System.Object, ByVal e As System.EventArgs) _
106       Handles btnRemove.Click
107
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108       ' remove ID from ListBox if state displayed
109       If cboState.Text = cboViewPackages.Text Then
110          lstPackages.Items.Remove(m_objPackage.PackageNumber)
111       End If
112
113       m_objList.RemoveAt(m_intPosition) ' remove package from list
114
115       ' load next package in list if there is one
116       If m_objList.Count > 0 Then
117
118          ' if not at first position, go to previous one
119          If m_intPosition > 0 Then
120             m_intPosition -= 1
121          End If
122
123          LoadPackage() ' load package data from item in list
124       Else
125          ClearControls() ' clear fields
126       End If
127
128       SetButtons(True) ' enable appropriate Buttons
129    End Sub ' btnRemove_Click
130
131    ' Edit/Update Button Click event
132    Private Sub btnEditUpdate_Click(ByVal sender As _
133       System.Object, ByVal e As System.EventArgs) _
134       Handles btnEditUpdate.Click
135
136       ' when Button reads "Edit", allow user to
137       ' edit package information only
138       If btnEditUpdate.Text = "&Edit" Then
139          fraAddress.Enabled = True
140          SetButtons(False)
141          btnEditUpdate.Enabled = True
142
143          ' change Button text from "Edit" to "Update"
144          btnEditUpdate.Text = "&Update"
145       Else
146
147          ' when Button reads "Update" remove the old package
148          ' data and add new data from TextBoxes
149          SetPackage()
150          m_objList.RemoveAt(m_intPosition)
151          m_objList.Insert(m_intPosition, m_objPackage)
152
153          ' display state in ComboBox
154          cboViewPackages.Text = m_objPackage.State
155
156          ' when done, return to normal operating state
157          fraAddress.Enabled = False  ' disable GroupBox
158          SetButtons(True) ' enable appropriate Buttons
159
160          ' change Button text from "Update" to "Edit"
161          btnEditUpdate.Text = "&Edit"
162       End If
163
164    End Sub ' btnEditUpdate_Click
165
166    ' set package properties
167    Private Sub SetPackage()
168       m_objPackage.Address = txtAddress.Text
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169       m_objPackage.City = txtCity.Text
170       m_objPackage.State = _
171         Convert.ToString(cboState.SelectedItem)
172       m_objPackage.Zip = Convert.ToInt32(Val(txtZip.Text))
173    End Sub ' SetPackage
174
175    ' load package information into Form
176    Private Sub LoadPackage()
177
178       ' retrieve package from list
179       m_objPackage = CType(m_objList.Item(m_intPosition), _
180          Package)
181
182       ' display package data
183       txtAddress.Text = m_objPackage.Address
184       txtCity.Text = m_objPackage.City
185       cboState.Text = m_objPackage.State
186       txtZip.Text = m_objPackage.Zip.ToString("00000")
187       lblArrivalTime.Text = _
188          m_objPackage.ArrivalTime.ToString
189       lblPackageNumber.Text = _
190          m_objPackage.PackageNumber.ToString
191    End Sub ' LoadPackage
192
193    ' clear all the input controls on the Form
194    Private Sub ClearControls()
195       txtAddress.Clear()
196       txtCity.Clear()
197       txtZip.Clear()
198       cboState.SelectedText = ""
199       lblArrivalTime.Text = ""
200       lblPackageNumber.Text = ""
201    End Sub ' ClearControls
202
203    ' enable/disable Buttons
204    Private Sub SetButtons(ByVal blnState As Boolean)
205       btnRemove.Enabled = blnState
206       btnEditUpdate.Enabled = blnState
207       btnNext.Enabled = blnState
208       btnBack.Enabled = blnState
209
210       ' disable navigation if not multiple packages
211       If m_objList.Count < 2 Then
212          btnNext.Enabled = False
213          btnBack.Enabled = False
214       End If
215
216       ' if no items, disable Remove and Edit/Update Buttons
217       If m_objList.Count = 0 Then
218          btnEditUpdate.Enabled = False
219          btnRemove.Enabled = False
220       End If
221
222    End Sub ' SetButtons
223
224    ' event raised when user selects a new state in ComboBox
225    Private Sub cboViewPackages_SelectedIndexChanged( _
226       ByVal sender As System.Object, ByVal e As System.EventArgs) _
227       Handles cboViewPackages.SelectedIndexChanged
228
229       Dim objViewPackage As Package ' control variable package
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230       Dim strState As String = _
231          Convert.ToString(cboViewPacakges.SelectedItem)
232
233       lstPackages.Items.Clear() ' clear ListBox
234
235       ' list all packages for current state in ListBox
236       For Each objViewPackage In m_objList
237
238          ' determine if state package is being shipped to
239          ' matches the state selected in the ComboBox
240          If objViewPackage.State = strState Then
241
242             ' add package number to the ListBox
243             lstPackages.Items.Add(objViewPackage.PackageNumber)
244          End If
245
246       Next
247
248       btnShip.Enabled = False ' disable Ship Button
249
250    End Sub ' cboViewPackages_SelectedIndexChanged
251
252    ' displaying package information for selected package

253    Private Sub lstPackages_DoubleClick(ByVal sender As _
254      Object, ByVal e As System.EventArgs) _
255      Handles lstPackages.DoubleClick
256
257       Dim objPackageInformation As Package ' temporary package
258       Dim strPackage As String = "" ' String for package information
259
260       ' check if the lstPackages ListBox is empty
261       If lstPackages.SelectedIndex <> -1 Then
262
263          For Each objPackageInformation In m_objList
264
265             ' if the package currently in objPackageInformation
266             ' matches the user's selected package
267             If objPackageInformation.PackageNumber = _
268                Convert.ToDouble(lstPackages.SelectedItem) Then
269                strPackage &= "Package " & _
270                   objPackageInformation.PackageNumber & _
271                   ControlChars.CrLf & _
272                   "Arrived at: " & _
273                   objPackageInformation.ArrivalTime & _
274                   ControlChars.CrLf & _
275                   "Address: " & _
276                   objPackageInformation.Address & _
277                   ControlChars.CrLf & _
278                   "City: " & _
279                   objPackageInformation.City & _
280                   ControlChars.CrLf & _
281                   "State: " & objPackageInformation.State & _
282                   ControlChars.CrLf & _
283                   "Zip code: " & _ 
284                   objPackageInformation.Zip.ToString("00000"))
285
286             End If
287
288          Next
289
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290       Else
291
292          ' if the user select a blank item in the ListBox
293          strPackage = "Please select a package"
294       End If
295
296       MessageBox.Show(strPackage, "Package Information", _
297          MessageBoxButtons.OK, MessageBoxIcon.Information)
298
299    End Sub ' lstPackages_DoubleClick
300
301    ' allow packages to be shipped
302    Private Sub btnShip_Click(ByVal sender As _
303       System.Object, ByVal e As System.EventArgs) _
304       Handles btnShip.Click
305
306       Dim objTempPackage As Package ' temporary package
307       Dim objTruckPackage As Package ' package to remove
308
309       m_intCounter += 1 ' increment package count
310
311       ' if there is less than 6 packages in m_intCounter 
312       If m_intCounter <= 5 Then
313          ' for each package from the m_objList ArrayList
314          For Each objTempPackage In m_objList
315
316             ' move package to truck
317             If objTempPackage.PackageNumber = _
318                Convert.ToInt32(lstPackages.SelectedItem) Then
319                m_objTruckList.Add(objTempPackage)
320                objTruckPackage = objTempPackage
321             End If
322
323          Next
324
325          ' remove the package from warehouse
326          m_objList.Remove(objTruckPackage)
327
328          ' remove selected package
329          lstPackages.Items.Remove(lstPackages.SelectedItem)
330
331          lstTruck.Items.Clear() ' clear ListBox
332          lstTruck.Items.Add("Package ID:") ' add header
333
334          ' list all packages in ListBox
335          For Each objViewPackage In m_objTruckList
336
337             ' add package to lstTruck ListBox
338             lstTruck.Items.Add(objViewPackage.PackageNumber)
339          Next
340
341          btnShip.Enabled = False ' disable the Ship Button
342          ClearControls() ' clear the TextBoxes
343          SetButtons(True) ' enable appropriate Buttons
344
345       Else
346          MessageBox.Show("Truck can only hold 5 packages", _
347             "Limit Exceeded", _
348             MessageBoxButtons.OK, MessageBoxIcon.Exclamation)
349
350          btnShip.Enabled = True ' enable the Ship Button
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351       End If
352
353    End Sub ' btnShip_Click
354
355    ' disable Ship button when no package is selected
356    Private Sub lstPackages_SelectedIndexChanged(ByVal sender As _
357       System.Object, ByVal e As System.EventArgs) _
358       Handles lstPackages.SelectedIndexChanged
359
360       If lstPackages.SelectedIndex <> -1 Then
361          btnShip.Enabled = True ' enable the Ship Button
362       End If
363
364    End Sub ' lstPackages_SelectedIndexChanged
365
366 End Class ' FrmShippingHub
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21
“Cat and Mouse” Painter 

Application
Introducing the Graphics Object and 

Mouse Events
Solutions
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Instructor’s Manual
Exercise Solutions

Tutorial 21

MULTIPLE-CHOICE
QUESTIONS

21.1 The x- and y-coordinates of the MouseEventArgs object are relative to .

21.2 The  method of the Graphics class draws a solid ellipse.

21.3 The  object passed to a mouse event handler contains information about the
mouse event that was raised.

21.4 The  event is raised when a mouse button is pressed.

21.5 A  is used to fill a shape with color using a Graphics object.

21.6 A(n)  event is raised every time the mouse interacts with a control.

21.7 The  property of MouseEventArgs specifies which mouse button was
pressed.

21.8 The  class contains methods for drawing text, lines, rectangles and other
shapes.

21.9 An ellipse with its  is a circle.

21.10 The  method creates a Graphics object.

Answers: 21.1) c.  21.2) a.  21.3) c.  21.4) c.  21.5) b.  21.6) c.  21.7) b.  21.8) c.  21.9) d.  21.10) b.

EXERCISES 21.11 (Line Length Application) The Line Length application should draw a straight black
line on the Form and calculate the length of the line(Fig. 21.27). The line should begin at the
coordinates where the mouse button is pressed and should stop at the point where the mouse
button is released. The application should display the line’s length (that is, the distance
between the two endpoints) in the Label Length =. Use the following formula to calculate

a) the screen b) the application
c) the Form or control that contains the control that raised the event
d) None of the above.

a) FillEllipse b) Ellipse 
c) SolidEllipse d) FilledEllipse 

a) EventHandler b) MouseEventHandler 
c) MouseEventArgs d) EventArgs 

a) MousePress b) MouseClick 
c) MouseDown d) MouseButtonDown 

a) painter b) brush 
c) paint bucket d) marker 

a) control b) mouse pointer
c) mouse d) user

a) Source b) Button 
c) WhichButton d) ButtonPressed 

a) Pictures b) Drawings 
c) Graphics d) Illustrations 

a) height twice the length of its width b) width set to zero
c) height half the length of its width d) height equal to its width

a) NewGraphics b) CreateGraphics 
c) PaintGraphics d) InitializeGraphics 
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the line’s length, where ( , ) is the first endpoint (the coordinates where the mouse but-
ton is pressed) and ( , ) is the second endpoint (the coordinates where the mouse button
is released). To calculate the distance (or length) between the two points, use the following
equation:

   

To draw a straight line, you need to use the DrawLine method on a Graphics object.
When drawing lines, you should use a Pen object, which is an object used to specify charac-
teristics of lines and curves. Use the following method call to draw a black line between the
two points using a Graphics object reference objGraphic:

objGraphic.DrawLine(New Pen(Color.Black), , , , )

Figure 21.27 Line Length application’s GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial21\Exercises\LineLength directory to your C:\SimplyVB direc-
tory. 

b) Opening the application’s template file. Double click LineLength.sln in the Line-
Length directory to open the application.

c) Declaring instance variables. Declare and initialize a reference to a Graphics object
that you will use to draw a line. Then declare four Integers in which you will store
the x- and y-coordinates of the two points.

d) Adding a MouseDown event handler. Create a MouseDown event handler. Add code to
the MouseDown event handler to store the coordinates of the first endpoint of the line. 

e) Creating the Distance method. Define a Function procedure named Length that
returns the distance between two endpoints as a Double. The Function procedure
should use the following statement to perform the line length calculation, where
intXDistance is the difference between the x-coordinates of the two points and
intYDistance is the difference between the y-coordinates of the two points:

Math.Sqrt((intXDistance ^ 2) + (intYDistance ^ 2))

f)  Adding a MouseUp event handler. Create a MouseUp event handler. First store the
coordinates of the line’s second endpoint. Then call the Length method to obtain the
distance between the two endpoints (the line’s length). Finally, display the line on the
Form and the line’s length in the Length = Label, as in Fig. 21.27.

g) Running the application. Select Debug > Start to run your application. Draw sev-
eral lines and view their lengths. Verify that the length values are accurate.

h) Closing the application. Close your running application by clicking its close box.

i) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

x1 y1
x2 y2

d x1 x2–( )2 y1 y2–( )2+=

x1 y1 x2 y2
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1 ' Exercise 21.11 Solution
2 ' LineLength.vb
3
4 Public Class FrmLineLength
5    Inherits System.Windows.Forms.Form
6
7    ' create and initialize Graphics object
8    Private m_objGraphic As Graphics = CreateGraphics()
9

10    Private m_intX1 As Integer  ' first point’s x-coordinate
11    Private m_intY1 As Integer  ' first point’s y-coordinate
12    Private m_intX2 As Integer  ' second point’s x-coordinate
13    Private m_intY2 As Integer  ' second point’s y-coordinate 
14
15    ' Windows Form Designer generated code
16
17    ' handles FrmLineLength’s MouseUp event
18    Private Sub FrmLineLength_MouseDown(ByVal sender As Object, _
19       ByVal e As System.Windows.Forms.MouseEventArgs) _
20       Handles MyBase.MouseDown
21
22       lblLength.Text = ““  ' clear Label
23
24       ' get x- and y- coordinates of mouse click
25       m_intX1 = e.X
26       m_intY1 = e.Y
27    End Sub ' FrmLineLength_MouseDown
28
29    ' returns distance between two points
30    Private Function Length() As Double
31
32       ' horizontal distance
33       Dim intXDistance As Integer = m_intX1 - m_intX2
34
35       ' vertical distance
36       Dim intYDistance As Integer = m_intY1 - m_intY2
37
38       Return Math.Sqrt((intXDistance ^ 2) + (intYDistance ^ 2))
39    End Function ' Length
40
41    ' handles FrmLineLength’s MouseUp event
42    Private Sub FrmLineLength_MouseUp(ByVal sender As Object, _
43       ByVal e As System.Windows.Forms.MouseEventArgs) _
44       Handles MyBase.MouseUp
45
46       ' final point
47       m_intX2 = e.X
48       m_intY2 = e.Y
49
50       ' distance between two points
51       Dim dblDistance As Double = Length()
52
53       ' draw line connecting the two points
54       m_objGraphic.DrawLine(New Pen(Color.Black), _
55          m_intX1, m_intY1, m_intX2, m_intY2)
56
57       ' display distance in Label
58       lblLength.Text = String.Format(“{0:F}”, dblDistance)
59    End Sub ' FrmLineLength_MouseUp
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21.12 (Circle Painter Application) The Circle Painter application should draw a blue circle
with a randomly chosen size when the user presses a mouse button anywhere over the Form
(Fig. 21.28). The application should randomly select a circle diameter in the range from 5 to
199, inclusive. To draw a blue circle with a given diameter (intDiameter), use the following
statement:

objGraphic.DrawEllipse(New Pen(Color.Blue), e.X, e.Y, _
   intDiameter, intDiameter)

The DrawEllipse method, when passed a Pen (instead of a brush) as an argument,
draws the outline of an ellipse. Recall that an ellipse is a circle if the height and width argu-
ments are the same (in this case, the randomly selected intDiameter). Use the x- and y-
coordinates of the MouseDown event as the x- and y- coordinates of the circle’s bounding box
(that is, the second and third arguments to the DrawEllipse method). Notice that the first
argument to the DrawEllipse method is a Pen object. See Exercise 21.11 for a description of
Pen.

Figure 21.28 Circle Painter application’s GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial21\Exercises\CirclePainter directory to your C:\SimplyVB
directory. 

b) Opening the application’s template file. Double click CirclePainter.sln in the
CirclePainter directory to open the application.

c)  Adding a MouseDown event handler. Create a MouseDown event handler. In the event
handler, retrieve the x- and y-coordinates of the location the mouse pointer when a
mouse button was pressed. Then generate a random number to use as the circle’s
diameter, using a Random object, and store it in a variable. Finally, call the DrawEl-
lipse method on a reference to a Graphics object to draw a blue circle on the Form
with the diameter generated by the Random object. 

d) Running the application. Select Debug > Start to run your application. Draw sev-
eral blue circles and make sure that they are of different sizes.

e) Closing the application. Close your running application by clicking its close box.

f) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

60
61 End Class ' FrmLineLength

1 ' Exercise 21.12 Solution
2 ' CirclePainter.vb
3
4 Public Class FrmCirclePainter
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
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21.13 (Advanced Circle Painter Application) In this exercise, you will enhance the applica-
tion you created in Exercise 21.12. The advanced Circle Painter application should draw
blue circles with a randomly generated diameter when the user presses the left mouse button.
When the user presses the right mouse button, the application should draw a red circle with a
randomly generated diameter (Fig. 21.29).

Figure 21.29 Advanced Circle Painter application’s GUI.

a) Copying the template to your working directory. Make a copy of the Circle-
Painter directory from Exercise 21.12 in your C:\SimplyVB directory. Rename the
copied directory AdvancedCirclePainter. If you have not completed
Exercise 21.12, follow the steps in Exercise 21.12 to complete the application.

b) Opening the application’s template file. Double click CirclePainter.sln file in
the AdvancedCirclePainter directory to open the application.

c) Drawing the appropriate circle. Use the Button property of the MouseEventArgs
reference, e, to determine which mouse button was pressed. Finally, call the DrawEl-
lipse method on a reference to a Graphics object to draw a blue circle on the Form
if the left mouse button was clicked, or a red circle if the right mouse button was
clicked. 

d) Running the application. Select Debug > Start to run your application. Draw sev-
eral blue circles of different sizes using the left mouse button, then draw several red
circles of different sizes using the right mouse button.

e) Closing the application. Close your running application by clicking its close box.

8
9    ' handles MouseDown event for FrmCirclePainter

10    Private Sub FrmCirclePainter_MouseDown(ByVal sender As _
11       Object, ByVal e As System.Windows.Forms.MouseEventArgs) _
12       Handles MyBase.MouseDown
13
14       ' initialize Graphics object
15       Dim objGraphic As Graphics = CreateGraphics()
16
17       ' initialize Random object
18       Dim objRandom As Random = New Random
19
20       ' generate a random circle diameter
21       Dim intDiameter As Integer = objRandom.Next(5, 200)
22
23       ' draw a blue circle
24       objGraphic.DrawEllipse(New Pen(Color.Blue), e.X, e.Y, _
25          intDiameter, intDiameter)
26
27    End Sub ' FrmCirclePainter_MouseDown
28
29 End Class ' FrmCirclePainter
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f) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

What does this code do? 21.14 Consider the code in Fig. 21.26. Suppose we change the MouseMove event handler to
the code below. What happens when the user moves the mouse? Assume that a Label lblD-
isplay has been placed on the Form.

Answer: The Label continuously displays the mouse pointer’s current position on the Form.

1 ' Exercise 21.13 Solution
2 ' CirclePainter.vb
3
4 Public Class FrmCirclePainter
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' handles MouseDown event for FrmCirclePainter

10    Private Sub FrmCirclePainter_MouseDown(ByVal sender As _
11       Object, ByVal e As System.Windows.Forms.MouseEventArgs) _
12       Handles MyBase.MouseDown
13
14       ' initialize Graphics object
15       Dim objGraphic As Graphics = CreateGraphics()
16
17       ' initialize Random object
18       Dim objRandom As Random = New Random
19
20       ' generate a random circle diameter
21       Dim intDiameter As Integer = objRandom.Next(5, 200)
22
23       ' left mouse button pressed
24       If e.Button = MouseButtons.Left Then
25
26          ' draw a blue circle if left mouse button pressed
27          objGraphic.DrawEllipse(New Pen(Color.Blue), e.X, e.Y, _
28             intDiameter, intDiameter)
29
30       ' right mouse button pressed
31       ElseIf e.Button = MouseButtons.Right Then
32
33          ' draw a red circle if right mouse button pressed
34          objGraphic.DrawEllipse(New Pen(Color.Red), e.X, e.Y, _
35             intDiameter, intDiameter)
36
37       End If
38
39    End Sub ' FrmCirclePainter_MouseDown
40
41 End Class ' FrmCirclePainter

▲

1 Private Sub FrmPainter_MouseMove(ByVal sender As Object, _
2    ByVal e As System.Windows.Forms.MouseEventArgs) 
3    Handles MyBase.MouseMove
4    
5    lblDisplay.Text = "I’m at " & e.X & ", " & e.Y & "."
6 End Sub ' FrmPainter_MouseMove
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What’s wrong with this code? 21.15 The following code should draw a BlueViolet circle of diameter 4 that corresponds
to the movement of the mouse. Find the error(s) in the following code:

Answer: The position arguments in the FillEllipse method have been transposed. Use 
method CreateGraphics to initialize a Graphics object. A circle’s height and width must be 
equal, so the fourth argument passed to method FillEllipse should be 4. There should be 
no assignment operator between the word FillEllipse and the parenthesis. The corrected 
code is as follows:

Programming Challenge 21.16 (Advanced Painter Application) Extend the Painter application to enable a user to
change the size and color of the circles drawn.

Figure 21.30 Advanced Painter application’s GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial21\Exercises\AdvancedPainter directory to your C:\SimplyVB
directory.

▲

1 Private Sub FrmPainter_MouseMove(ByVal sender As Object, _
2    ByVal e As System.Windows.Forms.MouseEventArgs) _
3    Handles MyBase.MouseMove
4
5    If m_blnshouldPaint = True Then
6       Dim objGraphic As Graphics = Graphics()
7
8       objGraphic.FillEllipse = ( _
9          New SolidBrush(Color.BlueViolet), e.Y, e.X, 5, 4)

10    End If
11 End Sub ' FrmPainter_MouseMove

1 Private Sub FrmPainter_MouseMove(ByVal sender As Object, _
2    ByVal e As System.Windows.Forms.MouseEventArgs)  _
3    Handles MyBase.MouseMove
4
5    If m_blnshouldPaint = True Then
6       
7
8       
9       

10    End If
11 End Sub ' FrmPainter_MouseMove

Dim objGraphic As Graphics = CreateGraphics()

objGraphic.FillEllipse( _                           
   New SolidBrush(Color.BlueViolet), e.X, e.Y, 4, 4)

▲

Panel pnlPainter
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b) Opening the application’s template file. Double click AdvancedPainter.sln in the
AdvancedPainter directory to open the application (Fig. 21.30).

c) Understanding the provided instance variables. The template already provides you
with four instance variables. Variable m_objBrushColor is a Color value that speci-
fies the color of the brush used in the Advanced Painter application. The
m_blnShouldPaint and m_blnShouldErase variable perform the same functions as
in this tutorial’s Painter application. The m_intDiameter variable stores the diame-
ter of the circle to be drawn.

d) Declaring an enumeration to store the circle diameter sizes. Declare an enumeration
Sizes to store the possible values of m_intDiameter. Set constant SMALL to 4,
MEDIUM to 8 and LARGE to 10.

e) Adding event handlers for the Color RadioButtons. The Color RadioButton’s event
handlers should set m_objBrushColor to their specified colors (Color.Red,
Color.Blue, Color.Green or Color.Black).

f) Adding event handlers for the Size RadioButtons. The Size RadioButton’s event
handlers should set m_intDiameter to Sizes.SMALL (for the Small RadioButton),
Sizes.MEDIUM (for the Medium RadioButton) or Sizes.LARGE (for the Large
RadioButton).

g) Adding a mouse event handler to a Panel. To associate mouse events with the
Panel, select pnlPainter from the Class Name ComboBox. Then select the appropri-
ate mouse event from the Method Name ComboBox.

h) Coding the MouseDown and MouseUp event handlers. The MouseUp and MouseDown
event handlers behave exactly as they do in the Painter application.

i) Coding the MouseMove event handler. The MouseMove event handler behaves as the
one in Painter application does. The color of the brush that draws the circle when
m_blnShouldPaint is True is specified by m_objBrushColor. The eraser color is
specified by the Panel’s BackColor property. 

j) Running the application. Select Debug > Start to run your application. Start draw-
ing on the Panel using different brush sizes and colors. Use the right mouse button to
erase part of your drawing.

k) Closing the application. Close your running application by clicking its close box.

l) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:
 

1 ' Exercise 21.16 Solution
2 ' AdvancedPainter.vb
3
4 Public Class FrmAdvancedPainter
5    Inherits System.Windows.Forms.Form
6
7    ' create Color value and initialize to Black
8    Private m_objBrushColor As Color = Color.Black
9

10    ' specify whether application should paint
11    Private m_blnShouldPaint As Boolean = False
12
13    ' specify whether application should erase
14    Private m_blnShouldErase As Boolean = False
15
16    ' diameter of MouseDown circle (initially set to small)
17    Private m_intDiameter As Integer = 4
18
19    ' size constants for diameter of MouseDown circle
20    Private Enum Sizes
21       SMALL = 4
22       MEDIUM = 8
23       LARGE = 10
24    End Enum
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25
26    ' Windows Form Designer generated code
27
28    ' handles radRed's CheckChanged event
29    Private Sub radRed_CheckedChanged(ByVal sender As _
30       System.Object, ByVal e As System.EventArgs) _
31       Handles radRed.CheckedChanged
32
33       ' set brush color to red
34       If radRed.Checked = True Then
35          m_objBrushColor = Color.Red
36       End If
37
38    End Sub ' radRed_CheckedChanged
39
40    ' handles radBlue's CheckChanged event
41    Private Sub radBlue_CheckedChanged(ByVal sender As _
42       System.Object, ByVal e As System.EventArgs) _
43       Handles radBlue.CheckedChanged
44
45       ' set brush color to blue
46       If radBlue.Checked = True Then
47          m_objBrushColor = Color.Blue
48       End If
49
50    End Sub ' radBlue_CheckedChanged
51
52    ' handles radGreen's CheckChanged event
53    Private Sub radGreen_CheckedChanged(ByVal sender As _
54       System.Object, ByVal e As System.EventArgs) _
55       Handles radGreen.CheckedChanged
56
57       ' set brush color to green
58       If radGreen.Checked = True Then
59          m_objBrushColor = Color.Green
60       End If
61
62    End Sub ' radGreen_CheckedChanged
63
64    ' handles radBlack's CheckChanged event
65    Private Sub radBlack_CheckedChanged(ByVal sender As _
66       System.Object, ByVal e As System.EventArgs) _
67       Handles radBlack.CheckedChanged
68
69       ' set brush color to black
70       If radBlack.Checked = True Then
71          m_objBrushColor = Color.Black
72       End If
73
74    End Sub ' radBlack_CheckedChanged
75
76    ' handles radSmall's CheckChanged event
77    Private Sub radSmall_CheckedChanged(ByVal sender As _
78       System.Object, ByVal e As System.EventArgs) _
79       Handles radSmall.CheckedChanged
80
81       ' draw small circles
82       If radSmall.Checked = True Then
83          m_intDiameter = Sizes.SMALL
84       End If
85
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86    End Sub ' radSmall_CheckedChanged
87
88    ' handles radSMedium's CheckChanged event
89    Private Sub radMedium_CheckedChanged(ByVal sender As _
90       System.Object, ByVal e As System.EventArgs) _
91       Handles radMedium.CheckedChanged
92
93       ' draw medium circles
94       If radMedium.Checked = True Then
95          m_intDiameter = Sizes.MEDIUM
96       End If
97
98    End Sub ' radMedium_CheckedChanged
99
100    ' handles radLarge's CheckChanged event
101    Private Sub radLarge_CheckedChanged(ByVal sender As _
102       System.Object, ByVal e As System.EventArgs) _
103       Handles radLarge.CheckedChanged
104
105       ' draw large circles
106       If radLarge.Checked = True Then
107          m_intDiameter = Sizes.LARGE
108       End If
109
110    End Sub ' radLarge_CheckedChanged
111
112    ' draw when mouse button pressed down
113    Private Sub pnlPainter_MouseDown(ByVal sender As _
114       Object, ByVal e As System.Windows.Forms.MouseEventArgs) _
115       Handles pnlPainter.MouseDown
116
117       ' draw if left mouse button held down
118       If e.Button = MouseButtons.Left Then
119          m_blnShouldPaint = True
120
121       ' erase if right mouse button held down
122       ElseIf e.Button = MouseButtons.Right Then
123          m_blnShouldErase = True
124       End If
125
126    End Sub ' pnlPainter_MouseDown
127
128    ' stop drawing after mouse released
129    Private Sub pnlPainter_MouseUp(ByVal sender As _
130       Object, ByVal e As System.Windows.Forms.MouseEventArgs) _
131       Handles pnlPainter.MouseUp
132
133       m_blnShouldPaint = False  ' do not draw 
134       m_blnShouldErase = False  ' do not erase
135    End Sub ' pnlPainter_MouseUp
136
137    ' draw when mouse moves if mouse down
138    Private Sub pnlPainter_MouseMove(ByVal sender As _
139       Object, ByVal e As System.Windows.Forms.MouseEventArgs) _
140       Handles pnlPainter.MouseMove
141
142       ' create Graphics object for the Panel
143       Dim objGraphic As Graphics = pnlPainter.CreateGraphics()
144
145       ' draw circles with specified brush color and size
146       If m_blnShouldPaint = True Then
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147
148          objGraphic.FillEllipse(New SolidBrush(m_objBrushColor), _
149             e.X, e.Y, m_intDiameter, m_intDiameter)
150
151       ' draw circles with Panel’s background color and specified size
152       ElseIf m_blnShouldErase = True Then
153
154          objGraphic.FillEllipse( _
155             New SolidBrush(pnlPainter.BackColor), _
156             e.X, e.Y, m_intDiameter, m_intDiameter)
157
158       End If
159
160    End Sub ' pnlPainter_MouseMove
161
162 End Class ' FrmAdvancedPainter
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22
Typing Application

Introducing Keyboard Events, Menus 
and Dialogs

Solutions
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Instructor’s Manual
Exercise Solutions

Tutorial 23

MULTIPLE-CHOICE
QUESTIONS

22.1 When creating a menu, typing a  in front of a menu item name will create an
access shortcut for that item.

22.2 Alt, Shift and Control are  keys.

22.3 KeyChar is a property of .

22.4 Typing a hyphen (-) as a menu item’s Text property will create a(n) .

22.5 A  provides a group of related commands for Windows applications.

22.6 The  enumeration specifies key codes and modifiers.

22.7 The  event is raised when a key is pressed by the user.

22.8  Which of the following is not a keyboard event?

22.9 Which of the following is not a structure?

22.10 The  type allows you to determine which Button the user clicked to exit a
dialog.

Answers: 22.1) a.  22.2) a.  22.3) d.  22.4) a.  22.5) c.  22.6) d.  22.7) d. 22.8) d.  22.9) c.  22.10) b.

EXERCISES 22.11 (Inventory Application with Keyboard Events) Enhance the Inventory application
that you developed in Tutorial 4 to prevent the user from entering input that is not a number.
Use keyboard events to allow the user to press the number keys, the left and right arrows and
the Backspace keys. If a key other than these is pressed, display a MessageBox instructing the
user to enter a number (Fig. 22.30).

a) & b) !
c) $ d) #

a) modifier b) ASCII
c) function d) special

a) KeyEventArgs b) Key

c) KeyArgs d) KeyPressEventArgs

a) separator bar b) access shortcut
c) new submenu d) keyboard shortcut

a) separator bar b) hot key
c) menu d) margin indicator bar

a) Keyboard b) Key

c) KeyboardTypes d) Keys

a) KeyPress b) KeyHeld 
c) KeyDown d) Both a and c.

a) KeyPress b) KeyDown

c) KeyUp d) KeyClicked

a) Char b) Color

c) String d) Date

a) DialogButtons b) DialogResult 
c) Buttons d) ButtonResult
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Figure 22.30 Enhanced Inventory application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial22\Exercises\KeyEventInventory directory to your C:\SimplyVB
directory. 

b) Opening the application’s template file. Double click KeyEventInventory.sln in
the KeyEventInventory directory to open the application.

c) Adding the KeyDown event handler for the first TextBox. Add an empty KeyDown
event handler for the Cartons per shipment: TextBox. 

d) Adding a Select Case statement. Add a Select Case statement to the KeyDown
event handler that determines whether a number key, a left or right arrow or the
Backspace key was pressed. 

e) Adding the Case Else statement. Add a Case Else statement that will determine
whether a key other than a valid one for this application was pressed. If an invalid
key was pressed, display a MessageBox that instructs the user to enter a number.

f) Adding the KeyDown event handler for the second TextBox. Repeat Steps c–e, only
this time create a KeyDown event handler for the Items per carton: TextBox. This
event handler should perform the same functionality as the one for the Cartons per
shipment: TextBox.

g) Running the application. Select Debug > Start to run your application. Try entering
letters or pressing the up and down arrow keys in the TextBoxes. A MessageBox
should be displayed. Enter valid input and click the Calculate Total Button. Verify
that the correct output is displayed.

h) Closing the application. Close your running application by clicking its close box.

i) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 22.11 Solution
2 ' Inventory.vb
3
4 Public Class FrmInventory
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    Private Sub btnCalculate_Click(ByVal sender As _

10       System.Object, ByVal e As System.EventArgs) _
11       Handles btnCalculate.Click
12
13       ' multiply values input and display result in Label
14       lblTotalResult.Text = _
15          (Val(txtCartons.Text) _
16          * Val(txtItems.Text)).ToString
17
18    End Sub ' btnCalculate_Click
19
20    Private Sub txtCartons_KeyDown(ByVal sender As Object, _
21       ByVal e As System.Windows.Forms.KeyEventArgs) _
22       Handles txtCartons.KeyDown
23
24       Dim result As DialogResult ' store result of MessageBox
25
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22.12 (Bouncing Ball Game) Write an application that allows the user to play a game, the
goal of which is to prevent a bouncing ball from falling off the bottom of the Form. When the

26       Select Case e.KeyData
27          Case Keys.D0 To Keys.D9 ' numbers
28
29          Case Keys.Back ' backspace
30
31          Case Keys.Enter ' enter
32
33          Case Keys.Left, Keys.Right ' arrows
34
35          Case Else ' all other keys
36
37             ' show MessageBox
38             result = MessageBox.Show("Enter numbers only", _
39                "Invalid Input", MessageBoxButtons.OK, _
40                MessageBoxIcon.Exclamation)
41
42             ' clear TextBox if invalid input entered
43             If result = DialogResult.OK Then
44                txtCartons.Clear()
45             End If
46
47       End Select
48
49    End Sub ' txtCartons_KeyDown
50
51    Private Sub txtItems_KeyDown(ByVal sender As Object, _
52       ByVal e As System.Windows.Forms.KeyEventArgs) _
53       Handles txtItems.KeyDown
54
55       Dim result As DialogResult ' store result of MessageBox
56
57       Select Case e.KeyData
58          Case Keys.D0 To Keys.D9 ' numbers
59
60          Case Keys.Back ' backspace
61
62          Case Keys.Enter ' enter
63
64          Case Keys.Left, Keys.Right ' arrows
65
66          Case Else ' all other keys
67
68             ' show MessageBox
69             result = MessageBox.Show("Enter numbers only", _
70                "Invalid Input", MessageBoxButtons.OK, _
71                MessageBoxIcon.Exclamation)
72
73             ' clear TextBox if invalid input entered
74             If result = DialogResult.OK Then
75                txtItems.Clear()
76             End If
77
78       End Select
79
80    End Sub ' txtItems_KeyDown
81
82 End Class ' FrmInventory
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user presses the S key, a blue ball will bounce off the top, left and right sides (the “walls”) of
the Form. There should be a horizontal bar on the bottom of the Form, which serves as a pad-
dle to prevent the ball from hitting the bottom of the Form. (The ball can bounce off the pad-
dle, but not the bottom of the Form.) The user can move the paddle using the left and right
arrow keys. If the ball hits the paddle, the ball should bounce up, and the game should con-
tinue. If the ball hits the bottom of the Form, the game should end. The paddle’s width should
decrease every 20 seconds to make the game more challenging. The GUI is provided for you
(Fig. 22.31).

Figure 22.31 Bouncing Ball application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial22\Exercises\BouncingBall directory to your C:\SimplyVB direc-
tory. 

b) Opening the application’s template file. Double click BouncingBall.sln in the
BouncingBall directory to open the application.

c) Creating the KeyDown event handler. Insert a KeyDown event handler for the Form.

d) Writing code to start the game. Write an If...Then statement in the KeyDown event
handler that tests whether the user presses the S key. You can use the KeyDown event
handler for the S key in this case because you do not care whether the user presses an
uppercase S or a lowercase S. If the user presses the S key, start the two Timers that
are provided in the template.

e) Inserting code to move the paddle left. Write an If...Then statement that tests if the
user pressed the left-arrow key and if the paddle’s horizontal position is greater than
zero. If the paddle’s horizontal position equals zero, the left edge of the paddle is
touching the left wall and the paddle should not be allowed to move farther to the
left. If both the conditions in the If…Then are true, decrease the paddle’s x-position
by 10.

f) Inserting code to move the paddle right. Write an If...Then statement that tests if the
user pressed the right-arrow key and whether the paddle’s x-coordinate is less than
the width of the Form minus the width of the paddle. If the paddle’s x-coordinate
equals the Form’s width minus the width of the paddle, the paddle’s right edge is
touching the right wall and the paddle should not be allowed to move farther to the
right. If both the conditions in the If…Then statement are true, increase the paddle’s
x-coordinate by 10.

g) Running the application. Select Debug > Start to run your application. Press the S
key to begin the game and use the paddle to keep the bouncing ball from dropping
off the Form. Continue doing this until 20 seconds have passed, and verify that the
paddle is decreased in size at that time.

h) Closing the application. Close your running application by clicking its close box.
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i) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 22.12 Solution
2 ' BouncingBall.vb
3
4 Public Class FrmBouncingBall
5    Inherits System.Windows.Forms.Form
6
7    Private intX As Integer ' ball's x-coordinate
8    Private intY As Integer ' ball's y-coordinate
9    Private intRectangleX As Integer ' paddle's x-coordinate

10    Private intRectangleWidth As Integer ' paddle's width
11
12    Private intDeltaX As Integer ' ball's x rate of change
13    Private intDeltaY As Integer ' ball's y rate of change
14
15    Private blnXLeft As Boolean ' tests if ball can move left
16    Private blnYUp As Boolean ' tests if ball can move up
17
18    Private Const intMAX_X As Integer = 400 ' x boundary
19    Private Const intMAX_Y As Integer = 400 ' y boundary
20
21    ' object to generate random numbers
22    Private objRandom As Random = New Random
23
24    ' Windows Form Designer generated code
25
26    Private Sub FrmBouncingBall_Load(ByVal sender As _
27       System.Object, ByVal e As System.EventArgs) _
28       Handles MyBase.Load
29
30       intX = objRandom.Next(100, 301) ' ball's initial x
31       intY = objRandom.Next(100, 301) ' ball's initial y
32       intRectangleX = 175 ' rectangle's intial x position
33       intRectangleWidth = 80 ' rectangle's intial width
34
35       blnXLeft = False ' ball can move left
36       blnYUp = False ' ball can move up
37       intDeltaX = 2 ' move ball 2 positions right
38       intDeltaY = 2 ' move ball 2 positions down
39    End Sub ' FrmBouncingBall_Load
40
41    Protected Overrides Sub OnPaint( _
42       ByVal e As System.Windows.Forms.PaintEventArgs)
43
44       ' create graphics object
45       Dim objGraphic As Graphics = CreateGraphics()
46
47       ' create new brush
48       Dim objBrush As SolidBrush = New SolidBrush(Color.Blue)
49
50       ' draw ball
51       objGraphic.FillEllipse(objBrush, intX, intY, 10, 10)
52
53       ' set color for, and draw paddle
54       objBrush.Color = Color.Brown
55       objGraphic.FillRectangle( _
56          objBrush, intRectangleX, 380, intRectangleWidth, 15)
57    End Sub ' OnPaint
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58
59    Private Sub tmrMoveBall_Tick(ByVal sender As System.Object, _
60       ByVal e As System.EventArgs) Handles tmrMoveBall.Tick
61
62       ' determine new x position
63       If blnXLeft = True Then
64          intX += intDeltaX
65       Else
66          intX -= intDeltaX
67       End If
68
69       ' determine new y position
70       If blnYUp Then
71          intY += intDeltaY
72       Else
73          intY -= intDeltaY
74       End If
75
76       If intY <= 0 Then
77          blnYUp = True
78          intDeltaY = objRandom.Next(2, 6)
79       ElseIf intY >= 370 AndAlso intX >= intRectangleX _
80          AndAlso intX <= (intRectangleX + intRectangleWidth) Then
81          blnYUp = False
82          intDeltaY = objRandom.Next(2, 6)
83       ElseIf intY >= 410 Then ' end game if ball hits floor
84          tmrMoveBall.Enabled = False
85          tmrShrinkSlider.Enabled = False
86          MessageBox.Show("Game Over")
87       End If
88
89       If intX <= 0 Then
90          blnXLeft = True
91          intDeltaX = objRandom.Next(2, 6)
92       ElseIf intX >= intMAX_X - 10 Then
93          blnXLeft = False
94          intDeltaX = objRandom.Next(2, 6)
95       End If
96
97       Invalidate() ' Refresh Form
98
99    End Sub ' tmrMoveBall_Tick
100
101    ' shrinks the paddle every 20 seconds
102    Private Sub tmrShrinkSlider_Tick(ByVal sender As _
103       System.Object, ByVal e As System.EventArgs) _
104       Handles tmrShrinkSlider.Tick
105
106       ' shrink paddle if paddle greater than twice ball's width
107       If intRectangleWidth >= 20 Then
108          intRectangleWidth = Convert.ToInt32( _
109             intRectangleWidth / 2)
110       End If
111
112    End Sub ' tmrShrinkSlider_Tick
113
114    ' handles KeyDown event
115    Private Sub FrmBouncingBall_KeyDown(ByVal sender As Object, _
116       ByVal e As System.Windows.Forms.KeyEventArgs) Handles _
117       MyBase.KeyDown
118
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22.13 (Modified Painter Application) Modify the Painter application that you developed in
Tutorial 21 to include menus that allow the user to select the size and color of the painted
ellipses and the color of the Form (Fig. 22.32). (The menus replace the RadioButtons.) Also,
add a multiline TextBox that allows the user to type text to accompany the painting. The user
should be able to use menus to select the font style and color of the text and the background
color of the TextBox.

Figure 22.32 Enhanced Painter GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial22\Exercises\ModifiedPainter directory to your C:\SimplyVB
directory. 

b) Opening the application’s template file. Double click ModifiedPainter.sln in the
ModifiedPainter directory to open the application.

c) Creating the menus. Create two menus. The first one should be titled Paint and
should contain a Paint Color… menu item, a Paint Size submenu that contains menu
items 4, 6, 8 and 10, a separator bar and a Background Color… menu item. The sec-
ond menu should be titled Text and have Text Color… and Font… menu items, a sep-
arator bar and a TextBox Color… menu item.

d) Changing the paint color. Add an event handler for the Paint Color… menu item.
This event handler should display a Color dialog that allows the user to change the
value stored in m_paintColor.

e) Changing the paint size. Add an event handler for each of the Size submenu’s menu
items. Each event handler should change the value stored in m_intDiamter to the

119       If e.KeyCode = Keys.S Then ' start game if user presses S key
120          tmrMoveBall.Enabled = True ' start tmrMoveBall
121          tmrShrinkSlider.Enabled = True ' start tmrShrinkSlider
122       End If
123
124       If e.KeyCode = Keys.Left AndAlso intRectangleX >= 0 Then
125          intRectangleX -= 10 ' move paddle to the left
126       End If
127
128       If e.KeyCode = Keys.Right AndAlso _
129          (intRectangleX <= intMAX_X - intRectangleWidth) Then
130
131          intRectangleX += 10 ' move paddle to the right
132       End If
133
134    End Sub ' FrmBouncingBall_KeyDown
135
136 End Class ' FrmBouncingBall
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value displayed on the menu (that is, clicking the 4 menu item will change the value
of m_intDiameter to 4).

f) Changing the background color. Add an event handler for the Background Color…
menu item. This event handler should display a Color dialog that allows the user to
change the value stored in m_backgroundColor and also change the BackColor
property of the Form. To change the background color of the Form, assign the value
specifying the background color to BackColor. For instance, the statement
BackColor = Color.White changes the background color of the Form to white.

g) Changing the text color. Add an event handler for the Text Color… menu item. This
event handler should display a Color dialog that allows the user to change the color
of the text displayed in the TextBox.

h) Changing the text style. Add an event handler for the Font… menu item. This event
handler should display a Font dialog that allows the user to change the style of the
text displayed in the TextBox.

i) Changing the TextBox’s background color. Add an event handler for the TextBox
Color… menu item. This event handler should display a Color dialog that allows the
user to change the background color of the TextBox.

j) Running the application. Select Debug > Start to run your application. Use the
menus to draw shapes of various colors and brush sizes. Enter text to describe your
drawing. Use the other menu options to change the color of the Form, the TextBox
and the text in the TextBox.

k) Closing the application. Close your running application by clicking its close box.

l) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 22.13 Solution
2 ' Painter.vb
3
4 Public Class FrmPainter
5    Inherits System.Windows.Forms.Form
6
7    ' specify whether moving the mouse should erase
8    Private m_blnShouldErase As Boolean
9

10    ' specify whether moving the mouse should draw
11    Private m_blnShouldPaint As Boolean
12
13    ' set diameter of MouseDown circle
14    Private m_intDiameter As Integer
15    Private m_paintColor As Color ' paint color
16
17    Private m_backgroundColor As Color ' background color
18
19    ' create Graphics object
20    Private m_objGraphic As Graphics
21
22    ' Windows Form Designer generated code
23
24    Private Sub FrmPainter_Load(ByVal sender As System.Object, _
25       ByVal e As System.EventArgs) Handles MyBase.Load
26
27       m_blnShouldErase = False ' should not be painting
28       m_blnShouldPaint = False ' should not be erasing
29       m_intDiameter = 8 ' set paint size
30       m_paintColor = Color.BlueViolet ' set paint color
31       m_backgroundColor = FrmPainter.DefaultBackColor
32       m_objGraphic = CreateGraphics() ' initialize graphics object
33    End Sub ' FrmPainter_Load
34
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35    ' handles FrmPainter's MouseDown event
36    Private Sub FrmPainter_MouseDown(ByVal sender As Object, _
37       ByVal e As System.Windows.Forms.MouseEventArgs) _
38       Handles MyBase.MouseDown
39
40       ' draw on Form if the left button is held down
41       If e.Button = MouseButtons.Left Then
42          m_blnShouldPaint = True
43
44       ' erase blue-violet circles if right button is held down
45       ElseIf e.Button = MouseButtons.Right Then
46          m_blnShouldErase = True
47       End If
48
49    End Sub ' FrmPainter_MouseDown
50
51    ' handles FrmPainter's MouseUp event
52    Private Sub FrmPainter_MouseUp(ByVal sender As Object, _
53       ByVal e As System.Windows.Forms.MouseEventArgs) _
54       Handles MyBase.MouseUp
55
56       m_blnShouldPaint = False  ' do not draw on the Form
57       m_blnShouldErase = False  ' do not erase
58
59    End Sub ' FrmPainter_MouseUp
60
61    ' handles FrmPainter's MouseMove event
62    Private Sub FrmPainter_MouseMove(ByVal sender As Object, _
63       ByVal e As System.Windows.Forms.MouseEventArgs) _
64       Handles MyBase.MouseMove
65
66       ' draw circle if left mouse button is pressed
67       If m_blnShouldPaint Then
68          m_objGraphic.FillEllipse(New SolidBrush(m_paintColor), _
69             e.X, e.Y, m_intDiameter, m_intDiameter)
70
71       ' mouse pointer "erases" if right mouse button is pressed
72       ElseIf m_blnShouldErase Then
73          m_objGraphic.FillEllipse( _
74             New SolidBrush(m_backgroundColor), _
75             e.X, e.Y, m_intDiameter, m_intDiameter)
76       End If
77
78    End Sub ' FrmPainter_MouseMove
79
80    Private Sub mnuitmColor_Click(ByVal sender As System.Object, _
81       ByVal e As System.EventArgs) Handles mnuitmColor.Click
82
83       Dim dlgColorDialog As New ColorDialog   ' Color Dialog
84       Dim result As DialogResult ' stores Button clicked
85
86       dlgColorDialog.FullOpen = True ' show all colors
87       result = dlgColorDialog.ShowDialog
88
89       ' do nothing if user clicked dialog's Cancel Button
90       If result = DialogResult.Cancel Then
91          Return
92       End If
93
94       ' assign new color to Paint object
95       m_paintColor = dlgColorDialog.Color
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96    End Sub ' mnuitmColor_Click
97
98    Private Sub mnuitmFour_Click(ByVal sender As System.Object, _
99     ByVal e As System.EventArgs) Handles mnuitmFour.Click
100
101       m_intDiameter = 4 ' set paint size to four
102    End Sub ' mnuitmFour_Click
103
104    Private Sub mnuitmSix_Click(ByVal sender As System.Object, _
105       ByVal e As System.EventArgs) Handles mnuitmSix.Click
106
107       m_intDiameter = 6 ' set paint size to six
108    End Sub ' mnuitmSix_Click
109
110    Private Sub mnuitmEight_Click(ByVal sender As System.Object, _
111       ByVal e As System.EventArgs) Handles mnuitmEight.Click
112
113       m_intDiameter = 8 ' set paint size to eight
114    End Sub ' mnuitmEight_Click
115
116    Private Sub mnuitmTen_Click(ByVal sender As System.Object, _
117       ByVal e As System.EventArgs) Handles mnuitmTen.Click
118
119       m_intDiameter = 10 ' set paint size to ten
120    End Sub ' mnuitmTen_Click
121
122    Private Sub mnuitmBackground_Click(ByVal sender As _
123       System.Object, ByVal e As System.EventArgs) _ 
124       Handles mnuitmBackground.Click
125
126       Dim dlgColorDialog As New ColorDialog   ' Color Dialog
127       Dim result As DialogResult ' stores Button clicked
128
129       dlgColorDialog.FullOpen = True ' show all colors
130       result = dlgColorDialog.ShowDialog()
131
132       ' do nothing if user clicked dialog's Cancel Button
133       If result = DialogResult.Cancel Then
134          Return
135       End If
136
137       m_backgroundColor = dlgColorDialog.Color ' set "erase" color
138       BackColor = dlgColorDialog.Color ' set Form's color
139    End Sub ' mnuitmBackground_Click
140
141    Private Sub mnuitmTextColor_Click(ByVal sender As System.Object, _
142       ByVal e As System.EventArgs) Handles mnuitmTextColor.Click
143
144       Dim dlgColorDialog As New ColorDialog   ' Color Dialog
145       Dim result As DialogResult ' stores Button clicked
146
147       dlgColorDialog.FullOpen = True ' show all colors
148       result = dlgColorDialog.ShowDialog()
149
150       ' do nothing if user clicked dialog's Cancel Button
151       If result = DialogResult.Cancel Then
152          Return
153       End If
154
155       ' assign new color to text
156       txtOutput.ForeColor = dlgColorDialog.Color
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What does this code do? 22.14 What is the result of the following code?

157    End Sub ' mnuitmTextColor_Click
158
159    Private Sub mnuitmFont_Click(ByVal sender As System.Object, _
160    ByVal e As System.EventArgs) Handles mnuitmFont.Click
161
162       Dim dlgFontDialog As New FontDialog   ' Font Dialog
163       Dim result As DialogResult ' stores Button clicked
164
165       ' show dialog and get result
166       result = dlgFontDialog.ShowDialog()
167
168       ' do nothing if user clicked dialog's Cancel Button
169       If result = DialogResult.Cancel Then
170          Return
171       End If
172
173       ' assign new font value to TextBox
174       txtOutput.Font = dlgFontDialog.Font
175    End Sub ' mnuitmFont_Click
176
177    Private Sub mnuitmTextBoxColor_Click(ByVal sender As _
178       System.Object,  ByVal e As System.EventArgs) _   
179       Handles mnuitmTextBoxColor.Click
180
181       Dim dlgColorDialog As New ColorDialog   ' Color Dialog
182       Dim result As DialogResult ' stores Button clicked
183
184       dlgColorDialog.FullOpen = True ' show all colors
185       result = dlgColorDialog.ShowDialog()
186
187       ' do nothing if user clicked dialog's Cancel Button
188       If result = DialogResult.Cancel Then
189          Return
190       End If
191
192       ' assign background color of TextBox
193       txtOutput.BackColor = dlgColorDialog.Color
194    End Sub ' mnuitmTextBoxColor_Click
195
196 End Class ' FrmPainter

▲

1 Private Sub mnuitmColor_Click(ByVal sender As _
2    System.Object, ByVal e As System.EventArgs) _
3    Handles mnuitmColor.Click
4
5    Dim dlgColorDialog As ColorDialog = New ColorDialog
6    Dim result As DialogResult
7
8    dlgColorDialog.FullOpen = True
9

10    result = dlgColorDialog.ShowDialog()
11
12    If result = DialogResult.Cancel Then
13      Return
14    End If
15
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Answer: When this event handler executes, the Color dialog is displayed. If the user chooses 
a color, that color is assigned to the BackColor property of lblDisplay. If the dialog’s Can-
cel Button is clicked, the dialog closes and this event handler terminates.

What’s wrong with this code? 22.15 This code should allow a user to pick a font from a Font dialog and set the text in txt-
Display to that font. Find the error(s) in the following code, assuming that a TextBox named
txtDisplay exists on a Form.

Answer: The code should check whether the user clicked the Cancel Button in the dialog. 
If the user clicked Cancel, the method should be terminated. If the user did not click Cancel, 
the text should be set to the selected style. 

Programming Challenge 22.16 (Dvorak Keyboard Application) Create an application that simulates the letters on
the Dvorak keyboard. A Dvorak keyboard allows faster typing by placing the most com-
monly used keys in the most accessible locations. Use keyboard events to create an applica-
tion similar to the Typing Application, except that it simulates the Dvorak keyboard instead
of the standard keyboard. The correct Dvorak key should be highlighted on the virtual key-
board and the correct character should be displayed in the TextBox. The keys and characters
map as follows:

■ On the top row, the P key of the Dvorak keyboard maps to the R key on a
standard keyboard, and the L key of the Dvorak keyboard maps to the P key
on a standard keyboard.

■ On the middle row, the A key remains in the same position and the S key on
the Dvorak keyboard maps to the semicolon key on the standard keyboard.

■ On the bottom row, the Q key on the Dvorak keyboard maps to the X key on
the standard keyboard and the Z key maps to the question mark key.

■ All of the other keys on the Dvorak keyboard map to the location shown in
Fig. 22.33.

16    BackColor = dlgColorDialog.Color
17 End Sub ' mnuitmColor_Click

▲

1 Private Sub Fonts()
2    Dim dlgFontDialog As FontDialog
3
4    dlgFontDialog = New FontDialog
5    dlgFontDialog.ShowDialog()
6    txtDisplay.Font = dlgFontDialog.Font
7 End Sub ' Fonts

1 Private Sub Fonts()
2    
3    Dim dlgFontDialog As FontDialog
4
5    dlgFontDialog = New FontDialog()
6    result = dlgFontDialog.ShowDialog()
7
8    
9    

10    
11    
12    
13
14 End Sub ' Fonts

Dim result As DialogResult

If result = DialogResult.Cancel Then   
   Return                              
Else                                   
   txtDisplay.Font = dlgFontDialog.Font
End If                                 

▲
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Figure 22.33 Dvorak Keyboard GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial22\Exercises\DvorakKeyboard directory to your C:\SimplyVB
directory. 

b) Opening the application’s template file. Double click DvorakKeyboard.sln in the
DvorakKeyboard directory to open the application.

c) Creating the KeyPress event handler. Add a KeyPress event handler for the Text-
Box.

d) Creating a Select Case statement. Add a Select Case statement to the KeyPress
event handler. The Select Case statement should test whether all of the letter keys
on the Dvorak keyboard were pressed except for the S, W, V and Z keys. If a Dvorak
key was pressed, highlight it on the GUI and display the character in the TextBox.

e) Creating a KeyDown event handler. Add a KeyDown event handler for the TextBox.
The S, W, V and Z keys do not map to a letter key on the standard keyboard; there-
fore, a KeyDown event handler must be used to determine whether one of these keys
was pressed.

f) Adding a Select Case statement. Add a Select Case statement to your KeyDown
event handler that determines whether S, W, V or Z was pressed. If one of these keys
was pressed, highlight the key, and add the character to the TextBox.

g) Running the application. Select Debug > Start to run your application. Use your
keyboard to enter text. Verify that the text entered is correct based on the rules in the
exercise description. Make sure the correct Buttons on the Form are highlighted as
you enter text.

h) Closing the application. Close your running application by clicking its close box.

i) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 22.16 Solution
2 ' DvorakKeyboard.vb
3
4 Public Class FrmDvorakKeyboard
5    Inherits System.Windows.Forms.Form
6
7    ' reference to last Button pressed
8    Dim m_btnLastButton As Button
9

10    ' Windows Form Designer generated code
11
12    Private Sub txtOutput_KeyUp(ByVal sender As Object, _
13       ByVal e As System.Windows.Forms.KeyEventArgs) _
14       Handles txtOutput.KeyUp
15
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16       ResetColor()
17    End Sub ' txtOutput_KeyUp
18
19    ' highlight Button passed as argument
20    Private Sub ChangeColor(ByVal btnButton As Button)
21
22       ResetColor()
23       btnButton.BackColor = Color.LightGoldenrodYellow
24       m_btnLastButton = btnButton
25    End Sub ' ChangeColor
26
27    ' changes m_btnLastButton's color if it refers to a Button
28    Private Sub ResetColor()
29
30       If IsNothing(m_btnLastButton) = False Then
31          m_btnLastButton.BackColor = _
32             m_btnLastButton.DefaultBackColor
33
34       End If ' m_btnLastButton is not Nothing
35
36    End Sub ' ResetColor
37
38    ' handles Form KeyPress Event
39    Private Sub txtOutput_KeyPress(ByVal sender As Object, _
40       ByVal e As System.Windows.Forms.KeyPressEventArgs) _
41       Handles txtOutput.KeyPress
42
43       ' convert pressed key to uppercase
44       Select Case Char.ToUpper(e.KeyChar)
45
46          ' following cases test if key pressed was a letter
47          Case Convert.ToChar(Keys.A) ' a maps to a key
48             ChangeColor(btnA)
49             txtOutput.Text &= "a"
50
51          Case Convert.ToChar(Keys.B) ' x maps to b key
52             ChangeColor(btnX)
53             txtOutput.Text &= "x"
54
55          Case Convert.ToChar(Keys.C) ' j maps to c key
56             ChangeColor(btnJ)
57             txtOutput.Text &= "j"
58
59          Case Convert.ToChar(Keys.D) ' e maps to d key
60             ChangeColor(btnE)
61             txtOutput.Text &= "e"
62
63          Case Convert.ToChar(Keys.F) ' u maps to f key
64             ChangeColor(btnU)
65             txtOutput.Text &= "u"
66
67          Case Convert.ToChar(Keys.G) ' i maps to g key
68             ChangeColor(btnI)
69             txtOutput.Text &= "i"
70
71          Case Convert.ToChar(Keys.H) ' d maps to h key
72             ChangeColor(btnD)
73             txtOutput.Text &= "d"
74
75          Case Convert.ToChar(Keys.I) ' c maps to i key
76             ChangeColor(btnC)
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77             txtOutput.Text &= "c"
78
79          Case Convert.ToChar(Keys.J) ' h maps to j key
80             ChangeColor(btnH)
81             txtOutput.Text &= "h"
82
83          Case Convert.ToChar(Keys.K) ' t maps to k key
84             ChangeColor(btnT)
85             txtOutput.Text &= "t"
86
87          Case Convert.ToChar(Keys.L) ' n maps to l key
88             ChangeColor(btnN)
89             txtOutput.Text &= "n"
90
91          Case Convert.ToChar(Keys.M) ' m maps to m key
92             ChangeColor(btnM)
93             txtOutput.Text &= "m"
94
95          Case Convert.ToChar(Keys.N) ' b maps to n key
96             ChangeColor(btnB)
97             txtOutput.Text &= "b"
98
99          Case Convert.ToChar(Keys.O) ' r maps to o key
100             ChangeColor(btnR)
101             txtOutput.Text &= "r"
102
103          Case Convert.ToChar(Keys.P) ' l maps to p key
104             ChangeColor(btnL)
105             txtOutput.Text &= "l"
106
107          Case Convert.ToChar(Keys.R) ' p maps to r key
108             ChangeColor(btnP)
109             txtOutput.Text &= "p"
110
111          Case Convert.ToChar(Keys.S) ' o maps to s key
112             ChangeColor(btnO)
113             txtOutput.Text &= "o"
114
115          Case Convert.ToChar(Keys.T) ' y maps to t key
116             ChangeColor(btnY)
117             txtOutput.Text &= "y"
118
119          Case Convert.ToChar(Keys.U) ' g maps to u key
120             ChangeColor(btnG)
121             txtOutput.Text &= "g"
122
123          Case Convert.ToChar(Keys.V) ' k maps to v key
124             ChangeColor(btnK)
125             txtOutput.Text &= "k"
126
127          Case Convert.ToChar(Keys.X) ' q maps to x key
128             ChangeColor(btnQ)
129             txtOutput.Text &= "q"
130
131          Case Convert.ToChar(Keys.Y) ' f maps to y key
132             ChangeColor(btnF)
133             txtOutput.Text &= "f"
134
135       End Select ' ends test for letters
136
137    End Sub ' txtOutput_KeyPress
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138
139    ' handles KeyDown event
140    Private Sub txtOutput_KeyDown(ByVal sender As Object, _
141       ByVal e As System.Windows.Forms.KeyEventArgs) _
142       Handles txtOutput.KeyDown
143
144       Select Case e.KeyData
145
146          ' use KeyDown for these keys because the Dvorak
147          ' representation does not map to letters of QWERTY keyboard
148          Case Keys.OemSemicolon ' s maps to semicolon key
149             ChangeColor(btnS)
150             txtOutput.Text &= "s"
151
152          Case Keys.Oemcomma ' w maps to comma key
153             ChangeColor(btnW)
154             txtOutput.Text &= "w"
155
156          Case Keys.OemPeriod ' y maps to period key
157             ChangeColor(btnV)
158             txtOutput.Text &= "v"
159
160          Case Keys.OemQuestion ' z maps t question mark key
161             ChangeColor(btnZ)
162             txtOutput.Text &= "z"
163
164       End Select
165
166    End Sub ' txtOutput_KeyDown
167
168 End Class ' FrmDvorakKeyboard
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Instructor’s Manual
Exercise Solutions

Tutorial 23

MULTIPLE CHOICE
QUESTIONS

23.1 Extracting desired information from Web pages is called . 

23.2 If IndexOf method does not find the specified substring, it returns .

23.3 The String class allows you to  Strings.

23.4  is a technology for describing Web content.

23.5 The String class is located in the  namespace.

23.6 The  method creates a new String object by copying part of an existing
String object.

23.7 All String objects are .

23.8 The IndexOf method does not examine any characters that occur prior to the
.

23.9 The  method determines whether a String ends with a particular substring.

23.10 The Trim method removes all whitespace characters that appear  a String.

Answers: 23.1) b.  23.2) c.  23.3) d.  23.4) c.  23.5) d.  23.6) b.  23.7) d.  23.8) a.  23.9) c.  23.10) d.

EXERCISES 23.11 (Supply Cost Calculator Application) Write an application that calculates the cost of
all the supplies added to the user’s shopping list (Fig. 23.18). The application should contain
two ListBoxes. The first ListBox contains all the supplies offered and their respective
prices. Users should be able to select the desired supplies from the first ListBox and add
them to the second ListBox. Provide a Calculate Button that displays the total price for the
user’s shopping list (the contents of the second ListBox).

a) Web crawling b) screen scraping
c) querying d) redirection

a) False b) 0

c) -1 d) None of the above.

a) search b) retrieve characters from
c) replace characters in d) All of the above.

a) Class String b) A String literal
c) HTML d) A screen scraper

a) String b) System.Strings

c) System.IO d) System

a) StringCopy b) Substring

c) CopyString d) CopySubString

a) the same size b) always equal to each other
c) preceded by at least one whitespace character
d) immutable

a) starting index b) first match
c) last character of the String d) None of the above.

a) CheckEnd b) StringEnd

c) EndsWith d) EndIs

a) in b) at the beginning of
c) at the end of d) at the beginning and end of
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Figure 23.18 Supply Calculator application’s GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial23\Exercises\SupplyCalculator directory to your C:\SimplyVB
directory. 

b) Opening the application’s template file. Double click SupplyCalculator.sln in
the SupplyCalculator directory to open the application.

c) Adding code to the Add >> Button. Double click the Add >> Button to create an
empty event handler. Add code to the event handler that adds the selected item from
the first ListBox to the lstStock ListBox. Make sure to check that at least one item
is selected in the first ListBox before attempting to add an item to the lstStock
ListBox.

d) Enabling the Buttons. Once the user adds something to the lstStock ListBox, set
the Enabled properties of the << Remove and Calculate Buttons to True.

e) Deselecting the items. Once the items are added to the lstStock ListBox, make
sure that those items are deselected in the lstSupply ListBox. Also, clear the Total:
Label to indicate to the user that a new total price must be calculated.

f) Adding code to the << Remove Button. Double click the << Remove Button to
create an empty event handler. Use a Do While loop to remove any selected items in
the lstStock ListBox. Make sure to check that at least one item is selected before
attempting to remove an item. [Hint: Method lstStock.Items.RemoveAt(intIn-
dex) will remove the item located at intIndex from the lstStock ListBox.]

g) Adding code to the Calculate Button. Double click the Calculate Button to create
an empty event handler. Use a For…Next statement to loop through all the items in
the lstStock ListBox. Convert each item from the ListBox into a String. Then use
the String method Substring to extract the price of each item.

h) Displaying the total. Convert the String representing each item’s price to a Deci-
mal, and add this to the overall total (of type Decimal). Remember to output the
value in currency format.

i) Running the application. Select Debug > Start to run your application. Use the
Add >> and << Remove Buttons to add and remove items from the Items in Your
List: ListBox. Click the Calculate Button and verify that the total price displayed is
correct.

j) Closing the application. Close your running application by clicking its close box.

k) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 23.11 Solution
2 ' SupplyCalculator.vb
3
4 Public Class FrmSupplyCalculator
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' remove item from shopping list
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10    Private Sub btnRemove_Click(ByVal sender As _
11       System.Object, ByVal e As System.EventArgs) _
12       Handles btnRemove.Click
13
14       ' if there is at least one item selected
15       If lstStock.SelectedIndex <> -1 Then
16
17          ' remove items while there are selected items
18          Do While lstStock.SelectedIndex <> -1
19
20             ' remove item at the selected index
21             lstStock.Items.RemoveAt(lstStock.SelectedIndex)
22          Loop
23
24       Else
25          ' display message if there is no item selected
26          MessageBox.Show("Please select item to remove", _
27             "Error Removing", MessageBoxButtons.OK, _
28             MessageBoxIcon.Exclamation)
29       End If
30
31       ' if there is no item
32       If lstStock.Items.Count < 1 Then
33
34          ' disable the Remove and Calculate Buttons
35          btnRemove.Enabled = False
36          btnCalculate.Enabled = False
37       End If
38
39       lblTotal.Text = "" ' clear lblTotal Label
40    End Sub ' btnRemove_click
41
42    ' add shopping item to list
43    Private Sub btnAdd_Click(ByVal sender As _
44       System.Object, ByVal e As System.EventArgs) _
45       Handles btnAdd.Click
46
47       ' if there is at least one item selected
48       If lstSupply.SelectedIndex <> -1 Then
49
50          ' add each item to lstStock ListBox
51          lstStock.Items.Add(lstSupply.SelectedItem)
52
53          btnRemove.Enabled = True ' enable the Remove Button
54          btnCalculate.Enabled = True ' enable the Calculate Button
55          lstSupply.SelectedIndex = -1 ' unselect items
56          lblTotal.Text = "" ' clear lblTotal
57
58       End If
59
60    End Sub ' btnAdd_Click
61
62    ' calculate total price for shopping list
63    Private Sub btnCalculate_Click(ByVal sender As _
64       System.Object, ByVal e As System.EventArgs) _
65       Handles btnCalculate.Click
66
67       Dim decTotal As Decimal ' total amount 
68       Dim strPrice As String ' temporary price variable 
69       Dim intCounter As Integer ' counter variable
70
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23.12 (Encryption Application) Write an application that encrypts a message from the user
(Fig. 23.19). The application should be able to encrypt the message in two different ways:
substitution cipher and transposition cipher (both described below). The user should be able
to enter the message in a TextBox and select the desired method of encryption. Display the
encrypted message in a Label.

In a substitution cipher, every character in the English alphabet is represented by a dif-
ferent character in the substitution alphabet. Every time a letter occurs in the English sen-
tence, it is replaced by the letter in the corresponding index of the substitution string. In a
transposition cipher, two Strings are created. The first new String contains all the charac-
ters at the even indices of the input String. The second new String contains all of the char-
acters at the odd indices. The new Strings are the encrypted text. For example a
transposition cipher for the word “code” would be: “cd oe.”

Figure 23.19 Text Encryption application’s GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial23\Exercises\Encryption directory to your C:\SimplyVB direc-
tory. 

b) Opening the application’s template file. Double click Encryption.sln in the
Encryption directory to open the application.

c) Adding code to the Encrypt Button. Double click the Encrypt Button to create an
empty event handler.

d) Determine the cipher method. Use If…Then…Else statements to determine which
method of encryption the user has selected and call the appropriate procedure.

e) Locating the SubstitutionCipher method. Locate the SubstitutionCipher pro-
cedure. The English and substitution alphabet Strings have been defined for you in
this procedure. 

f) Converting the text input to lowercase. Add code to the SubstitutionCipher
method that uses the ToLower method of class String to make all the characters in
the input string (txtPlainText.Text) lowercase.

71       ' run through list of item(s)
72       For intCounter = 0 To lstStock.Items.Count - 1
73
74          ' retrieve price from items
75          strPrice = lstStock.Items(intCounter).ToString
76
77          ' get substring starting after the $
78          strPrice = strPrice.Substring(strPrice.IndexOf("$") + 1)
79
80          ' add price of each item to total
81          decTotal += Convert.ToDecimal(strPrice)
82       Next
83
84       ' display total
85       lblTotal.Text = String.Format("{0:C}", decTotal)
86    End Sub ' btnCalculate_Click
87
88 End Class ' FrmSupplyCalculator
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g) Performing the substitution encryption. Use nested For…Next loops to iterate
through each character of the input String. When each character from the input
String is found in the String holding the English alphabet, replace the character in
the input String with the character located at the same index in the substitution
String.

h) Display the String. Now that the String has been substituted with all the corre-
sponding cipher characters, assign the cipher String to the lblCipherText Label.

i) Locating the TranspositionCipher method. Locate the TranspositionCipher
method. Define three variables—a counter variable and two Strings (each repre-
senting a word).

j) Extracting the first word. Use a Do While…Loop to retrieve all the “even” indices
(starting from 0) from the input String. Increment the counter variable by 2 each
time, and add the characters located at even indices to the first String created in
Step h.

k) Extracting the second word. Use another Do While…Loop to retrieve all the “odd”
indices (starting from 1) from the same input String. Increment the counter variable
by 2, and add the characters at odd indices to the second String that you created in
Step h.

l) Output the result. Add the two Strings together with a space in between, and out-
put the result to the lblCipherText Label.

m)Running the application. Select Debug > Start to run your application. Enter text
into the Enter text to encrypt: TextBox. Select the Substitution Cipher RadioBut-
ton and click the Encrypt Button. Verify that the output is the properly encrypted
text using the substitution cipher. Select the Transposition Cipher RadioButton and
click the Encrypt Button. Verify that the output is the properly encrypted text using
the transposition cipher.

n) Closing the application. Close your running application by clicking its close box.

o) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 23.12 Solution
2 ' Encryption.vb
3
4 Public Class FrmEncryption
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' using the substitution cipher

10    Private Sub SubstitutionCipher()
11
12       ' normal alphabet String
13       Dim strNormalAlphabet As String = _
14          "abcdefghijklmnopqrstuvwxyz .!?,"
15
16       ' substitution alphabet String
17       Dim strCipherAlphabet As String = _
18          "cdefg.hijk!lmn opqr?stuv,wxyzab"
19
20       Dim intIndex1 As Integer ' index variable for For...Next loop
21       Dim intIndex2 As Integer ' inner index variable
22       Dim strPlain As String ' String entered by the user
23       Dim strCipher As String ' encrypted String
24
25       lblCipherText.Text = "" ' clear output TextBox
26
27       ' change all the characters to lower case
28       strPlain = txtPlainText.Text.ToLower
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29
30       ' iterate through the length of the String
31       For intIndex1 = 0 To txtPlainText.Text.Length - 1
32
33          ' iterate through alphabet and special character( .!?,") 
34          For intIndex2 = 0 To 30
35
36             ' compare characters
37             If strPlain.Chars(intIndex1) = _
38                strNormalAlphabet.Chars(intIndex2) Then
39
40                ' build encrypted text
41                strCipher &= strCipherAlphabet.Chars(intIndex2)
42
43             End If
44
45          Next
46
47       Next
48
49       lblCipherText.Text = strCipher ' output the encrypted String
50    End Sub ' SubstitutionCipher
51
52    ' using the transposition cipher
53    Private Sub TranspositionCipher()
54       Dim intCounter As Integer = 0 ' counter variable
55       Dim strFirstWord As String ' first word 
56       Dim strLastWord As String ' second word
57
58       ' create first word from the "even" index
59       Do While intCounter < txtPlainText.Text.Length
60
61          ' add character from specified location to strFirstWord
62          strFirstWord &= txtPlainText.Text.Chars(intCounter)
63          intCounter += 2 ' increment counter by 2
64       Loop ' loop through the entire String
65
66       ' create second word from the "odd" indices
67       intCounter = 1
68
69       Do While intCounter < txtPlainText.Text.Length
70
71          ' add character from specified location to strLastWord
72          strLastWord &= txtPlainText.Text.Chars(intCounter)
73          intCounter += 2 ' increment counter by 2
74       Loop ' loop through the entire String
75
76       ' output encrypted text
77       lblCipherText.Text = strFirstWord & " " & strLastWord
78    End Sub ' TranspositionCipher
79
80    ' encrypt a String of characters
81    Private Sub btnEncrypt_Click(ByVal sender As System.Object, _
82       ByVal e As System.EventArgs) Handles btnEncrypt.Click
83
84       ' determine the selected RadioButton 
85       If radSubstitution.Checked = True Then
86          SubstitutionCipher() ' call SubstitutionCipher
87       Else
88          TranspositionCipher() ' call TranspositionCipher
89       End If
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23.13 (Anagram Game Application) Write an Anagram Game that contains an array of
pre-set words (Fig. 23.20). The game should randomly select a word and scramble its letters.
A Label displays the scrambled word for the user to guess. If the user guesses correctly, dis-
play a message, and repeat the process with a different word. If the guess is incorrect, display
a message, and let the user try again.

Figure 23.20 Anagram Game application’s GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial23\Exercises\Anagram directory to your C:\SimplyVB directory. 

b) Opening the application’s template file. Double click Anagram.sln in the Anagram
directory to open the application.

c) Locating the GenerateAnagram method. Locate the GenerateAnagram method. It is
the first method after the FrmAnagram_Load event handler. 

d) Picking a random word. Generate a random number to use as the index of the word
in the m_strAnagram array. Retrieve word from the m_strAnagram array, using the
first random number as an index. Store the word in another String variable. Gener-
ate a second random number to store the index of a character to be moved.

e) Generate the scrambled word. Use a For…Next statement to iterate through the
word 20 times. Each time the loop executes, pass the second random number created
in Step c to the Chars property of class String. Append the character returned by
Chars to the end of the String, and remove it from its original position. Next, gener-
ate a new random number to move a different character during the next iteration of
the loop. Remember to output the final word to the lblAnagram Label. 

f) Defining the Submit Button. Double click the Submit Button to generate an empty
event handler.

g) Testing the user’s input. Use an If…Then…Else statement to determine whether the
user’s input matches the actual word. If the user is correct, clear and place the focus
on the TextBox and generate a new word. Otherwise, select the user’s text and place
focus on the TextBox.

h) Running the application. Select Debug > Start to run your application. Submit cor-
rect answers and incorrect answers, and verify that the appropriate message is dis-
played each time.

i) Closing the application. Close your running application by clicking its close box.

j) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

90
91    End Sub ' btnEncrypt_Click
92
93 End Class ' FrmEncryption

1 ' Exercise 23.13 Solution
2 ' Anagram.vb
3
4 Public Class FrmAnagram
5    Inherits System.Windows.Forms.Form
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6
7    ' Windows Form Designer generated code
8
9    ' array of words to be scrambled

10    Private m_strAnagram As String() = New String() {"controls", _
11       "events", "properties", "visual", "program", "application", _
12       "basic", "debugger", "database", "files", "inheritance", _
13       "assembly", "multimedia", "procedures", "functions", _
14       "arrays", "strings", "collections", "integration", _
15       "structures"}
16
17    Private m_objRandom As Random = New Random ' random number
18    Private m_intRandomNumber As Integer ' random index variable
19    Private m_strScrambled As String ' randomly chosen word
20
21    ' generate new scrambled word 
22    Private Sub FrmAnagram_Load(ByVal sender As _
23       System.Object, ByVal e As System.EventArgs) _
24       Handles MyBase.Load
25
26       GenerateAnagram() ' generate new word
27    End Sub ' FrmAnagram_Load
28
29    ' scramble words
30    Private Sub GenerateAnagram()
31
32       ' generate new random number
33       m_intRandomNumber = m_objRandom.Next(0, 19)
34
35       ' select new word from array with m_intRandomNumber index
36       m_strScrambled = m_strAnagram(m_intRandomNumber)
37
38       ' generate new random index
39       Dim intRandomIndex As Integer = _
40          m_objRandom.Next(0, m_strScrambled.Length - 1)
41
42       Dim intCounter As Integer ' loop counter variable
43
44       ' loop to generate scrambled word
45       For intCounter = 0 To 20
46
47          ' attach character at the end of string
48          m_strScrambled &= m_strScrambled.Chars(intRandomIndex)
49
50          ' remove character from the word
51          m_strScrambled = m_strScrambled.Remove(intRandomIndex, 1)
52
53          ' new random index
54          intRandomIndex = _
55             m_objRandom.Next(0, m_strScrambled.Length - 1)
56
57       Next
58
59       lblAnagram.Text = m_strScrambled ' display scrambled word
60    End Sub ' GenerateAnagram
61
62    ' check if the user's answer is correct
63    Private Sub btnSubmit_Click(ByVal sender As _
64       System.Object, ByVal e As System.EventArgs) _
65       Handles btnSubmit.Click
66
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What does this code do? 23.14 What is assigned to strResult when the following code executes?

Answer: After assigning initial values to Strings strWord1, strWord2 and strWord3, the 
code above changes the word "CHORUS" to all lowercase letters, resulting in "chorus" being 
assigned to strResult. strResult then is assigned the substring of "chorus" beginning at 
the fifth character (index 4), "u", resulting in strResult’s value as "us". The next line of 
code deletes spaces from strWord2, resulting in the word "dinosaur". The substring of 
"dinosaur" beginning at the fifth character and of length 4 ("saur") is then assigned to 
strWord2. Then the value of strResult ("us") is appended to the end of strWord2 ("us") 
and placed in strResult, yielding "saurus". Following that, strWord3 is assigned a sub-
string of itself beginning one character after the first space character and of length 3 ("the"). 
Finally, the value "saurus" (strResult) is inserted into strWord3 at the location of the 
fourth character (the end of the string) and assigned to strResult. The final value of strRe-
sult is the word "thesaurus".

What’s wrong with this code? 23.15 This code should remove all commas from strTest and convert all lowercase letters
to uppercase letters. Find the error(s) in the following code.

67       ' answer is correct
68       If txtGuess.Text = m_strAnagram(m_intRandomNumber) Then
69          lblResult.Text = "You are Correct!"
70          GenerateAnagram() ' generate new word
71          txtGuess.Clear() ' clear the TextBox
72          txtGuess.Focus() ' place focus on TextBox
73       Else
74
75          ' answer is incorrect
76          lblResult.Text = "Wrong answer. Try again!"
77          txtGuess.Focus() ' place focus on TextBox
78          txtGuess.SelectAll() ' select the answer
79       End If
80
81    End Sub ' btnSubmit_Click
82
83 End Class ' FrmAnagram

▲

1 Dim strWord1 As String = "CHORUS"
2 Dim strWord2 As String = "d i n o s a u r"
3 Dim strWord3 As String = "The theme is string."
4 Dim strResult As String
5
6 strResult = strWord1.ToLower()
7 strResult = strResult.Substring(4)
8 strWord2 = strWord2.Replace(" ", "")
9 strWord2 = strWord2.Substring(4, 4)

10 strResult = strWord2 & strResult
11
12 strWord3 = strWord3.Substring(strWord3.IndexOf(" ") + 1, 3)
13
14 strResult = strWord3.Insert(3, strResult)

▲

1 Dim strTest As String = "Bug,2,Bug"
2
3 strTest = strTest.ToUpper()
4 strTest = strTest.Replace("")
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Answer: Replace method takes two arguments: one substring to search for, and another 
substring to replace all matching occurrences of the first argument. The proper call to 
method Replace is shown in the following code.

Programming Challenge 23.16 (Pig Latin Application) Write an application that encodes English language phrases
into pig Latin. Pig Latin is a form of coded language often used for amusement. Many varia-
tions exist in the methods used to form pig Latin phrases. For simplicity, use the following
method to form the pig Latin words:

To form a pig Latin word from an English-language phrase, the translation proceeds
one word at a time. To translate an English word into a pig Latin word, place the first
letter of the English word (if it is not a vowel) at the end of the English word and add
the letters “ay.” If the first letter of the English word is a vowel, place it at the end of the
word and add “y.” Using this method, the word “jump” becomes “umpjay”, the word
“the” becomes “hetay” and the word “ace” becomes “ceay.” Blanks between words
remain blanks.

Assume the following: The English phrase consists of words separated by blanks, there
are no punctuation marks, and all words have two or more letters. Enable the user to input a
sentence. The TranslateToPigLatin method should translate the sentence into pig Latin,
word by word. [Hint: You will need to use the Join and Split methods of class String dem-
onstrated in Fig. 23.16 to form the pig Latin phrases].

Figure 23.21 Pig Latin Application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial23\Exercises\PigLatin directory to your C:\SimplyVB directory. 

b) Opening the application’s template file. Double click PigLatin.sln in the PigL-
atin directory to open the application.

c) Splitting the sentence. Use method Split on the String passed to the Trans-
lateToPigLatin method. Assign the result of this operation to strWords.

d) Retrieving the word’s first letter. Declare a For…Next loop that iterates through
your array of words. As you iterate through the array, store each word’s first letter in
strTemporary.

e) Determining the suffix. Use If…Then…Else statements to determine the suffix for
each word. Store this suffix in strSuffix.

f) Generating new words. Generate the new words by arranging each word’s pieces in
the proper order.

g) Returning the new sentence. When the For…Next loop finishes, use method Join to
combine all of the elements in strWords, and Return the new pig Latin sentence.

h) Running the application. Select Debug > Start to run your application. Enter a sen-
tence and click the Translate Button. Verify that the sentence is correctly converted
into Pig Latin.

i) Closing the application. Close your running application by clicking its close box.

j) Closing the IDE. Close Visual Studio .NET by clicking its close box.

1 Dim strTest As String = "Bug,2,Bug"
2
3 strTest = strTest.ToUpper()
4 strTest = strTest.Replace(",", "")

▲
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Answer:

1 ' Exercise 23.16 Solution
2 ' PigLatin.vb
3
4 Public Class FrmPigLatin
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' receive sentence from user and send to TranslateToPigLatin

10    Private Sub btnTranslate_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnTranslate.Click
12
13       ' retrieve English phrase from user
14       Dim strPhrase As String = txtInput.Text
15
16       ' display output
17       txtOutput.Text = TranslateToPigLatin(strPhrase)
18    End Sub ' btnTranslate_Click
19
20    ' translates the string input by the user 
21    ' from English to pig Latin
22    Private Function TranslateToPigLatin( _
23       ByVal strEnglishPhrase As String) As String
24
25       Dim strWords As String() ' array to hold each word
26       Dim strSuffix As String ' suffix for the end of each word
27       Dim intIndex As Integer ' index to iterate through the array
28       Dim strTemporary As String ' temporary string
29
30       strWords = strEnglishPhrase.Split() ' split words
31
32       For intIndex = 0 To strWords.Length - 1
33
34          ' get first letter of each word
35          strTemporary = strWords(intIndex).Substring(0, 1).ToLower
36
37          ' check if each word starts with a vowel
38          If strTemporary = "a" OrElse _
39             strTemporary = "e" OrElse _
40             strTemporary = "i" OrElse _
41             strTemporary = "o" OrElse _
42             strTemporary = "u" Then
43
44             strSuffix = "y"
45          Else ' if not, suffix is different
46             strSuffix = "ay"
47          End If
48
49          ' swap letters to create new word
50          strWords(intIndex) = strWords(intIndex).Substring(1) & _
51             strTemporary & strSuffix
52
53       Next
54
55       ' put words together and return the whole sentence
56       Return String.Join(" ", strWords)
57    End Function ' TranslateToPigLatin
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58
59 End Class ' FrmPigLatin
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Instructor’s Manual
Exercise Solutions

Tutorial 24

MULTIPLE-CHOICE
QUESTIONS

24.1 Data maintained in a file is called .

24.2 Methods from the  class can be used to write data to a file.

24.3 Namespace  provides the classes and methods that you need to use to per-
form file processing. 

24.4 Sometimes a group of related files is called a .

24.5 A(n)  allows the user to select a file to open.

24.6 Digits, letters and special symbols are referred to as .

24.7 The  method reads a line from a file.

24.8 A  contains information that is read in the order that it was written to the
file.

24.9 The smallest data item that a computer can support is called a .

24.10 Methods from the  class can be used to read data from a file.

Answers: 24.1) a.  24.2) c.  24.3) a.  24.4) b.  24.5) b.  24.6) d.  24.7) a. 24.8) a.  24.9) d.  24.10) c.

EXERCISES 24.11 (Birthday Saver Application) Create an application that stores people’s names and
birthdays in a file (Fig. 24.35). The user creates a file and inputs each person’s first name, last
name and birthday on the Form. The information is then written to the file.

a) persistent data b) bits
c) secondary data d) databases

a) StreamReader b) FileWriter 
c) StreamWriter d) WriteFile 

a) System.IO b) System.Files 
c) System.Stream d) System.Windows.Forms 

a) field b) database
c) collection d) byte

a) CreateFileDialog b) OpenFileDialog 
c) MessageBox d) None of the above.

a) constants b) Integers
c) Strings d) characters

a) ReadLine b) Read 
c) ReadAll d) ReadToNewline 

a) sequential-access file b) text file
c) StreamReader d) StreamWriter 

a) character set b) character
c) special symbol d) bit

a) StreamWriter b) FileReader 
c) StreamReader d) ReadFile 



Tutorial 24 Ticket Information Application 291

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

Figure 24.35 Birthday Saver application’s GUI. 

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial24\Exercises\BirthdaySaver directory to your C:\SimplyVB
directory. 

b) Opening the application’s template file. Double click BirthdaySaver.sln in the
BirthdaySaver directory to open the application (Fig. 24.35).

c) Adding and customizing an OpenFileDialog component. Add an OpenFileDialog
component to the Form. Change its Name property to objOpenFileDialog. Set the
CheckFileExists property to False.

d) Importing namespace System.IO. Import System.IO to allow file processing.

e) Declaring a StreamWriter object. Declare a StreamWriter object that can be used
throughout the entire class.

f) Defining the Open File… Button’s Click event handler. Double click the Open
File… Button to create the btnOpen_Click event handler. Write code to display the
Open dialog. If the user clicks the Cancel Button in the dialog, then the event han-
dler should perform no further actions. Otherwise, determine whether the user pro-
vided a file name that has the .txt extension (indicating a text file). If the user did
not, display a MessageBox asking the user to select an appropriate file. If the user
specified a valid file name, perform Step f.

g) Initializing the StreamWriter. Initialize the StreamWriter in the
btnOpenFile_Click event handler, passing the user-input file name as an argument.
Allow the user to append information to the file by passing the Boolean value True
as the second argument to the StreamWriter.

h) Defining the Enter Button’s Click event handler. Double click the Enter Button to
create the event handler btnEnter_Click. This event handler should write the entire
name of the person on one line in the file. Then the person’s birthday should be writ-
ten on the next line in the file. Finally, the TextBoxes on the Form should be cleared,
and the DateTimePicker’s value should be set back to the current date.

i) Defining the Close File Button’s Click event handler. Double click the Close File
Button to create the btnClose_Click event handler. Close the StreamWriter con-
nection in this event handler.

j) Running the application. Select Debug > Start to run your application. Open a file
by clicking Open File… Button. After a file has been opened, use the input fields
provided to enter birthday information. After each person’s name and birthday are
typed in, click the Enter Button. When you are finished, close the file by clicking the
Close File Button. Browse to the file and ensure that its contents contain the birth-
day information that you entered.

k) Closing the application. Close your running application by clicking its close box.

l) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 24.11 Solution
2 ' BirthdaySaver.vb
3
4 Imports System.IO
5
6 Public Class FrmBirthdaySaver
7    Inherits System.Windows.Forms.Form
8
9    ' StreamWriter used to write to file
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10    Private m_objOutput As StreamWriter
11
12    ' Windows Form Designer generated code
13
14    ' Open File... Button’s Click event
15    Private Sub btnOpen_Click(ByVal sender As System.Object, _
16       ByVal e As System.EventArgs) Handles btnOpen.Click
17
18       ' display Open File... dialog
19       Dim result As DialogResult = objOpenFileDialog.ShowDialog()
20
21       ' exit event handler if user clicked Cancel Button
22       If result = DialogResult.Cancel Then
23          Return
24       End If
25
26       ' get specified file name
27       Dim strFileName As String = objOpenFileDialog.FileName
28
29       ' show error if user specified invalid file
30       If strFileName.EndsWith(".txt") = False Then
31          MessageBox.Show("File name must end with .txt", _
32             "Invalid File Type", _
33             MessageBoxButtons.OK, MessageBoxIcon.Error)
34
35       Else
36          btnOpen.Enabled = False
37          btnEnter.Enabled = True
38          btnClose.Enabled = True
39
40          m_objOutput = New StreamWriter(strFileName, True)
41       End If
42
43    End Sub ' btnOpen_Click
44
45    ' clear all user input
46    Sub ClearUserInput()
47       txtFirstName.Clear()
48       txtLastName.Clear()
49       dtpBirthday.Value = Date.Now
50    End Sub ' ClearUserInput
51
52    ' handles Enter Button’s Click event
53    Private Sub btnEnter_Click(ByVal sender As System.Object, _
54       ByVal e As System.EventArgs) Handles btnEnter.Click
55
56       ' write user input to file
57       m_objOutput.WriteLine(txtFirstName.Text & " " & _
58          txtLastName.Text)
59       m_objOutput.WriteLine(dtpBirthday.Value.Month & "/" & _
60          dtpBirthday.Value.Day & "/" & dtpBirthday.Value.Year)
61       ClearUserInput()
62    End Sub ' btnEnter_Click
63
64    ' handles Close File Button’s Click event
65    Private Sub btnClose_Click(ByVal sender As System.Object, _
66       ByVal e As System.EventArgs) Handles btnClose.Click
67
68       m_objOutput.Close()  ' close stream
69       btnOpen.Enabled = True
70       btnEnter.Enabled = False
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24.12 (Photo Album Application) Create an application that displays images for the user,
as shown in Fig. 24.36. This application should display the current image in a large Picture-
Box and display the previous and next images in smaller PictureBoxes. A description of the
book represented by the large image should be displayed in a multiline TextBox. The appli-
cation should use the Directory class’s methods to facilitate the displaying of the images.

Figure 24.36 Photo Album application GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial24\Exercises\PhotoAlbum directory to your C:\SimplyVB direc-
tory. 

b) Opening the application’s template file. Double click PhotoAlbum.sln in the Pho-
toAlbum directory to open the application.

c) Creating instance variables. Create instance variable m_intCurrent to represent the
current image that is displayed, and set the variable to 0. Create the
m_strLargeImage array (to store the path names of five large images), the
m_strSmallImage array (to store the path names of five small images) and the
m_strDescriptions array (to store the descriptions of the five books represented by
the images).

d) Defining the RetrieveData procedure. Create a Sub procedure named Retrieve-
Data to store the path names of the larger images in m_strLargeImages and the path
names of the smaller images in m_strSmallImage. Use the Directory class’s Get-
CurrentDirectory method to determine the directory path for the images\large
and images\small folders. Sequential-access file books.txt stores the file name of
each image. The file is organized such that the file name of the small and large images
are on the first line. These files have similar names. The small image’s file name ends
with _thumb.jpg (that is, filename_thumb.jpg) while the large image’s file name ends
with _large.jpg (that is, filename_large.jpg). The description of the book, which
should be stored in array m_strDescriptions, follows the file name.

e) Defining the DisplayPicture procedure. Create a Sub procedure named Display-
Picture to display the current image in the large PictureBox and to display the pre-
vious and next images in the smaller PictureBoxes.

71       btnClose.Enabled = False
72    End Sub ' btnClose_Click
73
74 End Class ' FrmBirthdaySaver
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f) Using If…Then…Else in the DisplayPicture procedure. Use an If…Then…Else
statement to display the images on the Form. If the Integer instance variable is 0,
display the image of the first book. Also, display the next book’s image in the next
image PictureBox. However, because there is no previous image, nothing should be
displayed in the previous image PictureBox, and the Previous Image Button should
be disabled. If the last image is displayed in the large PictureBox, then disable the
Next Image Button, and do not display anything in the next image PictureBox.
Otherwise, all three PictureBoxes should display their corresponding images, and
the Previous Image and Next Image Buttons should be enabled.

g) Defining the FrmPhotoAlbum_Load event handler. Double click the Form to create
the FrmPhotoAlbum_Load event handler. Invoke methods RetrieveData and Dis-
playPicture in this event handler.

h) Defining the btnPrevious_Click event handler. Double click the Previous Image
Button to create the btnPrevious_Click event handler. In this event handler,
decrease the Integer instance variable by 1 and invoke procedure DisplayPicture.

i) Defining the btnNext_Click event handler. Double click the Next Image Button to
create the btnNext_Click event handler. In this event handler, increment the Inte-
ger instance variable by 1 and invoke the DisplayPicture procedure.

j) Running the application. Select Debug > Start to run your application. Click the
Previous Image and Next Image Buttons to ensure that the proper images and
descriptions are displayed.

k) Closing the application. Close your running application by clicking its close box.

l) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 24.12 Solution
2 ' PhotoAlbum.vb
3
4 Imports System.IO
5
6 Public Class FrmPhotoAlbum
7    Inherits System.Windows.Forms.Form
8
9    ' represents current image’s index

10    Private m_intCurrent As Integer = 0
11
12    Private m_strLargeImage As String() = New String(5) {}
13    Private m_strSmallImage As String() = New String(5) {}
14    Private m_strDescriptions As String() = New String(5) {}
15
16    ' Windows Form Designer generated code
17
18    ' handles Form’s Load event
19    Private Sub FrmPhotoAlbum_Load(ByVal sender As System.Object, _
20       ByVal e As System.EventArgs) Handles MyBase.Load
21
22       RetrieveData()
23       DisplayPicture()  ' display first image
24    End Sub ' FrmPhotoAlbum_Load
25
26    ' handles Previous Image Button’s Click event
27    Private Sub btnPrevious_Click(ByVal sender As System.Object, _
28       ByVal e As System.EventArgs) Handles btnPrevious.Click
29
30       m_intCurrent -= 1
31       DisplayPicture()  ' display new images
32    End Sub ' btnPrevious_Click
33
34    ' handles Next Image Button’s Click event
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35    Private Sub btnNext_Click(ByVal sender As System.Object, _
36       ByVal e As System.EventArgs) Handles btnNext.Click
37
38       m_intCurrent += 1
39       DisplayPicture()  ' display new images
40    End Sub ' btnNext_Click
41
42    ' extract descriptions from file and images from the directory
43    Private Sub RetrieveData()
44
45       ' create directory path for large images
46       Dim strLargeDirectory As String = _
47          (Directory.GetCurrentDirectory & "\images\large\")
48
49       ' create directory path for small images
50       Dim strSmallDirectory As String = _
51          (Directory.GetCurrentDirectory & "\images\small\")
52
53       ' initialize StreamReader to read lines from file
54       Dim objInput As StreamReader = New StreamReader("books.txt")
55
56       ' read first image name before entering loop
57       Dim strImageName As String = objInput.ReadLine
58
59       Dim intCounter As Integer = 0
60
61       ' loop through lines in file
62       Do While strImageName <> ""
63    
64          m_strLargeImage(intCounter) = (strLargeDirectory _
65             & strImageName & "_large.jpg")
66          m_strSmallImage(intCounter) = (strSmallDirectory _
67             & strImageName & "_thumb.jpg")
68          m_strDescriptions(intCounter) = objInput.ReadLine
69
70          ' read next line in file
71          strImageName = objInput.ReadLine
72
73          intCounter += 1
74       Loop 
75
76    End Sub ' RetrieveData
77
78    ' displays images
79    Private Sub DisplayPicture()
80
81       ' set main image
82       picMain.Image = _
83             Image.FromFile(m_strLargeImage(m_intCurrent))
84
85       ' if index is 0 (first image), do not show previous image
86       If m_intCurrent = 0 Then
87          picPrevious.Image = Nothing ' do not show previous image
88
89          ' preview next image
90          picNext.Image = _
91             Image.FromFile(m_strSmallImage(m_intCurrent + 1))
92
93          btnPrevious.Enabled = False  ' disable Previous Button
94
95       ' if index corresponds to last item in array,
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24.13 (Car Reservation Application) Create an application that allows a user to reserve a
car for the specified day. The small car reservation company can rent out only four cars per
day. Let the application allow the user to specify a certain day. If four cars have already been
reserved for that day, then indicate to the user that no vehicles are available.

Figure 24.37 CarReservation application’s GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial24\Exercises\CarReservation directory to your C:\SimplyVB
directory.

b) Opening the application’s template file. Double click CarReservation.sln in the
CarReservation directory to open the application.

c) Adding a MonthCalendar control to the Form. Drag and drop a MonthCalendar
control on the Form. Set the Location property of the control to 16, 32.

d) Importing System.IO namespace. Import namespace System.IO to allow file pro-
cessing.

e) Defining the FrmReserve_Load event handler. Double click the Form to create the
FrmReserve_Load event handler.

96       ' do not show next image
97       ElseIf m_intCurrent = m_strLargeImage.GetUpperBound(0) Then
98          picPrevious.Image = _
99             Image.FromFile(m_strSmallImage(m_intCurrent - 1))
100
101          picNext.Image = Nothing  ' do not show Next image
102          btnNext.Enabled = False  ' disable Next Button
103
104       ' show previous, current and next image
105       Else
106          picPrevious.Image = _
107             Image.FromFile(m_strSmallImage(m_intCurrent - 1))
108
109          picNext.Image = _
110             Image.FromFile(m_strSmallImage(m_intCurrent + 1))
111
112          ' enable Buttons
113          btnPrevious.Enabled = True
114          btnNext.Enabled = True
115       End If
116
117       ' set description
118       txtDescription.Text = m_strDescriptions(m_intCurrent)
119    End Sub ' DisplayPicture
120
121 End Class ' FrmPhotoAlbum
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f) Defining a Function procedure. Create a Function procedure named NumberOf-
Reservations that takes one argument of type Date. The procedure should create a
StreamReader that reads from the reservations.txt file. Use a Do While Loop to
allow the StreamReader to search through the entire reservations.txt file to see
how many cars have been rented for the day selected by the user. The procedure
should close the StreamReader connection and return the number of cars rented for
the day selected.

g) Defining a Sub procedure. Create a Sub procedure named CheckReservations. This
procedure should invoke the NumberOfReservations Function procedure, passing
in the user-selected day as an argument. The CheckReservations method should
then retrieve the number returned by NumberOfReservations and determine if four
cars have been rented for that day. If four cars have been rented, then display a mes-
sage dialog to the user stating that no cars are available that day for rental. If fewer
than four cars have been rented for that day, create a StreamWriter object, passing
reservations.txt as the first argument True as the second argument. Write the
day and the user’s name to the reservations.txt file and display a message dialog
to the user stating that a car has been reserved.

h) Defining the btnReserve_Click event handler. Double click the Reserve Car But-
ton to create the btnReserve_Click event handler. In this event handler, invoke the
CheckReservations procedure and clear the Name: TextBox.

i) Running the application. Select Debug > Start to run your application. Enter sev-
eral reservations, including four reservations for the same day. Enter a reservation
for a day that already has four reservations to ensure that a message dialog will be
displayed.

j) Closing the application. Close your running application by clicking its close box.
Open reservations.txt to ensure that the proper data has been stored (based on
the reservations entered in Step i).

k) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 24.13 Solution
2 ' CarReservation.vb
3
4 Imports System.IO
5
6 Public Class FrmReserve
7    Inherits System.Windows.Forms.Form
8
9   ' Windows Form Designer generated code

10
11   ' method to determine number of cars rented for that day
12    Function NumberOfReservations(ByVal objDay As Date) As Integer
13
14       ' set to the value of selected day in month view
15       Dim intChosenDay As Integer = objDay.Day
16       Dim intFileDay As String
17       Dim intCars As Integer = 0
18
19       ' StreamReader reads lines from file to strLine
20       Dim objFile As StreamReader
21       Dim strLine As String
22
23       ' initialize StreamReader
24       objFile = New StreamReader("reservations.txt")
25
26       ' read the first line before entering loop
27       strLine = objFile.ReadLine
28
29       ' loop through all file data
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30       Do While strLine <> ""
31
32          intFileDay = strLine
33
34          ' if days match, increment count
35          If intFileDay = intChosenDay.ToString Then
36             intCars += 1
37
38          End If
39
40          ' read name in
41          objFile.ReadLine()
42
43          ' read day of next event in file
44          strLine = objFile.ReadLine
45       Loop
46
47       objFile.Close()
48
49       Return intCars
50    End Function ' NumberOfReservations
51
52    ' method to check reservations for chosen day
53    Sub CheckReservations()
54
55       Dim intCount As Integer
56       Dim intReservations As Integer
57
58       ' gets data for selected day and stores in intReservations
59       intReservations = NumberOfReservations(mvwDate.SelectionStart)
60
61       ' determine if user can reserve car that day
62       If intReservations >= 4 Then
63          MessageBox.Show("Sorry, all cars have been reserved" & _ 
64             " for this day. Please select another day.", _
65             "No cars available.", _
66             MessageBoxButtons.OK, MessageBoxIcon.Information)
67
68       Else
69
70          ' create StreamWriter to write to file
71          Dim objWrite As StreamWriter = _
72             New StreamWriter("Reservations.txt", True)
73
74          objWrite.WriteLine(mvwDate.SelectionStart.Day)
75          objWrite.WriteLine(txtName.Text)
76          objWrite.Close()
77
78          MessageBox.Show("A car has been reserved for you", _
79             "Car reserved", MessageBoxButtons.OK, _
80             MessageBoxIcon.Information)
81       End If
82
83    End Sub ' CheckReservations
84
85    ' invoke when Reserve Button clicked
86    Private Sub btnReserve_Click(ByVal sender As System.Object, _
87       ByVal e As System.EventArgs) Handles btnReserve.Click
88
89       ' determine if name was provided
90       If txtName.Text = "" Then
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What does this code do? 24.14 What is the result of the following code? Assume the application imports namespace
System.IO.
 

Answer: The code copies the contents of oldfile.txt to newfile.txt. After the file trans-
fer is completed, the files are closed by closing the StreamReader and StreamWriter. Note 
that if a blank line is encountered, copying stops at the blank line.

What’s wrong with this code? 24.15 Find the error(s) in the following code, which is supposed to read a line from some-
file.txt, convert the line to uppercase and then append it to somefile.txt. Assume the
application imports namespace System.IO.

91          MessageBox.Show("You must provide a name", _
92             "Name Required.", MessageBoxButtons.OK, _
93             MessageBoxIcon.Information)
94       Else
95          CheckReservations()
96          txtName.Clear()
97       End If
98    End Sub ' btnReserve_Click
99
100 End Class ' FrmReserve

▲

1 Dim strPath1 As String = "oldfile.txt"
2 Dim strPath2 As String = "newfile.txt"
3 Dim strLine As String
4
5 Dim objStreamWriter As StreamWriter
6 objStreamWriter = New StreamWriter(strPath2)
7
8 Dim objStreamReader As StreamReader
9 objStreamReader = New StreamReader(strPath1)

10
11 strLine = objStreamReader.ReadLine()
12
13 Do While strLine <> ""
14    objStreamWriter.WriteLine(strLine)
15    strLine = objStreamReader.ReadLine()
16 Loop
17
18 objStreamWriter.Close()
19 objStreamReader.Close()

▲

1 Dim strPath As String = "somefile.txt"
2 Dim strContents As String
3
4 Dim objStreamWriter As StreamWriter
5 objStreamWriter = New StreamWriter(strPath, True)
6
7 Dim objStreamReader As StreamReader
8 objStreamReader = New StreamReader(strPath)
9

10 strContents = objStreamReader.ReadLine
11
12 strContents = strContents.ToUpper()
13
14 objStreamWriter.Write(strContents)
15
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Answer:  Once the StreamWriter opens the file specified by strPath, the file is marked 
open. While open, no other object can open the file. Thus an exception is thrown when 
StreamReader tries to open the same file. A solution to this problem involves performing the 
reading operations before the writing operations. Notice in the code below that the Stream-
Reader is closed before the StreamWriter is opened.

Programming Challenge 24.16 (File Scrape Application) Create an application similar to the screen scraping appli-
cation of Tutorial 23, that opens a user-specified file and searches the file for the price of a
book, returning it to the user (Fig. 24.38). [Hints: You will need to use the ReadToEnd method
of class StreamReader to retrieve the entire contents of the files. The book price appears, for
example, in the sample booklist.htm file as Our Price: <b>$59.99</b>.]

Figure 24.38 File scrape application GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial24\Exercises\FileScrape directory to your C:\SimplyVB direc-
tory. Notice that two HTML files—booklist.htm and bookpool.htm—are provided
for you.

b) Opening the application’s template file. Double click FileScrape.sln in the File-
Scrape directory to open the application.

c) Creating an event handler. Create an event handler for the Open… Button that
allows the user to select a file to search for prices.

d) Creating a second event handler. Create an event handler for the Search Button.
This event handler should search the specified HTML file for the book price. When
the price is found, display it in the output Label.

e) Running the application. Select Debug > Start to run your application. Click the
Open… Button and select one of the .htm files provided in the FileScrape direc-
tory. Click the Search Button and view the price of the book. For booklist.htm, the
price should be $59.99 and bookpool.htm the price should be $39.50.

16 objStreamWriter.Close()
17 objStreamReader.Close()

1 Dim strPath As String = "somefile.txt"
2 Dim strContents As String
3
4 Dim objStreamReader As StreamReader
5 objStreamReader = New StreamReader(strPath)
6
7 strContents = objStreamReader.ReadLine
8
9 strContents = strContents.ToUpper()

10
11
12
13
14
15
16 objStreamWriter.Write(strContents)
17
18 objStreamWriter.Close()

objStreamReader.Close()

Dim objStreamWriter As StreamWriter              
objStreamWriter = New StreamWriter(strPath, True)

▲
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f) Closing the application. Close your running application by clicking its close box.

g) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 24.16 Solution
2 ' FileScrapeFig. 24.35.vb
3
4 Imports System.IO
5
6 Public Class FrmScreenScrape
7    Inherits System.Windows.Forms.Form
8
9    ' Windows Form Designer generated code

10
11    ' display OpenFile dialog when Open... Button is clicked
12    Private Sub btnOpen_Click(ByVal sender As System.Object, _
13       ByVal e As System.EventArgs) Handles btnOpen.Click
14
15       Dim result As DialogResult
16
17       ' show dialog to user for selecting file
18       result = objOpenFileDialog.ShowDialog()
19
20       If result = DialogResult.Cancel Then
21
22          Return  ' if user cancels, do nothing
23       Else
24
25          ' store file name that user selected
26          txtPath.Text = objOpenFileDialog.FileName
27       End If
28
29    End Sub ' btnOpen_Click
30
31    ' search file for price
32    Private Sub btnSearch_Click(ByVal sender As System.Object, _
33       ByVal e As System.EventArgs) Handles btnSearch.Click
34
35       Dim strFilePath As String
36       Dim intMatchLocation As Integer
37       Dim intRankBegin As Integer
38       Dim intRankEnd As Integer
39
40       ' if TextBox is empty, show an error message and return
41       If txtPath.Text = "" Then
42          MessageBox.Show("No path selected", _
43             "Path Not Chosen", MessageBoxButtons.OK, _
44             MessageBoxIcon.Exclamation)
45          Return
46       Else
47
48          ' set filepath to value in txtPath
49          strFilePath = txtPath.Text
50       End If
51
52       ' create stream reader to open and read text file
53       Dim objReader As StreamReader = New StreamReader(strFilePath)
54
55       ' read file from beginning to end
56       Dim strContents As String = objReader.ReadToEnd()
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57
58       ' close the file to free resource
59       objReader.Close()
60
61       ' find locations of text in file
62       intMatchLocation = strContents.IndexOf("Our Price:", 0)
63       intRankBegin = strContents.IndexOf("$", intMatchLocation)
64       intRankEnd = strContents.IndexOf("<", intRankBegin)
65
66       ' extract price from file
67       txtPrice.Text = strContents.Substring(intRankBegin, _
68          (intRankEnd - intRankBegin))
69
70    End Sub ' btnSearch_Click
71
72 End Class ' FrmScreenScrape



303

T U T O R I A L

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

25
ATM Application

 Introducing Database Programming
Solutions



Tutorial 25 ATM Application 304

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

Instructor’s Manual
Exercises for Tutorial

25

[Note: The solutions for this tutorial use relative paths when connecting to a
database. We have done this so that the solutions can be run from any location. The
student has only learned to connect to databases using absolute paths, so their solu-
tions must be run from a specific location.]

MULTIPLE-CHOICE
QUESTIONS

25.1 A  provides mechanisms for storing and organizing data in a manner that is
consistent with a database’s format.

25.2 An entire row in a database table is known as a .

25.3 A primary key is used to .

25.4 A data command object allows you to .

25.5 A data reader can .

25.6 In a SELECT statement, what follows the SELECT keyword?

25.7 What does the following SELECT statement do?

SELECT Age FROM People WHERE LastName = 'Purple'

25.8 The SQL  modifies information in a database.

25.9 Which of the following statements modifies the Accounts table’s PIN field? The
account number is 2?

25.10 A  is an organized collection of data.

Answers: 25.1) d.  25.2) a.  25.3) c.  25.4) c.  25.5) a.  25.6) b.  25.7) a.  25.8) d.  25.9) c.  25.10) b.

a) relational database b) connection object
c) data command d) database management system

a) record b) field
c) column d) primary key

a) create rows in a database b) identify fields in a database
c) distinguish between records in a table d) read information from a database

a) connect to a database b) read information from a database
c) execute a statement to retrieve or 

modify a database
d) create a database

a) retrieve information from a database b) modify information stored in a database
c) establish a connection to a database d) close a connection to a database

a) the name of the table b) the name of the field
c) the name of the database d) the criteria that the record must meet 

a) It selects the age of the person (or people) with the last name Purple from the Peo-
ple table.

b) It selects the value Purple from the Age table of the People database.
c) It selects the age of the person with the last name Purple from the People database.
d) It selects the People field from the Age table with the LastName value Purple.

a) SELECT statement b) MODIFY statement
c) CHANGE statement d) UPDATE statement

a) SELECT PIN FROM Accounts WHERE AccountNumber = 2
b) SELECT Accounts FROM AccountNumber = 2 WHERE PIN
c) UPDATE Accounts SET PIN=1243 WHERE AccountNumber = 2
d) UPDATE PIN=1243 SET AccountNumber = 2 WHERE Accounts

a) record b) database
c) data reader d) primary key
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EXERCISES 25.11 (Stock Portfolio Application) A stock broker wants an application that will display a
client’s stock portfolio (Fig. 25.37). All the companies that the user holds stock in should be
displayed in a ComboBox when the application is loaded. When the user selects a company
from the ComboBox and clicks the Stock Information Button, the stock information for that
company should be displayed in Labels.

Figure 25.37 Stock Portfolio application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial25\Exercises\StockPortfolio directory to your C:\SimplyVB
directory. 

b) Opening the application’s template file. Double click StockPortfolio.sln in the
StockPortfolio directory to open the application.

c) Copying the database to your working directory. Copy the stocks.mdb database
from your C:\Examples\Tutorial25\Exercises\Databases directory to your
C:\SimplyVB\StockPortfolio directory.

d) Adding a data connection to the Server Explorer. Click the Connect to Database
icon in the Server Explorer, and add a data connection to the stock.mdb database.
Add an OleDbConnection object to the Form. 

e) Adding command objects to the Form. Add two command objects to the Form, and
set both their Connection properties to the database connection object. Name the
command objects objSelectStockNameCommand and objSelectStockInforma-
tionCommand. The first object will be used to retrieve the name of a stock and the
second item will be used to retrieve all of a stock’s information, based on the name of
the stock.

f) Setting the command objects’ CommandText properties. Select the objSelectStock-
NameCommand object and click the ellipses Button that appears to the right of the
CommandText property in the Properties window. In the Query Builder, select stock-
Name from the stocks table and click OK. Select the objSelectStockInforma-
tionCommand and open the Query Builder as you did for
objSelectStockNameCommand. This time, select the stockSymbol, shares and price
items from the stocks table. Then, select the stockName item and provide it with
the =? criteria value. Finally, uncheck the stockName item from the stocks table.
Click OK to dismiss the Query Builder.

g) Adding a Load event to the Form. Add a Load event handler for the Form. Add code
to this event handler that opens a connection to the database. Use the objSelect-
StockNameCommand to retrieve the StockNames, and add them to the ComboBox.

h) Adding a Click event handler for the btnStockInformation Button. Add a Click
event handler for the Stock Information Button. Add code to the event handler that
passes the SelectedItem to the StockData method as a String. Then close the con-
nection.
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i) Defining the StockData method. Create a StockData method that takes a String
representing the name of the stock as an argument. Connect to the database, and
retrieve the information for the stock passed as an argument (using objSelect-
StockInformationCommand). Display the information in the corresponding Labels
and close the connection to the database. Call the ComputeTotalValueString
method, which you define in the next step, to calculate the total value.

j) Defining the ComputeTotalValueString method. Create the ComputeTotalVal-
ueString method to compute the total value by multiplying the number of shares by
the price per share.

k) Running the application. Select Debug > Start to run your application. Select a
company from the ComboBox and click the Stock Information Button. Verify that the
information displayed in the Stock Info GroupBox is correct, based on the informa-
tion stored in stock.mdb. Repeat this process for the other companies.

l) Closing the application. Close your running application by clicking its close box.

m)Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 25.11 Solution
2 ' StockPortfolio.vb
3
4 Imports System.Data.OleDb
5
6 Public Class FrmStockPortfolio
7    Inherits System.Windows.Forms.Form
8
9    ' Windows Form Designer generated code

10
11    ' called when Form is loaded
12    Private Sub FrmStockPortfolio_Load(ByVal sender _
13       As System.Object, ByVal e As System.EventArgs) _
14       Handles MyBase.Load
15
16       objOleDbConnection.Open() ' open connection
17
18       ' create data reader to read from database
19       Dim objReader As OleDbDataReader
20
21       objReader = objSelectStockNameCommand.ExecuteReader()
22
23       Do While objReader.Read
24
25          ' add all stock names in database to the ComboBox 
26          cboStockNames.Items.Add(objReader("stockName"))
27       Loop
28
29       objOleDbConnection.Close() ' close database connection
30    End Sub ' FrmStockPortfolio_Load
31
32    ' handles click event for btnStockInformation Button
33    Private Sub btnStockInformation_Click(ByVal sender As _
34       System.Object, ByVal e As System.EventArgs) _
35       Handles btnStockInformation.Click
36
37       ' String representing stock selected
38       Dim strSelection As String = _
39          Convert.ToString(cboStockNames.SelectedItem)
40
41       ' display stock information
42       StockData(strSelection)
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43    End Sub ' btnStockInformation_Click
44
45    ' retrieve stock information from database
46    ' and set corresponding output Labels with data
47    Private Sub StockData(ByVal strStock As String)
48
49       objOleDbConnection.Open() ' open connection
50
51       ' specify which stock’s information to retrieve
52       objSelectStockInformationCommand.Parameters( _
53          "stockName").Value = strStock
54
55       ' create data reader to read from database
56       Dim objReader As OleDbDataReader
57
58       objReader = objSelectStockInformationCommand.ExecuteReader()
59       objReader.Read() ' read from the database
60
61       ' set all output Labels 
62       ' with coresponding stock information
63       lblNameOutput.Text = strStock
64       lblSymbolOutput.Text = _
65          Convert.ToString(objReader("stockSymbol"))
66
67       lblShareNumberOutput.Text = _
68          Convert.ToString(objReader("shares"))
69
70       Dim decSharePrice As Decimal = _
71          Convert.ToDecimal(objReader("price"))
72
73       lblSharePriceOutput.Text = _
74          String.Format("{0:C}", decSharePrice)
75
76       objReader.Close() ' close OleDbDataReader
77
78       lblTotalOutput.Text = ComputeTotalValueString( _
79          lblShareNumberOutput.Text, Convert.ToString(decSharePrice))
80
81       objOleDbConnection.Close() ' close database connection
82    End Sub ' StockData
83
84    ' helper procedure to compute total value of stock
85    ' and return it as a String
86    Private Function ComputeTotalValueString(ByVal strShareNumber _
87       As String, ByVal strSharePrice As String) As String
88
89       Dim intShareNumber As Integer = _
90          Convert.ToInt32(strShareNumber)
91       Dim decSharePrice As Decimal = _
92          Convert.ToDecimal(strSharePrice)
93
94       ' return the total value formatted as a currency
95       Return String.Format("{0:C}", _
96          (intShareNumber * decSharePrice))
97
98    End Function ' ComputeTotalValueString
99
100 End Class ' FrmStockPortfolio
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25.12 (Restaurant Bill Calculator Application) A restaurant wants you to develop an
application that calculates a table’s bill (Fig. 25.38). The application should display all the
menu items from the restaurant’s database in four ComboBoxes. Each ComboBox should con-
tain a category of food offered by the restaurant (Beverage, Appetizer, Main course and
Dessert). The user can choose from one of these ComboBoxes to add an item to a table’s bill.
When the table is finished ordering, the user can click the Calculate Bill Button to display
the Subtotal:, Tax: and Total: for the table. 

Figure 25.38 Restaurant Bill Calculator application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial25\Exercises\RestaurantBillCalculator directory to your
C:\SimplyVB directory. 

b) Opening the application’s template file. Double click RestaurantBillCalcula-
tor.sln in the RestaurantBillCalculator directory to open the application. 

c) Copying the database to your working directory. Copy the menu.mdb database from
C:\Examples\Tutorial25\Exercises\Databases to your C:\SimplyVB\Restau-
rantBillCalculator directory.

d) Adding a data connection to the Server Explorer. Click the Connect to Database
icon in the Server Explorer, and add a data connection to the menu.mdb database.
Add an OleDbConnection object to the Form. 

e) Adding command objects to the Form. Add two command objects to the Form, and
set both their Connection properties to the database connection object. Name the
command objects objSelectNameCommand and objSelectPriceCommand. The first
object will be used to retrieve the name of a menu item, based on category (for exam-
ple, appetizer). The second command object will be used to retrieve a menu item’s
price, based on the item’s name.

f) Setting the command objects’ CommandText properties. Select the objSelectName-
Command object and open the Query Builder. Add the menu table and select the
name and category items. Provide the category item with the =? criteria value, then
deselect category in the menu table. Click OK. Select the objSelectPriceCommand
and open the Query Builder. This time, select the items marked price and name from
the menu table. Provide the name item with the =? criteria value. Finally, uncheck
the name item in the menu table. Click OK to dismiss the Query Builder.

g) Adding a Load event to the Form. Create the Load event handler for the Form. Add
code to the event handler that opens a connection to the database. Call the LoadCat-
egory method four times, each time passing a different category and ComboBox as
arguments. Close the connection to the database.



309 ATM Application Tutorial 25

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

h) Coding the LoadCategory method. Create a method LoadCategory that takes a
String representing the Category to load and the name of the ComboBox to add
items to as arguments. Because the Form’s Load event handler is calling this method
before it closes the connection to the database, the connection should still be open.
Create a data reader to read all the items from the database for the specified Cate-
gory, using objSelectNameCommand. Close the reader before exiting the method, so
that a new reader can be created when the method is invoked again.

i) Adding SelectedIndexChanged event handler for the ComboBoxes. Add a Select-
edIndexChanged event handler for all the ComboBoxes. Add code to the event han-
dler that adds the String representation of the SelectedItem to the ArrayList.

j) Adding a Click event handler for the btnCalculateBill Button. Add a Click
event handler for the Calculate Bill Button. Add code to the event handler that
ensures that a table number and waiter name have been entered. If one of these
fields is empty, display a MessageBox informing the user that both fields must contain
information. The event handler should then call the CalculateSubtotal method to
calculate the subtotal of the bill. Display the subtotal, tax and total of the bill in the
appropriate Labels.

k) Coding the CalculateSubtotal method. The CalculateSubtotal method should
open a connection to the database and retrieve the Price field for all the menu items
in the m_objBillItems ArrayList (using objSelectPriceCommand). This method
should then calculate the total price of all the items in the ArrayList and return this
value as a Decimal. Remember to close the connection to the database.

l) Running the application. Select Debug > Start to run your application. Enter a table
number and waiter name, and select different menu items from the ComboBoxes.
Click the Calculate Bill Button and verify that the subtotal, tax and total values are
correct. Select more items from the ComboBoxes and again click the Calculate But-
ton. Verify that the price of the new items has been added to the bill.

m)Closing the application. Close your running application by clicking its close box.

n) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 25.12 Solution
2 ' RestaurantBillCalculator.vb
3
4 Imports System.Data.OleDb
5
6 Public Class FrmRestaurantBillCalculator
7    Inherits System.Windows.Forms.Form
8
9    ' Windows Form Designer generated code

10
11    ' hold all items on running bill
12    Dim m_objBillItems As ArrayList = New ArrayList()
13
14    ' invoked when application is loaded
15    Private Sub FrmRestaurantBillCalculator_Load(ByVal sender As _
16       System.Object, ByVal e As System.EventArgs) _
17       Handles MyBase.Load
18
19       objOleDbConnection.Open() ' open connection to the database
20
21       ' load all ComboBoxes with appropriate items
22       LoadCategory("Beverage", cboBeverage)
23       LoadCategory("Appetizer", cboAppetizer)
24       LoadCategory("Main Course", cboMainCourse)
25       LoadCategory("Dessert", cboDessert)
26
27       objOleDbConnection.Close() ' close connection to the database
28    End Sub ' FrmRestaurantBillCalculator_Load
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29
30    ' loads the specified category of menu items in 
31    ' their corresponding ComboBox
32    Private Sub LoadCategory(ByVal strCategory As String, _
33       ByVal cboCategory As ComboBox)
34
35       ' specify category parameter
36       objSelectNameCommand.Parameters( _
37          "category").Value = strCategory
38
39       ' declare a reader for the database
40       Dim objMenuReader As OleDbDataReader
41
42       objMenuReader = _
43          objSelectNameCommand.ExecuteReader()
44
45       Do While objMenuReader.Read()
46
47          ' retrieve names of items in the specified category
48          ' from database, then add to specified ComboBox
49          cboCategory.Items.Add(objMenuReader("Name"))
50       Loop
51
52       objMenuReader.Close() ' close the reader
53    End Sub ' LoadCategory
54
55    ' handles SelectedIndexChanged event for cboBeverage ComboBox
56    Private Sub cboBeverage_SelectedIndexChanged(ByVal sender As _
57       System.Object, ByVal e As System.EventArgs) _
58       Handles cboBeverage.SelectedIndexChanged
59
60       ' add selected Beverage to m_objBillItems ArrayList
61       m_objBillItems.Add(cboBeverage.SelectedItem)
62    End Sub ' cboBeverage_SelectedIndexChanged
63
64    ' handles SelectedIndexChanged event for cboAppetizer ComboBox
65    Private Sub cboAppetizer_SelectedIndexChanged(ByVal sender As _
66       System.Object, ByVal e As System.EventArgs) _
67       Handles cboAppetizer.SelectedIndexChanged
68
69       ' add selected Appetizer to m_objBillItems ArrayList
70       m_objBillItems.Add(cboAppetizer.SelectedItem)
71    End Sub ' cboAppetizer_SelectedIndexChanged
72
73    ' handles SelectedIndexChanged event for cboMainCourse ComboBox
74    Private Sub cboMainCourse_SelectedIndexChanged(ByVal sender As _
75       System.Object, ByVal e As System.EventArgs) _
76       Handles cboMainCourse.SelectedIndexChanged
77
78       ' add selected Main Course to m_objBillItems ArrayList
79       m_objBillItems.Add(cboMainCourse.SelectedItem)
80    End Sub ' cboMainCourse_SelectedIndexChanged
81
82    ' handles SelectedIndexChanged event for cboDessert ComboBox
83    Private Sub cboDessert_SelectedIndexChanged(ByVal sender As _
84       System.Object, ByVal e As System.EventArgs) _
85       Handles cboDessert.SelectedIndexChanged
86
87       ' add selected Dessert to m_objBillItems ArrayList
88       m_objBillItems.Add(cboDessert.SelectedItem)
89    End Sub ' cboDessert_SelectedIndexChanged
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90
91    ' handles click event for btnCalculateBill Button
92    Private Sub btnCalculateBill_Click(ByVal sender As _
93       System.Object, ByVal e As System.EventArgs) _
94       Handles btnCalculateBill.Click
95
96       ' must enter waiter name and table number
97       If txtWaiterName.Text = "" OrElse _
98          txtTableNumber.Text = "" Then
99
100          MessageBox.Show( _
101             "Table Number and Waiter Name must be entered", _
102             "Empty Field", MessageBoxButtons.OK, _
103             MessageBoxIcon.Exclamation)
104
105       Else ' calculate the bill
106
107          ' calculate the Subtotal
108          Dim decSubtotal As Decimal = CalculateSubtotal()
109
110          ' display the Subtotal in Label
111          lblSubtotalResult.Text = String.Format("{0:C}", decSubtotal)
112
113          ' calculate tax and display in Label
114          Dim decTax As Decimal = Convert.ToDecimal( _
115             decSubtotal * 0.05)
116
117          lblTaxResult.Text = String.Format("{0:C}", decTax)
118
119          ' calculate total and display in Label
120          lblTotalResult.Text = _
121             String.Format("{0:C}", (decSubtotal + decTax))
122
123       End If
124
125    End Sub ' btnCalculateBill_Click
126
127    ' calculate the subtotal of the bill
128    Private Function CalculateSubtotal() As Decimal
129
130       ' open connection to the database 
131       objOleDbConnection.Open()
132
133       ' declare a reader for the database
134       Dim objMenuReader As OleDbDataReader
135
136       Dim intCounter As Integer
137       Dim decSubtotal As Decimal = 0
138
139       For intCounter = 0 To (m_objBillItems.Count - 1)
140
141          ' specify name of item to retrieve 
142          objSelectPriceCommand.Parameters("name").Value = _
143             Convert.ToString(m_objBillItems(intCounter))
144
145          objMenuReader = _
146             objSelectPriceCommand.ExecuteReader()
147
148          objMenuReader.Read() ' read from the database
149
150          ' retrieve price of items with specified name
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25.13 (Airline Reservation Application) An airline company wants you to develop an appli-
cation that displays flight information (Fig. 25.39). The database contains two tables, one con-
taining information about the flights, the other containing passenger information. The user
should be able to choose a flight number from a ComboBox. When the View Flight Information
Button is clicked, the application should display the date of the flight, the flight’s departure
and arrival cities and the names of the passengers schedule to take the flight.

Figure 25.39 Airline Reservation application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial25\Exercises\AirlineReservation directory to your C:\Sim-
plyVB directory. 

b) Opening the application’s template file. Double click AirlineReservation.sln in
the AirlineReservation directory to open the application.

c) Copying the database to your working directory. Copy the reservations.mdb data-
base from C:\Examples\Tutorial25\Exercises\Databases to your C:\Sim-
plyVB\AirlineReservation directory.

d) Adding a data connection to the Server Explorer. Click the Connect to Database
icon in the Server Explorer, and add a data connection to the reservations.mdb
database. Add an OleDbConnection object to the Form.

e) Adding command objects to the Form. Add three command objects to the Form, and
set all their Connection properties to the database connection object. Name the
command objects objSelectFlightNumberCommand (used to retrieve flight num-
bers), objSelectFlightInformationCommand (used to retrieve information about a
flight based on the flight’s number) and objSelectPassengerInformationCommand
(used to retrieve information about a flight’s passengers based on the flight’s num-
ber).

f) Setting the command objects’ CommandText properties. Select the objSelect-
FlightNumberCommand object and open the Query Builder. Select FlightNumber
from the flights table and click OK. Select the objSelectFlightInformationCom-
mand and open the Query Builder. This time, select the Date, DepartureCity and

151          ' and add price to dblSubtotal
152          decSubtotal += Convert.ToDecimal(objMenuReader("Price"))
153
154          objMenuReader.Close() ' close the reader
155       Next
156
157       ' close connection to the database
158       objOleDbConnection.Close()
159
160       Return decSubtotal
161    End Function ' CalculateSubtotal
162
163 End Class ' FrmRestaurantBillCalculator
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ArrivalCity items from the flights table. This action causes all items from the table to
be returned. Then, select the FlightNumber item and provide it with the =? criteria
value. Finally, uncheck the FlightNumber item from the flights table. Click OK to dis-
miss the Query Builder. Select the objSelectPassengerInformationCommand and
open the Query Builder. Select the LastName and FirstName items from the reser-
vations table. Then, select the FlightNumber item and provide it with the =? criteria
value. Finally, uncheck the FlightNumber item from the reservations table. Click OK
to dismiss the Query Builder.

g) Adding a Load event to the Form. Create a Load event handler for the Form that
opens a connection to the database. Retrieve all the FlightNumbers from the
Flights table in the reservations.mdb database (using objSelectFlightNumber-
Command), and add those FlightNumbers to the ComboBox.

h) Adding a Click event handler for the btnViewFlightInformation Button. Add a
Click event handler for the View Flight Information Button. Add code to the event
handler to pass the SelectedItem to the DisplayFlightInformation method.

i) Defining the DisplayFlightInformation method. The DisplayFlightInforma-
tion method should take as an argument a String representing the flight number
chosen. You will need to define two readers in this method, to read from the two
tables in the database. Once you open the connection to the database, create a reader
that reads the specified flight information from the flights table (using objSelect-
FlightInformationCommand). Display the flight information in the correct Label.
Close this reader, and create a second reader that reads passenger information from
the reservations table (using objPassengerInformationCommand). Retrieve from
the table all the passengers scheduled to take the specified flight. Clear any old items
from the ListBox, and display passengers’ names in the ListBox.

j) Running the application. Select Debug > Start to run your application. Select a
flight and click the View Flight Information Button. Verify that the flight informa-
tion is correct. Repeat this process for the other flights.

k) Closing the application. Close your running application by clicking its close box.

l) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 25.13 Solution
2 ' AirlineReservation.vb
3
4 Imports System.Data.OleDb
5
6 Public Class FrmAirlineReservation
7    Inherits System.Windows.Forms.Form
8
9    ' Windows Form Designer generated code

10
11    ' invoked when Form is loaded
12    Private Sub FrmAirlineReservation_Load(ByVal sender As _
13       System.Object, ByVal e As System.EventArgs) _
14       Handles MyBase.Load
15
16       objOleDbConnection.Open() ' open database connection
17
18       ' create reader to read information from database
19       Dim objReader As OleDbDataReader
20
21       objReader = objSelectFlightNumberCommand.ExecuteReader()
22
23       Do While objReader.Read()
24
25          ' retrieve flight number from database
26          ' and add it to cboChooseAFlight
27          cboChooseAFlight.Items.Add( _
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28             Convert.ToString(objReader("FlightNumber")))
29
30       Loop
31
32       objOleDbConnection.Close() ' close database connection
33    End Sub ' FrmAirlineReservation_Load
34
35    ' handles click event for btnViewFlightInformation Button
36    Private Sub btnViewFlightInformation_Click(ByVal sender _
37       As System.Object, ByVal e As System.EventArgs) _
38       Handles btnViewFlightInformation.Click
39
40       ' retrieve selected index
41       Dim strFlightNumber As String = _
42          Convert.ToString(cboChooseAFlight.SelectedItem)
43
44       ' display new flight information
45       DisplayFlightInformation(strFlightNumber)
46
47    End Sub ' btnFlightView_Click
48
49    ' display flight information in GroupBox’s Labels
50    Private Sub DisplayFlightInformation( _
51       ByVal strFlightNumber As String)
52
53       objOleDbConnection.Open() ' open database connection
54
55       objSelectFlightInformationCommand.Parameters( _
56          "FlightNumber").Value = strFlightNumber
57
58       ' create data reader to read information from database
59       Dim objFlightReader As OleDbDataReader
60
61       objFlightReader = _
62          objSelectFlightInformationCommand.ExecuteReader()
63
64       Do While objFlightReader.Read()
65
66          ' retrieve date, departure city, arrival city
67          lblDateOutput.Text = _
68             Convert.ToString(objFlightReader("Date"))
69          lblDepartureOutput.Text = _
70             Convert.ToString(objFlightReader("DepartureCity"))
71          lblArrivalOutput.Text = _
72             Convert.ToString(objFlightReader("ArrivalCity"))
73       Loop
74
75       objFlightReader.Close() ' close the data reader
76
77       ' specify flight number to retrieve passenger information
78       objSelectPassengerInformationCommand.Parameters( _
79          "flightNumber").Value = strFlightNumber
80
81       ' create data reader to read information from database
82       Dim objPassengerReader As OleDbDataReader
83
84       objPassengerReader = _
85          objSelectPassengerInformationCommand.ExecuteReader()
86
87       Dim strFirstName As String
88       Dim strLastName As String
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What does this code do? 25.14 What does the following code do?

Answer: This code segment connects to a database and retrieves the Age data for the person 
with the name Bob. This data is then stored in m_intAge. The code then closes both the data 
reader and the connection to the database.

What’s wrong with this code? 25.15 Find the error(s) in the following code. This method should modify the Age field of
strUserName.

Answer: Line 1 does not properly set the Age parameter—the Parameters property of 
objUpdateAge must be used. Also, no connection is made to the database before the UPDATE 
is attempted. 

89
90       lstDisplay.Items.Clear() ' clear previous passenger list
91
92       Do While objPassengerReader.Read()
93
94          strLastName = _
95             Convert.ToString(objPassengerReader("LastName"))
96          strFirstName = _
97             Convert.ToString(objPassengerReader("FirstName"))
98
99          lstDisplay.Items.Add(strLastName & ", " & strFirstName)
100       Loop
101
102       objPassengerReader.Close() ' close the data reader
103
104       objOleDbConnection.Close() ' close database connection
105
106    End Sub ' DisplayFlighInformation
107
108 End Class ' FrmAirlineReservation

▲

1 objSelectAgeData.Parameters("Name").Value = "Bob"
2
3 objOleDbConnection.Open()
4
5 Dim objReader As OleDbDataReader = _
6    objSelectAgeData.ExecuteReader
7
8 objReader.Read()
9

10 m_intAge = Convert.ToInteger(objReader("Age"))
11
12 objReader.Close()
13 objOleDbConnection.Close()  

▲

1 objUpdateAge("Age").Value = _
2    intAge
3
4 objUpdateBalance.Parameters("Original_NAME").Value = _
5    strUserName
6
7 objUpdateAge.ExecuteNonQuery()
8
9 objOleDbConnection.Close()  
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Programming Challenge 25.16 (Enhanced Restaurant Bill Calculator) Modify the application you developed in
Exercise 25.12 to keep track of multiple table bills at the same time. The user should be able
to calculate a bill for a table and save that table’s subtotal and waiter’s name. The user should
also be able to retrieve that information at a later time. [Hint: This database contains two
tables, one for the menu items, as before, and another for all the tables in the restaurant.]
Sample outputs are shown in Fig. 25.40.

1
2
3
4 objUpdateBalance.Parameters("Original_NAME").Value = _
5    strUserName
6
7
8
9 objUpdateAge.ExecuteNonQuery()

10
11 objOleDbConnection.Close()  

objUpdateAge.Parameters("Age").Value = _
   intAge                               

objOleDbConnection.Open()

▲
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Figure 25.40 Enhanced Restaurant Bill Calculator application’s GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial25\Exercises\RestaurantBillCalculatorEnhanced directory to
your C:\SimplyVB directory. 

b) Opening the application’s template file. Double click RestaurantBillCalcula-
tor.sln in the RestaurantBillCalculatorEnhanced directory to open the appli-
cation. 

c) Copying the database to your working directory. Copy the menu2.mdb database
from C:\Examples\Tutorial25\Exercises\Databases to your C:\Sim-
plyVB\RestaurantBillCalculatorEnhanced directory.

d) Adding a data connection to the Server Explorer. Click the Connect to Database
icon in the Server Explorer, and add a data connection to the menu2.mdb database.
Add an OleDbConnection object to the Form.

e) Adding command objects to the Form. Add five command objects to the Form, and
set their Connection properties to the database connection object. Name the com-
mand objects objSelectNameCommand, objSelectPriceCommand, objSelectTa-
bleNumberCommand, objSelectTableInfoCommand and objUpdateSubtotal-
Command.
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f) Setting the command objects’ CommandText properties. Set the CommandText prop-
erties of objSelectNameCommand and objSelectPriceCommand as you did in
Exercise 25.12. Set objSelectTableNumberCommand to retrieve table numbers from
the tables table. Set objSelectTableInfoCommand to retrieve the name of the
waiter and the subtotal of a table, based on that table’s number. Set objUpdateSub-
totalCommand to modify the subtotal for a table, also based on that table’s number.
[Note: For the last command object, you will need to change the type of query in the
Query Builder, as you did earlier in this tutorial.]

g) Copying your existing code. Copy the code for the application you created in
Exercise 25.12 into the template application for this exercise. Place this code before
method ResetForm. Disregard any syntax errors that may appear in the Task List at
this point.

h) Adding an instance variable. Add an instance variable (after the declaration of
m_objBillItems) called m_decSubtotal, that will hold the subtotal for each table
when it is loaded in the application.

i) Modifying methods btnCalculateBill_Click and CalculateSubtotal. Remove
the portion of the btnCalculateBill_Click event handler that checked for a table
number and waiter name—this information will be displayed shortly. Modify the
CalculateSubtotal method to update the table’s subtotal based on the table’s pre-
vious subtotal and any new items selected.

j) Creating a method. Create method LoadTables that reads the table numbers from
the database and adds them to the Table number: ComboBox. This method should be
called in FrmRestaurantBillCalculator_Load directly after the connection to the
database is opened.

k) Adding an event handler. Add an event handler for the Table number: ComboBox.
When a table is selected from the ComboBox, that table’s data should be loaded from
the database. 

l) Creating an event handler for the Save Table Button. Create an event handler for
the Save Table Button. This event handler should calculate the subtotal for the
selected table. The event handler should then call method UpdateTable, passing the
subtotal and table number as arguments. Finally, call the ResetForm method to reset
the data displayed in the GUI.

m)Creating an event handler for the Pay Bill Button. Create an event handler for the
Pay Bill Button. This event handler should retrieve the current table number then
call method UpdateTable, passing a subtotal of 0 (for new customers) and table
number as arguments. Finally, call the ResetForm method to reset the data displayed
in the GUI.

n) Creating method UpdateTable. Create a method UpdateTable that takes the subto-
tal and table number as arguments. This method should save the table data in the
database.

o) Running the application. Select Debug > Start to run your application. Select a
table number and various menu items from the ComboBoxes. Click the Calculate Bill
Button and verify that the subtotal, tax and total values are correct. Select more
items from the ComboBoxes and again click the Calculate Bill Button. Verify that the
price of the new items has been added to the bill. Click the Save Table Button.
Select a different table and various menu items. Click the Calculate Bill Button and
verify that the price of the new items has been added to the bill. Click the Save Table
Button. Select the first table and verify that the subtotal is the same as it was when
the table was saved. Select various menu items and Click the Calculate Bill Button.
Verify that the subtotal, tax and total values are correct (and now include prices of
the new menu items). Click the Pay Bill Button and verify that the subtotal is not
reset to $0.00.

p) Closing the application. Close your running application by clicking its close box.

q) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:
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1 ' Exercise 25.15 Solution
2 ' RestaurantBillCalculator.vb
3
4 Imports System.Data.OleDb
5
6 Public Class FrmRestaurantBillCalculator
7    Inherits System.Windows.Forms.Form
8
9    ' Windows Form Designer generated code

10
11    ' hold all items on running bill
12    Dim m_objBillItems As ArrayList = New ArrayList
13
14    Dim m_decSubtotal As Decimal = 0 ' current table subtotal
15
16    ' invoked when application is loaded
17    Private Sub FrmRestaurantBillCalculator_Load(ByVal sender As _
18       System.Object, ByVal e As System.EventArgs) _
19       Handles MyBase.Load
20
21       objOleDbConnection.Open() ' open connection to the database 
22
23       ' load cboTables ComboBox with table numbers
24       LoadTables()
25
26       ' load all ComboBoxes with appropriate items
27       LoadCategory("Beverage", cboBeverage)
28       LoadCategory("Appetizer", cboAppetizer)
29       LoadCategory("Main Course", cboMainCourse)
30       LoadCategory("Dessert", cboDessert)
31
32       objOleDbConnection.Close() ' close connection to the database
33    End Sub ' FrmRestaurantBillCalculator_Load
34
35    ' loads the specified category of menu items in 
36    ' their corresponding ComboBox
37    Private Sub LoadCategory(ByVal strCategory As String, _
38       ByVal cboCategory As ComboBox)
39
40       ' specify category parameter
41       objSelectNameCommand.Parameters( _
42          "category").Value = strCategory
43
44       ' declare a reader for the database
45       Dim objMenuReader As OleDbDataReader
46
47       objMenuReader = _
48          objSelectNameCommand.ExecuteReader()
49
50       Do While objMenuReader.Read()
51
52          ' retrieve names of items in the specified category
53          ' from database, then add to specified ComboBox
54          cboCategory.Items.Add(objMenuReader("Name"))
55       Loop
56
57       objMenuReader.Close()
58    End Sub ' LoadCategory
59
60    ' handles SelectedIndexChanged event for cboBeverage ComboBox
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61    Private Sub cboBeverage_SelectedIndexChanged(ByVal sender As _
62       System.Object, ByVal e As System.EventArgs) _
63       Handles cboBeverage.SelectedIndexChanged
64
65       ' add selected Beverage to m_objBillItems ArrayList
66       m_objBillItems.Add(cboBeverage.SelectedItem)
67    End Sub ' cboBeverage_SelectedIndexChanged
68
69    ' handles SelectedIndexChanged event for cboAppetizer ComboBox
70    Private Sub cboAppetizer_SelectedIndexChanged(ByVal sender As _
71       System.Object, ByVal e As System.EventArgs) _
72       Handles cboAppetizer.SelectedIndexChanged
73
74       ' add selected Appetizer to m_objBillItems ArrayList
75       m_objBillItems.Add(cboAppetizer.SelectedItem)
76    End Sub ' cboAppetizer_SelectedIndexChanged
77
78    ' handles SelectedIndexChanged event for cboMainCourse ComboBox
79    Private Sub cboMainCourse_SelectedIndexChanged(ByVal sender As _
80       System.Object, ByVal e As System.EventArgs) _
81       Handles cboMainCourse.SelectedIndexChanged
82
83       ' add selected Main Course to m_objBillItems ArrayList
84       m_objBillItems.Add(cboMainCourse.SelectedItem)
85    End Sub ' cboMainCourse_SelectedIndexChanged
86
87    ' handles SelectedIndexChanged event for cboDessert ComboBox
88    Private Sub cboDessert_SelectedIndexChanged(ByVal sender As _
89       System.Object, ByVal e As System.EventArgs) _
90       Handles cboDessert.SelectedIndexChanged
91
92       ' add selected Dessert to objBillItems ArrayList
93       m_objBillItems.Add(cboDessert.SelectedItem)
94    End Sub ' cboDessert_SelectedIndexChanged
95
96    ' handles click event for btnCalculateBill Button
97    Private Sub btnCalculateBill_Click(ByVal sender As _
98       System.Object, ByVal e As System.EventArgs) _
99       Handles btnCalculateBill.Click
100
101       ' calculate the Subtotal
102       Dim decSubtotal As Decimal = CalculateSubtotal()
103
104       ' display the Subtotal in Label
105       lblSubtotalResult.Text = String.Format("{0:C}", decSubtotal)
106
107       ' calculate tax and display in Label
108       Dim decTax As Decimal = Convert.ToDecimal(decSubtotal * 0.05)
109
110       lblTaxResult.Text = String.Format("{0:C}", decTax)
111
112       ' calculate total and display in Label
113       lblTotalResult.Text = _
114          String.Format("{0:C}", (decSubtotal + decTax))
115
116    End Sub ' btnCalculateBill_Click
117
118    ' calculate the subtotal of the bill
119    Private Function CalculateSubtotal() As Decimal
120
121       ' open connection to the database 
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122       objOleDbConnection.Open()
123
124       ' declare a reader for the database
125       Dim objMenuReader As OleDbDataReader
126
127       Dim intCounter As Integer
128       Dim decSubtotal As Decimal = m_decSubtotal
129
130       For intCounter = 0 To (m_objBillItems.Count - 1)
131
132          ' specify name of item to retrieve
133          objSelectPriceCommand.Parameters("name").Value = _
134             Convert.ToString(m_objBillItems(intCounter))
135
136          objMenuReader = _
137             objSelectPriceCommand.ExecuteReader()
138
139          ' read from the database
140          Do While objMenuReader.Read()
141
142             ' retrieve price of items with specified name
143             ' and add price to decSubtotal
144             decSubtotal += Convert.ToDecimal(objMenuReader("Price"))
145          Loop
146
147          objMenuReader.Close() ' close the reader
148       Next
149
150       ' close database connection
151       objOleDbConnection.Close()
152
153       Return decSubtotal
154    End Function ' CalculateSubtotal
155
156    ' reset all controls on the Form
157    Private Sub ResetForm()
158
159       ' clear all Labels
160       lblSubtotalResult.Text = ""
161       lblTaxResult.Text = ""
162       lblTotalResult.Text = ""
163       lblWaiterNameOutput.Text = ""
164
165       ' set Selected index to -1 so 
166       ' no item is selected in ComboBoxes
167       cboBeverage.SelectedIndex = -1
168       cboAppetizer.SelectedIndex = -1
169       cboMainCourse.SelectedIndex = -1
170       cboDessert.SelectedIndex = -1
171       cboTables.SelectedIndex = -1
172
173       fraMenuItems.Enabled = False ' disable Menu Items GroupBox
174
175       ' enable Waiter Information GroupBox
176       fraWaiterInformation.Enabled = True
177
178       ' disable all Buttons
179       btnSaveTable.Enabled = False
180       btnCalculateBill.Enabled = False
181       btnPayBill.Enabled = False
182
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183       m_decSubtotal = 0 ' clear subtotal
184
185       ' reinitialize m_objBillItems ArrayList
186       m_objBillItems = New ArrayList
187    End Sub ' ResetForm
188
189    ' load tables from database
190    Private Sub LoadTables()
191
192       ' declare a reader for the database
193       Dim objTableReader As OleDbDataReader
194
195       objTableReader = _
196          objSelectTableNumberCommand.ExecuteReader()
197
198       Do While objTableReader.Read()
199
200          ' retrieve names of items in the specified category
201          ' from database, then add to specified ComboBox
202          cboTables.Items.Add(objTableReader("TableNumber"))
203
204       Loop
205
206       objTableReader.Close()
207    End Sub ' LoadTables
208
209    ' handles SelectedIndexChanged event for cboTables ComboBox
210    Private Sub cboTables_SelectedIndexChanged(ByVal sender _
211       As System.Object, ByVal e As System.EventArgs) _
212       Handles cboTables.SelectedIndexChanged
213
214       fraMenuItems.Enabled = True ' enable all Menu Items GroupBox
215
216       ' enable all Buttons
217       btnSaveTable.Enabled = True
218       btnCalculateBill.Enabled = True
219       btnPayBill.Enabled = True
220
221       ' clear Tax and Total output Labels
222       lblTaxResult.Text = ""
223       lblTotalResult.Text = ""
224
225       objOleDbConnection.Open() ' open connection to the database 
226
227       ' SELECT statement used to retrieve item names 
228       objSelectTableInfoCommand.Parameters( _
229          "tableNumber").Value = _
230          Convert.ToInt32(cboTables.SelectedItem)
231
232       ' declare a reader for the database
233       Dim objTableReader As OleDbDataReader
234
235       objTableReader = _
236          objSelectTableInfoCommand.ExecuteReader()
237
238       Do While objTableReader.Read()
239
240          ' retrieve waiter name and subtotal from database
241          lblWaiterNameOutput.Text = _
242             Convert.ToString(objTableReader("WaiterName"))
243
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244          m_decSubtotal = _
245             Convert.ToDecimal(objTableReader("Subtotal"))
246          lblSubtotalResult.Text = _
247             String.Format("{0:C}", m_decSubtotal)
248       Loop
249
250       objTableReader.Close() ' close the reader
251
252       ' close connection to the database
253       objOleDbConnection.Close()
254
255       ' disable Waiter Information GroupBox
256       fraWaiterInformation.Enabled = False
257    End Sub ' cboTables_SelectedIndexChanged
258
259    ' handles click event for btnSaveTable Button
260    Private Sub btnSaveTable_Click(ByVal sender As _
261       System.Object, ByVal e As System.EventArgs) _
262       Handles btnSaveTable.Click
263
264       Dim decSubtotal As Decimal = CalculateSubtotal()
265       Dim intTableNumber As Integer = _
266          Convert.ToInt32(cboTables.SelectedItem)
267
268       ' update table
269       UpdateTable(decSubtotal, intTableNumber)
270
271       ResetForm() ' reset all controls
272    End Sub ' btnSaveTable_Click
273
274    ' handles click event for btnSaveTable Button
275    Private Sub btnPayBill_Click(ByVal sender As _
276       System.Object, ByVal e As System.EventArgs) _
277       Handles btnPayBill.Click
278
279       Dim intTableNumber As Integer = _
280          Convert.ToInt32(cboTables.SelectedItem)
281
282       UpdateTable(0, intTableNumber) ' update table
283       ResetForm()  ' reset all controls
284    End Sub ' btnPayBill_Click
285
286    ' update table information in database
287    Private Sub UpdateTable(ByVal decSubtotal As Decimal, _
288       ByVal intTableNumber As Integer)
289
290       objOleDbConnection.Open() ' open database connection
291
292       ' specify parameters for UPDATE statement 
293       objUpdateSubtotalCommand.Parameters( _
294          "subtotal").Value = decSubtotal
295       objUpdateSubtotalCommand.Parameters( _
296          "Original_TableNumber").Value = _
297          Convert.ToString(intTableNumber)
298
299       ' execute update statement
300       objUpdateSubtotalCommand.ExecuteNonQuery()
301
302       objOleDbConnection.Close() ' close database connection
303    End Sub ' UpdateTable
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304
305 End Class ' FrmRestaurantBillCalculator
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26
CheckWriter Application

Introducing Graphics and Printing
Solutions
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Instructor’s Manual
Exercise Solutions

Tutorial 26

MULTIPLE-CHOICE
QUESTIONS

26.1 The RGB value (0, 0, 255) represents .

26.2 The  property of the PrintPreviewDialog object makes text appear
smoother.

26.3 Use a  object to allow the users to preview a document before it is printed.

26.4 The  event handler specifies what will be printed.

26.5 To display the preview dialog of the  object, call method ShowDialog.

26.6 Set the  property to False to indicate that there are no more pages to print.

26.7 The Print method sends a  object to the printer for printing.

26.8 Keyword  references the current object.

26.9 Opacity is the  value of a color.

26.10 Design units are used to specify the  of a Font.

Answers: 26.1) c.  26.2) b.  26.3) a.  26.4) d.  26.5) a.  26.6) b.  26.7) a.  26.8) c.  26.9) b.  26.10) a. 

EXERCISES 26.11 (CheckWriter Modified to Print Background Images) Modify the CheckWriter
application to display and print a background for the check. The GUI should look similar to
Fig. 26.31. Users can select a background image. The image should appear in the Print pre-
view dialog box and also should print as a background to the check.

a) Color.Red b) Color.Green 
c) Color.Blue d) Color.Yellow 

a) AntiAlias b) UseAntiAlias 
c) Alias d) UseAlias 

a) PrintPreviewDialog b) PrintDocument 
c) Print d) PrintPreviewControl 

a) OnPaint b) Print 
c) Document d) PrintPage 

a) PrintPreviewDialog b) PrintDocument 
c) PrintDialog d) Both a and b.

a) Document b) HasMorePages 
c) TerminatePrint d) Both a and b.

a) Graphics b) PrintDocument 
c) PrintPreviewDialog d) Brush 

a) This b) Class 
c) Me d) Property 

a) red b) transparency 
c) dithering d) blue 

a) Size b) Name 
c) FontFamily d) Style 
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Figure 26.31  Modified CheckWriter GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial26\Exercises\ModifiedCheckWriter to your C:\SimplyVB direc-
tory.

b) Opening the application’s template file. Double click CheckWriter.sln in the
CheckWriter directory to open the application.

c) Create the CheckedChanged event handler. Double click the Wood RadioButton to
create its CheckedChanged event handler.

d) Defining the CheckedChanged event handler. Define the RadioButton’s Checked-
Changed event handler to notify the application when users have made a background
selection. If the Wood RadioButton is selected, then a preview of the wooden back-
ground should display in the picPreview PictureBox. Otherwise, if the Brick
RadioButton is selected, then a preview of the brick background should display in
the picPreview PictureBox.

e) Modifying the objPrintDocument_PrintPage event handler. Modify the
objPrintDocument_PrintPage event handler to print the background image. [Hint:
Use the DrawImage method to display the background image to print. DrawImage
takes five arguments: The image file, the x-coordinate, the y-coordinate, the width
and the height.] To print the image in the background, the DrawImage method must
be the first method called on the Graphics object.

f) Running the application. Select Debug > Start to run your application. Enter data
into the input fields and select either the Wood or Brick RadioButton. Verify that
the appropriate image is displayed to the left of the RadioButtons. Click the Preview
Button and verify that the check is displayed with the proper background. Close the
preview and repeat this process selecting the background you had not selected
before.

g) Closing the application. Close your running application by clicking its close box.

h) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 26.11 Solution
2 ' CheckWriter.vb
3
4 Imports System.Drawing.Printing
5
6 Public Class FrmCheckWriter
7    Inherits System.Windows.Forms.Form
8
9    Private m_objFont As Font ' instance variable to store font

10    Private m_strPath As String
11
12    ' Windows Form Designer generated code
13
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14    ' PrintPage event raised for each page to be printed
15    Private Sub objPrintDocument_PrintPage(ByVal sender _
16       As System.Object, ByVal e As PrintPageEventArgs)
17
18       Dim sngYPosition As Single
19       Dim sngXPosition As Single
20
21       ' represent left margin of page
22       Dim sngLeftMargin As Single = e.MarginBounds.Left
23
24       ' represent top margin of page
25       Dim sngTopMargin As Single = e.MarginBounds.Top
26
27       Dim strLine As String = Nothing
28       Dim objControl As Control
29
30       ' if m_strPath has value, display 
31       ' specified image on Image control
32       If m_strPath <> "" Then
33          Dim objImage As Image
34          objImage = Image.FromFile(m_strPath)
35
36          ' print image so it is the rear-most object
37          e.Graphics.DrawImage(Image.FromFile(m_strPath), _
38              sngLeftMargin, sngTopMargin, Me.Width, _
39              Me.Height - 60)
40
41       End If
42
43       ' iterate over the form, printing each control
44       For Each objControl In Me.Controls
45
46          ' we do not want to print Buttons or RadioButtons
47          If objControl.GetType.Name <> "Button" AndAlso _
48              objControl.GetType.Name <> "RadioButton" Then
49             strLine = objControl.Text
50
51             Select Case objControl.Name
52
53                ' underline the date
54                Case "dtpDate"
55                   m_objFont = New Font("Tahoma", 8.25, _
56                      FontStyle.Underline)
57
58                   ' draw a box around amount
59                Case "txtAmount"
60                   e.Graphics.DrawRectangle(Pens.Black, _
61                      txtAmount.Location.X + sngLeftMargin, _
62                      txtAmount.Location.Y + sngTopMargin - 4, _
63                      txtAmount.Width, txtAmount.Height)
64
65                   m_objFont = objControl.Font ' default font
66
67                Case Else
68                   m_objFont = objControl.Font ' default font
69
70             End Select
71
72             ' set string positions relative to page margins
73             sngXPosition = sngLeftMargin + _
74                 objControl.Location.X



Tutorial 26 CheckWriter Application 329

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

75
76             sngYPosition = sngTopMargin + _
77                 objControl.Location.Y
78
79             ' draw text in graphics object
80             e.Graphics.DrawString(strLine, m_objFont, _
81                 Brushes.Black, sngXPosition, sngYPosition)
82
83          End If
84
85       Next ' control
86
87       ' draw box around check
88       e.Graphics.DrawRectangle(Pens.Black, sngLeftMargin, _
89           sngTopMargin, Me.Width, Me.Height - 60)
90
91       ' indicate that there are no more pages to print
92       e.HasMorePages = False
93
94    End Sub ' objPrintDocument_PrintPage
95
96    ' print document
97    Private Sub btnPrint_Click(ByVal sender As _
98       System.Object, ByVal e As System.EventArgs) _
99       Handles btnPrint.Click
100
101       ' create new object to assist in printing
102       Dim objPrintDocument As New PrintDocument
103
104       ' tell PrintDocument where to find PrintPage event handler
105       AddHandler objPrintDocument.PrintPage, _
106          AddressOf objPrintDocument_PrintPage
107
108       ' if no printers installed, display error message
109       If PrinterSettings.InstalledPrinters.Count = 0 Then
110          ErrorMessage()
111          Return ' exit event handler
112       End If
113
114       ' print the document
115       objPrintDocument.Print()
116
117    End Sub ' btnPrint_Click
118
119    ' display document in print preview dialog
120    Private Sub btnPreview_Click(ByVal sender As _
121       System.Object, ByVal e As System.EventArgs) _
122       Handles btnPreview.Click
123
124       ' create new object to assist in previewing
125       Dim objPrintDocument As New PrintDocument
126
127       ' tell PrintDocument where to find PrintPage event handler
128       AddHandler objPrintDocument.PrintPage, _
129           AddressOf objPrintDocument_PrintPage
130
131       ' if no printers installed, display error message
132       If PrinterSettings.InstalledPrinters.Count = 0 Then
133          ErrorMessage()
134          Return ' exit event handler
135       End If
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26.12 (Company Logo Designer Application) Develop a Company Logo application that
allows users to design a company logo (Fig. 26.32). The application should provide the user
with RadioButtons to allow the selection of the next shape to draw. TextBoxes should be
provided to allow the user to enter the dimensions of the shapes.

136
137       objPreview.Document = objPrintDocument ' specify document
138       objPreview.ShowDialog() ' show print preview
139
140    End Sub ' btnPreview_Click
141
142    ' display an error message to the user
143    Sub ErrorMessage()
144
145       MessageBox.Show("No printers installed. You must " & _
146          "have a printer installed to preview or print " & _
147          "the document.", "Print Error", _
148          MessageBoxButtons.OK, MessageBoxIcon.Information)
149
150    End Sub ' ErrorMessage
151
152    ' display selected image in Image control
153    Private Sub radWood_CheckedChanged(ByVal sender As _
154        System.Object, ByVal e As System.EventArgs) _
155        Handles radWood.CheckedChanged
156
157       ' if Wood RadioButton is selected 
158       ' then set m_strPath to wood image
159       If radWood.Checked = True Then
160          m_strPath = "wood.jpg"
161
162          ' otherwise set m_strPath to brick image
163       Else
164          m_strPath = "bricks.jpg"
165       End If
166
167       ' set PictureBox image
168       picPreview.Image = Image.FromFile(m_strPath)
169
170    End Sub ' radWood_CheckedChanged
171
172 End Class ' FrmCheckWriter
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Figure 26.32 Company Logo GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial26\Exercises\CompanyLogo directory to your C:\SimplyVB direc-
tory.

b) Opening the application’s template file. Double click CompanyLogo.sln in the Com-
panyLogo directory to open the application.

c) Defining the Add Button’s Click event handler. Create the Add Button’s Click
event handler. Define the event handler so that the shape that users specify is drawn
on the PictureBox. Use the CreateGraphics method on the PictureBox to retrieve
the Graphics object used to draw on the PictureBox.

d) Defining the Clear Button’s Click event handler. Create the Clear Button’s Click
event handler, and define it so that the PictureBox is cleared. [Hint: To clear the
entire PictureBox, use the PictureBox’s Invalidate method. The Invalidate
method is often used to refresh (update) graphics of a control. By using the Invali-
date method without specifying a graphic to draw, the PictureBox clears.] Also
ensure that all TextBoxes are cleared when the Clear Button is clicked.

e) Running the application. Select Debug > Start to run your application. Use the
RadioButtons and TextBoxes to display at least one of each type of shape. Use dif-
ferent colors for the different shapes. Click the Clear Button to clear the shapes.

f) Closing the application. Close your running application by clicking its close box.

g) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:
.

1 ' Exercise 26.12 Solution
2 ' CompanyLogo.vb
3
4 Public Class FrmLogo
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' adds shapes specified by users to the PictureBox

10    Private Sub btnAdd_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnAdd.Click
12
13       ' create a graphics object to draw shapes
14       Dim objGraphics As Graphics = picImage.CreateGraphics
15
16       ' create brush object used for solid shapes
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17       Dim objBrush As SolidBrush = New SolidBrush( _
18          Color.FromName(Convert.ToString(cboColor.SelectedItem)))
19
20       ' create pen object used for unfilled shapes
21       Dim objPen As Pen = New Pen(objBrush)
22
23       ' create rectangle
24       If radRectangle.Checked = True Then
25
26          ' determine if all values are provided
27          If (txtX1.Text <> "" AndAlso txtY1.Text <> "" AndAlso _
28             txtX2.Text <> "" AndAlso txtY2.Text <> "") Then
29
30             objgraphics.DrawRectangle(objPen, Convert.ToInt32( _
31                txtXPosition.Text), Convert.ToInt32( _
32                txtYPosition.Text), Convert.ToInt32(txtWidth.Text), _
33                Convert.ToInt32(txtHeight.Text))
34          Else
35
36             MessageBox.Show("You did not provide all the setting" & _ 
37                " values", "Missing setting values", _ 
38                MessageBoxButtons.OK, MessageBoxIcon.Information)
39
40          End If
41
42       ElseIf radFilledRectangle.Checked = True Then
43          
44          ' determine if all values are provided
45          If (txtX1.Text <> "" AndAlso txtY1.Text <> "" AndAlso _
46             txtX2.Text <> "" AndAlso txtY2.Text <> "") Then
47
48             ' create filled rectangle
49             objgraphics.FillRectangle(objBrush, Convert.ToInt32( _
50                txtXPosition.Text), Convert.ToInt32( _
51                txtYPosition.Text), Convert.ToInt32(txtWidth.Text), _
52                Convert.ToInt32(txtHeight.Text))
53          Else
54
55             MessageBox.Show("You did not provide all the setting" & _ 
56                " values", "Missing setting values", _ 
57                MessageBoxButtons.OK, MessageBoxIcon.Information)
58
59          End If
60
61       ElseIf radEllipse.Checked = True Then
62          
63          ' determine if all values are provided
64          If (txtX1.Text <> "" AndAlso txtY1.Text <> "" AndAlso _
65             txtX2.Text <> "" AndAlso txtY2.Text <> "") Then
66
67             ' draw ellipse
68             objgraphics.DrawEllipse(objPen, Convert.ToInt32( _
69                txtXPosition.Text), Convert.ToInt32( _
70                txtYPosition.Text), Convert.ToInt32(txtWidth.Text), _
71                Convert.ToInt32(txtHeight.Text))
72          Else
73
74             MessageBox.Show("You did not provide all the setting" & _ 
75                " values", "Missing setting values", _ 
76                MessageBoxButtons.OK, MessageBoxIcon.Information)
77
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78          End If
79
80       ElseIf radFilledEllipse.Checked = True Then
81          
82          ' determine if all values are provided
83          If (txtX1.Text <> "" AndAlso txtY1.Text <> "" AndAlso _
84             txtX2.Text <> "" AndAlso txtY2.Text <> "") Then
85
86             ' create filled ellipse
87             objgraphics.FillEllipse(objBrush, Convert.ToInt32( _
88                txtXPosition.Text), Convert.ToInt32( _
89                txtYPosition.Text), Convert.ToInt32(txtWidth.Text), _
90                Convert.ToInt32(txtHeight.Text))
91          Else
92
93             MessageBox.Show("You did not provide all the setting" & _ 
94                " values", "Missing setting values", _ 
95                MessageBoxButtons.OK, MessageBoxIcon.Information)
96
97          End If
98
99       ElseIf radLine.Checked = True Then
100          
101          ' determine if all values are provided
102          If (txtX1.Text <> "" AndAlso txtY1.Text <> "" AndAlso _
103             txtX2.Text <> "" AndAlso txtY2.Text <> "") Then
104
105          ' draw line
106          objGraphics.DrawLine(objPen, Convert.ToInt32(txtX1.Text), _
107             Convert.ToInt32(txtY1.Text), Convert.ToInt32( _
108             txtX2.Text), Convert.ToInt32(txtY2.Text))
109          Else
110
111             MessageBox.Show("You did not provide all the X and Y" & _ 
112                " values", "Missing X Y values", _ 
113                MessageBoxButtons.OK, MessageBoxIcon.Information)
114
115          End If
116
117       End If
118
119    End Sub ' btnAdd_Click
120
121    ' clear the application GUI
122    Private Sub btnClear_Click(ByVal sender As System.Object, _
123       ByVal e As System.EventArgs) Handles btnClear.Click
124
125       ' clear all fields
126       txtX1.Text = ""
127       txtX2.Text = ""
128       txtY1.Text = ""
129       txtY2.Text = ""
130       txtXPosition.Text = ""
131       txtYPosition.Text = ""
132       txtWidth.Text = ""
133       txtHeight.Text = ""
134
135       ' clear PictureBox
136       picImage.Invalidate()
137
138    End Sub ' btnClear_Click
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26.13 (Letter Head Designer Application) Create a LetterHead application that allows
users to design stationery for company documents (Fig. 26.33). Allow users to specify the
image that will serve as the letterhead.

Figure 26.33 Letter Head GUI. 

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial26\Exercises\LetterHead directory to your C:\SimplyVB direc-
tory. 

b) Opening the application’s template file. Double click LetterHead.sln in the Let-
terHead directory to open the application.

c) Creating a PrintPreviewDialog control. Add a PrintPreviewDialog control to
allow users to preview the letterhead before it is printed.

d) Defining the PrintPage event handler. Allow users to print the document by defin-
ing the PrintPage event handler as you did in the CheckWriter application.

e) Defining the btnPrint_Click event handler. The btnPrint_Click event handler
should tell the PrintDocument where to find the PrintPage event handler, as in the
CheckWriter application, and print the document.

f) Defining the btnPreview_Click event handler. The btnPreview_Click event han-
dler should tell the PrintDocument where to find the PrintPage event handler, as in
the CheckWriter application, and then show the preview dialog.

g) Testing the application. The Letterhead.png image file, located in C:\Exam-
ples\Tutorial26\Exercises\Images has been provided for you to test the appli-
cation’s letter head image capability.

h) Running the application. Select Debug > Start to run your application. Enter your
contact information and specify the location of an image. [Note: An image has been
supplied in an Images directory, located in your C:\Examples\Tutorial26\Exer-
cises directory. The image should be displayed in the PictureBox at the top of the
Form. Click the Preview Button and verify that the image and contact information is
displayed in the preview. Finally, click the Print Button to verify that the letterhead
prints with the appropriate image and contact information.

i) Closing the application. Close your running application by clicking its close box.

j) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

139
140 End Class ' FrmLogo

1 ' Exercise 26.13 Solution
2 ' LetterHead.vb
3
4 Imports System.Drawing.Printing
5
6 Public Class FrmLetterHead

PictureBox displays image

User enters contact
information here
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7    Inherits System.Windows.Forms.Form
8
9    ' create font object

10    Private m_objFont As Font
11
12    ' Windows Form Designer generated code
13
14    ' PrintPage event raised for each page to be printed.
15    Private Sub objPrintDocument_PrintPage(ByVal sender _
16       As Object, ByVal e As PrintPageEventArgs)
17
18       Dim sngYPosition As Single
19       Dim sngXPosition As Single
20
21       Dim sngLeftMargin As Single = e.MarginBounds.Left
22       Dim sngTopMargin As Single = e.MarginBounds.Top
23
24       Dim strPath As String
25
26       ' get location of image
27       strPath = txtImage.Text
28
29       ' make sure image location was provided
30       If strPath <> "" Then
31          Dim objImage As Image
32          objImage = Image.FromFile(strPath)
33
34          ' print image so it is on top of page
35          e.Graphics.DrawImage(Image.FromFile(strPath), _
36             sngLeftMargin + picImage.Location.X, _
37             sngTopMargin + picImage.Location.Y, _
38             picImage.Size.Width, picImage.Size.Height)
39
40       End If
41
42       ' if contact information is provided, print data
43       If txtInformation.Text <> "" Then
44
45          ' specifies font of text
46          m_objFont = New Font("Tahoma", 12, _
47             FontStyle.Bold)
48
49          sngXPosition = sngLeftMargin + _
50             txtInformation.Location.X
51
52          sngYPosition = sngTopMargin + _
53             txtInformation.Location.Y
54
55          ' print information
56          e.Graphics.DrawString(txtInformation.Text, m_objFont, _
57             Brushes.Black, sngXPosition, sngYPosition)
58       End If
59
60       ' indicate there are no more pages to print
61       e.HasMorePages = False
62
63    End Sub ' objPrintDocument_PrintPage
64
65    ' print the document
66    Private Sub btnPrint_Click(ByVal sender As _
67       System.Object, ByVal e As System.EventArgs) _
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What does this code do? 26.14 What is the result of the following code? Assume that objOutput_PrintPage is
defined.

68       Handles btnPrint.Click
69
70       ' create new object to assist in printing
71       Dim objPrintDocument As New PrintDocument
72
73       ' tell printer where to find PrintPage event handler
74       AddHandler objPrintDocument.PrintPage, _
75          AddressOf objPrintDocument_PrintPage
76
77       ' print the document
78       objPrintDocument.Print()
79
80    End Sub ' btnPrint_Click
81
82    ' display document in print preview dialog
83    Private Sub btnPreview_Click(ByVal sender As _
84       System.Object, ByVal e As System.EventArgs) _
85       Handles btnPreview.Click
86
87       Dim objPrintDocument As PrintDocument = _
88          New PrintDocument
89
90       AddHandler objPrintDocument.PrintPage, _
91          AddressOf objPrintDocument_PrintPage
92
93       objPreview.Document = objPrintDocument
94       objPreview.ShowDialog()
95
96    End Sub ' btnPreview_Click
97
98    ' add the specified image to the Image control
99    Private Sub btnAdd_Click(ByVal sender As System.Object, _
100       ByVal e As System.EventArgs) Handles btnAdd.Click
101
102       ' import the image specified
103       If txtImage.Text <> "" Then
104
105          picImage.Image = Image.FromFile(txtImage.Text)
106
107       Else
108
109          MessageBox.Show("You must enter a path for your image.", _
110             "Input Error", MessageBoxButtons.OK, _
111             MessageBoxIcon.Information)
112
113       EndIf
114
115    End Sub ' btnAdd_Click
116
117 End Class ' FrmLetterHead

▲

1 Private Sub btnPrint_Click(ByVal sender As System.Object, _
2    ByVal e As System.EventArgs) Handles btnPrint.Click
3   
4    Dim objOutput As New PrintDocument
5    
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Answer: The code indicates that the PrintPage event for objOutput should invoke the 
objOutput_PrintPage event handler.

What’s wrong with this code? 26.15 Find the error(s) in the following code. This is the definition for a Click event handler
for a Button. This event handler should draw a rectangle on a PictureBox control.

Answer: When specifying a color for the SolidBrush you must precede the color name with 
“Color.” You cannot just write the color name. Also, to retrieve the Graphics object, the 
CreateGraphics method must be used, not AcquireGraphics. The corrected code is shown 
below.

Programming Challenge 26.16  (Screen Saver Simulator Application) Develop an application that simulates a
screen saver. This application should add random-colored, random-sized, solid and hollow
shapes at different positions of the screen (Fig. 26.34). Copy the C:\Exer-
cises\Tutorial26\ScreenSaver directory, and place it in your C:\SimplyVB directory.
The design of the Form has been created, which consists of a black Form and a Timer control.
In the ScreenSaver.vb code view, the DisplayShape method has been provided and the
Timer’s tick event handler has already been defined for you. 

You must write the rest of the DisplayShape method code. Create the Graphics object
from the Form using the Form’s CreateGraphics method, and specify random colors, sizes
and positions for the filled and hollow shapes that will be displayed on the screen. The width
and height of the shapes should be no larger than 100 pixels.

6    AddHandler objOutput.PrintPage, _
7       AddressOf objOutput_PrintPage
8
9    objPrintOutput.Print()

10
11 End Sub ' btnPrint_Click

▲

1 Private Sub btnDrawImage_Click(ByVal sender As System.Object, _
2    ByVal e As System.EventArgs) Handles btnDrawImage.Click
3
4    ' create an orange colored brush
5    Dim objBrush As SolidBrush = New SolidBrush(Orange)
6
7    ' create a Graphics object to draw on the PictureBox
8    Dim objGraphics As Graphics = picPictureBox.AcquireGraphics
9  

10    ' draw a filled rectangle
11    objGraphics.FillRectangle(objBrush, 2, 3, 40, 30)
12
13 End Sub ' btnDrawImage_Click

1 Private Sub btnDrawImage_Click(ByVal sender As System.Object, _
2    ByVal e As System.EventArgs) Handles btnDrawImage.Click
3
4    ' create an orange colored brush
5    Dim objBrush As SolidBrush = New SolidBrush( )
6
7    ' create a Graphics object to draw on the PictureBox
8    Dim objGraphics As Graphics = 
9  

10    ' draw a filled rectangle
11    objGraphics.FillRectangle(objBrush, 2, 3, 40, 30)
12
13 End Sub ' btnDrawImage_Click

Color.Orange

picPictureBox.CreateGraphics

▲
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Figure 26.34 Screen Saver running.

Answer:

1 ' Exercise 26.16 Solution
2 ' ScreenSaver.vb
3
4 Public Class FrmShapeChanger
5    Inherits System.Windows.Forms.Form
6
7    Private m_dblCount As Double = 0.0
8
9    ' Windows Form Designer generated code

10
11    ' create a specified graphic on the form
12    Private Sub DisplayShape()
13
14       ' create a Graphics object
15       Dim objGraphicsObject As Graphics = Me.CreateGraphics
16
17       ' create random object for random number generation
18       Dim objRandom As Random = New Random
19
20       ' create random color
21       Dim objColor As Color = Color.FromArgb( _
22          objRandom.Next(0, 255), objRandom.Next(0, 255), _
23          objRandom.Next(0, 255))
24
25       ' create brush object used for solid shapes
26       Dim objBrush As SolidBrush = New SolidBrush( _
27           objColor)
28
29       ' create pen object used for unfilled shapes
30       Dim objPen As Pen = New Pen(objBrush)
31
32       ' create random number used to create random shape
33       Dim intShape As Integer = objRandom.Next(0, 5)
34
35       ' set to width of form
36       Dim intWidth As Integer = Me.Size.Width
37
38       ' set to height of form
39       Dim intHeight As Integer = Me.Size.Height
40
41       ' decide which shape to draw
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42       Select Case intShape
43          Case 0
44
45             ' create filled rectangle
46             objGraphicsObject.FillRectangle(objBrush, _
47                objRandom.Next(0, Width), _
48                objRandom.Next(0, Height), _
49                objRandom.Next(10, 100), _
50                objRandom.Next(10, 100))
51
52          Case 1
53
54             ' create filled ellipse
55             objGraphicsObject.FillEllipse(objBrush, _
56                objRandom.Next(0, Width), _
57                objRandom.Next(0, Height), _
58                objRandom.Next(10, 100), _
59                objRandom.Next(10, 100))
60
61          Case 2
62
63             ' draw ellipse
64             objGraphicsObject.DrawEllipse(objPen, _
65                objRandom.Next(0, Width), _
66                objRandom.Next(0, Height), _
67                objRandom.Next(10, 100), _
68                objRandom.Next(10, 100))
69
70          Case 3
71
72             ' draw rectangle
73             objGraphicsObject.DrawRectangle(objPen, _
74                objRandom.Next(0, Width), _
75                objRandom.Next(0, Height), _
76                objRandom.Next(10, 100), _
77                objRandom.Next(10, 100))
78
79          Case 4
80
81             ' draw line
82             objGraphicsObject.DrawLine(objPen, _
83                objRandom.Next(0, Width), _
84                objRandom.Next(0, Height), _
85                objRandom.Next(10, Width), _
86                objRandom.Next(10, Height))
87       End Select
88
89    End Sub ' DisplayShape
90
91    ' invoked each time tmrScreenSaver ticks
92    Private Sub tmrScreenSaver_Tick(ByVal sender As System.Object, _
93       ByVal e As System.EventArgs) Handles tmrScreenSaver.Tick
94
95       m_dblCount += 0.25
96
97       ' draw shape every half second 
98       If m_dblCount Mod 2.5 = 0 Then
99          DisplayShape() ' draw another shape 
100       End If
101
102    End Sub ' tmrScreenSaver_Tick



340 CheckWriter Application Tutorial 26

© Copyright 1992-2004 by Deitel & Associates, Inc. and Pearson Education Inc. All Rights Reserved.

26.17 (Screen Saver Simulator Enhancement Application) Enhance the Screen Saver
Simulator application from Exercise 26.16 by modifying the Timer control’s Tick event han-
dler. Add code to this event handler so that after a specified amount of time, the screen
should clear the displayed shapes. After the screen clears, random shapes should continue to
display. Also, modify the code so that you can specify random opacity (alpha values) for the
colors by using Color structure’s FromArgb method. You should pass four arguments to this
method. The first argument is the alpha value, the second is the red value, the third is the
green value and the fourth is the blue value. 

Answer:

103
104 End Class ' FrmShapeChanger

1 ' Exercise 26.17 Solution
2 ' ScreenSaver.vb
3
4 Public Class FrmShapeChanger
5    Inherits System.Windows.Forms.Form
6
7    Private m_dblCount As Double = 0.0
8
9    ' Windows Form Designer generated code

10
11    ' create a specified graphic on the form
12    Private Sub DisplayShape()
13
14       ' create a Graphics object
15       Dim objGraphicsObject As Graphics = Me.CreateGraphics
16
17       ' create random object for random number generation
18       Dim objRandom As Random = New Random
19
20       ' create random color with random opacity
21       Dim objColor As Color = Color.FromArgb( _ 
22          objRandom.Next(0, 255), objRandom.Next(0, 255), _  
23          objRandom.Next(0, 255), objRandom.Next(0, 255))
24
25       ' create brush object used for solid shapes
26       Dim objBrush As SolidBrush = New SolidBrush(objColor)
27
28       ' create pen object used for unfilled shapes
29       Dim objPen As Pen = New Pen(objBrush)
30
31       ' create random number used to create random shape
32       Dim intShape As Integer = objRandom.Next(0, 5)
33
34       ' set to width of form
35       Dim intWidth As Integer = Me.Size.Width
36
37       ' set to height of form
38       Dim intHeight As Integer = Me.Size.Height
39
40       ' decide which shape to draw
41       Select Case intShape
42          Case 0
43
44             ' create filled rectangle
45             objGraphicsObject.FillRectangle(objBrush, _
46                objRandom.Next(0, Width), _
47                objRandom.Next(0, Height), _
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48                objRandom.Next(10, 100), _
49                objRandom.Next(10, 100))
50
51          Case 1
52
53             ' create filled ellipse
54             objGraphicsObject.FillEllipse(objBrush, _
55                objRandom.Next(0, Width), _
56                objRandom.Next(0, Height), _
57                objRandom.Next(10, 100), _
58                objRandom.Next(10, 100))
59
60          Case 2
61
62             ' draw ellipse
63             objGraphicsObject.DrawEllipse(objPen, _
64                objRandom.Next(0, Width), _
65                objRandom.Next(0, Height), _
66                objRandom.Next(10, 100), _
67                objRandom.Next(10, 100))
68
69          Case 3
70
71             ' draw rectangle
72             objGraphicsObject.DrawRectangle(objPen, _
73                objRandom.Next(0, Width), _
74                objRandom.Next(0, Height), _
75                objRandom.Next(10, 100), _
76                objRandom.Next(10, 100))
77
78          Case 4
79
80             ' draw line
81             objGraphicsObject.DrawLine(objPen, _
82                objRandom.Next(0, Width), _
83                objRandom.Next(0, Height), _
84                objRandom.Next(10, Width), _
85                objRandom.Next(10, Height))
86       End Select
87
88    End Sub ' DisplayShape
89
90    ' invoked each time tmrScreenSaver ticks
91    Private Sub tmrScreenSaver_Tick(ByVal sender As System.Object, _
92       ByVal e As System.EventArgs) Handles tmrScreenSaver.Tick
93
94       m_dblCount += 0.25
95
96       ' draw shape every half second 
97       If m_dblCount Mod 2.5 = 0 Then
98          DisplayShape() ' draw another shape 
99       End If
100
101       If m_dblCount Mod 200 = 0 Then
102          Me.Invalidate() ' clear screen
103       End If
104
105    End Sub ' tmrScreenSaver_Tick
106
107 End Class ' FrmShapeChanger
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Instructor’s Manual
Exercise Solutions

Tutorial 27

MULTIPLE-CHOICE
QUESTIONS

27.1 The  method is used to specify what the Microsoft Agent will say.

27.2 The  method is used to activate a Microsoft Agent character’s animation.

27.3 Method MoveTo takes two arguments. What do these arguments represent?

27.4 Which method of IAgentCtlCharacter displays the Microsoft Agent character on the
screen?

27.5 Use the  event handler to execute code when users click Hide the Agent
character context menu.

27.6 The Add method of the Commands property .

27.7 The  event handler controls what occurs when users speak to the Agent.

27.8  specifies the x-coordinate of the mouse cursor on the screen.

27.9 Specifying  as a parameter to Peedy’s Play method causes him to smile.

27.10 Specifying  as a parameter to Peedy’s Play method causes him to rest.

Answers: 27.1) a.  27.2) b.  27.3) c.  27.4) b.  27.5) b.  27.6) a.  27.7) a.  27.8) b.  27.9) c.  27.10) a.

a) Speak b) Say 
c) Command d) Voice 

a) Show b) Play 
c) Speak d) Appear 

a) The direction in which the Agent should move (left, right, up, down).
b) The name of the character and its position.
c) The x-coordinate and y-coordinate of the location to which the Agent object should 

move.
d) The name of the character and the direction of movement.

a) Play b) Show 
c) Speak d) Appear 

a) Hide b) HideEvent 
c) Command d) Disappear 

a) adds a new command to the command list.
b) joins two commands together.
c) displays the Commands pop-up window.
d) both a and c

a) Command b) ClickEvent

c) Click d) SelectedIndexChanged

a) Cursor.Location.X b) Cursor.Position.X 
c) Mouse.Location.X d) Mouse.Position.X 

a) "Think" b) "Smile" 
c) "Pleased" d) "Happy" 

a) "RestPose" b) "Rest" 
c) "Think" d) "Pose" 
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EXERCISES 27.11 (Appointment Book Application Using Microsoft Agent) Write an application that
allows users to add appointments to an appointment book that uses Microsoft Agent. When
users speak a person’s name, Merlin returns the time and date of the appointment that users
have with that person. If users say “Today”, Merlin returns a list of the users’ appointments
for the day.

Figure 27.32 Appointment Book GUI.

a) Copying the template to your working directory. Copy the directory C:\Exam-
ples\Tutorial27\Exercises\AppointmentBook to your C:\SimplyVB directory.

b) Opening the application’s template file. Double click AppointmentBook.sln in the
AppointmentBook directory to open the application.

c) Downloading the Merlin Microsoft Agent. Download the Merlin.acs character file
from the Microsoft Web site.

d) Adding the Agent Control to the Form. Add the Microsoft Agent control to the Form.

e) Creating module-level variables. Create three module-level variables of type Array-
List to store the date, time and person with which the user has an appointment. Cre-
ate a module-level variable of type AgentObjects.IAgentCtlCharacter (as you did
in the Phone Book application).

f) Defining the FrmAppointments_Load event handler. Load Merlin’s character file,
display him on the screen and add the “Today” command to the command list. 

g) Defining the btnAdd_Click event handler. Define this event handler so that the
information provided by the user is added to its corresponding ArrayList. The
Appointment With: TextBox input should be added to the ArrayList containing the
names of people with whom the user has an appointment. The input for the appoint-
ment date and time should also be added to their respective ArrayLists. Display an
error message if the user leaves the Appointment With: or the Appointment Time:
TextBox empty.

h) Adding voice-enabled commands. Within the btnAdd_Click event handler, add a
voice-enabled command that allows a user to speak the name of the person with
whom the user has an appointment to the command list. This allows a user to check
for whether there is an appointment with someone by speaking the person’s name.
The command should also appear in the Commands context menu.

i) Defining the Agent’s Command event handler. As you did in the Phone Book applica-
tion, define what occurs when a user speaks or selects a command. If the user speci-
fies the Today command, Merlin should tell the user the names of all the people with
whom the user has an appointment today. If the user specifies a specific name, Merlin
should state the time and date at which the user has an appointment with this person.
If the user did not schedule any appointments, then Merlin should inform the user
that no appointments were scheduled.

j) Running the application. Select Debug > Start to run your application. Enter vari-
ous appointments, where at least two of the appointments are scheduled for the cur-
rent day. Input the name of the person you are meeting at one of the appointments by
either speaking the name into your microphone, or right-clicking the agent and
selecting that person’s name. Verify that the agent repeats back correct information
about that appointment. Input the value “Today” by either speaking it into the
microphone or right-clicking the agent and selecting Today. Verify that the agent
repeats back all the appointments for the current day.

k) Closing the application. Close your running application by clicking its close box.
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l) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 27.11 Solution
2 ' AppointmentBook.vb
3
4 Public Class FrmAppointments
5    Inherits System.Windows.Forms.Form
6
7    ' create three Arraylists
8    Private m_objPerson As ArrayList = New ArrayList
9    Private m_objDate As ArrayList = New ArrayList

10    Private m_objTime As ArrayList = New ArrayList
11
12    ' represent current Agent
13    Private m_objMSpeaker As AgentObjects.IAgentCtlCharacter
14
15    ' Windows Form Designer generated code
16
17    ' invoked when Form is loaded
18    Private Sub FrmAppointments_Load(ByVal sender As _
19       System.Object, ByVal e As System.EventArgs) _
20       Handles MyBase.Load
21
22       ' load agent character file
23       objMainAgent.Characters.Load("Merlin", "Merlin.acs")
24
25       ' specify current agent
26       m_objMSpeaker = objMainAgent.Characters("Merlin")
27
28       ' show Merlin on screen
29       m_objMSpeaker.Show(0)
30
31       ' add voice enabled command to Agent object
32       m_objMSpeaker.Commands.Add("Today", "Today", _
33           "Today", True, True)
34    End Sub 'FrmAppointments_Load
35
36    ' add appointments to ArrayLists
37    Private Sub btnAdd_Click(ByVal sender As System.Object, _
38       ByVal e As System.EventArgs) Handles btnAdd.Click
39
40       If txtWith.Text = "" OrElse txtTime.Text = "" Then
41
42          MessageBox.Show( _
43             "You left one or more fields empty above", _
44             "Empty Field", MessageBoxButtons.OK, _
45             MessageBoxIcon.Error)
46       Else
47          ' add information to ArrayLists
48          m_objPerson.Add(txtWith.Text)
49          m_objDate.Add(dtpAddDate.Value.ToLongDateString)
50          m_objTime.Add(txtTime.Text)
51
52          m_objMSpeaker.Commands.Add(txtWith.Text, _
53             txtWith.Text, txtWith.Text, True, True)
54
55          ' clear TextBoxes
56          txtWith.Clear()
57          txtTime.Clear()
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58       End If
59
60    End Sub ' btnAdd_Click
61
62    ' determine what Agent does when it hears command
63    Private Sub objMainAgent_Command(ByVal sender As Object, _
64       ByVal e As AxAgentObjects._AgentEvents_CommandEvent) _
65       Handles objMainAgent.Command
66
67       ' get UserInput object
68       Dim objCommand As AgentObjects.IAgentCtlUserInput = _
69           CType(e.userInput, AgentObjects.IAgentCtlUserInput)
70
71       Dim intCount As Integer
72
73       ' boolean to determine if user has appointments
74       Dim blnAppointments As Boolean = False
75       Dim strAppointments As String = _
76          "Today you have an appointment with:"
77
78       ' determine if user spoke Today command
79       If objCommand.Name = "Today" Then
80
81          ' search objDate arraylist for appointments
82          ' set for today
83          For intCount = 0 To m_objDate.Count - 1
84
85             If Convert.ToString(m_objDate(intCount)) = _
86                Today.Date.ToLongDateString Then
87
88                ' add the appointment to string Agent speaks
89                strAppointments = strAppointments & _
90                    Convert.ToString(m_objPerson(intCount)) _
91                    & " at " & _
92                    Convert.ToString(m_objTime(intCount)) _
93                    & ", "
94
95                blnAppointments = True
96             End If
97
98          Next
99
100       Else
101          ' specify string Agent speaks
102          strAppointments = "You have to " & _
103              "meet with " & _
104              Convert.ToString(objCommand.Name) & _
105              " on: "
106
107          ' determine if user made command using 
108          ' person's name
109          For intCount = 0 To m_objPerson.Count - 1
110
111             If objCommand.Name = _
112                Convert.ToString(m_objPerson(intCount)) Then
113
114                ' add date and time to string Agent speaks
115                strAppointments = strAppointments & _
116                    Convert.ToString(m_objDate(intCount)) _
117                    & " at " & _
118                    Convert.ToString(m_objTime(intCount)) _
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27.12 (Craps Game Application Using Microsoft Agent) Modify the Craps Game applica-
tion from Tutorial 16 to include a Microsoft Agent character.

Figure 27.33 Modified Craps Game GUI.

a) Copying the template to your working directory. Copy the directory C:\Exam-
ples\Tutorial27\Exercises\CrapsGameEnhancement to your C:\SimplyVB
directory.

b) Opening the application’s template file. Double click CrapsGame.sln in the Craps-
GameEnhancement directory to open the application.

c) Downloading the Genie Microsoft Agent. Download the Genie.acs character file
from the Microsoft Web site.

d) Adding the Agent control to the Form. Add the Microsoft Agent control to the Form.

e) Creating a module-level variable. Create a module-level variable of type AgentOb-
jects.IAgentCtlCharacter (as you did in the Phone Book application).

f) Defining the FrmCrapsGame_Load event handler. Load Genie’s character file, and
display him on the screen. 

g) Modifying the btnPlay_Click event handler. Add code to the btnPlay_Click
event handler to control the Agent. When the user wins the game, Genie should play
his Pleased animation and congratulate the user. If the user loses, Genie should play
his Confused animation and say that the user lost. If the user neither wins nor loses,
Genie should tell the user to roll again. Make sure to reset him to his RestPose after
he plays any animation.

h) Defining the btnRoll_Click event handler. Add code to the btnRoll_Click event
handler to control the Agent. If users “make their point,” Genie should play his
Pleased animation and state that the user won. If the user rolls a 7, Genie should

119                    & ", "
120
121                blnAppointments = True
122             End If
123
124          Next
125
126       End If
127
128       ' if user has no appointments, specify in strAppointments
129       If blnAppointments = False Then
130          strAppointments = "You have no scheduled " _
131             & "appointments."
132       End If
133
134       ' Agent speaks strAppointments string
135       m_objMSpeaker.Speak(strAppointments)
136    End Sub ' objMainAgent_Command
137
138 End Class ' FrmAppointments
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play his Confused animation and say that the user lost. Otherwise, Genie should tell
the user to roll again.

i) Defining the btnInstructions_Click event handler. Define the
btnInstructions_Click event handler to make Genie introduce himself to the
user. Genie should then explain the rules to the game of craps.

j) Running the application. Select Debug > Start to run your application. Click the
Instructions Button and allow the agent character to tell you the rules of the game.
Use the Play and Roll Buttons to play a few games of craps. When you need to roll
again, verify that the agent tells you to roll again. Also, verify that the agents informs
you whether you won or lost at the end of each game.

k) Closing the application. Close your running application by clicking its close box.

l) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 27.12 Solution
2 ' CrapsGame.vb
3
4 Imports System.IO
5
6 Public Class FrmCrapsGame
7    Inherits System.Windows.Forms.Form
8
9    ' die-roll constants

10    Enum DiceNames
11       SNAKE_EYES = 2
12       TREY = 3
13       CRAPS = 7
14       LUCKY_SEVEN = 7
15       YO_LEVEN = 11
16       BOX_CARS = 12
17    End Enum
18
19    ' filename and directory constants
20    Const m_strFILE_PREFIX As String = "/images/die"
21    Const m_strFILE_SUFFIX As String = ".png"
22
23    ' instance variables
24    Private m_intMyPoint As Integer = 0
25    Private m_objRandom As Random = New Random
26
27    ' create object that represents current agent
28    Private m_objMSpeaker As AgentObjects.IAgentCtlCharacter
29
30    ' Windows Form Designer generated code 
31
32    ' begin new game and determine point
33    Private Sub btnPlay_Click(ByVal sender As System.Object, _
34         ByVal e As System.EventArgs) Handles btnPlay.Click
35
36       ' initialize variables for new game
37       m_intMyPoint = 0
38       fraPointDiceGroup.Text = "Point"
39       lblStatus.Text = ""
40
41       ' remove point-die images
42       picPointDie1.Image = Nothing
43       picPointDie2.Image = Nothing
44
45       Dim intSum As Integer = RollDice() ' roll dice
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46
47       ' check die roll
48       Select Case intSum
49
50          Case DiceNames.LUCKY_SEVEN, _
51             DiceNames.YO_LEVEN ' win on first roll
52
53             btnRoll.Enabled = False ' disable roll button
54             lblStatus.Text = "You win!!!"
55
56             ' play Agent's Pleased animation
57             m_objMSpeaker.Play("Pleased")
58
59             ' make Agent speak
60             m_objMSpeaker.Speak("Congratulations, you won!")
61
62             m_objMSpeaker.Play("RestPose")
63
64          Case DiceNames.SNAKE_EYES, _
65             DiceNames.TREY, _
66             DiceNames.BOX_CARS ' lose on first roll
67
68             btnRoll.Enabled = False
69             lblStatus.Text = "Sorry. You lose."
70
71             ' play Agent's Confused animation
72             m_objMSpeaker.Play("Confused")
73
74             ' make Agent speak
75             m_objMSpeaker.Speak("Sorry, you lost!")
76
77             m_objMSpeaker.Play("RestPose")
78
79          Case Else ' player must match point
80             m_intMyPoint = intSum
81             fraPointDiceGroup.Text = "Point is " & intSum
82             lblStatus.Text = "Roll Again!"
83             m_objMSpeaker.Speak("Please roll again.")
84             picPointDie1.Image = picDie1.Image
85             picPointDie2.Image = picDie2.Image
86             DisplayDie(picPointDie2, m_intMyDie2)
87             btnPlay.Enabled = False ' disable Play Button
88             btnRoll.Enabled = True  ' enable Roll Button
89       End Select
90
91    End Sub ' btnPlay_Click
92
93    ' determine outcome of next roll
94    Private Sub btnRoll_Click(ByVal sender As System.Object, _
95        ByVal e As System.EventArgs) Handles btnRoll.Click
96
97       Dim intSum As Integer = RollDice()
98
99       ' determine outcome of roll
100       If intSum = m_intMyPoint Then  ' player matches point
101          lblStatus.Text = "You win!!!"
102          m_objMSpeaker.Play("Pleased")
103          m_objMSpeaker.Speak("Congratulations, you won!")
104          m_objMSpeaker.Play("RestPose")
105
106          btnRoll.Enabled = False
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107          btnPlay.Enabled = True
108       ElseIf intSum = DiceNames.CRAPS Then ' player loses
109          lblStatus.Text = "Sorry. You lose."
110          m_objMSpeaker.Play("Confused")
111          m_objMSpeaker.Speak("Sorry, you lost!")
112          m_objMSpeaker.Play("RestPose")
113
114          btnRoll.Enabled = False
115          btnPlay.Enabled = True
116
117       Else
118          m_objMSpeaker.Speak("Please roll again.")
119       End If
120
121    End Sub ' btnRoll_Click
122
123    ' generate random die rolls
124    Private Function RollDice() As Integer
125
126       ' roll the dice
127       Dim intDie1 As Integer = m_objRandom.Next(1, 7)
128       Dim intDie2 As Integer = m_objRandom.Next(1, 7)
129
130       ' display image corresponding to each die
131       DisplayDie(picDie1, intDie1)
132       DisplayDie(picDie2, intDie2)
133
134       Return (intDie1 + intDie2) ' return sum of dice values
135
136    End Function ' RollDice
137
138    ' display die image
139    Private Sub DisplayDie(ByVal picDie As PictureBox, _
140       ByVal intFace As Integer)
141
142       ' assign die images to PictureBoxes
143       picDie.Image = _
144          Image.FromFile(Directory.GetCurrentDirectory & _
145          m_strFILE_PREFIX & intFace & m_strFILE_SUFFIX)
146
147    End Sub ' DisplayDie
148
149    ' invoked when Form is loaded
150    Private Sub FrmCrapsGame_Load(ByVal sender As System.Object, _
151       ByVal e As System.EventArgs) Handles MyBase.Load
152
153       ' load Genie character file
154       objMainAgent.Characters.Load("Genie", "Genie.acs")
155
156       m_objMSpeaker = objMainAgent.Characters("Genie")
157
158       ' show Genie on the screen
159       m_objMSpeaker.Show(0)
160    End Sub ' FrmCrapsGame_Load
161
162    ' Agent explains instructions of the game
163    Private Sub btnInstructions_Click(ByVal sender As System.Object, _
164       ByVal e As System.EventArgs) Handles btnInstructions.Click
165
166       m_objMSpeaker.Play("Wave")
167
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27.13 (Security Panel Application Using Microsoft Agent) Modify the Security Panel
application from Tutorial 12 to include Microsoft Agent.

Figure 27.34 Robby from modified Security Panel application.

a) Copying the template to your working directory. Copy the directory C:\Exam-
ples\Tutorial27\Exercises\SecurityPanelEnhancement to your C:\SimplyVB
directory.

b) Opening the application’s template file. Double click SecurityPanel.sln in the
SecurityPanelEnhancement directory to open the application.

c) Downloading the Robby Microsoft Agent. Download the Robby.acs character file
from the Microsoft Web site.

d) Adding the Agent control to the Form. Add the Microsoft Agent control to the Form.

168       m_objMSpeaker.Speak("Hello. I am Genie. Let me " & _
169           "explain how to play the game of craps.")
170
171       m_objMSpeaker.Speak("Click the Play button to begin " & _
172           "the game.")
173
174       m_objMSpeaker.Speak("Clicking Play causes you to roll" _
175           & " two dice.")
176
177       m_objMSpeaker.Speak("If the sum of your dice roll is " _
178           & "7 or 11 on your first throw, then you win.")
179
180       m_objMSpeaker.Speak("However, if the sum is 2, 3, or " _
181         & "12 on your first throw, then you lose.")
182
183       m_objMSpeaker.Speak("If the sum is 4, 5, 6, 7, 8, 9 " _
184           & "or 10 on your first throw, then that sum " _
185           & "becomes your 'point'")
186
187       m_objMSpeaker.Speak("To win, you must continue rolling" _
188           & " the dice until you roll the point value again.")
189
190       m_objMSpeaker.Speak("You lose if you roll a 7 before " _
191           & "reaching your point value.")
192
193       m_objMSpeaker.Play("RestPose")
194    End Sub ' btnInstructions_Click
195
196 End Class ' FrmCrapsGame
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e) Creating a module-level variable. Create a module-level variable of type AgentOb-
jects.IAgentCtlCharacter (as you did in the Phone Book application).

f) Defining the FrmSecurityPanel_Load event handler. Load Robby’s character file,
and display him on the screen. Command Robby to tell users to input their access
codes.

g) Modifying the btnEnter_Click event handler. Add code to the btnEnter_Click
event handler to use the Microsoft Agent. If the user enters a valid access code,
Robby should welcome the user and state the type of employee that the access code
represents. If the access code is invalid, then Robby should state that an invalid code
was provided and that access is denied.

h) Running the application. Select Debug > Start to run your application. Enter vari-
ous access codes. For correct access codes, verify that the agent tells you what type of
employee the access code represents. For incorrect access codes, verify that the
agents tells you that access is denied.

i) Closing the application. Close your running application by clicking its close box.

j) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 27.13 Solution
2 ' SecurityPanel.vb
3
4 Public Class FrmSecurityPanel
5    Inherits System.Windows.Forms.Form
6
7    Private m_objMSpeaker As AgentObjects.IAgentCtlCharacter
8
9    ' Windows Form Designer generated code

10
11    Private Sub btnEnter_Click(ByVal sender As System.Object, _
12      ByVal e As System.EventArgs) Handles btnEnter.Click
13
14       Dim intAccessCode As Integer ' stores access code entered
15       Dim strMessage As String  ' displays access status of users
16
17       intAccessCode = Convert.ToInt32(txtSecurityCode.Text)
18       txtSecurityCode.Clear()
19
20       Select Case intAccessCode ' check access code input
21
22          ' access code less than 10
23          Case Is < 10
24             strMessage = "Restricted Access"
25             m_objMSpeaker.Speak("Welcome. You have " _
26                 & "restricted access.")
27
28          ' access code between 1645 and 1689
29          Case 1645 To 1689
30             strMessage = "Technicians"
31             m_objMSpeaker.Speak("Welcome. Your access" _
32                 & " code indicates that you are " _
33                 & "part of the Technician Personnel.")
34
35          ' access code equal to 8345
36          Case 8345
37             strMessage = "Custodians"
38             m_objMSpeaker.Speak("Welcome. Your access" _
39                 & " code indicates that you are " _
40                 & "part of Custodial Services.")
41
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42          ' access code equal to 9998 or between
43          ' 1006 and 1008
44          Case 9998, 1006 To 1008
45             strMessage = "Scientists"
46             m_objMSpeaker.Speak("Welcome. Your access" _
47                 & " code indicates that you are " _
48                 & "part of the Scientific Personnel.")
49
50          ' if no other Case is True
51          Case Else
52             strMessage = "Access Denied"
53             m_objMSpeaker.Speak("Sorry, you did not " _
54                 & "provide a correct access code." _
55                 & " Access is denied.")
56
57       End Select
58
59       ' display time and message in ListBox
60       lstLogEntry.Items.Add(Date.Now & "   " & strMessage)
61    End Sub ' btnEnter_Click
62
63    Private Sub btnZero_Click(ByVal sender As System.Object, _
64       ByVal e As System.EventArgs) Handles btnZero.Click
65
66       txtSecurityCode.Text &= "0"  ' concatenate "0" to display
67    End Sub ' btnZero_Click
68
69    Private Sub btnOne_Click(ByVal sender As System.Object, _
70       ByVal e As System.EventArgs) Handles btnOne.Click
71
72       txtSecurityCode.Text &= "1"  ' concatenate "1" to display
73    End Sub ' btnOne_Click
74
75    Private Sub btnTwo_Click(ByVal sender As System.Object, _
76       ByVal e As System.EventArgs) Handles btnTwo.Click
77
78       txtSecurityCode.Text &= "2"  ' concatenate "2" to display
79    End Sub ' btnTwo_Click
80
81    Private Sub btnThree_Click(ByVal sender As System.Object, _
82       ByVal e As System.EventArgs) Handles btnThree.Click
83
84       txtSecurityCode.Text &= "3"  ' concatenate "3" to display
85    End Sub ' btnThree_Click
86
87    Private Sub btnFour_Click(ByVal sender As System.Object, _
88       ByVal e As System.EventArgs) Handles btnFour.Click
89
90       txtSecurityCode.Text &= "4"  ' concatenate "4" to display
91    End Sub ' btnFour_Click
92
93    Private Sub btnFive_Click(ByVal sender As System.Object, _
94       ByVal e As System.EventArgs) Handles btnFive.Click
95
96       txtSecurityCode.Text &= "5"  ' concatenate "5" to display
97    End Sub ' btnFive_Click
98
99    Private Sub btnSix_Click(ByVal sender As System.Object, _
100       ByVal e As System.EventArgs) Handles btnSix.Click
101
102       txtSecurityCode.Text &= "6"  ' concatenate "6" to display
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What does this code do? 27.14 After the user clicks the Call Button, what does the following event handler do?
   

103    End Sub ' btnSix_Click
104
105    Private Sub btnSeven_Click(ByVal sender As System.Object, _
106       ByVal e As System.EventArgs) Handles btnSeven.Click
107
108       txtSecurityCode.Text &= "7"  ' concatenate "7" to display
109    End Sub ' btnSeven_Click
110
111    Private Sub btnEight_Click(ByVal sender As System.Object, _
112       ByVal e As System.EventArgs) Handles btnEight.Click
113
114       txtSecurityCode.Text &= "8"  ' concatenate "8" to display
115    End Sub ' btnEight_Click
116
117    Private Sub btnNine_Click(ByVal sender As System.Object, _
118       ByVal e As System.EventArgs) Handles btnNine.Click
119
120       txtSecurityCode.Text &= "9"  ' concatenate "9" to display
121    End Sub ' btnNine_Click
122
123    Private Sub btnClear_Click(ByVal sender As System.Object, _
124       ByVal e As System.EventArgs) Handles btnClear.Click
125
126       txtSecurityCode.Clear() ' clear text from TextBox
127    End Sub ' btnClear_Click
128
129    ' invoked when the Form is loaded
130    Private Sub FrmSecurityPanel_Load(ByVal sender As _
131       System.Object, ByVal e As System.EventArgs) _
132       Handles MyBase.Load
133
134       ' load Agent character file
135       objMainAgent.Characters.Load("Robby", "Robby.acs")
136
137       ' specify current agent
138       m_objMSpeaker = objMainAgent.Characters("Robby")
139
140       ' show Robby on screen
141       m_objMSpeaker.Show(0)
142
143       ' Robby speaks
144       m_objMSpeaker.Speak("Please enter your security " _
145           & "access code.")
146    End Sub ' FrmSecurityPanel_Load
147
148 End Class ' FrmSecurityPanel

▲

1 Private Sub btnCall_Click(ByVal sender As System.Object, _
2    ByVal e As System.EventArgs) Handles btnCall.Click
3
4    objMainAgent.Characters.Load("Genie", "Genie.acs")
5
6    objMSpeaker = objMainAgent.Characters("Genie")
7
8    objMSpeaker.Show(0)
9

10    objMSpeaker.Speak("Hello, I'm Genie the special agent!")
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Answer: The agent object is loaded as “Genie.” Genie appears and says, “Hello, I'm Genie 
the special agent!”

What’s wrong with this code? 27.15 Find the error(s) in the following code. The event handler should have an agent object
appear and say, “Hello, my name is Merlin”. This should happen when the user clicks the
Call Button.
  

Answer: The Play method is called with an invalid argument. To have the agent say “Hello, 
my name is Merlin”, you must call the Speak method.

Programming Challenge 27.16 Car Payment Application Using Microsoft Agent) Enhance the Car Payment Cal-
culator application from Tutorial 9 to use the Microsoft Agent, Robby. When the application
is executed, Robby should appear on the screen and wave to users. He should then explain
the purpose of the application. After the user enters information into each field of the Car
Payment Calculator and clicks the Calculate Button, Robby should speak the calculated
payment amounts and the period (number of months) over which they were calculated. The
C:\Examples\Tutorial27\Exercises\CarPaymentCalculatorEnhancement directory
contains the template application for this exercise. Copy it to your working directory and
open the application to begin the exercise.

Answer:

11
12 End Sub

▲

1 Private Sub btnCall_Click(ByVal sender As System.Object, _
2    ByVal e As System.EventArgs) Handles btnCall.Click
3
4    objMainAgent.Characters.Load("Merlin", "Merlin.acs")
5          
6    objMSpeaker = objMainAgent.Characters("Merlin")
7
8    Dim intNumber As Integer = 10
9

10    objMSpeaker.Show(intNumber)
11
12    objMSpeaker.Play("Hello, my name is Merlin")
13
14 End Sub

1 Private Sub btnCall_Click(ByVal sender As System.Object, _
2    ByVal e As System.EventArgs) Handles btnCall.Click
3
4    objMainAgent.Characters.Load("Merlin", "Merlin.acs")
5
6    objMSpeaker = objMainAgent.Characters("Merlin")
7
8    Dim intNumber As Integer = 10
9

10    objMSpeaker.Show(intNumber)
11
12    
13
14 End Sub

objMSpeaker.Speak("Hello, my name is Merlin")

▲

1 ' Exercise 27.16 Solution
2 ' CarPayment.vb
3
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4 Public Class FrmCarPayment
5    Inherits System.Windows.Forms.Form
6
7    Private m_objMSpeaker As AgentObjects.IAgentCtlCharacter
8
9    ' Windows Form Designer generated code

10
11    ' handles Calculate Button's Click event
12    Private Sub btnCalculate_Click( ByVal sender As System.Object, _
13       ByVal e As System.EventArgs) Handles btnEnter.Click
14
15       Dim intYears As Integer = 2          ' repetition counter
16       Dim intMonths As Integer = 0         ' payment period
17       Dim intPrice As Integer = 0          ' car price
18       Dim intDownPayment As Integer = 0    ' down payment
19       Dim dblInterest As Double = 0        ' interest rate  
20       Dim decMonthlyPayment As Decimal = 0 ' monthly payment
21       Dim intLoanAmount As Integer = 0     ' cost after down payment
22       Dim dblMonthlyInterest As Double = 0 ' monthly interest rate
23       Dim strAgentSpeak As String = "You will have to pay: "
24
25       ' remove text displayed in ListBox
26       lstPayments.Items.Clear()
27
28       ' add header to ListBox
29       lstPayments.Items.Add("Months" & ControlChars.Tab & _
30          ControlChars.Tab & "Monthly Payments")
31
32       ' retrieve user input and assign values
33       ' to their respective variables
34       intDownPayment = Convert.ToInt32(Val(txtDownPayment.Text))
35       intPrice = Convert.ToInt32(Val(txtStickerPrice.Text))
36       dblInterest = Convert.ToDouble(Val(txtInterest.Text)) / 100
37
38       ' determine amount borrowed and monthly interest rate
39       intLoanAmount = intPrice - intDownPayment
40       dblMonthlyInterest = dblInterest / 12
41
42       ' loop four times                                     
43       Do While intYears <= 5
44
45          ' calculate payment period
46          intMonths = 12 * intYears
47
48          ' calculate monthly payment using Pmt   
49          decMonthlyPayment = Convert.ToDecimal( _
50               Pmt(dblMonthlyInterest, intMonths, -intLoanAmount))
51
52          ' display payment value
53          lstPayments.Items.Add(intMonths & ControlChars.Tab & _
54             ControlChars.Tab & String.Format("{0:C}", _
55             decMonthlyPayment))
56
57          If intYears < 5 Then
58
59             ' specify format of payment values for first
60             ' four years
61             strAgentSpeak = strAgentSpeak & String.Format("{0:C}", _
62                decMonthlyPayment) & " per month, over " & intMonths _
63                & " months, "
64          Else
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65             ' specify format for payment value of fifth year
66             strAgentSpeak = strAgentSpeak & "or " & _
67                String.Format("{0:C}", decMonthlyPayment) _
68                & " per month, over " & intMonths _
69                & " months."
70          End If
71
72          intYears += 1  ' increment counter
73       Loop 
74
75       ' Robby speaks strAgentSpeak string
76       m_objMSpeaker.Speak(strAgentSpeak)
77    End Sub ' btnCalculate_Click
78
79    ' invoked when Form is loaded
80    Private Sub FrmCarPayment_Load( ByVal sender As System.Object, _
81       ByVal e As System.EventArgs) Handles MyBase.Load
82
83       ' load Robby character into agent object
84       objMainAgent.Characters.Load("Robby", "Robby.acs")
85
86       m_objMSpeaker = objMainAgent.Characters("Robby")
87
88       ' show Robby on the screen
89       m_objMSpeaker.Show(0)
90
91       ' play Wave animation
92       m_objMSpeaker.Play("Wave")
93
94       ' make Robby speak instructions for application
95       m_objMSpeaker.Speak("Hello, I will be your assistant.")
96
97       m_objMSpeaker.Play("RestPose")
98
99       m_objMSpeaker.Speak( _
100          "You need to enter the price of a car," _
101          & "  the down-payment amount and " _
102          & " the annual interest rate of the loan.")
103
104       m_objMSpeaker.Speak( _
105          "After you input this information, " _
106          & "I will calculate the monthly payments you will " _
107          & "need to make for two-, three-, four- and " _
108          & "five-year loans.")
109    End Sub ' FrmCarPayment_Load
110
111 End Class ' FrmCarPayment
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Instructor’s Manual
Exercise Solutions

Tutorial 28

MULTIPLE-CHOICE
QUESTIONS

28.1 ASPX pages have the  extension.

28.2  applications divide functionality into separate tiers.

28.3 All tiers of a multi-tier application .

28.4 The client tier interacts with the  tier to access information from the
 tier.

28.5 A  is specialized software that responds to client requests by providing
resources.

28.6 A(n)  can be thought of as an address that is used to direct a browser to a
resource on the Web.

28.7 A  represents a group of  on the Internet.

28.8  is a Web server.

28.9 A  is a Web server that is located on a computer across a network such as the
Internet.

28.10 The  tier is the application’s user interface.

Answers: 28.1) d.  28.2) c.  28.3) c.  28.4) a.  28.5) d.  28.6) c.  28.7) a.  28.8) a.  28.9) c.  28.10) b.

EXERCISES 28.11 (Phone Book Application) Over the next three tutorials, you will create a Phone-
Book application. This phone book should be a Web-based version of the PhoneBook appli-

a) .html b) .wbform 
c) .vbaspx d) .aspx 

a) n-tier b) Multi-tier
c) Both a and b. d) None of the above.

a) must be located on the same computer 
b) must be located on different computers
c) can be located on the same computer or on different computers
d) must be arranged so that the client and middle tier are on the same computer and the 

information tier is on a different computer

a) middle; information b) information; middle
c) information; bottom d) bottom; information

a) host b) host name
c) DNS server d) Web server

a) middle tier b) ASPX page 
c) URL d) query string

a) domain; hosts b) host; domain names
c) host name; hosts d) None of the above.

a) IIS b) localhost 
c) Visual Studio .NET d) wwwroot 

a) localhost b) local Web server 
c) remote Web server d) None of the above. 

a) middle b) client
c) bottom d) information
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cation created in Tutorial 27. [Note: This Web application will not use Microsoft Agent.] The
PhoneBook application should consist of two ASPX pages, which will be named PhoneBook
and PhoneNumber. The PhoneBook page displays a DropDownList (a Web control similar to a
ComboBox Windows Form control) that contains the names of several people. The names are
retrieved from the db_Phone.mdb database. When a name is selected and the Get Number
Button is clicked, the client browser is redirected to the PhoneNumber page. The telephone
number of the selected name should be retrieved from a database and displayed in a Label
on the PhoneNumber page. For this exercise, you need only organize the components (Phone-
Book and PhoneNumber ASPX pages, db_Phone.mdb database and the code that performs
the specified functionality) of this Web application into separate tiers. Decide which compo-
nents belong in which tiers. You will begin building the solution, using Visual Studio .NET, in
the next tutorial.

Answer: The client tier should contain the ASPX pages’ GUIs. One page will contain a 
DropDownList control. The middle tier should contain the code used to retrieve the names 
and phone numbers from the database. The information tier should contain the 
db_Phone.mdb database where the phone-number information is stored. 

28.12 (US State Facts Application) Over the next three tutorials, you will create a
USStateFacts application. This application is designed to allow users to review their knowl-
edge about specific U.S. states. This application should consist of two ASPX pages. The first
page (named States) should display a ListBox containing 10 different state names. These
state names are stored in the db_StateFacts.mdb database. The user should be allowed to
select a state name and click a Button to retrieve information about the selected state from
the database. The information should be displayed on a different ASPX page (named State-
Facts). The StateFacts page should display an image of the state flag and list the state cap-
ital, state flower, state tree and state bird (retrieved from the database) in a Table. You will
be provided with images of the state flags. For this exercise, you need only organize the com-
ponents (States and StateFacts ASPX pages, db_StateFacts.mdb database and the code
that performs the specified functionality) of this Web application into separate tiers. Decide
which components belong in which tiers. You will begin building the solution, using Visual
Studio .NET, in the next tutorial.

Answer: The client tier should contain the ASPX pages’ GUIs, including a ListBox for the 
different state names. The middle tier should contain the code used to retrieve the state 
names and information from the database. The information tier should contain the 
db_StateFacts.mdb database where the state information is stored.

28.13 (Road Sign Review Application) Over the next three tutorials, you will create a
RoadSignReview application. The RoadSignReview application should consist of two
ASPX pages. This application displays road signs for users to review and allows them to
schedule a driving test. The first page (named RoadSigns) should display 15 road signs in a
Table. You will be provided images of the road signs. When the mouse pointer is moved over
a sign, the name of the sign will appear in a tooltip in the Web browser window. The table
should display the images by retrieving their information from the db_RoadSigns.mdb data-
base. This page also will contain two TextBoxes and a Button that allow users to provide
their information to register for a driving test. When users click the Register Button, the sec-
ond page (RoadTestRegistered) displays confirmation information that the user has regis-
tered for a driving test. For this exercise, you need only organize the components (RoadSigns
and RoadTestRegistered ASPX pages, db_RoadSigns.mdb database and the code that per-
forms the specified functionality) of this Web application into separate tiers. Decide which
components belong in which tiers. You will begin building the solution, using Visual
Studio .NET, in the next tutorial.

Answer: The client tier should contain the ASPX pages’ GUIs, one of which will contain a 
Table control for the various road signs. The middle tier should contain the code used to 
retrieve the road sign names from the database. The information tier should contain the 
db_RoadSigns.mdb database where the road-signs information is stored.
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Instructor’s Manual
Exercise Solutions

Tutorial 29

MULTIPLE-CHOICE
QUESTIONS

29.1 You change the  property of the ASPX page to specify the color that dis-
plays in the background of the page.

29.2 Button, Label and Table controls for ASPX pages can be accessed from the
 tab.

29.3 The  attribute is used to specify the position of a Web control on an ASPX
page. 

29.4 Unlike the Windows Form Designer, the Web Form Designer .

29.5 The BorderStyle property of the Image control .

29.6 Setting the BorderStyle property to OutSet makes a control appear .

29.7 Every  of a Table Web control can contain one or more .

29.8 For you to be able to create an ASP .NET Web application project,  must be
running.

29.9 The  mode allows you to create the ASPX page’s GUI by dragging and
dropping controls on the page.

29.10 To specify the position of a Web control, set the  and  values of
the  attribute.

Answers:  29.1) b.  29.2) a.  29.3) c.  29.4) b.  29.5) b.  29.6) a.  29.7) c.  29.8) a.  29.9) b.  29.10) c.

a) BackColor b) bgColor 
c) BackgroundColor d) Color 

a) Web Forms b) Components 
c) Data d) Both a and b. 

a) position b) location 
c) style d) coordinate 

a) does not provide two viewing modes
b) provides two viewing modes
c) allows you to design the graphical user interface
d) does not allow you to design the user interface

a) specifies the color of the border
b) specifies the type of border that displays around the Image control
c) specifies the width of the border d) Both a and b.

a) raised b) with a bold border
c) with the specified border width d) with the specified border color

a) TableRow; TableColumns b) TableColumn; TableRows
c) TableRow; TableCells d) TableCell; TableRows

a) IIS b) Microsoft Access
c) Microsoft Word d) Internet Explorer

a) HTML b) Design 
c) Visual d) GUI 

a) X, Y, style b) X, Y, position
c) TOP, LEFT, style d) TOP, LEFT, position
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EXERCISES [Note: In these exercises, we may ask you to set an ASPX page as the application’s start 
page, meaning that this page will appear first when the application is run. You can set an 
ASPX page as the start page by right clicking the file in the Solution Explorer and select-
ing Set As Start Page.]

29.11 (Phone Book Application: GUI) Create the user interface for the Phone Book
application. The design for the two pages for this application is displayed in Fig. 29.25.

a) Creating an ASP .NET Web application. Create an ASP.NET Web application
project, and name it PhoneBook. Rename the ASPX page to PhoneBook.aspx, and
set Option Strict to On. Set PhoneBook.aspx as the start page.

b) Changing the background color. Change the background color of your ASPX page
(PhoneBook.aspx) to the light-yellow Web Palette color (located in the sixth col-
umn of the 12th row) by using the bgColor property as demonstrated in this tutorial.
Change the title of the ASPX page to Phone Book.

c) Adding a Label. Create a Label, set the font size to X-Large and change the Text
property to Phone Book Web Application. Set the LEFT: portion of the style
attribute value to 40px and the TOP: portion to 17px. Name the control lblPhone-
Book.

d) Adding another Label. Create another Label, and set the Text property to Select a
name from the list and click the Get Number Button:. Set the LEFT: portion of
the style attribute value to 30px and the TOP: portion to 65px. Name this Web con-
trol lblInstructions.

e) Adding a DropDownList Web control. Create a DropDownList Web control by drag-
ging and dropping it from the Toolbox onto the ASPX page. The DropDownList Web
control looks similar to the ComboBox Windows Form control. Set the width to 190px,
and set the LEFT: portion of the style attribute value to 134px and the TOP: portion
to 108px. Name the DropDownList cboNames.

f) Adding a Button. Create a Button, set its width to 90px and change the Text prop-
erty to Get Number. Set the LEFT: portion of the style attribute value to 175px and
the TOP: portion to 200px. Name the Web control btnGet.

g) Adding another ASPX page to the Phone Book application. Add another ASPX
page to the Phone Book application, name it PhoneNumber.aspx and change the
background to the light-yellow color. Change the title property to Phone Number.

h) Adding a Label to the PhoneNumber.aspx. Create a Label and name it lblPhone-
Number. Set the font size to X-Large and change the Text property to Phone Num-
ber:. Set the LEFT: portion of the style attribute value to 20px and the TOP:
portion to 15px.

i) Adding another Label. Create another Label, set its BorderStyle to Inset, and set
its height and width to 50px and 380px, respectively. Clear the text of the Label.
Name the Label lblNumbers, and set the LEFT: portion of the style attribute value
to 25px and the TOP: portion to 80px.

j) Adding a Button to the PhoneNumber.aspx page. Create a Button, set its width to
115px and change the Text property to Phone Book. Set the LEFT: portion of the
style attribute value to 135px and the TOP: portion to 150px. Name the Button
btnPhoneBook.

k) Saving the solution file. Save the solution file to the PhoneBook folder located in the
root directory of your Web server, as you did in Step 8 of the box, Creating an
ASP .NET Web Application.
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Figure 29.25 Phone Book application ASPX pages’ design.

Answer: For this exercise, readers are asked to create the visual design of the page. They cre-
ate the design by dragging and dropping controls on the page. There is no code paste-up for 
this exercise. 

29.12 (US State Facts Application: GUI) Create the user interface for the US State Facts
application. The design for the two pages of this application is displayed in Fig. 29.26.

a) Creating an ASP .NET Web application. Create a new ASP.NET Web application
project, and name it USStateFacts. Rename the first ASPX page to States.aspx,
and set Option Strict to On. Set States.aspx as the start page.

b) Changing the background color. Change the background color of the States.aspx
page to the light-blue Web Palette color (located in the sixth column of the second
row) by using the bgColor property as demonstrated in this tutorial. Change the
title property of the ASPX page to States.

c) Adding a Label to States.aspx. Create a Label Web control, and place it on the
page. Set the font size to XX-Large, and change the Text property to States. Change
the LEFT: portion of its style attribute value to 390px, and set the TOP: portion to
15px. Name the Web control lblStates.

d) Adding a Horizontal Rule to States.aspx. Create a Horizontal Rule, place it on
the ASPX page and set its width to 150%. When setting its position, change the TOP:
value to 80px, set the LEFT: value to 0px and specify the Height: as 4px. Name the
Horizontal Rule hrzStates.

e) Adding another Label to States.aspx. Create another Label, and place it beneath
the Horizontal Rule. Change the font size to Medium, and set the Text property to
Select a state from the list and click the button to view facts about that
state:. Set its height to 16px and its width to 620px. Change the LEFT: portion of its
style attribute value to 195px, and set the TOP: portion to 100px. Name this Web
control lblInstructions.

f) Adding a ListBox to States.aspx. Create a ListBox, and place it on the ASPX
page. Set its Height property to 100px and its Width property to 155px. Set the
LEFT: portion of the style attribute value to 365px and the TOP: portion to 150px.
Name the ListBox lstStates.

g) Adding a Button to States.aspx. Create a Button, and place it on the page. Set its
Text property to Review Facts and its Width property to 130px. Change the LEFT:
portion of the style attribute value to 375px and the TOP: portion to 270px. Name
the Button btnFacts.

PhoneBook.aspx page

PhoneNumber.aspx page
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h) Adding another ASPX page to the US State Facts application. Add another ASPX
page to the US State Facts application, name it StateFacts.aspx and change the
background color to light blue. 

i) Adding a Label to StateFacts.aspx. Create a Label, name it lblStateName, set
its font size to XX-Large and change its ForeColor property to Blue. Clear the
Label’s text. Set its position by setting the LEFT: portion of the style attribute value
to 20px and the TOP: portion to 15px.

j) Adding a Horizontal Rule. Place the Horizontal Rule beneath the Label and set its
TOP: position to 90px, its LEFT: position to 0px and its Height: to 4px. Change the
width to 150%. Name the Horizontal Rule hrzStateFacts.

k) Adding an Image control to StateFacts.aspx. Create an Image control and set its
BorderStyle to Outset. Change the BorderWidth to 5px. Set its height to 200px
and its width to 300px. Set the position of the Image by changing the LEFT: portion
of the style attribute value to 20px and the TOP: portion to 110px. Name the Web
control imgFlag.

l) Adding a Table to StateFacts.aspx. Create a Table with four rows and two col-
umns. Set the BorderStyle to Outset, the BorderWidth to 5px and GridLines to
Both. Set the height and width of each TableCell of the first column to 70px and
200px, respectively, and set the Font property’s Size to Large. Set the Text property
of the cells in the first column to Capital:, Flower:, Tree: and Bird:, respectively.
Change the LEFT: portion of the style attribute value to 335px and the TOP: por-
tion to 110px. Name the Table control tblState.

m)Adding a Button to StateFacts.aspx. Create a Button, change its text to State
List, and change the LEFT: portion of the style attribute value to 285px and the
TOP: portion to 425px. Name the Button control btnStateList.

n) Saving the solution file. Save the solution file to the USStateFacts folder located in
the root directory of your Web server, as you did in Step 8 of the box, Creating an
ASP .NET Web Application.
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Figure 29.26 US State Facts application ASPX pages’ design.

Answer: For this exercise, readers are asked to create the visual design of the page. They cre-
ate the design by dragging and dropping controls on the page. There is no code paste-up for 
this exercise. 

29.13 (Road Sign Review Application: GUI) Create the user interface for the Road Sign
Review application. The design for the two pages of this application is displayed in Fig. 29.27.

a) Creating an ASP .NET Web application. Create a new ASP.NET Web application
project, and name it RoadSignReview. Change the name of the existing ASPX page
to RoadSigns.aspx, and set Option Strict to On. Set RoadSigns.aspx as the start
page.

b) Changing the background color. Change the background color of RoadSigns.aspx
to the light-green Web Palette color (located in the sixth column of the 14th row) by
using the bgColor property as demonstrated in this tutorial. Change the title of the
ASPX page to RoadSigns.

c) Adding a Label to RoadSigns.aspx. Create a Label, and set its font size to XX-
Large. Change the Text property to Road Signs. Set its position by changing the
style attribute value’s LEFT: portion to 295px and the TOP: portion to 16px. Name
the Label control lblRoadSigns.

d) Adding a Horizontal Rule to RoadSigns.aspx. Create a Horizontal Rule. Set its
width to 150%, and set the TOP: position to 80px, the LEFT: position to 0px and the
height to 4px. Name the Horizontal Rule hrzRoadSigns.

States.aspx page

StateFacts.aspx page
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e) Adding a Table to RoadSigns.aspx. Create a Table with three rows and five col-
umns. Set the BorderStyle to Outset, the BorderWidth to 5px and the GridLines
property to Both. Also, set the Table’s Height property to 279px and Width prop-
erty to 626px. Set each row’s height to 50px and each TableCell’s width to 20px.
Change the style attribute value by setting LEFT: to 70px and TOP: to 150px. Name
the Table control tblRoadSigns.

f) Adding a Label to RoadSigns.aspx. Create a Label, and set its font size to Large.
Change the Text property to Register for Your Driving Test. Set its position by
changing the style attribute value’s LEFT: portion to 70px and TOP: portion to
470px. Name the Web control lblRegister.

g) Adding a Label and TextBox to RoadSigns.aspx. Create a Label and set its text to
Name:. Set its font size to Medium, and change its position to LEFT: 70px and TOP:
520px. Name the Label control lblName. Create a TextBox, and place it next to the
Name: Label. Set its height to 20px and width to 115px. Change the position to
LEFT: 135px and TOP: 520px. Name the TextBox control txtName.

h) Adding another Label and TextBox pair to RoadSigns.aspx. Create a Label and
set its text to Phone Number:. Set its font size to Medium, and change its position to
LEFT: 275px and TOP: 520px. Name the Label control lblPhoneNumber. Create a
TextBox, and place it next to the Phone Number: Label. Set its height to 20px and
width to 115px. Change its position to LEFT: 410px and TOP: 520px. Name the
TextBox control txtPhoneNumber.

i) Adding a Button to RoadSigns.aspx. Create a Button, set its Text to Register,
and change its height and width to 30px and 120px, respectively. Change the position
of the Button by setting the LEFT: portion of the style attribute value to 555px and
the TOP: portion to 520px. Name the Button control btnRegister.

j) Adding another ASPX page to the Road Sign Review application. Add another
ASPX page to the application, name it RoadTestRegistered.aspx and change the
background color to light green. 

k) Adding a Label to RoadTestRegistered.aspx. Create a Label, setting its font size
to XX-Large and its Text property to Registration Complete. Change its position
by setting the LEFT: portion of its style attribute value to 200px and the TOP: por-
tion to 15px. Name the Label control lblRegistration.

l) Adding a Horizontal Rule to RoadTestRegistered.aspx. Create a Horizontal
Rule. Set its width to 150%, the TOP: position to 80px, the LEFT: position to 0px and
the height to 4px. Name the Horizontal Rule hrzRoadTestRegistered.

m)Adding another Label to RoadTestRegistered.aspx. Create a Label, name it
lblConfirmation and set its font size to Medium. Delete the Text property value,
and leave it blank. Change its position by setting the LEFT: portion of its style
attribute value to 125px and the TOP: portion to 130px.

n) Saving the solution file. Save the solution file to the RoadSignReview folder located
in the root directory of your Web server, as you did in Step 8 of the box, Creating an
ASP .NET Web Application.
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Figure 29.27 Road Signs application ASPX pages’ design.

Answer: For this exercise, readers are asked to create the visual design of the page. They cre-
ate the design by dragging and dropping controls on the page. There is no code paste-up for 
this exercise. 

RoadSigns.aspx page

RoadTestRegistered.aspx
page
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Instructor’s Manual
Exercise Solutions

Tutorial 30

MULTIPLE-CHOICE
QUESTIONS

30.1  is an example of a database product.

30.2 An advantage of using information in a database is that . 

30.3 When a funnel appears to the right of a field’s CheckBox in the Query Builder dialog, it
indicates that .

30.4 The Parameters property of  contains a collection of parameters.

30.5 The  can be used to create an OleDbConnection.

30.6 You use the  object to create SQL statements for retrieving data from a
database.

30.7 The  is used when creating SQL statements visually for the OleDbCommand
object’s CommandText property. 

30.8 You use the  object to open a connection to the database.

30.9 You use the  property of the OleDbCommand object to specify values for
information that is not known in advance.

30.10 Another name for the database tier is .

Answers: 30.1) d.  30.2) c.  30.3) b.  30.4) d.  30.5) a.  30.6) c.  30.7) b.  30.8) a.  30.9) b.  30.10) c.

a) Microsoft Access b) Microsoft SQL Server
c) Oracle d) All of the above.

a) the data can be updated in real time
b) information that changes need be updated only in one location
c) Both a and b.
d) None of the above.

a) information will be updated in the specified field
b) a value will be retrieved from that field according to specified criteria
c) the field will not be included in the SQL statement
d) None of the above.

a) OleDbConnection b) OleDbDataConnection 
c) OleDbDataCommand d) OleDbCommand 

a) Server Explorer window b) Query Builder tool
c) Both a and b. d) None of the above.

a) OleDbConnection b) OleDbDataReader 
c) OleDbCommand d) None of the above. 

a) Server Explorer window b) Query Builder tool
c) Both a and b. d) None of the above.

a) OleDbConnection b) OleDbDataReader 
c) OleDbCommand d) None of the above. 

a) Connection b) Parameters 
c) Field d) Name 

a) the information tier b) the bottom tier
c) Both a and b. d) None of the above.
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EXERCISES 30.11 (Phone Book Application: Database) Create the database connections and data
command objects for the PhoneBook application by using the Server Explorer window and
the Query Builder tool. 

a) Opening the application. Open the PhoneBook application that you created in
Tutorial 29.

b) Copying the db_Phone.mdb database to the Databases folder. Copy the C:\Exam-
ples\Tutorial30\Exercises\Databases\db_Phone.mdb database to the Data-
bases folder in IIS’s wwwroot folder.

c) Using Server Explorer to add a connection to the database. In the Server Explorer
window, add a connection to the db_Phone.mdb database. Drag and drop the connec-
tion object onto the PhoneBook.aspx page. Name the connection object
objOleDbConnection.

d) Using Query Builder for the PhoneBook.aspx page. Add an OleDbCommand to the
PhoneBook.aspx page. Set the Connection property to the OleDbConnection object
you added to the ASPX page, and use Query Builder to set the CommandText prop-
erty of the OleDbCommand. This command should retrieve all the names of the people
from the database. Name this command object objSelectNames.

e) Adding a connection to the database to the PhoneNumber.aspx page. Using the
Server Explorer window, drag and drop a database connection object onto the
PhoneNumber.aspx page. Name this connection object objOleDbConnection.

f) Using Query Builder for PhoneBook.aspx. Add an OleDbCommand to the
PhoneNumber.aspx page. Set the Connection property to the OleDbConnection
object you added to the ASPX page, and use Query Builder to set the CommandText
property of the OleDbCommand. This configuration should retrieve the phone number
of the person whose name will be selected, from the DropDownList in the
PhoneBook.aspx page, by the user. You need to set the criteria to specify which per-
son’s phone number will be retrieved from the database. Name this command object
objSelectPhoneNumber.

g) Saving the solution. Select File > Save All to save the solution’s files.

Answer: Connect to the database by using the Server Explorer window, and specify data 
command objects by using the Query Builder tool. 

30.12 (US State Facts Application: Database) Create the database connections and data
command objects for the USStateFacts application by using the Server Explorer window
and the Query Builder tool. 

a) Opening the application. Open the USStateFacts application that you created in
Tutorial 29.

b) Copying the db_StateFacts.mdb database to the Databases folder. Copy the
C:\Examples\Tutorial30\Exercises\Databases\db_StateFacts.mdb database
to the Databases folder in IIS’s wwwroot folder.

c) Using Server Explorer to add a connection to the database. In the Server Explorer
window, add a connection to the db_StateFacts.mdb database. Drag-and-drop the
connection object onto the States.aspx page. Name this connection object
objOleDbConnection.

d) Using Query Builder for the States.aspx page. Add an OleDbCommand to the
States.aspx page. Set the Connection property to the OleDbConnection object
you added to the ASPX page and use Query Builder to set the CommandText prop-
erty of the OleDbCommand. This command should retrieve the names of the states
from the name field of the states table in the database. Name this command object
objSelectNames.

e) Adding a connection to the database to the StateFacts.aspx page. Using the
Server Explorer window, drag-and-drop a database connection object onto the data-
base on the StateFacts.aspx page. Name this connection object
objOleDbConnection.

f) Using Query Builder for StateFacts.aspx. Add an OleDbCommand to the
StateFacts.aspx page. Set the Connection property to the OleDbConnection
object you added to the ASPX page, and use Query Builder to set the CommandText
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property of the OleDbCommand. This configuration should retrieve all the informa-
tion, from the states table of the database, about the state that is selected by the
user. You need to set the criteria to specify which state’s information will be retrieved
from the database. Name this command object objSelectStateInformation.

g) Saving the solution. Select File > Save All to save the solution’s files.

Answer: Connect to the database by using the Server Explorer window, and specify data 
command objects by using the Query Builder tool. 

30.13 (Road Sign Review Application: Database) Create the database connections and
data command objects for the RoadSignReview application by using the Server Explorer
window and the Query Builder tool. 

a) Opening the application. Open the RoadSignReview application that you created in
Tutorial 29.

b) Copying the db_RoadSigns.mdb database to the Databases folder. Copy the
C:\Examples\Tutorial30\Exercises\Databases\db_RoadSigns.mdb database
to the Databases folder in IIS’s wwwroot folder.

c) Using Server Explorer to add a connection to the database. In the Server Explorer
window add a connection to the db_RoadSigns.mdb database. Drag and drop the
connection object onto the RoadSigns.aspx page. Name this command object
objOleDbConnection.

d) Using Query Builder for the RoadSigns.aspx page. Add an OleDbCommand to the
RoadSigns.aspx page. Set the Connection property to the OleDbConnection object
that you added to the ASPX page, and use Query Builder to set the CommandText
property of the OleDbCommand. This configuration should retrieve all the information
about all the road signs from the signs table of the database. You will not need to
specify a criterion for this exercise, because all the information from the database
needs to be retrieved. Name this command object objSelectSignInformation.

e) Saving the solution. Select File > Save All to save the solution’s files.

Answer: Connect to the database by using the Server Explorer window, and specify data 
command objects by using the Query Builder tool. 
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Instructor’s Manual
Exercise Solutions

Tutorial 31

MULTIPLE-CHOICE
QUESTIONS

31.1 The Page_Load event handler .

31.2 The Response.Redirect method .

31.3 Session items are used in the Bookstore application because .

31.4 Session state is used for  in ASP.NET. 

31.5 The file extension for an ASPX code-behind file is .

31.6 The Response object is a predefined ASP.NET object that .

31.7 The Response.Redirect method takes a(n)  as an argument.

31.8 The  property specifies the image that an Image control displays.

31.9 The Visual Basic .NET file that contains the ASPX page’s corresponding class is called
the .

31.10 Information can be maintained across Web pages by adding a  to the Ses-
sion object.

Answers: 31.1) c.  31.2) b.  31.3) b.  31.4) a.  31.5) c.  31.6) d.  31.7) a.  31.8) b.  31.9) b.  31.10) a.

a) redirects the client browser to different Web pages
b) defines the functionality when a Button is clicked
c) executes any processing necessary to display a Web page
d) defines the functionality when a Web control is selected

a) refreshes the current Web page
b) sends the client browser to a specified Web page
c) responds to user input
d) responds to the click of a Button

a) variables in ASP.NET Web applications must be created as Session items
b) values need to be shared among Web pages
c) Session items are simpler to create than instance variables
d) Both a and b.

a) tracking user-specific data b) running an application
c) using a database d) None of the above.

a) .asp b) .aspx 
c) .aspx.vb d) .code 

a) connects to a database b) retrieves information from a database 
c) creates Web controls  

d) provides methods for responding to client requests 

a) URL b) Integer value
c) Boolean value d) OleDbConnection object

a) ImageGIF b) ImageURL 
c) Image d) Display 

a) ASPX file b) code-behind file 
c) class file d) None of the above.

a) key-value pair b) number
c) database connection object d) None of the above.
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EXERCISES 31.11 (Phone Book Application: Functionality) Define the middle tier for the Phone
Book application.

a) Opening the application. Open the PhoneBook application that you created in
Tutorial 29 and continued to develop in Tutorial 30.

b) Importing System.Data.OleDb in PhoneBook.aspx.vb. Import the Sys-
tem.Data.OleDb namespace in PhoneBook.aspx.vb.

c) Defining the Page_Load event handler of PhoneBook.aspx page. Use the Open
method to open the connection to the database. Create a data reader to read the
information specified by the data command object. 

d) Populating the DropDownList with names. Add a Do While...Loop to Phone-
Book.aspx’s Page_Load method. This loop should add to the DropDownList each
person’s name read by the data reader.

e) Closing the reader and connection. Close the data reader and the connection to the
database by invoking their Close methods.

f) Creating the Get Number Button’s Click event handler for the PhoneBook.aspx
page. Double click the Get Number Button to create the Click event’s event
handler. 

g) Creating a Session item. In the Click event handler, create a Session item to store
the selected name.

h) Redirecting to the PhoneNumber.aspx page. In the Click event handler, use the
Response.Redirect method to redirect the client browser to the PhoneNum-
ber.aspx page.

i) Importing System.Data.OleDb in PhoneNumber.aspx.vb. Import the Sys-
tem.Data.OleDb namespace in PhoneNumber.aspx.vb.

j) Defining the Page_Load event handler for the PhoneNumber.aspx page. Use the
Open method to open the connection to the database. Access the Session item to
retrieve the selected name. Specify this name as the parameter value for the OleDb-
Command object. Create a data reader to read the information specified by the data
command object. 

k) Displaying the selected name and phone number. In the Page_Load event handler,
read the desired phone number from the data reader. Display the selected name and
corresponding phone number in the lblNumbers Label.

l) Closing the reader and connection. Close the data reader and the connection to the
database by invoking their Close methods.

m)Creating the Phone Book Button’s Click event handler for the PhoneNumber.aspx
page. Double click the Phone Book Button to create the Click event’s event han-
dler. 

n) Redirecting to the PhoneBook.aspx page. In the Click event handler, use the
Response.Redirect method to redirect the client browser to the PhoneBook.aspx
page.

1 ' Solution 31.11 Solution
2 ' PhoneBook.aspx.vb
3
4 Imports System.Data.OleDb
5
6 Public Class PhoneBook
7    Inherits System.Web.UI.Page
8
9    ' control declarations

10    
11    ' Web Form Designer Generated Code 
12
13    ' invoked when page is loaded
14    Private Sub Page_Load(ByVal sender As System.Object, _
15       ByVal e As System.EventArgs) Handles MyBase.Load
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16
17       objOleDbConnection.Open() ' open connection to the database
18
19       ' declare reader to read from database
20       Dim objReader As OleDbDataReader
21
22       ' create reader to read from database
23       objReader = objSelectNames.ExecuteReader()
24
25       ' add names to DropDownList
26       Do While objReader.Read()
27
28          ' add item to DropDownList
29          cboNames.Items.Add(Convert.ToString(objReader("Name")))
30       Loop
31
32       objReader.Close() ' close the reader 
33
34       ' close the connection to the database
35       objOleDbConnection.Close() 
36    End Sub ' Page_Load
37
38    ' invoke when btnGet Button is clicked
39    Private Sub btnGet_Click(ByVal sender As System.Object, _
40       ByVal e As System.EventArgs) Handles btnGet.Click
41
42       Session("Name") = Convert.ToString(cboNames.SelectedItem)
43
44       ' redirect to another ASPX page
45       Response.Redirect("PhoneNumber.aspx") 
46    End Sub ' btnGet_Click
47
48 End Class ' PhoneBook

1 ' Exercise 31.11 Solution
2 ' PhoneNumber.aspx.vb
3
4 Imports System.Data.OleDb
5
6 Public Class PhoneNumber
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7    Inherits System.Web.UI.Page
8
9    ' control declarations

10    
11    ' Web Form Designer Generated Code 
12
13    ' invoked when page is loaded
14    Private Sub Page_Load(ByVal sender As System.Object, _
15       ByVal e As System.EventArgs) Handles MyBase.Load
16
17       ' represents the name
18       Dim strName As String = Convert.ToString(Session("Name"))
19
20       objOleDbConnection.Open() ' open connection to the database
21
22       ' specify name to retrieve phone number for
23       objSelectPhoneNumber.Parameters( _
24          "Name").Value = strName
25
26       ' declare reader to read from the database
27       Dim objReader As OleDbDataReader
28
29       ' create reader to read from the database
30       objReader = objSelectPhoneNumber.ExecuteReader()
31
32       objReader.Read() ' start data reader
33
34       ' display name and number in Label
35       lblNumbers.Text = strName & "'s number is: " & _
36          Convert.ToString(objReader("Phone_Numbers"))
37
38       objReader.Close() ' close data reader
39       
40       ' close the connection to the database
41       objOleDbConnection.Close()
42    End Sub ' Page_Load
43
44    ' redirects user back to PhoneBook.aspx
45    Private Sub btnPhoneBook_Click(ByVal sender As System.Object, _
46       ByVal e As System.EventArgs) Handles btnPhoneBook.Click
47
48       Response.Redirect("PhoneBook.aspx")
49    End Sub ' btnPhoneBook_Click
50
51 End Class ' PhoneNumber 
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31.12 (US State Facts Application: Functionality) Define the middle tier for the US State
Facts application. 

a) Opening the application. Open the USStateFacts application that you created in
Tutorial 29 and continued to develop in Tutorial 30.

b) Copying the FlagImages folder to your project folder. Copy the C:\Exam-
ples\Tutorial31\Exercises\Images\FlagImages folder to the USStateFacts
folder.

c) Importing System.Data.OleDb in States.aspx.vb. Import the Sys-
tem.Data.OleDb namespace in States.aspx.vb before the class definition.

d) Defining the Page_Load event handler for the States.aspx page. Use the Open
method to open the connection to the database. Create a data reader to read the
information specified by the data command object. 

e) Populating the ListBox with state names in the States.aspx page. Add a Do
While...Loop to States.aspx’s Page_Load method. This loop should add to the
ListBox the name of each state read by the data reader.

f) Creating a Button’s Click event handler for the States.aspx page. Double click
the Review Facts Button to create the Click event’s event handler. 

g) Creating a Session item. Create a Session item in the Click event handler and
assign it to the state name that the user selects from the ListBox.

h) Redirecting to the StateFacts.aspx page. In the Click event handler, use the
Redirect.Response method to redirect the client browser to the StateFacts.aspx
page.

i) Importing System.Data.OleDb in StateFacts.aspx.vb. Import the Sys-
tem.Data.OleDb namespace in StateFacts.aspx.vb.

j) Defining the Page_Load event handler of StateFacts.aspx page. Use the Open
method to open the connection to the database. Access the Session object to
retrieve the selected state name. Specify this name as a parameter value for the Ole-
DbCommand object. Create a data reader to read the information specified by the data
command object. 

k) Displaying the state facts in the Table. In the Page_Load event handler, use the data
reader to retrieve the desired state’s facts. Display the selected state’s name in the
lblStateName Label. Set the ImageURL property of the Image control to the loca-
tion of the selected state’s flag image. Display the name of the state capital, flower,
tree and bird in the Table on the StateFacts.aspx page.

l) Closing the connection. Close the connection to the database by invoking the Close
method.
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m)Creating the State List Button’s Click event handler for the StateFacts.aspx
page. Double click the State List Button to create the Click event handler. 

n) Redirecting to the States.aspx page. In the Click event handler use the Redi-
rect.Response method to redirect the client browser to the States.aspx page.

1 ' Exercise 31.12 Solution
2 ' States.aspx.vb
3
4 Imports System.Data.OleDb
5
6 Public Class States
7    Inherits System.Web.UI.Page
8
9    ' control declarations

10    
11    ' Web Form Designer Generated Code 
12
13    ' invoked when page is loaded
14    Private Sub Page_Load(ByVal sender As System.Object, _
15       ByVal e As System.EventArgs) Handles MyBase.Load
16
17       objOleDbConnection.Open() ' open connection to the database
18
19       ' declare reader to read from database
20       Dim objReader As OleDbDataReader
21
22       ' create reader to read from database
23       objReader = objSelectNames.ExecuteReader()
24
25       ' add names to the ListBox
26       Do While objReader.Read()
27
28          ' add item to ListBox
29          lstStates.Items.Add(Convert.ToString(objReader("Name")))
30       Loop
31
32       objReader.Close() ' close the reader 
33
34       ' close the connection to the database
35       objOleDbConnection.Close()
36    End Sub ' Page_Load
37
38    ' handle click event
39    Private Sub btnFacts_Click(ByVal sender As System.Object, _
40       ByVal e As System.EventArgs) Handles btnFacts.Click
41
42       ' create Session item named strName
43       Session("strName") = lstStates.SelectedItem.Text
44
45       ' redirect to another ASPX page
46       Response.Redirect("StateFacts.aspx")
47    End Sub ' btnFacts_Click
48
49 End Class ' States
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1 ' Solution 31.12 Solution
2 ' StateFacts.aspx.vb
3
4 Imports System.Data.OleDb
5
6 Public Class StateFacts
7    Inherits System.Web.UI.Page
8
9    ' control declarations

10    
11    ' Web Form Designer Generated Code 
12
13    ' invoked when page is loaded
14    Private Sub Page_Load(ByVal sender As System.Object, _
15       ByVal e As System.EventArgs) Handles MyBase.Load
16
17       ' display name of selected book
18       lblStateName.Text = Convert.ToString(Session("strName"))
19
20       objOleDbConnection.Open() ' open connection to database
21
22       ' specify state name to retrieve information about
23       objSelectStateInformation.Parameters("Name").Value = _
24          Convert.ToString(Session("strName"))
25
26       ' declare database reader to read from database
27       Dim objReader As OleDbDataReader
28
29       ' create database reader to read from database
30       objReader = objSelectStateInformation.ExecuteReader()
31
32       ' while reader is reading database, retrieve data from
33       ' specified positions and display them on page
34       Do While objReader.Read()
35
36          ' display flag for selected state
37          imgFlag.ImageUrl = “FlagImages/” & _
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31.13 (Road Sign Review Application: Functionality) Define the middle tier for the Road
Sign Review application. 

a) Opening the application. Open the RoadSignReview application that you created in
Tutorial 29 and continued to develop in Tutorial 30.

38             Convert.ToString(objReader("flag"))
39
40          ' display information from database in Table
41          tblState.Rows(0).Cells(1).Text = _
42             Convert.ToString(objReader("capital"))
43          tblState.Rows(1).Cells(1).Text = _
44             Convert.ToString(objReader("flower"))
45          tblState.Rows(2).Cells(1).Text = _
46             Convert.ToString(objReader("tree"))
47          tblState.Rows(3).Cells(1).Text = _
48             Convert.ToString(objReader("bird"))
49       Loop
50
51       objOleDbConnection.Close() ' close connection to database
52    End Sub ' Page_Load
53
54    ' invoked when user clicks Button
55    Private Sub btnStateList_Click(ByVal sender As System.Object, _
56       ByVal e As System.EventArgs) Handles btnStateList.Click
57
58       ' redirects to States.aspx page
59       Response.Redirect("States.aspx")
60    End Sub ' btnStateList_Click
61
62 End Class ' StateFacts
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b) Copying the SignImages folder to your project folder. Copy the C:\Exam-
ples\Tutorial31\Exercises\Images\SignImages folder to the RoadSignReview
folder.

c) Importing System.Data.OleDb and System.Web.UI.WebControls to Road-
Signs.aspx.vb. Import the System.Data.OleDb and System.Web.UI.WebCon-
trols namespaces to RoadSigns.aspx.vb. You need to import
System.Web.UI.WebControls because you will be creating a Web control program-
matically in this exercise.

d) Defining the Page_Load event handler for the RoadSigns.aspx page. Use the Open
method to open the connection to the database. Create a data reader to read the
information specified by the data command object. 

e) Populating the Table with sign images in the RoadSigns.aspx page. Add a Do
While...Loop to RoadSigns.aspx’s Page_Load method. This loop should display an
image of the sign and display the sign name in the ToolTip property. This property
specifies the text that displays in a tooltip box when the mouse hovers over the
Image. The sign image and name should be retrieved using the data reader. To dis-
play an Image in a cell of the Table, you need to create an Image control, specify a
cell and use the cell’s Controls.Add method to add an image to that cell. For exam-
ple, to create an Image control programmatically, type Dim imgImageName As Image =
New Image(). You then need to set the ImageURL property to the location of the
desired image. To display an Image control in the first cell of the first row, you would
write the line Table.Rows(0).Cells(0).Controls.Add(imgImageName). Also, if
you wish to specify text for a tooltip, you must set the cell’s ToolTip property—for
example, Table.Rows(0).Cells(0).ToolTip = “This is a tooltip”. 

f) Closing the reader and connection. Close the data reader and the connection to the
database by invoking their Close methods.

g) Creating the Register Button’s Click event handler for RoadSigns.aspx. Double
click the Register Button of RoadSigns.aspx to create the Click event handler. 

h) Creating Session item. Create two Session items in the Click event handler, and
set the first one equal to the user input for the Name: TextBox. The second Session
item should equal the user input for the Phone Number: TextBox.

i) Redirecting to the RoadTestRegistered.aspx page. In the Click event handler, use
the Redirect.Response method to redirect the client browser to the RoadTestReg-
istered.aspx page.

j) Defining the Page_Load method of RoadTestRegistered.aspx page. Use the Ses-
sion items to display a confirmation to the user about the user’s registration infor-
mation. Display the confirmation using Label lblConfirmation. Display the user’s
name, and display text which states that the user will be contacted shortly at the
phone number provided. This information should be displayed in a Label.

1 ' Exercise 31.13 Solution
2 ' RoadSigns.aspx.vb
3
4 Imports System.Data.OleDb
5 Imports System.Web.UI.WebControls
6
7 Public Class RoadSigns
8    Inherits System.Web.UI.Page
9

10    ' control declarations
11    
12    ' Web Form Designer Generated Code 
13
14    ' invoked when page is loaded
15    Private Sub Page_Load(ByVal sender As System.Object, _
16       ByVal e As System.EventArgs) Handles MyBase.Load
17
18       objOleDbConnection.Open() ' open connection to the database
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19
20       ' declare reader to read from database
21       Dim objReader As OleDbDataReader
22
23       ' create reader to read from database
24       objReader = objSelectSignInformation.ExecuteReader()
25
26       Dim intRow As Integer = 0
27       Dim intColumn As Integer = 0
28
29       ' display signs in Table
30       Do While objReader.Read()
31
32          ' move to next row
33          If intColumn > 4 Then
34             intRow += 1
35             intColumn = 0
36          End If
37
38          ' create new Image control
39          Dim imgCellImage As Image = New Image()
40
41          ' set ImageURL property
42          imgCellImage.ImageUrl = “SignImages/” & _
43             Convert.ToString(objReader("sign"))
44
45          ' add image to table
46          tblRoadSigns.Rows((intRow)).Cells( _
47             intColumn).Controls.Add(imgCellImage)
48
49          ' add image name to ToolTip
50          tblRoadSigns.Rows(intRow).Cells(intColumn).ToolTip = _
51             Convert.ToString(objReader("name"))
52
53          intColumn += 1 ' increment column location
54       Loop
55
56       objReader.Close() ' close the reader 
57
58       ' close the connection to the database
59       objOleDbConnection.Close()
60    End Sub ' Page_Load
61
62    ' handles click event for btnRegister Button
63    Private Sub btnRegister_Click(ByVal sender As System.Object, _
64       ByVal e As System.EventArgs) Handles btnRegister.Click
65
66       ' create Session item
67       Session("strName") = txtName.Text
68       Session("strPhoneNumber") = txtPhoneNumber.Text
69
70       ' redirect to another ASPX page
71       Response.Redirect("RoadTestRegistered.aspx")
72    End Sub ' btnRegister_Click
73
74 End Class ' RoadSigns
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1 ' Exercise 31.13 Solution
2 ' RoadTestRegistered.aspx.vb
3
4 Public Class RoadTestRegistered
5    Inherits System.Web.UI.Page
6
7    ' control declarations
8    
9    ' Web Form Designer Generated Code 

10
11    ' invoked when page is loaded
12    Private Sub Page_Load(ByVal sender As System.Object, _
13       ByVal e As System.EventArgs) Handles MyBase.Load
14
15       ' display output
16       lblConfirmation.Text = Convert.ToString(Session("strName")) & _
17          ", you have registered to take your driving test. " & _
18          "We will call you back at " & _
19          Convert.ToString(Session("strPhoneNumber")) & _
20          " to confirm a date."
21    End Sub ' Page_Load
22
23 End Class ' RoadTestRegistered
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Instructor’s Manual
Exercise Solutions

Tutorial 32

32.1 Dealing with exceptional situations as an application executes is called . 

32.2 A(n)  is always followed by at least one Catch block or a Finally block. 

32.3 The method call Convert.ToInt32( "123.4a" ) will throw a(n) .

32.4 If no exceptions are thrown in a Try block, .

32.5 A(n)  is an exception that does not have an exception handler, and therefore
might cause the application to terminate execution.

32.6 A Try block can have  associated with it.

32.7 The  statement is used to rethrow an exception from inside a Catch block.

32.8  marks the end of a Try block and its corresponding Catch and Finally
blocks.

32.9 A Finally block is located .

32.10 A  is executed if an exception is thrown from a Try block or if no exception
is thrown.

Answers: 32.1) b.  32.2) c.  32.3) a.  32.4) a.  32.5) b.  32.6) c.  32.7) b.  32.8) a.  32.9) c.  32.10) b.

EXERCISES 32.11 (Enhanced Miles Per Gallon Application) Modify the Miles Per Gallon application
(Exercise 13.13) to use exception handling to process the FormatExceptions that occur
when converting the strings in the TextBoxes to Doubles (Fig. 32.16). The original applica-
tion allowed the user to input the number of miles driven and the number of gallons used for
a tank of gas, to determine the number of miles the user was able to drive on one gallon of
gas.

a) exception detection b) exception handling
c) exception resolution d) exception debugging

a) if statement b) event handler
c) Try block d) None of the above.

a) FormatException b) ParsingException 

c) DivideByZeroException d) None of the above.

a) the Catch block(s) are skipped b) all Catch blocks are executed
c) an error occurs d) the default exception is thrown

a) uncaught block b) uncaught exception
c) error handler d) thrower

a) only one Catch block b) several Finally blocks
c) one or more Catch blocks d) None of the above. 

a) Rethrow b) Throw

c) Try d) Catch

a) End Try b) End Finally 
c) End Catch d) End Exception 

a) after the Try block, but before each Catch block
b) before the Try block
c) after the Try block and the Try block’s corresponding Catch blocks
d) Either (b) or (c).

a) Catch block b) Finally block 
c) exception handler d) All of the above.
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Figure 32.16 Enhanced Miles Per Gallon application’s GUI.

a) Copying the template to your working directory. Copy the directory C:\Exam-
ples\Tutorial32\Exercises\EnhancedMilesPerGallon to your C:\SimplyVB
directory. 

b) Opening the application’s template file. Double click EnhancedMilesPerGal-
lon.sln in the EnhancedMilesPerGallon directory to open the application.

c) Adding a Try block. Find the btnCalculateMPG_Click event handler. Enclose all of
the code in this event handler in a Try block. 

d) Adding a Catch block. After the Try block, add a Catch block to handle any Forma-
tExceptions that may occur in the Try block. Inside the Catch block, add code to
display an error message dialog.

e) Running the application. Select Debug > Start to run your application. Enter
invalid data as shown in Fig. 32.16 and click the Calculate MPG Button. A Message-
Box should appear asking you to enter valid input. Enter valid input and click the
Calculate MPG Button again. Verify that the correct output is displayed.

f) Closing the application. Close your running application by clicking its close box.

g) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 32.11 Solution
2 ' MilesPerGallon.vb
3
4 Public Class FrmMilesPerGallon
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' calculate and return miles per gallon

10    Private Function MilesPerGallon( _
11       ByVal dblMilesDriven As Double, _
12       ByVal dblGallonsUsed As Double) As Double
13
14       Return dblMilesDriven / dblGallonsUsed
15    End Function ' MilesPerGallon
16
17       ' handles Calculate Button's Click event
18    Private Sub btnCalculateMPG_Click(ByVal sender As _
19       System.Object, ByVal e As System.EventArgs) _
20       Handles btnCalculateMPG.Click
21
22       ' retrieve user input
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32.12 (Enhanced Prime Numbers Application) Modify the Prime Numbers application
(Exercise 13.17) to use exception handling to process the FormatExceptions that occur
when converting the strings in the TextBoxes to Integers (Fig. 32.17). The original applica-
tion took two numbers (representing a lower bound and an upper bound) and determined all
of the prime numbers within the specified bounds, inclusive. An Integer greater than 1 is
said to be prime if it is divisible by only 1 and itself. For example, 2, 3, 5 and 7 are prime num-
bers, but 4, 6, 8 and 9 are not.

Figure 32.17 Enhanced Prime Numbers application’s GUI.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial32\Exercises\EnhancedPrimeNumbers directory to your C:\Sim-
plyVB directory.

b) Opening the application’s template file. Double click EnhancedPrimeNumbers.sln
in the EnhancedPrimeNumbers directory to open the application.

c) Adding a Try block. Find the btnCalculatePrimes_Click event handler. Enclose
all the code following the variable declarations in a Try block. 

23       Try
24
25          ' display miles per gallon
26          lblOutputValue.Text = String.Format("{0:F}", _
27             MilesPerGallon(Convert.ToDouble(txtMilesDriven.Text), _
28             Convert.ToDouble(txtGallonsUsed.Text)))
29
30       ' prompt for input in correct format
31       Catch formatExceptionParameter As FormatException
32
33          MessageBox.Show( _
34             "Please enter decimal numbers for ” & _ 
35             “the miles driven and gallons.", _
36             "Invalid Number Format", MessageBoxButtons.OK, _
37             MessageBoxIcon.Error)
38
39       End Try ' end Try...Catch statement
40
41    End Sub ' btnCalculateMPG_Click
42
43 End Class ' FrmMilesPerGallon
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d) Adding a Catch block. Add a Catch block that catches any FormatExceptions that
may occur in the Try block you added to btnCalculatePrimes_Click in Step c.
Inside the Catch block, add code to display an error message dialog. 

e) Running the application. Select Debug > Start to run your application. Enter
invalid data as shown in Fig. 32.17 and click the Calculate Primes Button. A Mes-
sageBox should appear asking you to enter valid input. Enter valid input and click
the Calculate Primes Button again. Verify that the correct output is displayed.

f) Closing the application. Close your running application by clicking its close box.

g) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 32.12 Solution
2 ' PrimeNumbers.vb
3
4 Public Class FrmPrimeNumbers
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' determine if number is prime

10    Private Function Prime(ByVal intNumber As Integer) As Boolean
11       Dim intCount As Integer ' declare counter
12
13       ' set square root of intNumber as limit
14       Dim intLimit As Integer = Convert.ToInt32(Math.Sqrt(intNumber))
15
16       ' loop until intCount reaches square root of intNumber
17       For intCount = 2 To intLimit
18
19          If intNumber Mod intCount = 0 Then
20             Return False ' number is not prime
21          End If
22
23       Next
24
25       Return True ' number is prime
26    End Function ' Prime
27
28    ' handles Calculate Primes Button's Click event
29    Private Sub btnCalculatePrimes_Click(ByVal sender As _ 
30       System.Object, ByVal e As System.EventArgs) _
31       Handles btnCalculatePrimes.Click
32
33       ' declare variables
34       Dim intLowerBound As Integer
35       Dim intUpperBound As Integer
36       Dim intCounter As Integer
37       Dim strOutput As String
38
39       ' attempt to retrieve input from user
40       Try
41          intLowerBound = Convert.ToInt32(txtLowerBound.Text)
42          intUpperBound = Convert.ToInt32(txtUpperBound.Text)
43
44          If intLowerBound <= 0 OrElse intUpperBound <= 0 Then
45             MessageBox.Show("Bounds must be greater than 0", _
46                "Invalid Bounds", MessageBoxButtons.OK, _
47                MessageBoxIcon.Exclamation)
48          ElseIf intUpperBound < intLowerBound Then
49             MessageBox.Show("Upper bound cannot be less than " & _
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32.13 (Enhanced Simple Calculator Application) Modify the Simple Calculator applica-
tion (Exercise 6.13) to use exception handling to process the FormatExceptions that occur
when converting the strings in the TextBoxes to Integers and the DivideByZeroException
when performing the division (Fig. 32.18). We will define what a DivideByZeroException is
shortly. The application should still perform simple addition, subtraction, multiplication and
division.

Figure 32.18 Enhanced Simple Calculator application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial32\Exercises\EnhancedSimpleCalculator directory to your
C:\SimplyVB directory. 

50                "lower bound", "Invalid Bounds", _
51                MessageBoxButtons.OK, MessageBoxIcon.Exclamation)
52          Else
53
54             ' loop from lower bound to upper bound
55             For intCounter = intLowerBound To intUpperBound
56
57                ' if prime number, display in TextBox
58                If Prime(intCounter) = True Then
59                   strOutput &= (intCounter & ControlChars.CrLf)
60                End If
61
62             Next
63          End If
64
65          txtPrimeNumbers.Text = strOutput
66
67       Catch formatExceptionParameter As FormatException
68          MessageBox.Show( _
69             "Please enter integers for the lower and upper " + _
70             "bounds.”, "Invalid Number Format", _
71             MessageBoxButtons.OK, MessageBoxIcon.Error)
72
73       End Try ' end Try...Catch statement
74
75    End Sub ' btnCalculatePrimes_Click
76
77 End Class ' FrmPrimeNumbers
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b) Opening the application’s template file. Double click EnhancedSimpleCalcula-
tor.sln in the EnhancedSimpleCalculator directory to open the application.

c) Adding a Try block to the btnAdd_Click event handler. Find the btnAdd_Click
event handler. Enclose the body of btnAdd_Click in a Try block.

d) Adding a Catch block to the btnAdd_Click event handler. Add a Catch block that
catches any FormatExceptions that may occur in the Try block that you added in
Step c. Inside the Catch block, add code to display an error message dialog.

e) Adding a Try block to the btnSubtract_Click event handler. Find the
btnSubtract_Click event handler, which immediately follows btnAdd_Click.
Enclose the body of the btnSubtract_Click in a Try block. 

f) Adding a Catch block to the btnSubtract_Click event handler. Add a Catch block
that catches any FormatExceptions that may occur in the Try block that you added
in Step e. Inside the Catch block, add code to display an error message dialog.

g) Adding a Try block to the btnMultiply_Click event handler. Find the
btnMulitply_Click event handler, which immediately follows
btn_Subtract_Click. Enclose the body of the btnMultiply_Click in a Try block. 

h) Adding a Catch block to the btnMultiply_Click event handler. Add a Catch block
that catches any FormatExceptions that may occur in the Try block that you added
in Step g. Inside the Catch block, add code to display an error message dialog.

i) Adding a Try block to the btnDivide_Click event handler. Find the
btnDivide_Click event handler, which immediately follows btnMultiply_Click.
Enclose the body of the btnDivide_Click in a Try block. 

j) Adding a Catch block to the btnDivide_Click event handler. Add a Catch block
that catches any FormatExceptions that may occur in the Try block that you added
in Step i. Inside the Catch block, add code to display an error message dialog.

k) Adding a second Catch block to the btnDivide_Click event handler. Immediately
following the first Catch block inside the btnDivide_Click event handler, add a
Catch block to catch any DivideByZeroExceptions. A DivideByZeroException is
thrown when division by zero in integer arithmetic occurs. Inside the Catch block,
add code to display an error message dialog.

l) Running the application. Select Debug > Start to run your application. Enter valid
input for the first number and 0 for the second number, then click the Button for
division. A MessageBox should appear asking you not to divide by 0. Enter invalid
input (such as letters) for the first and second number, then click any one of the But-
tons provided. This time, a MessageBox should appear asking you to enter valid
input. Enter valid input and click any one of the Buttons provided. Verify that the
correct output is displayed.

m)Closing the application. Close your running application by clicking its close box.

n) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answer:

1 ' Exercise 32.13 Solution
2 ' SimpleCalculator.vb
3
4 Public Class FrmCalculator
5    Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    ' handles addition Button's Click event

10    Private Sub btnAdd_Click(ByVal sender As System.Object, _
11       ByVal e As System.EventArgs) Handles btnAdd.Click
12
13       ' try to get user input
14       Try
15
16          lblResult.Text = (Convert.ToInt32(txtFirstNumber.Text) + _
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17             Convert.ToInt32(txtSecondNumber.Text)).ToString
18
19       ' handle case when user enters invalid input
20       Catch formatExceptionParameter As FormatException
21
22          ' prompt user for correct input
23          MessageBox.Show( _
24             "Please enter two integer values.", _
25             "Invalid Number Format", MessageBoxButtons.OK, _
26             MessageBoxIcon.Error)
27
28       End Try ' end Try...Catch statement
29
30    End Sub ' btnAdd_Click
31
32    ' handles subtraction Button's Click event
33    Private Sub btnSubtract_Click(ByVal sender As System.Object, _
34       ByVal e As System.EventArgs) Handles btnSubtract.Click
35
36       ' try to get user input
37       Try
38
39          lblResult.Text = (Convert.ToInt32(txtFirstNumber.Text) - _
40             Convert.ToInt32(txtSecondNumber.Text)).ToString
41
42       ' handle case when user enters invalid input
43       Catch formatExceptionParameter As FormatException
44
45          ' prompt user for correct input
46          MessageBox.Show( _
47             "Please enter two integer values.", _
48             "Invalid Number Format", MessageBoxButtons.OK, _
49             MessageBoxIcon.Error)
50
51       End Try ' end Try...Catch statement
52
53    End Sub ' btnSubtract_Click
54
55    ' handles multiplication Button's Click event
56    Private Sub btnMultiply_Click(ByVal sender As System.Object, _
57       ByVal e As System.EventArgs) Handles btnMultiply.Click
58
59       ' try to get user input
60       Try
61
62          lblResult.Text = (Convert.ToInt32(txtFirstNumber.Text) * _
63             Convert.ToInt32(txtSecondNumber.Text)).ToString
64
65       ' handle case when user enters invalid input
66       Catch formatExceptionParameter As FormatException
67
68          ' prompt user for correct input
69          MessageBox.Show( _
70             "Please enter two integer values.", _
71             "Invalid Number Format", MessageBoxButtons.OK, _
72             MessageBoxIcon.Error)
73
74       End Try ' end Try...Catch statement
75
76    End Sub ' btnMultiply_Click
77
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What does this code do? 32.14 What does the following code do, assuming that dblValue1 and dblValue2 are both
declared as Doubles?
 

78    ' handles division Button's Click event
79    Private Sub btnDivide_Click(ByVal sender As System.Object, _
80       ByVal e As System.EventArgs) Handles btnDivide.Click
81
82       ' try to retrieve user input and perform division
83       Try
84
85          Dim result As Integer = _ 
86             Convert.ToInt32(txtFirstNumber.Text) \ _
87             Convert.ToInt32(txtSecondNumber.Text)
88
89          lblResult.Text = result.ToString
90
91       ' handle case when user enters invalid input
92       Catch formatExceptionParameter As FormatException
93
94          ' prompt user for correct input
95          MessageBox.Show( _
96             "Please enter two integer values.", _
97             "Invalid Number Format", MessageBoxButtons.OK, _
98             MessageBoxIcon.Error)
99
100       ' handle case when user tries to divide by zero
101       Catch divideByZeroExceptionParameter As DivideByZeroException
102
103          ' prompt user for correct input
104          MessageBox.Show( _
105             "You cannot divide by 0. Please enter another value.", _
106             "Arithmetic Error", MessageBoxButtons.OK, _
107             MessageBoxIcon.Error)
108
109       End Try ' end Try...Catch statement
110
111    End Sub ' btnDivide_Click
112
113    ' handles TextChanged event
114    Private Sub txtFirstNumber_TextChanged(ByVal sender _
115       As System.Object, ByVal e As System.EventArgs) _
116       Handles txtFirstNumber.TextChanged
117
118       lblResult.Text = ""
119    End Sub ' txtFirstNumber_TextChanged
120
121    ' handles TextChanged event
122    Private Sub txtSecondNumber_TextChanged(ByVal sender _
123       As System.Object, ByVal e As System.EventArgs) _
124       Handles txtSecondNumber.TextChanged
125
126       lblResult.Text = ""
127    End Sub ' txtSecondNumber_TextChanged
128
129 End Class ' FrmCalculator

▲

1 Try
2
3    dblValue1 = Convert.ToDouble(txtInput1.Text)
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Answer: This code multiplies two Doubles if both inputs in txtInput1 and txtInput2 can 
be converted to type Double (that is, decimal or integer values). Otherwise it displays an 
error message dialog that informs the user to enter decimal values in the TextBoxes.

What’s wrong with this code? 32.15 The following code should add integers from two TextBoxes and display the result in
txtResult. Assume that intValue1 and intValue2 are declared as Integers. Find the
error(s) in the following code:

Answer: The error in this code is that the Catch block appears after the End Try keywords. 
All Catch blocks must appear before these keywords. Also, there should be no End Catch 
following the Catch block.

4    dblValue2 = Convert.ToDouble(txtInput2.Text)
5
6    txtOutput.Text = (dblValue1 * dblValue2).ToString
7
8 Catch formatExceptionParameter As FormatException
9

10    MessageBox.Show( _
11       "Please enter decimal values.", _
12       "Invalid Number Format", _
13       MessageBoxButtons.OK, MessageBoxIcon.Error)
14
15 End Try

▲

1 Try
2
3    intValue1 = Convert.ToInt32(txtInput1.Text)
4    intValue2 = Convert.ToInt32(txtInput2.Text)
5
6    txtOutput.Text = (intValue1 + intValue2).ToString
7
8 End Try
9

10 Catch formatExceptionParameter As FormatException
11
12    MessageBox.Show( _
13       "Please enter valid Integers.", _
14       "Invalid Number Format", _
15       MessageBoxButtons.OK, MessageBoxIcon.Error)
16
17 End Catch

1 Try
2
3    intValue1 = Convert.ToInt32(txtInput1.Text)
4    intValue2 = Convert.ToInt32(txtInput2.Text)
5
6    txtOutput.Text = (intValue1 + intValue2).ToString
7
8    Catch formatExceptionParameter As FormatException
9

10    MessageBox.Show( _
11       "Please enter valid Integers.", _
12       "Invalid Number Format", _
13       MessageBoxButtons.OK, MessageBoxIcon.Error)
14
15 End Try 
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Programming Challenge 32.16 (Enhanced Vending Machine Application) The Vending Machine application from
Tutorial 3 has been modified to use exception handling to process the IndexOutOfRangeEx-
ceptions that occur when selecting items out of the range 0 through 7 (Fig. 32.19). This type
of exception will be defined shortly. To get a snack, the user must type the number of the
desired snack in the TextBox, then press the Dispense Snack: Button. The name of the
snack is displayed in the output Label.

Figure 32.19 Vending Machine application.

a) Copying the template to your working directory. Copy the C:\Exam-
ples\Tutorial32\Exercises\EnhancedVendingMachine directory to your
C:\SimplyVB directory. 

b) Opening the application’s template file. Double click EnhancedVendingMa-
chine.sln in the EnhancedVendingMachine directory to open the application.

c) Adding a Try block. Find the btnDispense_Click event handler. Enclose all of the
code in the event handler in a Try block. 

d) Adding a Catch block. Add a Catch block that catches any FormatExceptions that
may occur in the Try block that you added to btnDispense_Click in Step c. Inside
the Catch block, add code to display an error message dialog. 

e) Adding a second Catch block. Immediately following the Catch block you added in
Step d, add a second Catch block to catch any IndexOutOfRangeExceptions that
may occur. An IndexOutOfRangeException occurs when the application attempts
to access an array with an invalid index. Inside the Catch block, add code to display
an error message dialog. 

f) Running the application. Select Debug > Start to run your application. Make an out
of range selection (for instance, 32) and click the Dispense Snack Button. Verify
that the proper MessageBox is displayed for the invalid input. Enter letters for a

▲
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selection and click the Dispense Snack Button. Verify that the proper MessageBox
is displayed for the invalid input.

g) Closing the application. Close your running application by clicking its close box.

h) Closing the IDE. Close Visual Studio .NET by clicking its close box.

Answers:

1 ' Exercise 32.16 Solution
2 ' VendingMachine.vb
3
4 Public Class FrmVendingMachine
5     Inherits System.Windows.Forms.Form
6
7    ' Windows Form Designer generated code
8
9    Dim strSnacks As String() = New String() _

10       {"Chocolate Chip Cookie", "Bubble Gum", _
11       "Plain Pretzel", "Soda", "Salted Pretzel", _
12       "Oatmeal Cookie", "Diet Soda", "Sugar-free Gum"}
13
14    ' method to dispense snack
15    Private Sub btnDispense_Click(ByVal sender As _
16       System.Object, ByVal e As System.EventArgs) _
17       Handles btnDispense.Click
18
19       ' try to get user input
20       Try
21
22          ' get user input
23          Dim intSelection As Integer = _
24             Convert.ToInt32(txtSelection.Text)
25
26          lblOutput.Text = strSnacks(intSelection).ToString & _
27             " has been dispensed"
28
29       ' handle case when user enters invalid input
30       Catch formatExceptionParameter As FormatException
31
32          MessageBox.Show( _
33             "Please enter an integer value", _
34             "Number Format Exception", _
35             MessageBoxButtons.OK, MessageBoxIcon.Error)
36
37       ' handle case when user inputs number not in array bounds
38       Catch indexExceptionParamter As IndexOutOfRangeException
39
40          MessageBox.Show( _
41             "Please enter a value between 0-7.", _
42             "Array Index Out of Bounds Error", _
43             MessageBoxButtons.OK, MessageBoxIcon.Error)
44
45       End Try ' end Try...Catch statement
46
47    End Sub ' btnDispense_Click
48
49 End Class ' FrmVendingMachine


